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About FlashPro

FlashPro is Microsemi's programming software tool for SmartFusion, IGLOO, ProASIC3, Fusion devices.
You will be able to navigate easily through the FlashPro software because of its similarities with other
Microsemi software tools. The FlashPro software includes the following features:

e Supports modification of I/O states during programming
e Supports automatic construction of chain from scan chain operation
e Supports importing non-Microsemi BSDL files for automatic chain construction
e Supports direct multiple Microsemi device chain programming and serialization
e Supports single device STAPL files generation
e Supports single device SVF files generation
e Supports single device IEEE 1532 files generation
e Supports Chain STAPL file generation
e Supports Chain SVF file generation
e Supports a single GUI to drive multiple FlashPro5/4/3/3X programmers for parallel programming
e Supports 1.2V programming for IGLOO devices
Note: Note: Parallel programming via FlashPro (USB/LPT1) or FlashPro Lite programmers is not supported.
e Supports device serialization for parallel programming
e Aredesigned GUI, which features a project manager to manage the programming files and data
e Enhanced In-System Programming (ISP) Support

An optional In-House Programming (IHP) service is available if you are purchasing Microsemi devices in
volume. Contact Microsemi for more information.

For step-by-step instructions on how to use these features, see the FlashPro Tutorial.

If you arrived here by pressing the F1 key in FlashPro, use the Search tool in help for more information on
specific content, or click the Help button embedded in any dialog box or GUI for context-specific help.

Installing FlashPro Express Software

See the FlashproExpress Installation Instructions on the Microsemi website for information on how to install
FlashproExpress software and relevant system requirements.

View the detailed Install Instructions and System Requirements at the Flashpro Express software page:
http://www.microsemi.com/products/fpga-soc/design-resources/programming/flashproexpress#overview

Programming Tool Model Overview

The FlashPro software is designed for use in the operation, user design, and production programming flows.

Design Debug

The figure below illustrates the programming design flow when an engineer is in debug mode. In the
programming design flow, the new Programming files (STAPL/ PDB) are generated for a design change and
are sent to the FlashPro software for testing and debugging the design.

Note: FlashPoint is integrated into Designer; therefore, the STAPL file is generated from Designer. FlashPro v6.2 and
greater can be used to export STAPL files from PDB files created by FlashPoint (Designer).

FlashPro User's Guide 5
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Figure 1 - Programming Design Flow

Operation/Production Planning

The figure below shows an illustration of the operation flow. In this illustration, the production coordinator
generates the programming files (STAPL/PDB) with or without serialization and/or security settings (see
Programming application note for further information). The production coordinator loads the programming
file in the FlashPro software to set up the configurations for production programming, such as Serialization
options, Action selections, and Procedure selections, etc.

FlashPoint
[Designer) Single Device STAPL

|

FlashPro JTAG
STAPL / PDE File Software FlashPro3 ProASIC3/E
N

Programming
Stations

Configuration File

Figure 2 - Operation Flow

The production coordinator may want to generate different configuration files for each programming station
(depending on the logistics and serialization options). For example, if the Programming file contains 10,000
serial data and the production coordinator decides to split the serial data designation to one thousand for
each programming station, then ten configuration files will be generated (one for each of the ten
programming stations). However, if you are not using serialization, you only need one configuration file.

The production coordinator can test the configuration files with one or more FlashPro5/4/3/3X programmers
before sending it to the production programming floor. If PDB files are used in the production flow, warning
icons may appear on the FlashPro/FlashPoint GUI because the automatic audit cannot find the source file
on the production environment; the PDB file contains the valid programming data. If STAPL files are used,
loaded STAPL files will be audited on execution of an action to determine if the original STAPL file has been
modified. If it has not been modified, the action will continue to run. If it has been modified you will be
prompted to reload the modified STAPL file, or to continue running the current action. If you select to reload
the modified STAPL file, all previous programming settings will be refreshed and will need to be performed
again.
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Programming Tool User Model Overview - SmartFusion Only

Operation/Production Programming

The figure below shows an illustration of the production programming flow. The operator imports the
configuration file and begins programming the devices by clicking the Run button. The operator's interaction

with FlashPro should be limited.
At the end of a programming session, the serialization log file (if applicable) and the programming log file are
sent back to the production coordinator for record keeping.

:1
FlashPro FlashPro3 JTAG ProASIC3/E
Software

send 1o
Production Coordinator
for record keeping

Configuration File

Serialization Log Programming Log

N~

Figure 3 - Production Programming Flow

A A J

Express Configuration Programming (IGLOO, ProASIC3 and Fusion devices only)

The figure below illustrates the Express Configuration Programming Flow. In this flow, you can program the
security setting into the IGLOO, ProASIC3 and Fusion family device directly from the FlashPro software.

Note: FlashPoint is integrated into the FlashPro v6.0 and later software.

ITAG

FlashPro ProASIC3/E

Software

I FlashPro3

PDE Flle with
Security Settings

Figure 4 - Express Configuration Programming Flow

Programming Tool User Model Overview - SmartFusion Only

The FlashPro software is designed for use in the operation, user design, and production programming flows.

Design Debug

The figure below illustrates the programming design flow when an engineer is in debug mode. In the
programming design flow, the new files (FDB, UFC, EFC) are generated for a design change and are sent to
the FlashPro software for testing and debugging the design.
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Figure 5 - SmartFusion Programming Design Debug Flow

Operation/Production Planning

The figure below shows an illustration of the operation flow. In this illustration, the production coordinator
generates the programming files (STAPL/PDB) with or without serialization and/or security settings (see
Programming application note for further information). The production coordinator loads the programming
file in the FlashPro software to set up the configurations for production programming, such as Serialization
options, Action selections, and Procedure selections, etc.
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Figure 6 - SmartFusion Operation Flow

The production coordinator may want to generate different configuration files for each programming station
(depending on the logistics and serialization options). For example, if the Programming file contains 10,000
serial data and the production coordinator decides to split the serial data designation to one thousand for
each programming station, then ten configuration files will be generated (one for each of the ten
programming stations). However, if you are not using serialization, you only need one configuration file.

The production coordinator can test the configuration files with one or more FlashPro5/4/3/3X programmers
before sending it to the production programming floor. If PDB files are used in the production flow, warning
icons may appear on the FlashPro/FlashPoint GUI because the automatic audit cannot find the source file
on the production environment; the PDB file contains the valid programming data. If STAPL files are used,
loaded STAPL files will be audited on execution of an action to determine if the original STAPL file has been
modified. If it has not been modified, the action will continue to run. If it has been modified you will be
prompted to reload the modified STAPL file, or to continue running the current action. If you select to reload
the modified STAPL file, all previous programming settings will be refreshed and will need to be performed
again.

Operation/Production Programming

The figure below shows an illustration of the production programming flow. The operator imports the
configuration file and begins programming the devices by clicking the Run button. The operator's interaction
with FlashPro should be limited.
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SmartFusion2 Programming

At the end of a programming session, the serialization log file (if applicable) and the programming log file are
sent back to the production coordinator for record keeping.

[

FlashPro ITAG

Software

Configuration File FlashPro4/3/3X SmartFusion

send 10
Production Coordinator
Serialization Log Programming Log for record keeping

S

Figure 7 - SmartFusion Production Programming Flow

h 4

h 4

Creating a New PDB for SmartFusion

The figure below illustrates the new SmartFusion programming flow. In this flow you can program the
security, FPGA Array, FlashROM and Embedded Flash Memory (NVM) for SmartFusion.

FlashPro JTAG ;
. || FlashPro 4/3/3¥ || SmartFusion

Security Only (no file)
FDB
EFC
UFC

l

FlashPro PDB

Figure 8 - Creating a New PDB for SmartFusion

SmartFusion2 Programming

SmartFusion2 programming is executed from within Libero SoC.

See the Libero SoC help for information on SmartFusion2 programming, including programming
authentication error codes and programming error codes.

FlashPro User's Guide 9
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Supported Families

Microsemi's Libero SoC software supports the following families of devices:
e SmartFusion2

e IGLOO2

e SmartFusion
¢ IGLOO

e ProASIC3

e Fusion

When we specify a family name, we refer to the device family and all its derivatives, unless otherwise
specified. See the table below for a list of supported device families and their derivatives:

Table 1 - Product Families and Derivatives

Device Family Description
Family Derivatives
SmartFusion2 | N/A Address fundamental requirements for advanced security, high reliability and low power in
critical industrial, military, aviation, communications and medical applications.
IGLOO2 N/A Low-power mixed-signal programmable solution

SmartFusion

SmartFusion

SmartFusion intelligent mixed-signal FPGAs are the only devices that integrate an FPGA,
ARM Cortex-M3, and programmable analog, offering full customization and IP protection.

Fusion N/A Mixed-signal FPGA integrating ProASIC3 FPGA fabric, programmable analog block, support
for ARM® Cortex -M1 soft processors, and flash memory into a monolithic device.
IGLOO IGLOO The ultra-low-power, programmable solution
IGLOOe Higher density IGLOO FPGAs with six PLLs and additional I/O standards
IGLOO nano | The industry’s lowest power, smallest size solution
IGLOO PLUS | The low-power FPGA with enhanced I/O capabilities
ProASIC3 ProASIC3 The low-power, low-cost, FPGA solution
ProASIC3E Higher density ProASIC3 FPGAs with six PLLs and additional I/O standards
ProASIC3 Lowest cost solution with enhanced I/O capabilities
nano
ProASIC3L The FPGA that balances low power, performance, and low cost
Automotive ProASIC3 FPGAs qualified for automotive applications
ProASIC3
Military Military temperature ASPE600L, A3P1000, and A3PE3000L
ProASIC3/EL
RT ProASIC3 | Radiation-tolerant RT3PE600L and RT3PE3000L
10 FlashPro User's Guide
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Installing FlashPro Software and Hardware

Installing FlashPro Software and Hardware

See the FlashPro Installation Instructions on the Microsemi website for information on how to install
FlashPro software/hardware and relevant system requirements.

View the detailed Install Instructions and System Requirements at the FlashPro software page:
http://www.microsemi.com/products/fpga-soc/design-resources/programming/flashpro#overview

Starting FlashPro

You can start the FlashPro software from Programs > Microsemi FlashPro vx.x >
FlashPro. If you installed the program in a folder other than FlashPro, choose that folder from the
Programs menu.

The figure below shows the FlashPro GUI. From this GUI, you can create a new project by clicking the New
Project button or open an existing project by clicking the Open Project button.

You can also access the above features from the menu bar. You can access all the other features after you
open or create a new project.

FlashPro User's Guide 11
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FlashPro Interface

The main FlashPro interface consists of two views, one for Single Device Programming and the other for
Chain Programming (see figure below). The GUI consists of a Flow window, Device Configuration Window
(for single or chain programming), Log window and a Status bar. The Log window displays programming
information, error messages, and warning messages. The Status bar displays your programming mode
(chain programming or single device programming) and file status.
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DM 2 &% @n HE €4 & ©HDs |5 0
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Figure 9 - FlashPro for Single Device File Programming

Note the different options in the Flow window for the Chain Programming GUI and the Single Device
Programming GUI. In addition to the different Flow window options, the Chain Programming GUI view
consists of the Chain Configuration window which displays the devices in your chain.
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Figure 10 - FlashPro for Chain Programming

Creating a New Project

With the FlashPro software, you have the option of choosing either the Single STAPL file or Chain
programming mode. You make this choice through the New Project dialog box (see figure below). By
choosing the Chain Programming mode, you are enabling chain programming. The Single STAPL file
Programming mode functions with the same programming capabilities as the FlashPro software v4.2.

To create a new project:
1. Click the New Project button or from the File menu choose New Project.
2. From the New Project dialog box, type in the name of your project in the Project Name field.

New Project E

Project Mame:
f proiz]

Project Location:
I CiDocuments and Settingsifarlew Browse. .. |

Programming mode

% Single device
" Chain

OF I Cancel | Help |

Figure 11 - New Project Dialog Box

3. If necessary, change the default location of your project in the Project Location field.
4. Choose your Programming mode (Single device or Chain).
5. Click OK. The FlashPro GUI displays (see figure below).
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Opening a Project

You can open a project from the File menu or by clicking on the Open Project button in the flow window.

To open a project:

Figure 12 - FlashPro GUI

Note: You can switch between the two programming modes from Tools > Mode. From there, you can choose either Single

Device Programming or Chain Programming.

1. From the File menu, choose Open Project. The Open Project dialog box appears.

2. Find your project file or type in your project file name in the File name field.

3. Click Open.

Saving a Project

Click the Save button on the toolbar, or from the File menu choose Save Project to save your project.

If you want to save your project under a different name/path, from the File menu choose Save Project As
and save your project with the new name.

Parallel Programming with FlashPro5/4/3/3X

Parallel programming enables you to program multiple Microsemi devices in parallel with multiple
programmers. In parallel programming, all targeted devices are programmed with the same programming
file (STAPL). The targeted device or chain configuration that is connected to each programmer must be

identical.

The FlashPro software together with the FlashPro5/4/3/3X programmers supports parallel programming via
a USB port. You can connect up to sixteen FlashPro5/4/3/3X's to a PC via a USB v1.1 or a USB v2.0 port.
FlashPro5/4/3/3X requires a self-powered hub.

Connecting FlashPro5/4/3/3X (a USB v2.0 enabled programmer) to USB v1.1 port increases device
programming time due to a slow data transfer rate on the USB v1.1 port in comparison to a USB v2.0 port.

Note: FlashPro (USB/LPT1) or FlashPro Lite programmers do not support parallel programming.

14
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Serialization with FlashPro

The following figure illustrates how you can connect a FlashPro5/4/3/3X programmer for parallel
programming.

» FlashPrao3 | ProASIC3E
H > FlashPro3 » ProASIC3E
/ E
H
]
H / E
U >
E '
H
l
B —
» FlashPro3 » ProASIC3E
H
U * FlashPro3 3 ProASICIE
B —»
-

L

Figure 13 - Connecting a FlashPro5/4/3/3X Programmer

An independent thread processes the STAPL file during parallel programming. In an Microsemi test, parallel
programming is approximately five times faster than programming 16 devices sequentially.

Note: Microsemi has tested Belkin PCI-USB cards and hubs. We have found that parallel programming works best with
the vendor's latest driver installed and with the matching hubs.

Serialization with FlashPro

You can use the FlashROM in the ProASIC3 device for serialization. For each target ProASIC3 device,
different FlashROM contents are generated.

Serial Programming enables you to program a sequence of ProASIC3 devices in serial with an identical
FPGA program and with different serialization data. Serialization data can consist of different FlashROM
content and/or AES key values. To learn how to activate the serialization feature, see Skip Serial Data or
Reuse Serial Data.

There are two different STAPL formats that support serial programming, multiple actions to multiple serial
data and single action to multiple FlashROM.

Multiple Actions to Multiple FlashROM Serial Data

This format supports a generic STAPL player because the STAPL player does not provide a mechanism for
Serial Programming. One programming action is created to target different serial data. See examples below:

- PROGRAM_1 programs the FPGA Array and the first serial data.

FlashPro User's Guide 15
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- PROGRAM_2 programs the FPGA Array and the second serial data.

Single Action to Multiple FlashROM Serial Data

This format is created when the target programmer is FlashPro, Sculptor Il, or BP auto programmer, where
the newly innovated Microsemi Serial Programming mechanism is supported. One programming action will
program multiple serial data in serial.

FlashPro and SVF

SVF (Serial Vector Format) is an industry standard file format that is used to describe JTAG operations. Like
STAPL files, SVF files are used for describing the in-system programming algorithm for SmartFusion,
IGLOO, ProASIC3 and Fusion family devices. Unlike STAPL files, SVF files support only one ACTION or
programming flow per file, due to language limitations. In addition, the SVF specification does not support
message display and flow control, such as conditional statements or loops.

As a result, Microsemi tools (Designer and FlashPro software) generate a set of SVF files corresponding to
the equivalent STAPL ACTIONS that are applicable to the silicon features selected.

For example, for a typical STAPL file that has the following ACTIONS: ERASE, ERASE_ALL, PROGRAM,
PROGRAM_ARRAY, VERIFY, VERIFY_ARRAY, DEVICE_INFO, READ_IDCODE, and
VERIFY_DEVICE_INFO, a set of corresponding SVF files are generated and named: ERASE.sVf,
ERASE_ALL.svf, PROGRAM.svf, PROGRAM_ARRAY .sVf, etc. These files are generated in a folder,
<Programming File Name>_svf, created during generation. The diagram below demonstrates the
differences between the STAPL and SVF files that are created.

STAPLFILE SVE FOLDER
PROGRAM PROGRAM.svf
ERASE

ERASE svf
VERIFY

VERIFY.svf
PROGRAM_ARRAY
VERIFY ARRAY ERASE ARRAY.svf
DEVICE_INFO

VERIFY_ARRAY.svf

Figure 14 - STAPL vs SVF files
NOTE: DEVICE_INFO.svf file is not generated because SVF files do not support messsage display or flow control.

Table 2 - SVF Outline

SVF File Array | FROM NVM Security | Previously
(Flash | Settings | Programmed
Memory Device?
System
Builder)
ERASE X X YES or NO
ERASE_ALL X X X YES or NO
ERASE_ARRAY X YES or NO
ERASE_FROM X YES or NO
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SVF File Array | FROM NVM Security | Previously

(Flash | Settings | Programmed

Memory Device?

System

Builder)
ERASE_SECURITY X YES or NO
PROGRAM X X YES or NO
PROGRAM_ARRAY X YES or NO
PROGRAM_FROM X YES or NO
PROGRAM_NVM X YES or NO
PROGRAM_SECURITY X YES or NO
VERIFY X X X YES or NO
VERIFY_ARRAY X YES or NO
VERIFY_FROM X YES or NO
VERIFY_NVM X NO
ENC_DATA_AUTHENTICATION | X YES

STAPL Actions not Available with SVF
The following STAPL actions are not available with SVF: DEVICE_INFO, VERIFY_DEVICE_INFO,

READ_IDCODE

FlashPro and the 1532 File Format

1532 is an IEEE industry standard file format that is used to describe JTAG operations. Like STAPL files,
1532 files are used for describing the in-system programming algorithm for SmartFusion, IGLOO, ProASIC3
and Fusion family devices. 1532 programming file generation will generate two files (*.isc, *.bsd) within a

folder.

& Microsemi

FlashPro and the 1532 File Format

The folder will be created with the following name <Programming File Name>_1532. The *.bsd file contains
the IEEE 1532 programming algorithm. The *.isc file contains the programming data to be programmed into

the device.

IEEE 1532 programming files will only be exported in FlashPro for SmartFusion devices when an FDB has been properly

imported.

STAPL to 1532 Action Mapping
The IEEE 1532 standard requires using default ACTION names in order to function with 1532 compliant

players. The table below describes the STAPL to 1532 ACTION name mappings.

NOTE: 1532 ACTIONS can have a data member parameter to allow reuse of the same ACTION name for different

features.

Table 3 - STAPL to 1532 Action Name Mapping

FlashPro User's Guide
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STAPL Action 1532 Action
ERASE_FROM ERASE(FROM)
PROGRAM_FROM PROGRAM(FROM)
VERIFY_FROM VERIFY(FROM)
PROGRAM PROGRAM
PROGRAM_ARRAY PROGRAM(ARRAY)
ERASE_ARRAY ERASE(ARRAY)
ERASE ERASE
ERASE_ALL ERASE(ALLDATA)
VERIFY VERIFY
VERIFY_ARRAY VERIFY(ARRAY)
READ_IDCODE READ(IDCODE)
ENC_DATA_AUTHENTICATION VERIFY(ENCDATA)
PROGRAM_SECURITY PROGRAM(SECURITY)
DEVICE_INFO READ
VERIFY_NVM VERIFY_NVM

VERIFY_SECURITY

VERIFY(SECURITY)

PROGRAM_NVM

PROGRAM_NVM

STAPL Actions not Available with 1532

The following STAPL action is not available with 1532: VERIFY_DEVICE_INFO

18
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Single STAPL/PDB File Basic Tutorial

Introductory Programming Tutorials

Single STAPL/PDB File Basic Tutorial

This section provides step-by-step instructions to familiarize you with the basic features of the FlashPro
software, specifically how to program a device. For more detailed step-by-step instructions and help with
advanced features of the software, please see specific topics in the online help.

Note: This tutorial assumes that you have already installed the latest version of FlashPro software and have started the
program.

First, create a new project and name it Tutorial. If FlashPro is launched through the Libero SoC, a new
project will be created automatically and a PDB or FDB file loaded, if available.

To Create a Project:
1. Click the New Project button in FlashPro.
2. Inthe New Project dialog box, type Tutorial in the Project Name field.

Mew Project §|

Projeck Marme:

Project Location:
| Browse. .,

Programming mode

* Single device
" Chain

K | Cancel Help

Figure 15 - New Project Dialog Box
If necessary, change the default location of your project in the Project Location field.

Select the Single device Programming mode

5. Click OK. The FlashPro GUI displays (see figure below). The Programmer List Window updates with
your programmer information.

FlashPro User's Guide
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1 FlashPro - [dddd] * (=3

File Edt Yiew Tools Programmers Configuration Customize Help

DEE ¢ % o HE 4 & oHdH |9 0

Mew Project D :
OpenProect (@™ _>

Frogrammer Programmes Poit Py Py
MName Type Statuz Enabled
]
E Refrash/Rescan for Programmers
x| Software Wersion: 9.1.2.0 -
<l |priver : 3.0.0 buila 1
progeaumeer '300964' : FlashProd

Created new project 'Vilkiran\programming designs\fsfidesignec)impli)dddd_fphdddd. pro*

PDB file 'V:\kiren\programming designs\fsfidesigner)impll)dddd.pdb' has been loaded successfully.
DESIGN : dddd: CHECESUM : 7C2F; PDBE_VERSION : 1.6

Checking for software updates...

Rescanning for Programmers...

All j Errors ) Warnings J\ Info

Ready i Ykiran\programming_designs\fsFidesignerlimpl 11dddd pdb SINGLE

Figure 16 - FlashPro Main Window

Loading and Configuring a Programming File

Once you have created your project and connected your programmer, you are ready to load your PDB or
STAPL file.

To load a Programming file:

1. Click the Configure device button. The Single Device Configuration window displays in FlashPro .

2. Click the Browse button to find your Programming file.
3. From the Load Programming File dialog box, select your Programming file and click Open.

The Single Device Configuration Window updates to list your Programming file information and the actions
available with your Programming file in the Action list box (see figure below). Program is the default action
displayed in the Action list box.

Note: Microsemi recommends using the default settings.

x [ Programming file

dddd.pdb Browse. ..
Modify. ..
DATE_MODIFIED Thu Feb 03 15:58:14 2011 P Mode: © Basic = Advanced
FDE_FILE_NAME Vilkiran\prograuming designs)fsf\dasig .
CREATOR Designer Version: S.1.2.0 Achion
MODIFIED
3 DESICH dddd |':'HD'3F'-°‘M ﬂ
CHECKSUM 7FCZF
; PDB_WERSION 1.6 Procedures. ..
5 IDCODE 035341CF
'__ IDHASH OFFFFFFF
& |FAMILY FUSION
E DEVICE AFS1500 ¥
< >
¥
g Chain Parameter. ..
-

Figure 17 - Single Device Configuration Window
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This tutorial gives instructions on how to program a device. For an explanation on the other actions
available, see Programming File Actions.

Programming a Device
Now that you have loaded your PDB file, programming a device is the next step.

To program a device:
1. From the Action list, select Program (see figure below).

x [ Programming file

dddd.pdb

Browse...
Modify. ..

DATE_MODIFIED Thu Feb 03 15:53:14 2011 A Mode: ( Basic * Advanced
PDE_FILE_NAME Vilkiran\programming designs)fsfidesic
CREATOR Designer Version: 9.1.2.0 Action
MODIFIED

3 | [pESION dddd PROGRAM =]
CHECHSUM 7C2ZF

E PDE_VERSION 1.6 Procedures..

§ |IDCODE D3E3ALCE

®| |IDMASKE OFFFFFFF

o |FAMILY FUSION

‘g DEVICE AFS1500 b4
< >

b}

é Chain Parameter. ..

@

&

Figure 18 - Selecting Program from the Action List box
2. Click the Procedures button (see figure below).

Action

|PROGRAM =l

Figure 19 - Procedures Button

The Select Action And Procedures dialog box appears, showing the procedures for the Programming
action (see figure below). Microsemi recommends using the default settings.
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Select Action And Procedures @

Action:

.
Procedures I:
W_INITIALIZE

CHECK_AND_BACKUP_CALIB

v DO_ERASE

DO_PROGRAM

vl DO_VERIFY_BOL

¥ DO_PROGRAM_RLOCK _
DO_VERIFY_PGM_RLOCK

¥ DO_PROGRAM_NVM_3 =

Restore Default Procedures
Help OK Cancel

Figure 20 - Select Action and Procedures Dialog Box
3. Click the Restore Default Procedures button.

4. In FlashPro click the Program button to program your device.

The Programmer List Window updates the Programmer Status column with Run Passed indicating that
you have successfully programmed the device (see figure below).

Note: The status indicator updates during programming to show the programming progress, then it will
change to a pass or fail result when the operation is complete.

Programmer Programmer Part Programmer Programmer
MName Type or Status Enabled
1103375 FlazhPra3 usb03375 (USB 1.1)  RUM PASSED v

Figure 21 - Successfully Programmed Device

5. View the Log window and take note of the details about your programmed device.
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Single Microsemi Device with Serialization Tutorial

This tutorial provides step-by-step instructions on how to program a single Microsemi Device with
Serialization. Before you begin this tutorial, make sure you have already installed the FlashPro software and
that you are familiar with the basic features of using the FlashPro software.

First, create the file generator using FROM for device serialization. You must have access to the Libero IDE
v8.0 or later software to complete this step.

To Configure the FROM data for serialization:

1. Generate FROM via the Catalog.

2. From the Properties section in the FlashROM Settings dialog box, select Auto Inc or Read From
File region. For the Auto Inc region, specify the step value. You will not be able to modify this value in
the FlashPoint software.

Complete the normal design flow and finish place and route.
Select Program FlashROM .
Click Browse to find the UFC file.

Check the FPGA Array box and click Next. The FlashROM Settings window appears (as shown in the
figure below).

o v oa oW

FlashROM Settings - Step 2 of 2 %
|FIashROM regions: Region_7_10 ;I
Prograrn Properties:

page Harne Fegion 7 10

v Start page 7
Start ward 10

v Length B
Cantent Static:

¥ State Fixed

I3 Type HEX
Walus 12323

I

v

v

v

FlashR.OM STAPL File bvpe
’7 * Single STAPL file for all devices " One STAPL file per device
Mumber of devices to program: 100 Target Programmer... |
Help | Back I [exk I Firish | Cancel |

Figure 22 - FlashROM Settings- Step 2 of 2
7. Select the FROM page you want to program and data value for the configured regions.
Note: Note: The generated STAPL file contains only the data that targets the selected FROM page.

8. Modify properties for the serialization by specifying the Start and Max values. For the Auto Inc region,
specify the Start and Max values. For the Read From File region, select the file name of the custom
serialization file.

9. Select the FlashROM programming file type you want to generate from the two options below:
Choose single STAPL file for all devices: generates one programming file with all FROM values.
Choose one STAPL file per device: generates a separate programming file for each FROM value.
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Enter the number of devices you want to program and generate the required programming file.

11. Click the Finish button.

You have completed the steps to enable device serialization. Now you are ready to program a device using

Device Serialization in FlashPro.

To program a device using device serialization:
1. Click the New Project button in the FlashPro.
2. Inthe New Project dialog box, type Tutorial in the Project Name field.
3. Check the Single STAPL file option from the Programming Mode area.
4. If necessary, change the default location of your project in the Project Location field.
5. Click OK. The FlashPro GUI appears (see figure below).

T FlashPro - [dddd] * EEIX

Fil= Edt ‘iew Tools Programmers Configuration Customze Help

D 2 &% @i HE €4 % £H08 | 0

Mew Project D

Open Project @

View Programmers %|

o .

|

dddd.pdb

B

DATE_MODIFIED
FDB_FILE_NAME
CREATOR
MODIFIED
DESIGH
CHECKSUM
PDE_VERSION
IDCODE

Thu Feb 03 L5:58:14 Z0LL
V:ikiran\programming designs)fsfide: Action
Designer Version: 9.1.2.0

dddd
TCZP

1.8
O353ALCF

Mode: " Basic  Advanced

[PROGRAM

=l

Procadures...

|

|- | | | Single Davice Sonfiguration Window -

Progeammer

Software Version: 9.1.2.0
Driver : 3.0.0 build 1

'30964" : FlashProd

Created new project 'Viikiran) programiming designs)f£sf)designer’ impll)dddd fpldddd.pro’

DESIGN : dddd; CHECESUM : 7C2F; FPDBE VERSION : 1.6
Checking for software updates...

PDB file 'Vilkiran\programming designshfsfi\designec)impll)dddd.pdb' has been loaded successfully.

Rescanning for Programmers...
i ll,{&rmiwamsgs x[r\fn?

Ready Wi ir an\programining_designs fsfidesigner impll \dddd.pdb  STNGLE

Figure 23 - FlashPro Main GUI

The Programmer List Window updates with your programmer information.

6. Click the Configure STAPL File button to load the STAPL file. The Single STAPL Configuration

Window appears in the FlashPro GUI.
7. Click the Browse button to find your STAPL file.

From the Load STAPL File dialog box, find your STAPL file and click Open. The Single STAPL
Configuration Window updates to list your STAPL file information and the actions available with your

STAPL file in the Action list box (see figure below).
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x | Prograrmming Fil=

I Serialization
i, pib Browse...
Modify...
DATE MODIFIED Sat Jan 29 19:38:14 2011 ~
PDE_FILE_NAME V:\kiran\programaing designs\sf_ser)de Action
CREATOR FlashPro Wersiom: 9.1.2.0
MODIFIED FlashPro Version: 2.1.2.0 [pﬂggw j
é DESIGH
- CHECESTHM Q0o
5 POB_VERSION 1.8 Procedues...
.E IDCODE OEALZLCF
IDMASE ODFFFFFF
FAMILY PAZSOCE by
< ?
£
a Chain Parameter... Inspect Device
#

Figure 24 - Single STAPL Configuration Window with STAPL File Uploaded

9. From the Single Device Configuration Window in FlashPro, check the Serialization box and click
the Select Serialization Indexes button.

The Serial Settings dialog box appears (see figure below).

Serial Settings [$_<|

W00 ] O N e L P —

[v Yiew unused data
[v View used data
[v View skipped data

Filker: | *

v Log serial data; |Regiu:un_6_3 j

Help

Hagla»

o]

Cancel |

Figure 25 - Serial Settings Dialog Box

10. From the Serial Settings dialog box, click All to select all the serial data.
11. Click OK. The Serialization Indexes text box updates (see figure below).
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v Seriglization
Serialization

Action: | FROGRAM ﬂ Procedures...

| i Select Senalization ndexes. . |

Sernal Indexes | Skate | Programmers |

Jruzed
Jruzed
Jruzed
Jruzed
Jruzed
Jruzed
Jruzed
Jruzed
Jruzed
1] Jruzed

i 8 Y o 3 R Y S ) Y

M ext Senialization Data: 1

Figure 26 - Single STAPL File Configuration Window- Serialization Indexes Update
12. Click the Program button to program your device using serialization.

Chain Programming Tutorial

This tutorial demonstrates how to directly program an APA300 device that is part of a heterogeneous JTAG
chain. The example in this tutorial uses one APA300 device and three non-Microsemi devices configured as
shown in the figure below.

Note: This tutorial is performed in Advanced Mode. Y ou can change your display mode to Advanced Mode from the
Preferences dialog box.

Tbo Device d Device 3 Device 2 Device
o — [ DO 0l DO oI TDO oI DO |

™S ™S ™S ™S ™S
- ‘ ‘ - | APA300
TCK T Nor-Actel — 1o Non_Actel — 1o Non-Actel ’,TCK

Figure 27 - APA Device Tutorial Example

First, create a new project.

To create a new project:
1. Click the New Project button in FlashPro.
2. Inthe New Project dialog box, type Tutorial in the Project Name field.
3. Select the Chain option in the Programming Mode.
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Chain Programming Tutorial

Mew Project rz|

Project Mame:

| Tutorial

Project Location:
| A Ackelpril Tukorial Browse, ..

Pragramming maode

" Single device
{* Chain

K | Cancel Help

Figure 28 - New Project Dialog Box

4. If necessary, change the default location of your project in the Project Location field.
5. Click OK. The FlashPro GUI appears (see figure below).

A FlashPro - [Tutorial] E]@]@

File Edit ¥lew Tools Programmers Conflguration Customize  Help

0= T ||[esdR ||, 02 EE | s ®

|»

Mew Project ']j

Open Project Eﬂ Wiew Programmers % -
- e | -
x
Programmer Programmer P Pri N o
Mame Type Port S tatus Enabled Device / Action

Hetresh/Hescan hor Frogrammers

Progranmer List Window

Software Version: §5.0.0.40

Created new project 'C:hlictelpri)fpro_tutorialitutorial.pro!
Software Version: §5.0.0.40

Created new project 'C:%ActelprihTutorialiTutorial.pro'

Lo lx.

| hAII A Errurs A W i gy },‘Infu .{

Ready Mo devices inchain CHAIN

Figure 29 - FlashPro Main GUI
Note: Note: The Programmer List Window updates with your programmer information.

6. From the Menu bar, click Programmers > Scan Chain (or select the programmer in the Programmer
List Window, right-click and choose Scan Chain).

Scan Chain shows how the devices are ordered in the chain in the Log window (see figure below). In this example, APA300 is the

first device and will be programmed first in the chain since it is connected directly to TDO.
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Ed| programmer '3017Y5' @ 3can Chain. ..

| programmer '30175' ¢ Found 32 instruction register bits.
programmer ' 30175' @ Checking IDCODES. ..
programwmer '30175' @ Dewiee 1: 11A051CF Mfr: Actel Part: APA3OO0
programmer '30175' @ Dewvice Z: Unknown
programmer ' 30175' @ Dewvice 3: Unknown
programwmer '30175' @ Dewviee 4: Unknown
programmer ' 30175' @ 3can Chain PAISED.

Figure 30 - Log Window Scan Chain Order
Add Actel Device 'A or

7. From the Chain Configuration window, click either ;

Add NonrActel Device buttons to add devices to the chain. In this example, click the Add
Microsemi Device button because the APA300 is the first device in the chain.

The Add Microsemi Device dialog box displays (see figure below).

Add Actel Device [X]

Programming File: | J

" Device

Device: | J

Marne |

Help | (0] 4 | Zancel

Figure 31 - Add Microsemi Device Dialog Box

Select the File radio button and click the Browse button to find your programming file.
9. Select the Device radio button, then choose the APA300 device from the Device drop-down.

10. Inthe STAPL File field, load the APA300.stp file by using the Browse button “'* to locate the file.
11. In the Name field, keep APA300 as the default name.
12. The APA300 device is added to the Chain Configuration Window (see figure below).

x—i{TDI N TDO}—O...—.{TDI 2 TDOHTDI 1 TDO}—O

Iv Show Chain E diting

Device Hame File

1 | APA3O0 [ | AP 2300 0 CiManualstestuesignerimpl WAPA300 sty E]I

2 | Mon Actel [ |Device 2

Figure 32 - Chain Configuration Window: Device One

12. Click the Add Non-Microsemi Device button to add the non-Microsemi device. The Add Non-
Microsemi Device dialog box appears (see figure below). You can load the BSDL file or enter the IR
length and Max TCK Frequency of the device. In this tutorial, you will enter the IR length and Max TCK
frequency for this device.
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Add Non-Actel Device

X)

" File
BSDL file: |

* Data

IR length: 2
Max TCK Freq.: |1 MHz

Mame: | Device 2

el o ]

Cancel

Figure 33 - Add Non-Microsemi Device Window
14.

For this device, enter 8 in the IR length field and keep the Max TCK freq default to 1IMHz.
15. Name the device, "Device 2" and click OK. The second device now appears in the Chain Configuration
Window (as shown in the figure below).
x—i{TDI N TDO}—O...—.{TDI 2 TDOHTDI 1 TDO}—O

Iv Show Chain E diting

Device

Hame

1 | &PA300 [l AP2Z00

File
O CManualstestidesignerimpl APAZ00 stp
2 | Mon Actel [ |Device 2

]|

Figure 34 - Chain Configuration Window: Device Two

16. Repeat step 15 for Device 3 and Device 4.

17.

Check the Enable Device box for the APA300 device. After you add all the devices in the chain, the
Chain Configuration Window should look like the figure below.

x—i{TDI N TDO}—O...—.{TDI 2 TDOHTDI 1 TDO}—O

Iv Shaowe Chain Editing

Device Hame File
1 | APAZOO0 [+ | &FA3500 & CManualstestidesignerimpl! WRA300 st =]
2 | Mon Actel [ |Device 2
3 | Mon Actel [ |Device 3
4 | Mon Actel [&)|Device 4

Figure 35 - Chain Configuration Window: All Devices in the Chain

18.

After you have added all of the devices to the chain in the correct order, click the Run button to
program the chain.
19. When programming is complete, the results are listed in the Log window (see figure below).
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x| progrowmcyr '30175" @ Scoan Choain. ..
J prograwmer '30175' : Zcan Chain PASSED.
programmer '30175' @ device 'APAS00' : Executing action PROGRLH

prograrmer '30175' : device 'APA300' : SERIAL# = OC1DFA7EBOG0SO
programmer '30175' @ device 'APAI00' : PROGRAMMING AREAY

programmer '30175' @ device 'APA3S00' : VERIFYING PROGRAMMED BITS...
programmer '30175' @ device 'APA3S00' : VERIFYING NON-PROGRAMHMED EITS...

prograwmer '3U1VLY @ device ' APAIUUY @ Finished: Tue Jul 15 1d:iUY:iod SUUG (Elapsed time UUIUE:IUU)
prugramm=r '30175"  device "APAIO0" : ExecuLing amcLion PROGRAN PAISED.
prograwmer '30175' : Chain programweing PASSED.

o-0-0-0-0-20

Figure 36 - Programmer List Window: Programming Complete

SmartFusion Programming Tutorial

You can program your SmartFusion device without using the Libero SoC by using an EFC or UFC file from
standalone SmartDesign, or using an FDB file from standalone Designer.
To program a SmartFusion device without using the Libero SoC:

1. Start FlashPro and click New Project to create a new project. Specify your Project Name, Project
Location and Programming Mode.

Click Configure Device.

3. Single Mode: Click the Create button to create your new PDB programming file. The create PDB
dialog box appears (as shown in the figure below).

Create PDB §|

Device: | AZF200M3F =]

Package:  |ssaget

Marne: |smartFusiUn_Dl 13

Location: | Ciactelpritsmartfusion_0113

]
[o]4 | Cancel |

Figure 37 - Create PDB Dialog Box

Chain Mode: Click Add Microsemi Device and choose a SmartFusion device from the drop-down menu.
Click the Create PDB button in the Chain Configuration Window. The Create PDB dialog box appears.

4. Specify your PDB parameters. Click OK to continue. The FlashPoint SmartFusion Programming File
dialog box appears.

5. Specify your security settings and select which silicon features you want to program. Click the Import
button for your EPGA Array, FlashROM and Embedded Flash Memory files to add them to your PDB
file.

You must have a FDB file to program your FPGA Array, a UFC file to program your FlashROM, and a
EFC file to program your Embedded Flash Memory.

Click the Modify buttons if you wish to modify your FlashROM or Embedded Flash Memory files
before you save your PDB file.

6. (Optional) Specify your 1/0O States During Programming.
7. Click Save PDB to save your new PDB file.

If you make changes to your Security, I/O States During Programming, EFC, UFC or FDB file, click Modify
in FlashPro to open and re-save your PDB with the updated files and settings.

See Reprogramming a Secured Device for information on programming a secured SmartFusion device.
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Modifying Memory Contents and Programming a Device Tutorial

This tutorial provides step-by-step instructions on how to load a Program Database (PDB) file, modify the
memory contents, and program the device.

Before you begin this tutorial, you should have a design with an EFMB client in it with a generated
programming file for this design. You will first create a new project and title it "tutorial.” If FlashPro is

launched through Libero SoC, a new project will automatically be created and a PDB file will be loaded, if
available.

Creating a new project

If you are familiar with this feature, follow the basic procedures for creating a new project. However, if you

would like step-by-step instructions, see the creating a new project section in the Single STAPL/PDB File
Basic Tutorial.

Loading and Configuring a PDB File
Once you have created your project and connected your programmer, you are ready to load your PDB file.

To load a PDB file:

1. Click the Configure Device button. The Single PDB Configuration window appears in FlashPro.
2. Click the Browse button to find your PDB file.
3. From the Load PDB File dialog box, find your PDB file and click Open.

Modify Embedded Flash Memory Block Content
Now, you are ready to modify the Embedded Flash Memory Block content.
To modify Embedded Flash Memory Block content:
1. Click the PDB Configuration button to open FlashPoint.

FlashPoint - Programming File Generator - Step 1 of 3

Silicon Featurels) to be programmed:
o [V Security settings
[¥ FPGA Array
¥ FlashRom
Criginal FlashROM configuration File:

Embedded Flash Memory Blocks (EFME):

Program :I:;:; LE('::;::m Original Configuration File
1 Ird firrmareh AN 1 F:%Flash_temom_Block.efc Madify...

™ Programming previously secured device(s)

Modify I/C States During Pragrarmming. ..

Silicon signature {max length is § HEX chars):

Help Text Firish Cancel

Figure 38 - Program File Generator
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2. Check the Program box.

3. Click the Modify button to import Embedded Flash Memory Block configuration and memory content
file. The Modify Embedded Flash Memory Block dialog box appears

Madify Fmbedded Flash Memory Rlack 3]
Block name: Firrnwaral VM _INST
Dlock location: 1
Bluck vonfigur ation fiks: DiwrodaDauditimm_all new Al eveelc It © nnfiguration FHe. .. |
Bluck conent:
Solect All Clients Unscloct All Chents
Stan —_ JTAG Protection
Prngram |Client Type | Client Name | Address e Hrevent MPrevent | MNriginal Memnry Content File
fhex)  [dePtiRwidth) ooy wiite
1 = Analng Spste  ash M LT I =
2 73 CFI Data cfiData N/ A I M~ Dr:\prodB0auditmm_simple\inpul_m Impart content...
3 4 Dala Sluaue s 1] 148 I r D AprodB0ausBrmvn sanplehingd Import content
4 W Intiakzation it oo 1H0 I | r Dr:\prod00audithmm_smple'input_m Impart content...
5 F RAM Initiakzat raminit 100 5129 I r
heo | o | cancel |

Figure 39 - Modify Embedded Flash Memory Block Content Dialog Box

4. Click the Import Configuration File button to import the Embedded Flash Memory Block configuration
and memory content from the EFC file. This will populate the client table below. All clients that belong
to this block will be selected by default.

5. Click the Import content button if you want to change the client memory content.

6. Click OK.

7. Click Finish.
Note: FlashPoint audits original configuration and memory content files and warns you if the files cannot be located or if
they have been updated. These files are not required as the last updated configuration and memory content is stored in the

PDB.

~

The original configuration file has changed.
Click on the Modify button to view the details.

al Configuration File

ctelpriFlashProhFuzsion_Viewhsm | paodify,.

Figure 40 - Audit Warning

Proceed to program the device. For steps on how to program a device, see the Programming a device
section of the Single STAPL/PDB file basic tutorial.

Modifying FlashROM Contents and Programming a Device Tutorial

This tutorial provides step-by-step instructions on how to load a Program Database (PDB) file, modify the
memory contents, and program the device.

Before you begin this tutorial, you should have a design with an EFMB client in it with a generated
programming file for this design. You will first create a new project and title it "tutorial." If FlashPro is
launched through the Libero SoC Project Manager, a new project will automatically be created and a PDB
file will be loaded, if available.

Creating a new project

If you are familiar with this feature, follow the basic procedures for creating a new project. However, if you
would like step-by-step instructions, see the creating a new project section in the Single STAPL/PDB File
Basic Tutorial.
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Modifying FlashROM Contents and Programming a Device Tutorial

Loading and Configuring a PDB File

Once you have created your project and connected your programmer, you are ready to load your PDB file.
To load a PDB file:

1. Click the Configure Device button. The Single Device Configuration Window displays in FlashPro
(see figure below).

x| Programming File
To continue,

lnad existing programming File Browse. ..
or create new POE Fils

[Snpan. [

Figure 41 - Single Device Configuration Window

Single Device Configuration Window

2. Click the Browse button to find your PDB file. From the Load Programming File dialog box, find
your PDB file and click Open. .

Modify FlashROM Content
Now you are ready to modify the FlashROM content.
1. Click the PDB Configuration button. This opens FlashPoint.
2. Select FlashROM under Silicon feature(s) to be programmed (see figure below).

FlashPoint - Programming File Generator - Step 1 of 3

Silicon Featurels) ko be programmed;
e v Security settings
v FPGA Array
¥ Flashrom
Criginal FlashROM configuration File:

Embedded Flash Memory Blocks (EFME):

Program Ella?lﬁ:: LE{I:':t:iI:Jn Original Configuration File
1 ™2 firmwareh /My _ 1 F:\Flash_Memory_Block. efc Fodify...

[ Programming previously secured device(s)

Modify IQ States During Programming. . .

Silicon signature (max length is 8 HEX chars):

Help ek Finish Cancel

Figure 42 - FlashPoint Programming File Generator
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3. Click the Browse button to select the *.ufc FlashROM configuration file by and navigating to the
configuration file. This file is normally present in the SmartGen subfolder of the Libero SoC project, in a
folder with the FlashROM IP block's name.

Click Next.
5. Select the FlashROM pages you want to program (see figure below).

FlashROM Settings - Step 2 of 2 3
|FIashROM regions; Fegion_0_0 LI
Program Propettizs:
page Marne Region_0 0
v Start page 0
Start word a
v Length 16
Content Static
¥ State Fixed
I Type HEX
Walue F14F8FF4Fa40341861
I SESERDOT1104050
v
v
v

Help | Back I Text I Finish Cancel

Figure 43 - FlashROM Settings Dialog Box

6. Click Finish.

Proceed to program the device. For steps on how to program a device, see the Programming a device
section of the Single STAPL/PDB file basic tutorial.

Programming Only Security Settings Tutorial

This tutorial provides step-by-step instructions on how to program only the security settings into a device.
No design or PDB file is needed to follow this tutorial.

First create a new project and name it tutorial. If FlashPro is launched from the Project Manager, a new
project will automatically be created and a PDB file will be loaded, if available. For this tutorial you always
need to create a new project.

Creating a New Project

If you are familiar with this feature, follow the basic procedures for creating a new project. However, if you
would like step-by-step instructions, see the creating a new project section in the Single STAPL/PDB file
basic tutorial.

Configuring the Security Settings
Once you have created your project and connected your programmer, you are ready to load your PDB file.
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Programming Only Security Settings Tutorial

To configure the security settings:
1. Click the Configure Device button. The Single Device Configuration window appears in FlashPro
(see figure below).

= | [~ Programming file
Ta continue,

load existing programming File Browse. ..
or create new FOE file

ESTTE ||

Figure 44 - Single Device Configuration Window

Single Device Configuration Window

2. Click Create. This opens the Create PDB dialog box, as shown in the figure below.

Create PDB &|

Device: | j
Package: | ﬂ

Marmne: | |

Lacation: |

Ik | Cancel |

Figure 45 - Create PDB Dialog Box

3. Select the desired device and package (if available) from the drop down list, and specify the filename
and location. Click OK. FlashPoint opens. SmartFusion, IGLOO, ProASIC3 and Fusion family devices
support securing the device with a pass key as well as encrypting programming files using an AES
key. Flash devices can also be permanently locked, preventing reprogramming.

4. Check the Security Settings checkbox to secure the unsecured device.

Warning: Make a note of the security keys that you are using. Once a device is secured, it cannot be
reprogrammed without those keys.
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X

Security Settings - Step 2 of 2

Security level For this device:

- | - High - Protect with Pass Key. ~

- Lock the FPGA Array For both writing and verifving,
- Use the Pass Key o write or verify,

Medium

- Lock the FlashROM For both reading and writing wvia the

ITAG intetface.

- Use the Pass Key to read or write,

= _  Mone ¥
Custorn Level, .. Default Level |
Pass Key (max length is 32 HEX chars):
A | Generate random key |

AES Key (max length is 32 HEX chars):

Help Back | Finish | Cancel

Figure 46 - Security Settings Dialog Box

5. Click Finish.

Proceed to program the device. For steps on how to program a device, see the Programming a device
section of the Single STAPL/PDB file basic tutorial.

Automatic Chain Construction Tutorial
This tutorial demonstrates how to automatically scan a chain of devices and construct the chain within
FlashPro. Automatic chain construction saves the effort of manually adding each device to your chain.

The software also scans the chain before constructing it, which reduces the possibilities of having errors in
the chain. This feature is fully automated if your chain is composed of only Microsemi devices. If you have
non-Microsemi devices in your chain, you can still use the Auto Chain Construction feature. However, you
will be required to either manually add the BSDL file or enter the IR length and max TCK for each non-
Microsemi device. This tutorial goes through the flow for an Microsemi-only chain first, followed by
instructions on adding Non-Microsemi devices to the database.

Note: This tutorial requires that your chain is connected to the computer you are using, via an Microsemi programmer, and

that you have suitable programming files to program the devices in your chain.

To automatically scan a chain of devices and construct the chain:
1. Start a new project in FlashPro. Select Chain as the Programming Mode.
2. Click the Configure Chain button in FlashPro.

3. From the Configuration menu, choose Construct Chain Automatically; or click the Construct the
chain from a Scan Chain operation link in the Chain Configuration Window, see below.
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Figure 47 - Construct Chain Automatically
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4. A popup appears asking you to select the programmer you would like to use from the ones attached to
your computer. Choose the appropriate programmer (as shown in the figure below) and click OK.

Scan Programmer(s)

The device chain will be autamatically builk to makch the
physical chain of one or more programmers.

Select the programmet(s) you wank bo scan:

Prograrmmer(z]
303964

Select Al | Unselect Al

Help

Cancel

X

Figure 48 - Select Programmer Popup

an example.
¥ FlashPro - [mm] *

Fle Edit Wiew Tools Programmers Configuration Customize Help

DEE ? |[%a® =

Automatic chain construction starts. The Log window documents the detection and verification of all devices
in your chain. The devices are added to the chain in the Chain Configuration Window; see figure below for

ezl e b B BE R R R RE A
Programmer Programmer Prog Progi - c
Illlm Type Port Status Enabled Device / Action
130964 FlashProd usb30964 (USB 20) SCAN CHAIN PASSED Icd
Refresh/Rescan for Programmers .| RUN IE!!B |
: s
- Add Actel Device 14
—-|rn| N rnol—-no —-|r|)| 2 rnol—-lrnl 1 TDO}—- CresteFDB.. | Configure Device.. | ﬂ ﬂ &
Add NorvActel Devicel
¥ Show Chain Editing Inspect Device |
- - IR Max TCK = Enable = Enable B Serial
Device MName File Length (MHz) Device | Seral Action
1| AIPILNWAGL] B ATPILNVAGLINGS =]
2 | AFSEO0 = | AFSEND

10 | mf

Figure 49 - Scan Chain Configuration Passed

FlashPro User's Guide

Data

HIGH-Z
]

37



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
- - when clicked. View the online help included with software to enable all linked content.
& Microsemi

In some cases, FlashPro is not able to uniquely identify the device due to shared IDCODEs, and lists all
possible devices (ex: AGLO30V2/AGL030V5). Once a programming file is loaded for that device, the device
field only shows one device, since the programming file will only be targeted to one device.

Adding Non-Microsemi Devices to the Chain

FlashPro recognizes non-Microsemi devices in the chain, but it does not contain any device information,
such as IR length or Max TCK. The figure below lists Microsemi devices and non-Microsemi devices in the

chain.
x .
: Add Actel Device 14 |
_-|rn| N 1|)o|_- e _-|1|)| 2 rnoI_-|r|;| 1 T00|—' Create PDB... | Configure Device... | il iJ il
Add Nar-detel Device
[¥ Show Chain Editing Inspect Device
- = IR Max TCK = Enable = Enable c Serial
Device Name File Length (MHz) Device | Serial Action Data HIGH-Z
1 ASPILNVAGLL B AZPILINVAGLINGS = 8 10 r L
2 | AFSBO0 [ | AFSE00 8
3 MonActel B devicel 2 1
3 4 MonActel | device2 2 1
4[5 | NonActel | deviced 2 1

Figure 50 - Non-Microsemi Devices in a Chain

You must import the BSDL file into Microsemi's non-Microsemi device database for FlashPro to recognize
your non-Microsemi device.

To import the device BSDL into the FlashPro non-Microsemi device database and run the scan
chain:

1. From the Tools menu, choose Import Settings for Non-Microsemi Devices. This opens the Import

Settings for Non-Microsemi Devices dialog box. This dialog box enables you to import and remove
BSDL files from the database and lists all the device information contained in the BSDL file.

2. Click the Import BSDL Files button and navigate to the folder that contains your BSDL files. Select
the file and click OK. Once the BSDL is imported into the database, the original BSDL file is no longer
audited by FlashPro. If changes are made to the original source BSDL file, it will not affect the BSDL
file that has been imported into the non-Microsemi device database.

Remove BSDL files from the database by selecting the file and clicking the Remove button.

3. Once you have the appropriate BSDL files loaded to the database, you can construct the chain. To do
so, from the Configuration menu, choose Construct Chain Automatically and select the appropriate
programmer from the dialog box. FlashPro runs a scan chain, detects the devices in the chain, and
associates them with the BSDL files in the database, as shown in the figure below.

x Add Actel Device 2 ]
—+IDI N 100'_,“. —+IDI 2 -"”H-lm 'I TDO}—' Creste FDB... | Conifigure Uwice...] FaR xl el Device 74
Add Nonfictel Device
[¥ Shows Chain Editing =

g = IR Max TCK  Enable Enable - Serial
e D e Length = [MHz) | Device Serial HEDD Data Lol
1 | Hon Actel ™| devicel 2 1
3 | MonActel ™| device3 2 1
3 4 | AFSE00 | AFS600 =] 8 10 I |
5 |5 | AIPLINIAGLL B3| ASPILNVAGLINIZS @ 8 10 r r

Figure 51 - Non-Microsemi Devices in the Chain with Associated BSDL Files

It is possible to add multiple BSDL files to your Non-Microsemi device database that have the same
IDCODE. If the BSDL files list the same IR length but different TCK values, FlashPro automatically chooses
the file with the lowest TCK value by default and no action is required. If the IR lengths are different you
receive an error message asking you to resolve the conflict.

To resolve the issue, click the drop-down arrow adjacent to the device name. This opens the Non-Microsemi
Device Configuration dialog box (as shown in the figure below). From here you can choose the BSDL file
that you wish to use. Browse to the BSDL file or use the Data to input the IR length and Max TCK
Frequency. Once you select your data you can enter a new hame or use the default.
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Figure 52 - Non-Microsemi Device Configuration Dialog Box

For a tutorial on manually adding both Microsemi and non-Microsemi devices to your chain as well as
programming the chain, refer to the Chain Programming Tutorial.

See Also
Understanding the Chain Configuration Window
Import Settings for Non-Microsemi Devices

eNVM/EFMB Client JTAG Protection Use Flow

eNVM/EFMB client JTAG protection enables you to protect specific clients with a User Pass Key while
leaving others unprotected.

See the eNVM Client JTAG Protection Tutorial or EEFMB Client JTAG Protection Tutorial for step by step
instructions.
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Figure 53 - eNVM/EFMB Client JTAG Protection Tutorial Use Flow

eNVM Client JTAG Protection Tutorial - SmartFusion

This tutorial provides step-by-step instructions on how to enable JTAG protection for eNVM clients. The
protection can be read, write or both and it is protected with a User Pass Key (FlashLock).

The JTAG protection of eNVM clients enables you to protect specific clients with a User Pass Key while
leaving others unprotected.

One example use is IP customization. This enables an IP vendor to allow limited visibility to eNVM clients for
IP customers. The IP vendor can protect specific clients and leave other clients unprotected for modification
by IP customers. See the eNVM/EFMB Client JTAG Protection use flow diagram for a detailed example of a
typical use case.

Before you begin this tutorial, make sure you have already installed the FlashPro software and that you are
familiar with its basic features.

JTAG READ/WRITE protection is set when you create your original eNVM in Libero SoC. You cannot
change this setting in FlashPro/FlashPoint.

40

FlashPro User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

& Microsemi

eNVM Client JTAG Protection Tutorial - SmartFusion

Importing an EFC (Embedded Flash Configuration) File with Client JTAG

protection in a Previously Unsecured PDB

1. Create a client in eNVM configurator with JTAG read and write protect (as shown in the figure below).
If the MSS block is generated with an eNVM client with JTAG protection then FlashPro requires that you

specify a User Pass Key prior to programming or exporting programming files.

Add Data Storage Client @

Cliert name: |Legr_1
|
Content:
% Memory file: |E:\daa\Wnrancs\Fmgmmrrhg\eNVM JTAG Pr

Foemat Aslel-Binau.-j Brovese.,,

" Mo conbert [client iz a placeholder)

0 | Use shsolute addressing

Start address: 0w |B0 _|:|

Size of word: 8 -] bits

Murnber of words: 3 [decimal)

JTAG Protection

[+ Prevent iead [V Prevent wite

0K Cancel

1

Figure 54 - Generating the EFC File with JTAG Protection

2. Import the EFC file with JTAG protection in FlashPoint. When the EFC file is imported the Security
Settings box is checked automatically, implying that you must set the User Pass Key (as shown in the

figure below).
The PDB file cannot be saved without specifying the pass key.
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Figure 55 - Importing the EFC File with JTAG Protection

3. Click Specify to open the Security Settings dialog box. Notice that Enable eNVM client JTAG
protection box is checked. This indicates that reading, writing, and verifying of other eNVM pages are
allowed but the reading and writing of specific eNVM clients are protected.

4. To enforce the eNVM client JTAG protection in the PDB file, enter a Pass Key or click Generate
random key (as shown in the figure below).
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eNVM Client JTAG Protection Tutorial - SmartFusion

Security Settings E|

Security level For this device:

" High No protection
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AFS Key (max length is 32 HEX chars):

Help (a4 Cancel

Figure 56 - Setting Security

Custom Level Security Settings

If you select Custom Level security and decide to protect writing of the entire eNVM block, then the eNVM
client JTAG protection Write, if enabled, will be overridden by full block protection.

If the Read protection of the eNVM block is left open, then the eNVM client JTAG protection Read will be
enabled if a client has a read protection enabled.

If you choose to encrypt the entire eNVM block, then the eNVM client JTAG protection Write will be disabled
if enabled, due to enforced encryption. The eNVM client JTAG protection Write, if enabled, will be
overridden by full block protection.

To set Custom Level Security:

1. Click Custom Level to open the Custom Security Level dialog box (as shown in the figure below)
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Figure 57 - Setting Security for Unprotected eNVM Clients

2. Click the Set Security checkbox to secure Read, Write and Verify using Flash Lock. In this mode you

can unlock Read and Verify and only protect Write by FlashLock. The eNVM client JTAG read
protection will be enabled.

3. Click the Encrypt checkbox to secure Write using the AES Key. Read, Verify will be secured by

FlashLock in this mode. You must enter the AES key in addition to the Pass Key before saving the
PDB file.

Setting Standard Security Levels

There are two types of standard level security: High and Medium. If either of the two is selected the eNVM
client JTAG protection is overridden or disabled. You can enforce Read, Write and Verify protection of the
entire eNVM block with the Pass Key and/or AES key. JTAG protection of specific pages will not be
available.

Importing EFC (Embedded Flash Configuration) File with Client JTAG Protection
in Previously Secured PDB
The secure PDB file exported from FlashPro is called a secured PDB.

If you import an EFC file that has JTAG protection into a secured PDB file but does not have eNVM clients
with JTAG protection enabled then the FlashPro returns an EFC file has eNVM client JTAG protection
and cannot be loaded error, as shown in the figure below.
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EFMB Client JTAG Protection Tutorial - Fusion

EFC fibe has ey client JTAG protection and cannot be loaded.
Security cannot be modified in a currenthy secured PDE,

QK

Figure 58 - EFC File with JTAG Protection Cannot be Imported into a Secured PDB Error Message
You can import any EFC file that does not have JTAG protection.
You cannot import a new EFC with JTAG protection into a secured PDB that already has an EFC file

imported with eNVM client JTAG protection. You can update the memory content by importing MEM files for
the specific clients (as shown in the figure below).

Currently loaded EFC has eNVYM client JTAG protection and
! cannot be changed in a currently secured PDE,
You can update memory content by importing
rem File For each individual client.

OK

Figure 59 - New EFC File Cannot Overwrite Existing eNVM Client JTAG Protection Error Message

EFMB Client JTAG Protection Tutorial - Fusion

This tutorial provides step-by-step instructions on how to enable JTAG protection for eNVM clients. The
protection can be read, write or both and it is protected with a User Pass Key (FlashLock).

The JTAG protection of EFMB clients enables you to protect specific clients with a User Pass Key while
leaving others unprotected.

One example use is IP customization. This enables an IP vendor to allow limited visibility to EFMB clients for
IP customers. The IP vendor can protect specific clients and leave other clients unprotected for modification
by IP customers. See the eNVM/EFMB Client JTAG Protection use flow diagram for a detailed example of a
typical use case.

Before you begin this tutorial, make sure you have already installed the FlashPro and/or Designer software
and that you are familiar with its basic features.

JTAG READ/WRITE protection is set when you create your original EFMB in Libero SoC. You cannot
change this setting in Designer/FlashPoint or FlashPro/FlashPoint.

EFMB Client JTAG Protection in Designer/FlashPoint

If the ADB file has an EFM (Embedded Flash Memory) block with page/client JTAG protection enabled, the
EFC file appears in the FlashPoint window when you click the Programming File button in Designer.

A message indicating JTAG protection is enabled appears in the Embedded Flash Memory Block (EFMB)
tooltip, as shown in the figure below.
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Figure 60 - EFMB Client JTAG Protection
To set EFMB Client JTAG Protection:

1. Check the Security Settings or Programming previously secured devices checkbox and click
Next. The Security Settings dialog box opens.

2. Specify the appropriate security settings.

If the EFM block is generated with an EFMB client with JTAG protection then FlashPro requires that you
specify a User Pass Key prior to programming or exporting programming files.

3. Import the EFC file with JTAG protection in the FlashPoint dialog box. When the EFC file is imported
the Security Settings box is checked automatically, implying that you must set the User Pass Key (as
shown in the figure below).

The PDB file cannot be saved without specifying the pass key.
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1 @ ¥ MYk _block_04.. 1 D:AFusion_Mediatsmartgenirvm_jta... | Modify...

™| Programming previously secured device(s)

o Specify [j0 States During Programming. ..

Silicon signature {max length is 8 HEX chars):

Help | Back | Text | Finish I Cancel |

Figure 61 - Importing the EFC File with JTAG Protection

4. Click Next to open the Security Settings dialog box. Notice that the Enable EFMB client JTAG
protection box is checked. This indicates that reading, writing, and verifying of other EFMB pages are
allowed but the reading and writing of specific EFMB clients are protected.

5. To enforce the EFMB client JTAG protection in the PDB file, enter a Pass Key or click Generate
random key (as shown in the figure below).

Security level For this device:
- | - Hgh Mo protection ;I
- Allovs writing and verifying of the FPGA Array.
iy - Allows reading, writing, and verifying of the FlashROM,
Jemsg Elﬂgw readin_g, writing, and verifying of the EFME (EFME client
Mo protection is enabled).

€ Enable EFME client ITAG pratection
EFME client 1TAG protection is enabled.

[
Custom Level.., Default Level |
Pass Key (max length is 32 HEX chars):
Z7BECACZESSoDa201509F097 1B557F11 Generate random key |
AES key {max length is 32 HEX chars):
I Generate random key |

Help | Back | Finish | Cancel |

Figure 62 - Setting Security

Custom Level Security Settings

If you select Custom Level security and decide to protect writing of the entire EFMB, then the EFMB client
JTAG protection Write, if enabled, will be overridden by full block protection.
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If the Read protection of the EFMB is left open, then the EFMB client JTAG protection Read will be enabled
if a client has Read protection enabled.

If you choose to encrypt the entire EFMB, then the EFMB client JTAG protection Write will be disabled due
to enforced encryption. The EFMB client JTAG protection Write, if enabled, will be overridden by full block

protection.

To set Custom Level Security:
1. Click Custom Level to open the Custom Security Level dialog box (as shown in the figure below)

Custom Security Level E

Silicon Feature Se?:zllilyn Encrypt Heasdecu'\l:-:risfeumizrile
FPGA Amay - I
FlashROM - r
NY¥M_block_0/NVM_INST [ 1) O o

o To see EFME client JTAG protection information place your mouse cursor over each block

[~ Permanently lock the security settings.

Help | OF I Cancel |

Figure 63 - Setting Security for Unprotected eNVM Clients
2. Click the Set Security checkbox to secure Read, Write and Verify using Flash Lock. In this mode you
can unlock Read and Verify and only protect Write by FlashLock. The EFMB client JTAG read
protection will be enabled.

3. Click the Encrypt checkbox to secure Write using the AES Key. Read, Verify will be secured by
FlashLock in this mode. You must enter the AES Key in addition to the Pass Key before saving the

PDB file.

Setting Standard Security Levels

There are two types of standard level security: High and Medium. If either of the two is selected the EFMB
client JTAG protection is overridden or disabled. You can enforce Read, Write and Verify protection of the
entire EFMB with the Pass Key and/or AES key. JTAG protection of specific pages will not be available.

EFMB client JTAG Protection via FlashPro/FlashPoint
If the PDB file was created with the EFMB client and JTAG protection is enabled you can click Modify in
FlashPro to change the settings.

Fusion Calibration Backup and Recovery Tutorial

This tutorial provides step-by-step instructions on how to backup and recover default calibration data on a
Fusion device. It assumes that you have created a new project, connected your programmer, and loaded a
Fusion PDB/STAPL file created in Designer v8.4 or above.

If you would like step-by-step instructions on how to create a new project, see the Creating a New Project
section in the FlashPro Single STAPL Basic Tutorial..

If you would like step-by-step instructions on loading a programming file, see the Loading and Configuring a
Programming File section in the FlashPro Single STAPL Basic Tutorial.

Note: This feature is only supported in STAPL and PDB programming files.
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Specify /O States During Programming Tutorial

Backing Up Default Fusion Calibration Data

A backup copy of the Fusion calibration data is created once after ANY programming ACTION, except
READ_IDCODE, is executed. The copy will be stored in the spare pages of eNVM. The FlashPro Log
window shows that a backup copy of the calibration data has been created (as shown in the figure below).

programuer '07898' : Scan Chain...

programmer '078928' @ Scan Chain PASSED.

programeer '07898' : Executing action PROGRAM

programmer '078598' : Checking for Backup Calibration Data...
programmer '07528' : Reading Master Calibration Data...
programoer '078%8' : Writing Calibration Backup Copy
programmer '07S528' : Erase

programoer '07528' ¢ Conpleted srase

progresmoer '07898' : Progresmning FPGA Array

Figure 64 - FlashPro Log Window

Recovering Default Fusion Calibration Data

1. Load the PDB/STAPL file created in Designer v8.4 or above.

2. In the FlashPro Configuration window, click Advanced and select RECOVER_CALIB (as shown in the
figure below).

Action

Procedures...

Figure 65 - RECOVER_CALIB

3. Click Run to restore the original Fusion calibration data. The Log window shows the data is restored (as shown

in the figure below).
programmoer ' 07385' : Scan Chain. ..
programmer ' 073953' : Scan Chain PASSED.
programmer '07358' : Executing action RECCVER CALTE
programmer ' 073853' : Checking for Backup Calibration Data...
programmer ' 073953' @ Reading Master Calibration Data...
programmoer '073853' @ Writing Calibration Backup Copy
programmoer ' 07385' : Checking for Backup Calibration Data...
programmer '073953' @ Restoring Master Calibration Data.

Figure 66 - Restoring Original Calibration Data
Note: The Calibration data can only be restored after a backup has been made.

Specify 1/0O States During Programming Tutorial

This tutorial explains how to modify the I/O states during programming within FlashPro for used and unused
1/0s. It also explains how to modify the Boundary Scan Registers (BSRs) for each 1/O to allow for more
detailed customization of the I/O states during programming. Finally, it shows how to save and load these
settings with a file.

Note: This tutorial requires a design with a valid *.pdb file associated with it. If you launch FlashPro from a Libero SoC
project, a FlashPro project is created automatically and the PDB file loaded. Otherwise, you can start a new FlashPro
project and load a PDB file; refer to Single STAPL/PDB file basic tutorial for more information.
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You can also modify the individual Boundary Scan Registers; see the Modify Boundary Scan Registers
section for more information.

To modify the state of an 1/0 during programming:

1. Once your PDB is successfully loaded, from the Configuration menu, choose PDB Configuration.
This brings up FlashPoint . FlashPoint is the tool that allows you to modify the PDB programming file
from within FlashPro.

2. In FlashPaint, click the Specify I/O States During Programming button. The Specify I/O States
During Programming dialog box appears (as shown below). This dialog box enables you to modify the

I/O states during programming for all used and unused I/Os.

Specify I/0 States During Programming
Load from file. .. | Save ko file... | [™ show BSR Details
Port Hame Macro Cell Pin Humber 1/0 State [Output Only) j
BIST ADLIB:INBUF T2 1
BvPASS_I0 ADLIB:INBUF K1 1
CLK ADLIB:INBUF B1 1
ENOUT ADLIB:INBUF J16 1
LED ADLIB:OUTBUF M3 a
MONITOR[O] ADLIB:OUTBUF ES a
MOMITOR[] ADLIB:OUTBUF c7 d
MOMITOR[Z] ADLIB:OUTBUF k] d
MONITOR[3] ADLIB:OUTBUF D7 d
MONITOR[4] ADLIB:OUTBUF A1 d
OEa ADLIB:INBUF E4 d
OEb ADLIB:INBUF F1 d
O5C_EN ADLIB:INBUF K3 d
PAD[10] ADLIB:BIBUF_LYCMOS33U ME d
PAD[11] ADLIB:BIBUF_LYCMOS33D R? d
PAD[12] ADLIB:BIBUF_LYCMOS33U D11 d
FPAD[13] ADLIB:BIBUF_LVCMOS 33D ciz z
PAD[14] ADLIB:BIBUF_LYCMOS33U RE d LI
Help | OF I Cancel |

Figure 67 - 1/0 States During Programming Window

The default view displays a grid with 4 columns: Port Name, Macro Cell, Pin Number, and I/O State (Output
Only). Port Name lists the port associated with each of theses pins, if the pin is not used in the design, the
Port Name for this pin reads Unused. The Pin Number column contains a list of all the pins for the package
associated with the design open in FlashPro.The Macro Cell column contains the Microsemi macro
associated with each pin, as with Port Names, if the pin is not used, the Macro Cell for this pin reads
Unused. The I/O State column is the only column editable in FlashPro.

3. Select an I/0O State from the drop-down menu for each 1/0O you want to modify.

Please refer to Specifying 1/0 States During Programming for information on sorting and selecting multiple
entries in the grid.

4. Click Save in the Specify I/O States During Programming window, then Finish in FlashPoint to return
to FlashPro. The PDB is updated with your new settings.

Congratulations, you have successfully modified the 1/O states that will be held during programming.

Modifying Boundary Scan Registers

Each I/O in your device is comprised of an Input, Output and Output Enable Boundary Scan Register (BSR)
cell.

The BSR cells enable you to define I/O states during programming and control the individual states for each
Input, Output, and Output Enable register.
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To modify the individual Boundary Scan Registers of an /O in your device:

1. Select the Show BSR Details checkbox in the Specify I/0 States During Programming window.
This replaces the 1/0 State (Output Only) column with a Boundary Scan Registers column that is split
into Input, Output Enable and Output.

2. Modify each of the registers for any 1/0O to set your custom options. See the Specifying I/O States
During Programming - I/O States and BSR Details help topic for an explanation of the individual BSR
settings.

3. (Optional) Uncheck the Show BSR Details checkbox to return to the default view.

Note: Note: Updated I/Os with non-default settings are displayed as User-Defined BSR in the default
view.

Click OK and complete programming to save your updated settings to the ADB and programming files.

Saving and Loading I/O State Settings

Click Save to File to save your changes. This enables you to save your custom I/O settings in an 10S file.
Click Load from File to load a previously saved *.ios file.

Y ou must click OK and complete programming to save your updated settings to the ADB and programming files.

See Also
Specifying I/O States During Programming
Specifying 1/0O States During Programming - I/O States and BSR Details
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Advanced Tutorials

Multiple Device Chain Programming

This tutorial provides step-by-step instructions on how to program multiple Microsemi devices in a chain.
You should already be familiar with the basic features of the FlashPro software.

Note: This tutorial does not provide software installation instructions. Please have FlashPro already installed before you
begin.
In the figure below, there are three devices in a chain (two A3P250 and one A3PEG600). In this section, we
will program these three devices in the chain.

TDO
TDI TDI DO TDI DO
TMS TMS TMS —
TCK ’ TCK TCK
[ A3P250 A3PEROD ’7
+ ]

Figure 68 - APA Device Tutorial Example
First you need to create a project.

To create a new project:
1. Click the New Project button in FlashPro.
2. From the New Project dialog box, type “Tutorial” in the Project Name field.

3. Check the Chain box (see figure below).

New Project F§|

Project Marne:

| Tutorial

Project Location:

| CnFlashProvs0iMulk_ackel _Chain' Browse, ..

Programming mode
" Single STAPL file
* Chain

Ik | Cancel Help

Figure 69 - New Project Dialog Box
4. If necessary, change the default location of your project in the Project Location field.
5. Click OK. The FlashPro main window appears.
Note: Note: The Programmer List window updates with your programmers information.

6. From the Programmers menu, choose Scan Chain (or select the programmer in the Programmer
List window, right-click, then choose Scan Chain) (see figure below).
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Multiple Device Chain Programming

Programmen Programmer Poit Programmes Programmes
Name T or Status Enabled

Edit cell

) eing

) Sef Test
%5 scan Chain
8% Remave

Disable

Run Sslected Programmers

Refresh/Rescan for Programimers PROGRAM EE&

Figure 70 - Select Programmer Window

Scan Chain shows how the devices are ordered in the chain in the log window (see figure below). In this
case, A3P250 is the first device that will be programmed in the chain since it is connected directly to TDO.

| prograwener '01245' @ Found 24 instruction register bits.

L progragener '01245' @ Checking IDCODEsS...
progragener '01245' @ Device 1: 2A141CF Mfr: Actel Part: HVASP250
progragener '01245' @ Device Z: 123261CF Mfr: Actel Part: MVAIPE&OO
progragener '01245' @ Dewvice 3: ZA141CF Mfr: Actel Fart: A3PZ250
programoer '01245' @ SJcan Chain PASSED.
4

| r\AII .":. Errors .}\ Warnings P\Infa lf"

Figure 71 - Scan Chain Order in the Log Window
7. Click the Configure Chain button. The Chain Configuration window displays (see figure below).

x_-lnn N Tm}_uu_-[‘rm 2 moH]n' 'I rml_, | ’—I J J _I ﬂdd.ﬁ.clelDeﬂcem

Add Non-Actel Device
[# Show Chain Editing
- " IR Max TCK  Enable = Enable - Serial
D — i3 Length  [MHz] | Device Serial LELT Data o

Figure 72 - Chain Configuration Window

8. Inthe Chain Configuration window, click the Add Device button to add devices to the chain. The
Add Microsemi Device dialog box appears (as shown in the figure below).

Add Actel Device X

" File

Programming file: | J

* Device

Device:

Mame: | A3P2S0

Help (04 | Cancel

Figure 73 - Add Microsemi Device Dialog Box

9. Choose the "A3P250" device from the Device drop-down.
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In the STAPL file field, use the Browse button to locate the A3P250.stp file.

In the Name field, leave A3P250 as default. The A3P250 device is added into the Chain
Configuration window (see figure below).

x

ConfigueDevice.. | 4| 4| X| Add Actel Device JA |

—-I'IDI N 1|)o’—~o»—u|ro| 2 ruo|—-|1o| 1 me}—. Modiy PDB... |
Add Non-Actel Device
¥ Show Chain Editing Inspect Device
5 - IR Max TCK  Enable Enable Serial
Device Name File Length  [MHz]  Device Seiial Data HIGH-Z

1 | AFSEOD

12.
13.

Figure 74 - Device One Chain Configuration Window
Repeat the same process for ASPE600 and the other A3P250 respectively.

After you have finished adding all of the devices in the chain, the Chain Configuration window

updates.

—-|1'n| N TDol—uu—-['rbl 2 'mol—-lrm 1 'mol—

Create FDB... | Coriiguie Device... | il il il M

Add NorvActel Device
[+ Shows Chain Editing Inspect Device
: IR Max TCK = Enable = Enable - Serial
Device Name File Length | ([MHz) | Device | Sedial Aclion Data HIGH-Z
1 AR50 ¥ A%F250 = 8 10 ¥

ASPEE0 Eﬁm
3 A3PZ50 [ A3P250 (2) =] 8 10 v

Figure 75 - Chain Configuration Window: All Devices in the Chain

14. Once all the devices have been added to the chain in the correct order, click the Run button to
program the chain.
15. When Programming is complete, the Programmer List window displays. See figure below.

5178

Programmer
Hame

Programmer
Type

Programmer
Status

Programmer

Enabled Device [ Action

bl 7E

Fiefresh/Fiescan for Programmers

|- |x ||Programres Jat Window

programmer '03175°
programmer '03178'
03178

¢ device 'AJPZ50' ! Finlshed: Wed Jul 05 17:15:45 Z006 (Elapsed time 00:0Ll:Z3) ~
: dewvice 'AIPZS0' : Executing action PROGRAM PAZSSED.
PL UL s L i Chain progrmmming PASZED.

o-@-0-0-0-0

£ >
All f Crrors }, Warnings Jy Info [

Figure 76 - Programmer List Window Done

Congratulations! You have just completed the FlashPro Multiple Microsemi Device Chain Programming
tutorial.

Multiple Device Serialization Chain Programming

This tutorial provides step-by-step instructions on how to program multiple Microsemi devices with
serialization. Before you begin this tutorial, you should already be familiar with the basic features of the
FlashPro software.

Note: This tutorial does not provide software installation instructions. Please have FlashPro already installed before you
begin.

In this tutorial you will program two devices in a chain (one device is A3P250 and the other is ASPE600).
The STAPL file for the first A3P250 device contains 10 serialization data. See figure below.
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Multiple Device Serialization Chain Programming

TDO
TDI DI TDO ol TDO
™S ™S ™S _ |
TCK . 1TCK TCK
[ A3P250 A3PEG00 ’7
)| .

Figure 77 - APA Device Tutorial Example
First you need to create a project.

To create a new project:
1. Click the New Project button in FlashPro.
2. From the New Project dialog box, type "Tutorial" in the Project Name field.
3. Check the Chain box (as shown in the figure below).

New Project P§|

Project Mame:

| Tutorial

Project Locatkion:
| O \FlashProws0irualki_sckel_Chain Browse, .,

Programming mode
" Single STAPL file
* Chain

(04 | Cancel Help

Figure 78 - New Project Dialog Box

4. If necessary, change the default location of your project in the Project Location field.

5. Click OK. The FlashPro main window appears and updates the Programmer List info with your
programmer information.

6. From the Programmers menu, choose Scan Chain (or select the programmer in the Programmer List
window, right-click, then choose Scan Chain) (as shown in the figure below).

Programmer Programmer Port Proc Prog
Name Type = Status Enabled
4 1 FlashPro4 usb30964 (USE 2.0)
Edit cell

) ping
) Self Test

%8 5can Chain

B Remove
Disable

Run Selected Programmers

Refresh/Rescan for Programmers: PROGRAM % |

Figure 79 - Scan Chain Selection

Scan Chain shows how the devices are ordered in the chain in the log window (see figure below). In this
case, A3P250 is the first device will be programmed in the chain since it is connected directly to TDO.
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x| progratmer '03178' @ Found 24 instruction register bhits.

I programer '03178' : Checking IDCODEs. ..
prograrmumer '03178' @ Dewvice 1: ZA4141CF Mfr: Actel Part: AIPZE0
progratoer '03178' @ Dewice 2@ 123Z61CF Mfr: Actel Part: AZPE6OOD
programmer '03175' @ Device 3: ZA141CF Mfr: Actel Part: ASPEZS0
programmer '03178' @ Scan Chain PASIED.
£

| r'l.l.n.ll a'{. Errors .:'"'. W arnings I.‘-'-.|In|‘u:: ,-"

Figure 80 - Scan Chain Order in the Log Window
7. Click the Configure Chain button . The Chain Configuration window appears (see figure below).

“—for N~ 2 v 1 ot~ | ] 4] s] x| eemF)

Add NorvActel Device |
[¥ Show Chain Ediing
- . IR Max TCK = Enable Enable . Serial
Device MName File Length {MHz) Device | Serial Action Data HIGH-Z

Construct the chain from a Scan Chain operation...

Figure 81 - Chain Configuration Window

8. Inthe Chain Configuration window, click the Add Device button to add devices to the chain. The
Add Microsemi Device dialog box appears.

9. Choose A3P250 device from the Device drop-down menu (as shown in the figure below).

Add Actel Device 3

" File

Prograrnrming File: | J

* Device

Device:

Mame: | A3P2S0

Help Ok | Cancel

Figure 82 - Add Microsemi Device Dialog Box
10. Inthe STAPL file field, use the Browse button to locate the A3P250.stp file.
11. In the Name field, leave A3P250 as default.
12. Click OK. The A3P250 device is added into the Chain Configuration window.

13. Repeat steps 8 to 11 for A3PE600 and A3P250 respectively. After you are finished adding all devices
in the chain, the Chain Configuration window updates (as shown in the figure below).

e N B, 5 o 0y, ] 1ol e N N R ]

Add Nonréctel Device
W Show Chan Editing Inzpact Device
: - ] Max TCK = Enable = Enable : Senal
Device Name File Length [MHz) Device | Serial Action Data HIGH-Z2
1 A3FPZS0 ® a3PzE0 [=] 3 10 1
asFEend ) S 8

3 AFE0 AP0 10 P

Figure 83 - Chain Configuration Window for all Devices
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Multiple Programmer Multiple Device Chain Programming

From the Chain Configuration Window, check the Enable Serial box. This enables the Serial Data
option in the Chain Configuration window.

Click Select in the Serial Data column, the Serial Settings dialog box displays as shown in the figure

below.
X]

Serjal Settings

[ e B B = p B ) B

i

[v Yiew unused data
[v Yiew used data
[v View skipped data

Filter: | *

v Log serial data: |Regiu:un_6_3

Help

=l
Cancel |

o]

Figure 84 - Serial Settings Dialog Box

From the Serial Settings dialog box, click the All button to select all the serial data.
Click OK.

Once all the devices have been added to the chain in the correct order and serialization has been
selected, click the Run button to program the chain.

When programming is complete, the Programmer List window appears and indicates that the devices
are ready for programming (as shown in the figure below).

Programmer Programmer Port
Hamve Type
078 3 uzk03178

Programmer
Status

Programmer

Enabled Device | Actlon

Figure 85 - Programmer List Window Done

Congratulations! You have just completed the FlashPro Multiple Device Serialization Chain Programming
tutorial.

Multiple Programmer Multiple Device Chain Programming

This tutorial demonstrates step-by-step instructions on how to parallel program two chains using two
programmers, each with two Microsemi SoC Devices (A3P250 and A3PEG00). See the figure below for an
illustration.

TDO
TDI Dl TDO TDI DO
TMS ———»— TS TMS
TCK TCK TCK
A3P250 A3PEGOOD

Figure 86 - APA Device Tutorial Example
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You should already be familiar with the basic features of the FlashPro software before you begin this tutorial.
Note: This tutorial does not provide software installation instructions. Please have FlashPro already installed before you
begin.

First you need to create a project.

1. Click the New Project button in FlashPro.

2. From the New Project dialog box, type “Tutorial” in the Project Name field.
3. Check the Chain box (see figure below).

Mew Project &|

Project Mame:

| Tutorial

Project Location:

| C:\FlashProwS04kult_Progr_Mulki_ Browse. ..

Programming mode

" Single STAPL File
{* Chain

(4 | Cancel Help

Figure 87 - New Project Dialog Box

4. If necessary, change the default location of your project in the Project Location field.

Click OK. The FlashPro main window appears and displays your updated programmer information (as
shown in the figure below).

Programmer Programmer Programmer Programmer S .
Hame Tupe Port Status Fnahled Devics /Action
1 072 FlashPro2 usb03178 ™
2 M5 FlachPro2 uzb01245 =

Figure 88 - FlashPro User Interface

6. From the Programmers menu, choose Scan Chain (or select the programmer in the Programmer
List window, right-click, then choose Scan Chain). The Select Programmer(s) dialog box displays
(see figure below).
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Multiple Programmer Multiple Device Chain Programming

%]

Select programmer(s)

Select the programmet(s) yau wank b scan:

Programmer(z]
i0317g
01245

Select All | Unselect Al |

o]

Figure 89 - Select Programmer Window

The Programmer List window shows the Scan Chain Test was passed and how the devices are ordered in
the chain (see figure below).

Cancel | Help |

Frogrammern Programmern Frogrammer Programmern
Mame Type L Status Fnahled Lo R
|1 o378 Flazhlro3 uzb03178 SCAN CHAIN PASSEL [+
£ Bl s FlashP 15011 245
£
g Hetresh/Hecan bor Frogrammers
s
x| programmer '01245' : Sean Chain... A
| Woarning: programmer '01245° @ Vpuwop has been selected on programmer AND @n exbecnally p ide pump has al
programmer "01245' : Found £ instruction register bits.

"D1z45"
"o1zas!
"D1245'

i Checking IDCODEs...
: Device 1: 123261CF Nfr: ketel Part:
Soan Chain PAJSED.

DLUGL UL
programmwer
Progranmer

L3PEEOD

all { Errors ) Warnings ) Info [

Figure 90 - Scan Chain Order in the Log Window

7.

Click the Configure Chain button . The Chain Configuration window appears (as shown in the figure
below).

=

| ’—I _I._I _—Ihdd.b.uelbeﬁoeﬂ

o N oo 2 o 1

Add Non-Actel Device
[¥ Show Chain Editing
: " IR Max TCK  Enable  Enable - Senial
eCs) L= 3 Length | [MHz] = Device Serial acton Data il

Figure 91 - Chain Configuration Window

8. Inthe Chain Configuration window, click the Add Device button to add devices to the chain. The
Add Microsemi Device dialog box appears.
9. Choose A3PEG00 device from the Device drop-down menu (as shown in the figure below).
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Actel Device Configuration P§|
© Fle
Praogramming File: | Wil kiran\programming_designs), ...
" Device

Device: | J

Mame: | A3PESO0

Help Ok | Cancel

Figure 92 - Add Microsemi Device Dialog Box

10. Inthe STAPL file field, use the Browse button to locate the ASPE600.stp file.
11. In the Name field, leave ASPEG600 as default.

12. The A3PEG600 device is added into the Chain Configuration window (as shown in the figure below).

x 5
Add Actel Device 4
_.Im N w,l_.m_.lm 2 ",,Hm 1 m,|_. CiestePDB.. | ConfgueDevce. | 4| #]| X|
Add NoreActel Device
¥ Show Chain Ediing Inspect Device |
- - 131 Max TCK  Emable  Enable - Serial
Device MName File (MHz] Devics Sarial Action Data HIGH-Z

Length
AFPERND ]

[ A3PEEDD

Figure 93 - Device One Chain Configuration Window

13. Repeat steps 8 to 11 for A3P250. After you are finished adding all devices in the chain, the Chain
Configuration window updates (as shown in the figure below).

x

Add Actel Device 14
-|m| N roo}—-.u o1 2 monl 1 ml—- | | __J ___l _l
Add Non-Actel Device
[+ Shaw Chain Editing
- , IR Max TCK = Enable  Enable - Senal
pence L= 2 Length = [MHz) | Device | Serial LELET Data s

Figure 94 - Chain Configuration Window for all Devices

14. Once all the devices have been added to the chain in the correct order and serialization has been
selected, click the Run button to program the chain.

15.  When programming is complete, the Programmer List Window appears (as shown in the figure

below).
=
Programmer Programmer Programmer Programmer —_
Part Device | Act
tlame lvpe Status Enabled euice [Action
1 e FlashProd usbl3 /g HUN PASSED rd
o245 FlazhPro3 LSk 245

Figure 95 - Programmer List Window Done

Congratulations! You have just completed the FlashPro Multiple Device Serialization Chain Programming
tutorial.
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Multiple Programmer and Multiple Device Serialization Chain Programming

Multiple Programmer and Multiple Device Serialization Chain
Programming

This tutorial demonstrates step-by-step instructions on how to parallel program two chains using two
programmers, each with two Microsemi SoC Devices (A3P250 with Serialization and A3PE600). See the
figure below for an illustration.

TDO
TDI Dl TDO TDI DO
TMS ———»— TS TMS

TCK TCK TCK
A3P250 A3PEROO

Figure 96 - APA Device Tutorial Example

You should already be familiar with the basic features of the FlashPro software before you begin this tutorial.
The STAPL file for the A3P250 device contains 10 serialization data.

Note: This tutorial does not provide software installation instructions. Please have FlashPro already installed before you

begin.
First you need to create a project.
1. Click the New Project button in FlashPro.
2. From the New Project dialog box, type “Tutorial” in the Project Name field.
3. Check the Chain box (see figure below).

Mew Project §|

Project Marme:

| Tutorial

Project Location:
| [ hFlashProwS0iMule_Progr_Mualk_y Browse, .,

Programming mode

" Single STAPL File
* Chain

K | Cancel Help

Figure 97 - New Project Dialog Box

4. If necessary, change the default location of your project in the Project Location field.

Click OK. The FlashPro main window and the Programmer List window displays your updated
programmer information.

6. From the Programmers menu, choose Scan Chain (or select the programmer in the Programmer
List window, right-click, then choose Scan Chain). The Select Programmer(s) dialog box appears
(as shown in the figure below).
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Figure 98 - Select Programmer Window

The Programmer List window shows the Scan Chain Test was passed and how the devices are ordered in

the chain (see figure below). In this example, A3PE600 will be programmed first in the chain since it is
connected directly to TDO.

Programmer

Hame 1vpe
1 [

Programmer Part

Status Enabled oI
Flashros =hlii /8 SCAN CHAIN PASSHD |7
2 M FlashProd 15h1 745

SCAHN CHAIN PASSHD "2

Figure 99 - Scan Chain Order in the Log Window

7. Click the Configure Chain button . The Chain Configuration window appears (as shown in the figure
below).
'—-|'rn| Nwol—-m—-lml 2 rnol—-lrol 1 TDO}—‘ | | +#| 2] __JMI
MdNonMelDevml
[¥ Show Chain Ediing
Device Name File et B S B T R Action el HIGHZ

Construct the chain from a Scan Chain operation...

Figure 100 - Chain Configuration Window

In the Chain Configuration window, click the Add Microsemi Device button to add devices to the
chain. The Add Microsemi Device dialog box appears.

8.

9. Choose A3PEG600 device from the Device drop-down menu (as shown in the figure below).
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Figure 101 - Add Microsemi Device Dialog Box
10. Inthe STAPL file field, use the Browse button to locate the A3SPE600.stp file.

11. In the Name field, leave A3PEG600 as default. The ASPE600 device is added into the Chain
Configuration window.

12. Repeat the steps above to add the A3P250. After finished adding all devices in the chain, the Chain
Configuration window updates (see figure below).

B N R, 3 ol ] ool o | e ) Ko i 1) 2] s |

Add Norvictel Device:
[¥ Show Chain Editing Inspect Device I
[ File IR Max TCK  Enable  Enable firee— Serial HIGHZ

Length [MHz]) Device Serial Data

2 AZPIE02) 10 v

Figure 102 - Chain Configuration Window for all Devices
14. In the Chain Configuration Window, check the Enable Serial box.

15. Click Select in the Serial Data column. The Serial Settings dialog box appears (as shown in the
figure below).
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Figure 103 - Serial Settings Dialog Box

16. From the Serial Settings dialog box, click the All button to select all the serial data.
17.  Click OK.

18. Once all the devices have been added to the chain in the correct order and serialization has been
selected, click the Runbutton to program the chain.

19. When programming is complete, the Programmer List window updates (as shown in the figure

below).
x
Programmer Programmer Programmer Programmear U N
Port Device | Acti
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Figure 104 - Programmer List Window Done
Congratulations! You have just completed the FlashPro Multiple Programmer and Multiple Device Serialization Chain

Programming tutorial.

Setting Disabled Microsemi SoC Devices to HIGH-Z

This tutorial explains how to set disabled Microsemi SoC SmartFusion, IGLOO, ProASIC3, Fusion devices
in a chain to HIGH-Z during chain programming.

Note: This tutorial requires a design with valid *.pdb/*.stp files for a chain of devices. If you launch FlashPro from a Libero
SoC project, a FlashPro project is created automatically and the PDB/STP file loaded. Otherwise, you can start a new
FlashPro project and load a PDB/STP file; refer to the Chain Programming Tutorial for more information.

1. Once all your devices have been added to the chain, from the Chain Configuration window, choose

which devices you would like disabled during programming by de-selecting the appropriate checkbox
from the Enable Device column.

Now that you have disabled devices a checkbox appears in the HIGH-Z column of the Chain Configuration
window. If the HIGH-Z column is not shown in the Chain Configuration Grid, right-click any column header
and choose HIGH-Z.
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Setting Disabled Microsemi SoC Devices to HIGH-Z

2. Select the HIGH-Z checkbox to ensure your disabled devices enter HIGH-Z mode and remains in that
mode until chain programming is complete.

HIGHZ is not supported if enabled Microsemi devices are executing one of the following ACTIONS:
e PROGRAM_NVM_ACTIVE_ARRAY
e VERIFY_NVM_ACTIVE_ARRAY
e READ_IDCODE

Disabled devices 1/0s will not go to HIGHZ and the they will not tri-state. Any other ACTION will work as
expected

:—!il'l]l N TDoI—oooo—ti'lDI 2 onﬂ)l 'I 1Do|—- Create FDB... | Configuse Device... | ﬂ ﬂ & M

Add Non-&actel Device
W Show Chain Editing Inspect Device
- IR Max TCK = Enable Enable - Serial
Device Name File Length [MHz) Devica | Senal Action s HIGH-Z

1 | AGLEOINVG [ AGLEOIVG

2 | AGLEOOVS (3] AGLEOOVS (2) 8 10

Figure 105 - HIGH-Z Option in FlashPro
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Programming Settings and Operations

Introduction

The FlashPro software enables you to connect multiple programmers to your computer. With each
programmer you select, you can connect the programmer, perform a self-test, customize, add, and remove
and analyze the JTAG chain.

Programmer Settings

The Programmer Settings dialog box includes setting options for FlashPro5/4/3/3X, FlashPro Lite and
FlashPro.
Note: You can set the TCK setting in the PDB/STAPL file by selecting the TCK frequency in the Programmer Settings

dialog box.

Limitation of the TCK frequency for the selected programmer:
e FlashPro supports 1-4 MHz
e FlashPro Lite is limited to 1, 2, or 4 MHz only.
e FlashPro5/4/3/3X supports 1-4 MHz.
Limitation of the TCK frequency for the target device:
e |GLOO, ProASIC3, and Fusion — 10MHz to 20MHz
e ProASICPLUS and ProASIC — 10 MHz.

During execution, the frequency set by the FREQUENCY statement in the PDB/STAPL file will override the
TCK frequency setting selected by you in the Programmer Settings dialog box unless the Force TCK
Frequency checkbox is selected.

To set your programmer settings:

1. From the Tools menu, choose Programmer Settings.The Programmer Settings dialog box appears
(as shown in the figure below).
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Figure 106 - Programmer Settings Dialog Box for FlashPro

2. Click a programmer tab and check the appropriate settings for your programmer.
3. Click OK.

FlashPro Programmer Settings

Choose your programmer settings for FlashPro (see above figure). If you choose to add the Force TCK
Frequency, select the appropriate MHz frequency. After you have made your selection(s), click OK.
Default Settings

e The Vpp, Vpn, Vdd(l), and Vddp options are checked (Vddp is set to 2.5V) to instruct the FlashPro
programmer(s) to supply Vpp, Vpn, Vdd(l) and Vddp.

e The Drive TRST option is unchecked to instruct the FlashPro programmer(s) NOT to drive the TRST
pin.

e The Force TCK Frequency option is unchecked to instruct FlashPro to use the TCK frequency
specified by the Frequency statement in the STAPL file(s).

FlashPro Lite Programmer Settings

If you choose to add the Force TCK Frequency, select the appropriate MHz frequency. After you have made
your selection(s), click OK.

Default Settings
e The Vpp and Vpn options are checked to instruct the FlashPro Lite programmer(s) to supply Vpp and
Vpn.

e The Drive TRST option is unchecked to instruct the FlashPro Lite programmer(s) NOT to drive the
TRST pin.

FlashPro User's Guide 67



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

& Microsemi

e The Force TCK Frequency option is unchecked to instruct the FlashPro Lite to use the TCK frequency
specified by the Frequency statement in the STAPL file(s).

FlashPro5/4/3/3X Programmer Settings

For FlashPro3, you have the option of choosing the Set Vpump setting or the Force TCK Frequency. If you
choose the Force TCK Frequency, select the appropriate MHz frequency. For FlashPro5/4/3X settings, you
have the option of switching the TCK mode between Free running clock and Discrete clocking. After you
have made your selections(s), click OK.

Default Settings

e The Vpump option is checked to instruct the FlashPro3 programmer(s) to supply Vpump to the device.

e The Force TCK Frequency option is unchecked to instruct the FlashPro3 to use the TCK frequency
specified by the Frequency statement in the PDB/STAPL file(s).

e FlashPro3x default TCK mode setting is Free running clock

TCK Setting (ForceTCK Frequency)

If Force TCK Frequency is checked (in the Programmer Setting) then the selected TCK value is set for
the programmer and the Frequency statement in the PDB/STAPL file is ignored.

Note: FlashPro Lite RevA supports only 4MHz on TCK.

Default TCK frequency

When the PDB/STAPL file or Chain does not exist, the default TCK frequency is set to 4MHz. In the Single
Device File Programming mode, FlashPro will parse through the file and search for the "freq" keyword and
the "MAX_FREQ" Note field, which are expected in all Microsemi flash device files. The FlashPro software
uses the lesser value of the two as the default TCK frequency.

In Chain Programming mode, when more than one Microsemi flash device is targeted in the chain, the
FlashPro software passes through all of the files and searches for the “freq" keyword and the "MAX_FREQ"
Note field. The FlashPro software uses the lesser value of all the TCK frequency settings and the
"MAX_FREQ" Note field values.

Ping Programmers
To ping a programmer(s):
1. From the Programmers menu, choose Ping.

2. Select the programmers you want to connect from the Select Programmer(s) dialog box.
3. Click OK.

Note: You can click the Refresh/Rescan for Programmers button to quickly ping new programmers.

Performing a Self-Test

To perform a self-test:
1. From the Programmers menu, choose Self Test.
2. Select the programmer(s) you want to self-test from the Select Programmer(s) dialog box.
3. Click OK.

Note: Y ou must connect the programmer to the self-test board that comes with your programmer before performing a self-

test.

You can also perform self-test by right-clicking on a specific programmer from the Programmer List
Window and selecting Self-Test.
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Scanning a Chain

Note: Self-test is not supported with FlashPro4 or FlashPro Lite programmers. These programmers are rigorously tested at

the factory during production.

Scanning a Chain

The scan chain operation scans and analyzes the JTAG chain connected to programmer(s) you have
selected.
To scan a chain:

1. From the Programmers menu, choose Scan Chain.

2. Select the programmers you want to scan from the Select Programmer(s) dialog box.

3. Click OK.
You can also perform Scan Chain by right-clicking on a specific programmer from the Programmer List
Window and selecting Scan Chain.
To scan and check a chain:

1. From the Tools menu, choose Modes > Chain Programming.

2. From the Chain Configuration window, select auto construct or add devices.
3. From the Programmers menu, choose Scan and Check Chain.
4

Select the programmers that you want to scan and check chain from the Select Programmer(s) dialog
box.

5. Click OK.

You can also perform Scan Chain and Scan and Check Chain by right-clicking a specific programmer from
the Programmer List Window and selecting Scan Chain or Scan and Check Chain.

Enabling and Disabling Programmers

Once your programmer is enabled you can connect the programmer, perform a self-test, scan the chain, or
remove it.
To enable a programmer:
1. From the View menu, choose Programmer Details Window.
2. Check the Enable programmer checkbox in the Programmer Details Window.
The Programmer Details window displays all the information about your programmer.

Note: Note: You can also enable your programmer from the Programmer List window by checking the
checkbox in the Programmer Enabled column.

Disable your programmer by unchecking the Enable programmer checkbox from the Programmer Details
Window or by unchecking the checkbox in the Programmer Enabled column in the Programmer window.

Renaming a Programmer

Enter the new programmer name in the Programmer Details window to rename the programmer. By
default, the programmer name is the same as the programmer ID.

Removing a Programmer

To remove a programmer:
1. From the Programmers menu, choose Remove.
2. Select the programmers you want to remove from the Select Programmer(s) dialog box.
3. Click OK.
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Selecting Programmers

The Select Programmer(s) dialog box gives you the option of selecting all and unselecting all of the
programmers that you want to ping. See figure below.

Select programmer(s) [')_<|

Select the programmet(s) you wank o ping:

Frogrammer|z] |
01236

Select Al | Unselect .ﬁ.II|

Ik | Cancel | Help |

Figure 107 - Selecting Programmer(s) Dialog Box
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Single Device Programming

Single Device Configuration

Single Device Programming

When devices are joined together in a JTAG chain, all of their Instruction Registers (IR) and Data Registers
(DR) are put in a long shift register from TDI to TDO. The IR length defers from device to device and the DR
length depends on the instruction that shifts into the instruction register.

When targeting Device 2 (see figure below), you need to know the IR length for Device 1 and Device 3.
Given this information, you can bypass both devices by shifting an all one pattern into their instruction
registers before and after the instruction targeted at Device 2. The number of bits you shift before Device 2's
instruction is the pre IR length, and the number of bits you need to add after Device 2's instruction is the post
IR length. In this case, the pre IR bits are shifted into

Device 1 and post IR bits are shifted into Device 3.

Device 3 Device 2 Device 1
R ] TR} (R
\—-—I I—-—‘
[ DR ] I—-J | DR_|

Targeting Device 2

When the bypass instruction is shifted into Device 1 and Device 3, the TDI and TDO of the two devices are
connected to the 1-bit bypass register at the Shift-DR state. To correctly shift the data in and data out of
Device 2's register, you need to shift one bit of data before and after Device 2's data.

The number of bits you need to shift into the data register for Device 1 is the pre-DR length and the number
of bits we need to shift into the data register for Device 3 is the post-DR length. With the IR and DR length
information, you can shift instructions and data into Device 2 with the correct registration.

DO

Figure 108 -

To create the JTAG chain (shown in the above figure):
1. Connect the TCK and TMS from the programmer to all of the devices.
2. Connect the programmer’s TDI pin to the TDI pin of device 3.
3. For all devices in the chain, connect the TDO output of one device to the TDI input of the next device.
4. Connect the TDO output of the last device to the programmer’s TDO input.
The order of devices in the chain is set by the connections of TDI to TDO.

The ChainBuilder software takes the order of the devices in a chain and their IR lengths and adds the pre-
IR, post-IR, pre-DR, and post-DR padding bits in the device you want to program, which properly aligns the
instructions and data within the IR and DR of the devices.

If you do not use the ChainBuilder software, the FlashPro software tries to find the pre-IR, post IR, pre-DR,
and post-DR values during the Analyze Chain operation.

For more information, see ProASIC programming and ProASICPLUS and ProASIC programming
introduction.

To find out how to set the IR length, see Chain Settings.

Loading a Programming File

You can either load a programming file from the Configuration menu or from the Single Device
Programming Window. The section below describes how to load a programming file from the Single
Device Programming Window.
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To Load a programming file from the Single Device Programming window:

1. From the View menu, choose Single Device Configuration to activate the Single Device
Configuration Window.
2. Click the Browse button in the Single Device Configuration Window (see figure below).

= | [~ Programming file
Ta continue,

load existing programming File Browse. ..
or create new FOE file

ST [ wsie |

Figure 109 - Signal Device Configuration Window

Single Device Configuration window

The Load Programming File dialog box appears.

3. Navigate to your programming file, select it, and click Open. The programming file is loaded and the
Single Device Configuration Window updates.

Select Target Device

The Select Target Device dialog box is located in the Configuration menu.

The Select Target Device dialog box enables you to select the target device you want to program. If you
are only programming one device in a chain, there is no need for you to make a selection. The Select
Target Device dialog box automatically displays your device (see figure below).

Select Target Device

Target device: [F

Help ol | Cancel |

Figure 110 - Select Target Device (One Device in a Chain)

If you are programming more than one Flash device in a chain, you need to select the target device you
want to program. If you attempt to program your device without selecting a target device, a warning
message appears.

If the warning message appears, click OK and the Select Target Device dialog box appears. From the
Select Target Device dialog box, select the device you want to program (see figure below).

Select Target Device

Target device: |RF‘5E-'I]] 2) j
&, 1
Help |

Figure 111 - Select Target Device (Multiple Devices in a Chain)
Click the down arrow to display the list of devices in your chain. Then, make your selection and click OK.
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Chain Settings

Note: When the FlashPro software does not detect your chain configuration, you must specify the Pre/Post IR fields by
entering these values in the Set Pre/Post IR Values dialog box (see figure below).

Set Pre/Post IR values x|

FlashPra failed to determine the Pre and Post IR
values for the dewvice A3PEEO0 (17

Pre IR: I ]
Post IR I ]

(04 Zancel | Help I

Figure 112 - Pre IR and Post IR Values for the Target Device
For more information, see Single STAPL file programming information.

Chain Settings

Click the Chain Parameter button in the Single Device Configuration window to set the chain settings
(see the Chain Settings dialog box below). See Single Device Programming Information for more
information about these STAPL settings.

Chain Parameter P§|

Pre IR IIII*
Pre DR: IIII*
Post IR o
Post DR: R

Restore Defaults |

Help | Cancel |

Figure 113 - Chain Settings Dialog Box

Serial Settings

Click the Select Serialization Indexes/Select Serialization Actions button from the Single Device
Configuration Window. The Serial Settings dialog box appears (as shown in the figure below).

Note: Depending on the STAPL file format (Microsemi format or generic format) used, you will either see Indexes

columns or Actions columns in the Serial Settings dialog box.
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Figure 114 - Serial Settings Dialog Box

Click the red arrow buttons in the center of the dialog box to move from the Actions column to the Selected
Actions column. The indexes/actions available for selection are located on the left and the indexes/actions
you choose to select are located on the right column. Viewing options are available in the checkboxes under
the Actions column. If you check Log serial data, you can select the FlashROM region name where the
serial data will be stored.
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Chain Programming

Chain Order

The chain order is located in the Chain Configuration Window. The devices you add to the chain must be
in the correct order and must match the physical chain to be programmed. The TDO for the first device
connects to the programmer, and the last device's TDI connects to the programmer. The devices in the
chain go in order from a device's TDI into the next device's TDO, as shown in the figure below.

]—tTDI N o ees —ito1 2 0101 | TDO—

Figure 115 - Chain Order

Multiple Device Chain Programming

The FlashPro software enables direct chain programming without generating a chain STAPL file. Each
device will be programmed in sequential order starting from device 1 to device N. See example below. For
more information about chain order, see the Chain Order help topic.

TDI > Device N > Device N-1 >... > Device 2 > Device 1 > TDO

You have the advantage of using the Chain Builder GUI interface to construct the target physical chain.
Therefore, you do not need to calculate the PRE/POST IR/DR value of the target device. Instead, you must
provide either a valid BSDL file or the IR length and TCK Fmax values when you add a non-Microsemi
device to the chain.

You also have the advantage of automatically generating the chain from a scan chain operation. If you
connect the target chain to your Microsemi programmer, then you can automatically construct the chain.
Refer to the Automatic Chain Construction Tutorial for more information.

Note: Even though the FlashPro software enables direct chain programming without generating a Chain STAPL file, this
functionality is still available. For more information, see Export Chain STAPL file.

Device Programming Compatibility
The following is a list of flash devices that can be programmed together in a chain.

e SmartFusion, IGLOO, ProASIC3 and Fusion, excluding ProASIC3L, families can be programmed in
the same chain.

PLUS

e ProASIC™ S can only be programmed with other ProASIC™"* devices.

e ProASIC can only be programmed with other ProASIC devices.

Programmer Support

FlashPro5/4/3/3X supports only SmartFusion, IGLOO, ProASIC3 and Fusion family devices. The Vpump on
FlashPro5/4/3/3X is designed to support the programming of only one device. Please make sure that
Vpump, Vcc and Vijtag are provided on board for chain programming. Connect the Vpump to the header as
the FlashPro software will attempt to check for all external supplies, including Vpump, to ensure successful
programming. There is no limitation to the chain length; however, ensure that the JTAG signal integrity and
the timing are preserved.

FlashPro and FlashPro Lite support both ProASIC
both devices in the same chain.

PLUS and ProASIC devices. However you cannot program

Unless all supplies are provided on board, there is a limitation of programming eight ProASIC™"* or

ProASIC devices in a chain.
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Multiple Device Serialization in a Chain

When you program multiple SmartFusion, IGLOO, ProASIC3 and Fusion family parts, you can use the
serialization functionality for more than one device. You must generate STAPL files with the correct
serialization data in them to use this functionality.

Each serialization enabled STAPL file may contain a different number of serialization data, but you may only
select the same number of serialization data to program in a single Serialization/Programming session.

See the example below for further explanation:

In this example, you have a chain of two devices (one device is an A3P250 and the other device is an
A3PEG600). The STAPL file for the A3P250 contains 10,000 serialization data and the STAPL file for the
A3PEG600 has 5,000 serialization data. In a single Serialization/Programming session, you are allowed to
select serialization data indexed from 1 to 1,000 for the ASPE600 device and serialization data indexed from
5,001 to 6000 for the A3P250 device. However, FlashPro errors out (at the beginning of a programming
operation) when the amount of the Serialization data you select is different from the devices.

Reuse Serial Data That Failed Programming

If any of the devices in the chain fail programming, the entire chain fails. All of the devices with serialization
enabled will fail as well. The serialization data will be reused or skipped based on your settings. See the
example below for more information:

You have a chain with three devices. Device 1 and Device 3 are serialization enabled. You have selected
Serialization Data 1 to 100 for Device 1 and 501 to 600 for Device 3, and you have set to reuse any unused
Serialization Data. Device 2 is targeted for programming without serialization. See the figure below for an

illustration.
Time ) 1 501 gt};?:;
0 Programmer | o e Devz ] Devt | -
PASS PASS PASS
P’ 2 502
o) Programmer 1”7 51w Devz ] Devt | FAIL
FAIL PASS PASS
Progratoter - 2 = J
2 * Levi * Devd * Devl FalL
MNiA FAIL PASS
Frogrammer * 2 202
L) » Devi » Devl » Devl || PASS
PASS PAZS PASS
Frogrammer + : gk
53 » Devi » Devl » Devl || PASS
PASS PAZS PASS

At time t0, all devices in the chain passed programming so the Serialization Data indexes are advance to 2
and 502 for Device 3 and Device 1 respectively. At time t1 and t2, one of the devices failed programming so
the device indexes are reused for time t3.

Note that at time t2, when Device 2 failed to program; Device 3 will not be programmed.

Multiple Device Serialization and Parallel Programming

The FlashPro software enables parallel programming for ProASIC3, excluding ProASIC3L, family devices
using multiple FlashPro5/4/3/3X programmers. The following figure illustrates how the indexes are reused in
a parallel programming environment.
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Chain Configuration Window

. Chain
Time . 1 301 et
Programmer | J
W Devi | Devi  Devl PAST
PazRs PazRs PazRs
0 " 2 502
Programmer 2
e = ™ Devi ™ Devi ™ Devl J FAIL
FaTIL PARS PARS
= e 2 502
rOarater
W Dew3 M Devi —# Devl J FAIL
tl Mia FAIL PaZRS
. 3 503
Progratnmer 2 [ J
W Devi » Devi  Devl Pazs
PaZs PaZs PaZs
_ 2 502
Progratnmer 1 [ J
» Devi » Devi * Devl Pazs
PaZRS PaZRS PaZRS
2 _ 4 04
Progratmer 2 J
| Devi | Devi * Devl Pazs
PaZs PaZs PaZs

At time t0, the chain failed to program so index 2 and 502 are reassigned to Device 3 and Device 1
respectively at time t1. The failed indexes are not assigned to the programmer that previously failed. It will
always be assigned to the devices in the first programmer in the Programmer List.

Chain Configuration Window

The Chain Configuration Window displays the chain order, the chain editing options, and the chain
configuration grid (see figure below). The Chain Configuration Grid enables you to view and set options for
each of your devices. Right-click a column heading in the grid and choose a menu option to show or hide a
specific column.

The Chain Configuration Grid enables you to view, sort and/or set the following options:

Device - Device name

Name - Editable field for a user-specified device name. If you have two or more identical devices in
your chain you can use this column to give them unique names.

File - Path to programming file
IR Length - Device instruction length.

Max TCK (MHz) - Maximum clock frequency to program a specific device. FlashPro uses this
information to ensure that the programmer operates at a frequency lower than the slowest device in
the chain.

Enable Device - Select to enable the device for programming
Enable Serial- Select to enable serialization when you have loaded a serialization programming file
Action - List of programming actions for your device.

Procedures - Advanced option; enables you to customize the list of recommended and optional
procedures for the selected Action.

Serial Data - Opens the Serial Settings dialog box; enables you to set your serialization data.

Serial Status - Displays serialization status; lists serialization index(es)/action(s) that have been used
and shows the next serialization data that will be programmed.
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e HIGH-Z - Sets disabled Microsemi SoC SmartFusion, IGLOO, ProASIC3, Fusion devices in the chain
to HIGH-Z (tri-states all the I/Os) during chain programming of enabled Microsemi devices in the daisy
chain.

The Show Chain Editing checkbox, when checked displays your chain editing options (Configure device,
Add Microsemi Device, Add Non-Microsemi Device, and organization buttons to move your device within the

grid).
Note: For information on how to Add Microsemi and Non-Microsemi devices, see Chain Editing.
Note: For information on how to use the Organize buttons (located next to the Add Microsemi and Add Non-Microsemi
buttons) in the Chain Configuration grid, see Using the Organize buttons in the Chain Programming grid.

You can enable programming and serialization by checking the Enable Device checkbox and the Enable
Serial checkbox in the Chain Configuration grid.

—-|rn| N wol—-ooo—-lml 2 rnol—olml 1 mol_- | ’—l _I _J _I Addnctelnwicem|

Add NonActel Device |
¥ Show Chain Ediing _—

Serial

IR Max TCK = Enable  Enable o
Action Data HIGH-Z

Device Name File Length = [MHz) | Device | Serial

Construct the chain from a Scan Chain operation...

Figure 116 - Chain Configuration Window

Chain Editing Options
The FlashPro software enables you to automatically construct the chain by clicking the Construct the chain

from a Scan Chain operation link, or by selecting Construct Chain Automatically from the
Configuration menu.

FlashPro also enables you to manually edit your chain by adding Microsemi and Non-Microsemi devices.
You can add devices by clicking the Add Microsemi Device button and the Add Non-Microsemi Device
button, or you can select these options from the Configuration menu.

For more information about how to edit the chain, see Chain Editing.

Editing the Chain Configuration Grid

The Chain Configuration Grid enables you to select an Action for your device, Enable Serialization, and edit
the grid using the right-click menu.
To select an Action from the Configuration Grid:

1. Choose the device you would like to program and check the Enable Device checkbox.

2. Inthe Action column, click the down arrow to expose the drop down menu (see figure below).

3. Select your desired action.

Action

PROGRAM =

DEVICE_IMFO
ERASE
ERASE_ALL
ERASE_ARRAY
ERASE_FROM
P A b
PROGRAM SRR,
PROGRAM_FROM
READ |DCODE
WERIFY

VERIFY _ARRAY
WVERIFY _FROM

Figure 117 - Drop Down Menu for Select Action
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Chain Editing

Before you can enable serialization, you must check the Enable Device checkbox.

To enable Serialization:
1. Check the Enable Serial checkbox. By enabling serialization, the action options change.
2. Inthe Action column, click the down arrow to expose the drop down menu (see figure below).

Action

PROGRAM =

P 0

PROGRAM FROM |
VERIFY
VERIFY _FROM

Figure 118 - Drop Down Menu for Select Action

3. Select your desired action.

Serial
Data

Figure 119 - Serial Data Column

4. Click the Select button from the Serial Data column, which is next to the Action column (see above
figure). The Serial Settings dialog box displays.

5. Choose your serial settings from the Serial Settings dialog box.

See Serial Settings for more information about this topic.
Note: Uncheck the Enable Serial checkbox to disable serialization.

To edit the Chain Configuration Grid:
1. Select the device you would like to edit and right click anywhere in the row of the selected device.

2. Select and click an option from the right-click menu.
Note: The Device Configuration menu (see figure below) includes options for configuring your device.

Configure, .. CLrl+F
IT Progran Chrl+P
8% Select Action. .. Chrl4+-Shift+4

Setialization »

Load STAPL File... Ckrl+3hife+L

Figure 120 - Device Configuration Menu

Chain Editing

The chain order is located in the Chain Configuration Window (see figure below). The devices you add to the
chain must be in the correct order and must match the physical chain to be programmed.

—-|r N TI.J"O}—vooo—iTDI 2 'IDOH'IDI 1 1Do|—- Create FDE...

sl Inspect Device |

Enable Enable

Device Serial
F
=2

x

HIGH-2

Figure 121 - Chain Configuration Window

Check the Show Chain Editing checkbox to display chain editing options (Add Microsemi Device, Add
Non-Microsemi Device). See figure below.
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IR Max TCK  Enable Enable . Serial
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rogiammin(=) 8 10 BTN [ PROGRAM o

Device Name
[ | A3PEE00
| A3P250

Figure 122 - Chain Configuration Window

You can edit the chain by adding Microsemi and Non-Microsemi Devices, for information refer to:
¢ Adding Microsemi Devices
¢ Adding Non-Microsemi Devices
¢ Adding Microsemi Devices from a STAPL File

e Automatic Chain Construction Tutorial

e Chain Programming Tutorial

Using the Organize Buttons in the Chain Programming Grid

The organize buttons enable you to select the order of the devices in your Chain Programming grid (see
figure below).

x Add Actel Device 4
—‘{TDI N YW]—‘ . _.{“n 2 tpoH‘[m 'I 'mol_. Create PDE... | Configure Device... | il ﬂ !I
Add Non-Actel Device
¥ Show Chain E diing Inspect Device
" - IR Max TCK  Enable Enable - Serial
Device Name File Length [MHz2) Device | Serial Action Data HIGH-Z
1| AFSEOD | AIPEEID O V' \kiran\programmin ) 8 10 W M |PROGR&M <l =
2 AF0OM3IF AR50 @ V:\kiran\programmin (=) 8 10 C~ 1 PROGRAM

Figure 123 - Chain Configuration Window (Displaying Organize Buttons)

You can move devices up and down or delete devices within the grid. See the table below for a description
of each button.

Table 4 - Organize Buttons

Button Description
Moves your device up in the Chain Programming grid.
+ | Moves your device down in the Chain Programming grid.
Izl Deletes your device from the Chain Programming grid.

Cutting, Copying and Pasting Devices from the Chain

If you want to make changes to your chain, you must make these changes from the spreadsheet in the
Chain Programming grid.

To copy or cut adevice from the chain programming grid:

1. Select the device you would like to edit and right click anywhere in the row of the selected device. The
right-click menu appears.

2. Select Copy or Cut from the right-click menu to copy your device.
To paste a device from the chain programming grid:

1. Right-click the location where you would like to Paste the device.
2. Select Paste from the right-click menu .
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Removing Devices from the Chain

Removing Devices from the Chain

If you want to make changes to your chain, you must make these changes from the spreadsheet in the
Chain Programming grid.

To remove a device from the chain programming grid:

1. Select the device you would like to remove and right click anywhere in the row of the selected device.
The right-click menu appears.

2. ChooseRemove from the right-click menu to delete your device.

Moving Devices within the Chain

You can move devices within the chain by using the Organize buttons (located next to the Add Microsemi
and Add Non-Microsemi Device buttons) in the Chain Programming grid (as shown in the figure below).

*| 2| X|

Figure 124 - Organize Buttons

To move or delete a device within the chain:
1. Click a device to select it.

2. Click one of the Organize button arrows to move your device up or down the spreadsheet. Click the
delete button (red X) to remove a device.

For more information about the Organize buttons, see Using the Organize buttons in the Chain
Programming grid.

Skip Serial Data

If you are unable to perform the programming action on your device, if your device fails to program, and you
have selected the Skip Serial Data serialization setting, the software automatically uses the next serial data
when you program the next device. By default, the software is set to Skip Serial Data.

You can change the serialization setting by selecting Tools > Serialization or you can click the Skip serial
data icon or the Reuse serial data icon from the toolbar.

Reuse Serial Data

If your device fails to program, and you have selected the Reuse Serial Data serialization setting, the
software automatically reuses the current serial data when you program the next device.

Note: The FlashPro default setting is Skip Serial Data.

You can change the serialization setting by selecting Tools > Serialization or you can click the Skip serial
data icon or the Reuse serial data icon from the toolbar.

Serialization with Parallel Programming

When programming the multiple ProASIC3 devices in parallel, while performing serialization at the same
time, each target device is assigned a Serial Index/Action for each programming run. Upon each successful
completion of each programming run, a new index is assigned to the each target device for the next
programming run. This process continues until the selected Serial Indices/Actions are exhausted.

Note: If programming failure is encountered, depending on the user setting, the failed serial data may be reused or skipped

in the next programming run.

FlashPro User's Guide 81



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

& Microsemi

If, in the last programming run, the remaining number selected Serial Indices/Actions is less than the number of targeted
ProASIC3 devices, the targeted devices without an assigned Serial Index/Action are skipped in the final serial

programming run.
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Adding a Microsemi Device

Chain Editing

Adding a Microsemi Device

To add an Microsemi device:

1. Click the Add Microsemi Device button from the Chain Programming grid. The Add Microsemi
Device dialog box appears (see figure below).

Add Actel Device x|

Programming file: | J

" Device

Drevice: | J

MName : |

Help | K | Zancel

Figure 125 - Add Microsemi Device

Click the Device radio button and choose your device from the Device list drop-down menu.

3. Click the File radio button, then click the Browse button in the Programming file text box to find your
PDB/STAPL file. The Use File dialog box appears.

4. Find your PDB/STAPL file and click Open. Your PDB/STAPL file name appears in the Name text box.
You can change the name by clicking in the text box.

5. Click OK. Your device displays in the Chain Programming grid.

You can also add a Microsemi device from Configuration > Add Microsemi Device.

Adding a Microsemi Device from Files

To add a Microsemi device from afile:

1. From the Configuration menu, choose Add Microsemi Devices From Files. The Add Microsemi
Devices From Files dialog box appears.

2. Locate your file and click Open. Your device displays in the Chain Programming grid.

Adding a Non-Microsemi Device

When adding a non-Microsemi device, you must choose either a BSDL file or customize the Instruction
Register (IR) length and the Max TCK frequency of the device.

IR Length

The IR length specifies the number of IR bits in a specific device.
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Max TCK Frequency

Maximum clock frequency to program a specific device. FlashPro uses this information to ensure that the
programmer operates at a frequency lower than the slowest device in the chain.

BSDL File

Boundary Scan Description Language (BSDL) files describe the characteristics of a specific device. When
using a BSDL file, FlashPro extracts the IR length and TCK frequency for the specific device and uses the
information to build the FlashPro STAPL file. If you do not have a BSDL file for your specific device, you
must manually enter the IR length and Max TCK for your device. This information should be found in the
datasheet for the device.

To add a non Microsemi device using a BSDL file:

1. Click the Add Non-Microsemi Device button in the Chain Programming window. The Add Non-
Microsemi Device dialog box appears (see figure below).

Add Non-Actel Device X
" File
ESOL File: | J
(* [Data

IR, length: z
Max TCK Freq.: |1 MHz

Mame: | Device 2

Help (04 | Cancel

Figure 126 - Add Non-Microsemi Device Dialog Box

2. Type in the BSDL file or locate it by clicking the Browse button. If you click the Browse button to find
your BSDL file, the Use File dialog box displays.

3. Select your BSDL file from the Use File dialog box, and click Open.
4. Click OK, and your device appears in the Chain Programming grid.

When closing the Add Non-Microsemi Device window, if you specified a BSDL file, it is parsed and its IR
length and Max TCK frequency are retrieved.

Note: If you select a BSDL file, you cannot specify an IR length and Max T'CK frequency.

To add a Non-Microsemi device using an IR length and a Max TCK frequency:
1. Click the Add Non-Microsemi Device button from the Chain Programming window.
2. Click the Data option from the Add Non-Microsemi Device dialog box.
3. Enter the IR length AND the Max TCK frequency in MHz.
4. Click OK.
If you decide to use custom data, you must specify both an IR length and Max TCK frequency.
Note: The IR length must be an integer greater than or equal to 2, and the Max TCK frequency must be a float greater than
orequal to 1.
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Adding a Non-Microsemi Device

Non-Microsemi Device Configuration Dialog Box
It is possible to add multiple BSDL files to your Non-Microsemi device database that have the same
IDCODE. If the BSDL files list the same IR length but different TCK values, FlashPro automatically chooses
the file with the lowest TCK value by default and no action is required. If the IR lengths are different you
receive an error message asking you to resolve the conflict.
To resolve the issue, click the drop-down arrow adjacent to the device name. This opens the Non-Microsemi
Device Configuration dialog box (as shown in the figure below). From here you can choose the device that
you wish to use. Select the device from the dropdown menu and enter a new name or use the default.

Non-Actel Device Configuration

BSDL File: | Wi lkirantprogramming_designsisar_» ...

" Data

IR length:
Max TCK Freq.: MMHz

Mame: | AFSE00FG2SE

Help | Ik | Cancel

Figure 127 - Non-Microsemi Device Configuration Dialog Box
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Configuring a Programmer

Selecting an Action

The available actions are depend on what type of STAPL file you have loaded into the software.

To configure a programmer:

1. From the Configuration menu, choose Select Action. The Select Action and Procedures dialog
box appears (see figure below). You can change the procedures for each action; the procedures that
appear will vary depending on both your device and the action you have selected.

Select Action And Procedures E|
Action:
DEVICE_INFO -
Procedures |

YERIFY_IDCODE
READ_IMITIALIZE
CHECK_AND_BACKUP CALIE
READ_IDCODE_OMLY
DO_DEVICE_IMFO
DO_QUERY_SECURITY
DO_EXIT

KK EE R XX

Restore Default Procedures |

Help | (] 4 | Cancel |

Figure 128 - Select Action and Procedures Dialog Box

2. Click the checkboxes of the available procedures or click the Restore Default Procedures button in
the Select Action and Procedures dialog box.

3. Click OK.
Click the Restore Default Procedures to return to default settings.
For example, if you wish to disable the gathering of Check and Backup calibration data:

In the Action drop-down menu, choose DEVICE_INFO.

2. Click Procedures to open the Select Action and Procedures dialog box (as shown in the figure
above).

3. Click CHECK_AND_BACKUP_CALIB to clear the checkbox and disable it.
4. Click OK to continue.

Using Serialization

To use serialization:
1. Enable serialization by checking the Serialization checkbox.
2. Select an action in the Action text box.
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Modifying Programming Settings in FlashPro with a PDB File

3. Click the Select Serialization Indexes button. The Serial Settings dialog box displays (see figure
below).

Note: Note: Depending on the STAPL file format (Microsemi format or generic format) used, you will either
see Indexes columns or Actions columns in the Serial Settings dialog box.

Serjal Settings [5_<|

[ e R I = p R ) B

i

[v Yiew unused data
[v Yiew used data
[v View skipped data

Filker: | *

¥ Log serial data: |Regiu:un_6_3 j

Help | O, | Cancel |

Figure 129 - Serial Settings Dialog Box
Note: Depending on your STAPL file, you would click the Select Serialization Action button (see figure below).

¥ Seriskeation
Senahzation
SeialActions | State | Programmens |
PROGRAM_1 Urnssed

PROGRAM_2 Urnised
FROGRAM_3 Urused
PROGRAM_4 Uruzed
PROGRAM_S Urwsed

Next Seriskization Data: PROGRAM_1

Figure 130 - Select Serialization Actions Button

Modifying Programming Settings in FlashPro with a PDB File

FlashPro enables you to modify programming settings within the software by using a PDB file. This feature
is available only for PDB files generated from Designer v8.1 or greater. This feature allows modification of
features being programmed, security settings, and memory content update for FlashROM and Embedded
Flash Memory Blocks (Fusion only). Please refer to Modifying Memory Contents and Programming a Device
Tutorial (EFMB) and Modifying FlashROM Contents and Programming a Device Tutorial for an example.
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Note: Y ou cannot add or remove the FPGA feature from your PDB. If you would like to add or remove this feature from

your PDB, regenerate the PDB from Designer.

See Also
Configuring security, FlashROM and Embedded Flash Memory Block settings in FlashPro
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Configuring Security, FlashROM and Embedded Flash Memory Settings in FlashPro

Configuring Security

Configuring Security, FlashROM and Embedded Flash Memory
Settings in FlashPro

From the Configuration menu, choose Load Programming File (PDB).
Select the PDB file and click Open, this loads the programming file.

From the Configuration menu, choose PDB Configuration. The Programming File Generator
appears (see figure below).

FlashPoint - Programming File Generator - Step 1 of 2

Silicon Featurels) to be programmed;
[ Security settings
-
IV FlashRom

Criginal FlashROM configuration File:

Pl adbifrom.ufc Import. ..

Embedded Flash Memory Blocks (EFME):

Program EII:;I; LE::Da(t:il:Jn Original Configuration File
1 ~ it A i P:tadbhafz2504calib. efc b adify...

-

Modify I/C States During Programming. ..

Silicon signature {max length is & HEX chars):

Help Texk | Finish | Cancel

Figure 131 - Programming File Generator

4. Select the Silicon feature(s) you want to program:

e Security settings
e FlashROM

e Embedded Flash Memory Block

5. Check the Programming previously secured device(s) box if you are reprogramming a device that
has been secured.

Because the SmartFusion, IGLOO, ProASIC3 and Fusion families enable you to program the Security
Settings separately from the FPGA Array and/or FlashROM, you must indicate if the Security Settings were
previously programmed into the target device. This requirement also applies when you generate
programming files for reprogramming.

6. Enter the Silicon signature (0-8 HEX characters).
7. Click Next.
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Configuring Security Settings in FlashPro

To configure the security settings:
1. From the Configuration menu, choose Load Programming File (PDB).
2. Select the PDB file and click Open, this loads the programming file.

3. Fromthe Configuration menu, choose PDB Configuration. The Programming File Generator
appears (as shown in the figure below).

-

FlashPoint - Programming File Generator - Step 1 of 3

Silicon Featureds) bo be programmed:
6 [¥ Security settings
I
[¥ FlashRom
Criginal FlashROM configuration file:

P:hadb'ifrom.ufc Impart,..

Embedded Flash Memory Blocks (EFME):

Program ﬁl;ﬁt LEI!:Datt:iI:JH Original Configuration File
1 ~ mvm_ingkdnwm_i... 0 P:4adbhafs250hcalib. efc Madify...

-

Modify I/ States During Programming. ..

Silicon signature {max length is & HEY chars):

Help exk | Finish | Cancel

Figure 132 - Programming File Generator

4. Check the Security Settings checkbox and click Next. This brings up the Security Settings dialog
box (shown below).
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Configuring Security Settings in FlashPro

FlashPoint - Programming File Generator - Step/1 of 3

Security level For this device;

Pass Key (max length is 32 HEX chars):

- High Protect with 128-bit Advanced Encryption Standard (AES) key A
and Pass Key T
) - se AES key to write or verify the FPGEA Array.
Medium
- se AES key to write or werify the FlashROM wvia the JTAG .
inkerface,
Mone N

Custarn Level,.. Default Level |

AES Key (max length is 32 HEY chars):

Generate random key |

Help Eiack Mexk | Finish | Cancel |

Generate random key |

Figure 133 - Security Settings Dialog Box

5. Move the sliding bar to select the security level for FPGA, FlashROM, and EFMB (see table for a
description of the security levels).
Table 5 - Security Level Descriptions
Security | Security Option Description
Level
High Protect with a Access to the device is protected by an AES Key and the Pass Key. The Write and Verify

Encryption

Key

128-bit Advanced | operations of the FPGA Array use a 128-bit AES encrypted bitstream. From the JTAG

Standard (AES) Read back of the FlashROM content via the JTAG interface is protected by the Pass Key.
key and a Pass Read back of the FlashROM content is allowed from the FPGA Array.

interface, the Write operation of the FlashROM uses a 128-bit AES encrypted bitstream.

Medium | Protect with

Pass | The Write and Verify operations of the FPGA Array require a Pass Key. From the JTAG

Key interface, the Read and Write operations on the FlashROM content require a Pass Key.
You can Verify the FlashROM content via the JTAG interface without a Pass Key. Read
back of the FlashROM content is allowed from the FPGA Array.
None No Security The Write and Verify operations of the FPGA Array do not require keys. The Read, Write,

and Verify operations of the FlashROM content also do not require keys.

Note: Note: When a device is programmed with a Pass key and AES key, only the Pass key is required

for reprogramming since re-entering the correct Pass key unlocks the bits that restrict programming
to require AES encryption and also unlocks the bits that prohibit reprogramming altogether (if
locked); thus both plaintext and encrypted programming are [re-] enabled.

Enter the Pass Key and/ or the AES Key as appropriate. You can generate a random key by clicking
the Generate random key button.

The Pass Key protects all the Security Settings for the FPGA Array and/or FlashROM.

The AES Key decrypts FPGA Array and/or FlashROM programming file content. Use the AES Key if
you intend to program the device at an unsecured site or if you plan to update the design at a remote
site in the future.
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7. Click Finish.
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You can also customize the security levels by clicking the Custom Level button.

To change or disable your security keys you must run the ERASE_SECURITY action code. This erases your

security settings and enables you to generate the programming file with new keys and reprogram, or to
generate a programming file that has no security key.

Custom Security Settings

For advanced use, you can customize your security levels.

To set custom security levels:

1. Click the Custom Level button in the Setup Security page. The Custom Security dialog box appears
(see figure below).

Custom Security Level

X

[ Permanently lock the security settings,

Help

2 Security Settings
Device Feature Seﬁcﬁtlity Encrypt Read | "luf']::lify | ?ﬁflite
FPGA Armray v ~
FlashROM ™ ™2 RES
firmwaret/NYM_INST [# 1] ¥ v I R =

Cancel

levels.

Figure 134 - Custom Security Level
2. Select the FPGA Array Security, the FlashROM Security, and Embedded Flash Memory block

The silicon features can have different Security Settings. See the tables below for a description of

the custom security option levels for FPGA Array, FlashROM, and Embedded Flash Memory

block.

Table 6 - FPGA Array

Security Option

Description

Lock for both writing and verifying

d Set Security Settings
Device Feature .. | Encrypt
Security] ~ = 'F'| Read | verify | wirite
FPGA Array ~ r i I -

Allows writing/erasing and
verification of the FPGA Array
via the JTAG interface only with
a valid Pass Key.
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Security Option

Description

Lock for writing

Device Feature

Set

Security Settings

Encrypt

Security

Read | Verify | Write

FPGA Arrzy

i r

@ |

Allows the writing/erasing of the
FPGA Array only with a valid
Pass Key. Verification is allowed
without a valid Pass Key.

Use the AES Key for both writing and verifying

Device Feature

Set

Security e

Security Settings

Read | Verify | Wirite

FPGA Array

| ¥ |~

EREETES

Allows the writing/erasing and
verification of the FPGA Array
only with a valid AES Key via the
JTAG interface. This configures
the device to accept an
encrypted bitstream for
reprogramming and verification
of the FPGA Array. Use this
option if you intend to complete
final programming at an
unsecured site or if you plan to
update the design at a remote
site in the future. Accessing the
device security settings requires
a valid Pass Key.

Allow write and verify

Device Fature

Set

Security Settings

Security S

Read | Werify | Write

FPGA Array

| &

Allows writing/erasing and
verification of the FPGA Array
with plain text bitstream and
without requiring a Pass Key or
an AES Key. Use this option
when you develop your product
in-house.

Note: The ProASIC3 family FPGA Array is always read protected regardless of the Pass Key or the AES Key protection.

Table 7 - FlashROM

Security Option

Description

Lock for both reading and writing

Allows the writing/erasing and

_ <ot Security Settings reading of the FIashRQM via t'he
Device Feature s - | Encrypt : . JTAG interface only with a valid
ecurity Read | Verify | Write T
Pass Key. Verification is allowed
FlashROM & r i 7| (] @ | without a valid Pass Key.
Lock for writing Allows the writing/erasing of the
: Set Security Settings FlashROM via the JTAG
Device Feature i Encrypt - - interface only with a valid Pass
Read | Verify | write Key. Reading and verification is
FlashROM w r (%] (] 3 | allowed without a valid Pass
Key.
Use the AES Key for writing Allows the writing/erasing of the
Device Feature i Encrypt bl 'FltaS?ROM \IlIal t_flﬁ JTA?d AES
Security ryp Read || Venly | Wiite interface only with a vali

FlashROM

4 ¥

£

Key. This configures the device
to accept an encrypted bitstream
for reprogramming of the
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Security Option

Description

FlashROM. Use this option if you
complete final programming at
an unsecured site or if you plan
to update the design at a remote
site in the future.

Note: The bitstream that is read
back from the FlashROM is
always unencrypted (plain text).

Allow reading, writing, and verifying

S it
Device Feature SEt. Encrypt ecurity Settings
Security Read | Verify | Wirite
FlagshROM | r r

Allows writing/erasing, reading
and verification of the FlashROM
content with a plain text
bitstream and without requiring a
valid Pass Key or an AES Key.

Note: The FPGA Array can always read the FlashROM content regardless of these Security Settings.

Table 8 - Embedded Flash Memory Block

Security Option

Description

Lock for reading, verifying, and writing

Allows the writing and reading

i set Er1Cn‘rm| Security Settings | | of the Embedded Flash
Security | Read | Verify | wirite | _’V'temfory B'°|°k va the JILAF?
interface only with a valid Pass
e SR SR 1) | 4 r m E m Key. Verification accomplished
by reading back and compare.
Lock for writing Allows the writing of the
Device Feature o Encrypt SECUIIY e I S Embedded Flash Mgmory
i Rea [ verity [ Write || o0t e Pass Key.
firmwareVNVM_INST (# 1) i r (] [ 7 Reading and verification is
allowed without a valid Pass
Key.
Use AES Key for writing Allows the writing of the
Device Feature ==L Encrypt Sl Sl Embedded Flash Mgmory
it Read [ very [_wimte | | e ey, This
ey v IL E m configures the device to accept

an encrypted bitstream for
reprogramming of the
Embedded Flash Memory
Block. Use this option if you
complete final programming at
an unsecured site or if you
plan to update the design at a
remote site in the future. The
bitstream that is read back
from the Embedded Flash
Memory Block is always
unencrypted (plain text), when
a valid pass key is provided.
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Security Option

Description

Allow reading, writing, and verifying

Allows writing, reading and

ShE Set E i Security Settings verification of the Embedded
evice Feature ey ncryp = | Verity | Write Fl-?ﬁh Mlem()try tBLot(:I: (:ontentd
with a plain text bitstream an
Do ) | [ £ without requiring a valid Pass

Key or an AES Key.

3. To make the Security Settings permanent, select the Permanently lock the security settings check
box. This option prevents any future modifications of the Security Setting of the device. A Pass Key is
not required if you use this option.

Note: Note: When you make the Security Settings permanent, you can never reprogram the Silicon
Signature. If you lock the write operation for the FPGA Array or the FlashROM, you can never
reprogram the FPGA Array or the FlashROM, respectively. If you use an AES key, this key cannot be
changed once you permanently lock the device.

To use the Permanent FlashLock™ feature, select Lock for both writing and verifying for FPGA Array
and Lock for both reading and writing for FlashROM and select the Permanently lock the security
settings checkbox as shown in the figure below. This will make your device one-time-programmable.

Custom Security Level

!

2 Security Settings
Dewvice Feature Seifll;ity Encrypt Road | "lu'::rify | ?#lite
FPGA Amray W ~ HES
FlashROM ™ ~
firmwareh/NVYM_INST [# 1] v "2 i i

[ Permanently lock the security settings,

Custom Security Level- Permanent Lock

4. Click the OK button. The Security Settings page appears with the Custom security setting
information.

Changing or Disabling Security Keys
To change or disable your security keys you must run the ERASE_SECURITY action code.

ERASE_SECURITY erases your security settings and enables you to generate the programming file with
new keys and reprogram, or to generate a programming file that has no security key.

Your action codes vary according to device family:
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e Programming File Actions - SmartFusion and Fusion Devices
e Programming Actions - IGLOO and ProASIC3 Devices

Configuring FlashROM Settings in FlashPro

To configure the FlashROM settings:

1. From the Configuration menu, choose Load Programming File (PDB).
2. Select the PDB file and click Open, this loads the programming file.

3. From the Configuration menu, choose PDB Configuration. The Programming File Generator
appears.

4. Check the FlashROM checkbox and click Browse to load a FlashROM configuration file. Click Next.
This brings up the FlashROM Settings dialog box (see figure below).

FlashROM Settings - Step 2 of 2 X
FlashROM regions: Region_0_0 LI
Program Properties:
page Name Region_0 0
v Start page i
Start word 1]
v Length 16
Content Static
v State Fixed
I Type HEX
Walue F14F8FF4F34 0341861
v SESERDOT104080
v
v
v

Help | Eack I Iext I Finish Cancel

Figure 135 - FlashROM Settings Dialog Box

5. Select the FlashROM memory page that you want to program.
6. Enter the data value for the configured regions.
7. If you selected the region with a Read From File, specify the file location.
8. If you selected the Auto Increment region, specify the Start and Max values.
9. Enter the number of devices you want to program.
10. Click the Target Programmer button. The Select Programmer Type dialog box appears.
11. Click Finish. FlashPoint generates your programming file.
Note: You cannot change the FlashROM region configuration from FlashPoint. Y ou can only change the configuration
from the FlashROM core generator.
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Express Configuration

The express configuration feature in FlashPro allows you to set the security settings as well as FlashROM
content without a design. This allows the production flow to be executed in parallel to the design effort if
needed.

For example, you can pre-program the security settings with the High Security setting and serialize the
device using FlashROM without the FPGA design in a secured programming environment. The FPGA Array
and EFMB design can be programmed in unsecured programming environment using encrypted
programming file. Refer to Programming Only Security Settings Tutorial for more information.

Note: This feature is only available for SmartFusion, IGLOO, ProASIC3 and Fusion devices.
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Programming File Actions for IGLOO and ProASIC3 Devices
IGLOO and ProASIC3 devices support the following features:
e FPGA Array
e FlashROM
e Security settings

You can program these features separately or together using different programming files or by using one
programming file.
Note: When we specify a family name, we refer to the device family and all its derivatives, unless otherwise specified. See

the Supported Families topic for a complete list of families and their derivatives.

The STAPL files for IGLOO and ProASIC3, excluding ProASIC3L, devices include actions targeted at one,
two, or all three of the IGLOO and ProASIC3 features (FPGA Array and FlashROM and Security Settings).
The combinations of the features you selected to target results in different actions that are available in the
STAPL file. See the following table for an illustration.

The table indicates that if you choose the feature FPGA Array, it will be affected by the PROGRAM file
action.

If you choose the feature Security, it will be unaffected by the PROGRAM action.
Table 9 - IGLOO and ProASIC3 Device Programming Actions

Features Selected

FPGA | FlashROM | Security | FPGA FPGA FlashROM and Security
Array Array and | Array and
FlashROM | Security

STAPL Actions Available (correspond with Features Selected above)

PROGRAM X X X X X
VERIFY X X X X X
ERASE X X X X X
ERASE_ALL X X X X X X
DEVICE_INFO X X X X X X
READ_IDCODE X X X X X X
ERASE_FROM X X X

PROGRAM_FROM

ERASE_ARRAY X X X
VERIFY_ARRAY X X X
ENC_DATA_AUTHENTICATION | X X X
PROGRAM_SECURITY X X X
ERASE_SECURITY X X X

Note: The ENC_DATA_AUTHENTICATION Action is only available when you choose encrypted programming.
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Programming Actions
See the table below for a list of all the actions for the programming file.
Table 10 - Programming File Actions

Action Description

PROGRAM Programs all selected family features: FPGA Array, targeted FlashROM pages, security setting and
silicon signature (if provided).

VERIFY Verifies all selected features: FPGA Array, targeted FlashROM pages, security setting and silicon
signature (if provided).

ERASE Erases all selected family features: FPGA Array, targeted FlashROM pages, security setting and
silicon signature (if provided).

ERASE_ALL Erases all features in the targeted device regardless of the features selected to generate the STAPL
file.

DEVICE_INFO Displays the IDCODE, Silicon Signature, the design name, the checksum, and device security

settings and programming environment information programmed into the device.

VERIFY_DEVICE_INFO | Verifies the IDCODE, silicone signature, design name, checksum, device security settings and
programming information programmed into the device.

READ_IDCODE Reads the device ID code from the device.

ERASE_FROM Erases only the targeted FlashROM pages, not the entire FlashROM.
PROGRAM_FROM Programs only the targeted FlashROM pages.

VERIFY_FROM Verfies the targeted FlashROM pages.

PROGRAM_ARRAY Programs the FPGA Array and Silicon Signature (if applicable) into the device.

VERIFY_ARRAY Verifies the FPGA Array and Silicon Signature (if applicable) into the device.

ERASE_ARRAY Erases the FPGA Array and Silicon Signature (if provided).

PROGRAM_SECURITY | Programs only the Security Settings.

ERASE_SECURITY Erases only the Security Settings.

Note: FIX_INT_ARRAYS - This function is only applicable to STAPL file only. Depending on the STAPL player
implementation, the indexing of an integer array may start from different direction. The STAPL standard did not clearly
specify how it should be implemented. The FIX_INT_ARRAYS function detects the indexing implemented by the
STAPL player and flips the content of the integer array if needed.

UNLOCK_UKEY: This function unlocks a secured device if it is locked by FlashLock.
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Options available in Programming Actions
The table below shows the available actions in the programming file.
Table 11 - Programming File Actions

Action Description

PROGRAM When you target the Security Setting, you have the option of not erasing and programming the
Security Setting by deselecting the following 2 procedures before executing the action. -
SET_ERASE_SEC, - DO_PROGRAM_SECURITY. When you perform encrypted programming, you
have the option of skipping the data authentication before programming by deselecting the
DO_ENC_AUTHENTICATION procedure before executing the action.

ERASE When you target the Security Setting, you have the option of not erasing the Security Setting by
deselecting the SET_ERASE_SEC procedures before executing the action.

PROGRAM_ARRAY | When you perform encrypted programming, you have the option of skipping the data authentication
before programming by deselecting the DO_ENC_AUTHENTICATION procedure before executing
the action.

Note: The DO_ENC_AUTHENTICATION procedure prevents you from proceeding with encrypted programming
with incorrect data due to corruption or an operator error. If incorrect data is detected during encrypted programming, the

device will not be functional after programming.
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Programming File Actions - SmartFusion and Fusion

FlashPro enables you to program security settings, FPGA Array, eNVM and embedded flash memory blocks
(EFMB), and FlashROM features for AFS device support. You can program these features separately using
different programming files or you can combine them into one programming file.

Note: If you are programming SmartFusion devices you are using eNVM. If you are programming Fusion devices you are
using the Embedded Flash Memory Block (EFMB). When referring to these elements together we refer to them as
eNVM/EFMB.

The STAPL files for SmartFusion and Fusion devices include actions targeted at one, two, or all four of the
programming features: FPGA Array and FlashROM, Security Settings, and eNVM/EFMB. The combinations
of the features you selected to target, results in different actions that are available in the STAPL file. See the
following table for an illustration.

The table indicates that if you select ERASE_ALL that it will affect any Programming Feature (or
combination of features) marked with an X. According to the table, the only Programming Feature unaffected
by ERASE_ALL is the eNVM/EFMB.

Compare that to the ERASE command: ERASE does not have any effect on the following Programming
Features: Security; Embedded Flash Memory Block; Security AND eNVM/EFMB.

Table 12 - SmartFusion and Fusion Programming File Actions

Programming Features Selected
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STAPL Actions Available (correspond with Features Selected above)

PROGRAM X | x X | X X X [x X X X
VERIFY X |x X | X X X [X X X X
ERASE X |x X | X X X [x X X X
ERASE_ALL X [x [x X [ X |x X X [X X X X
DEVICE_INFO X |x [x [x X [ X |x X X [x X X X
READ_IDCODE X |x [x [x X [ X | X X X [x X X X
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Programming Features Selected
ERASE_FROM X X X X X X
PROGRAM_ARRAY X X X X X X
VERIFY_ARRAY X X X X X X
ENC_DATA_AUTHENTIFICATION [ X X X X X X
PROGRAM_SECURITY X X X | X X X
ERASE_SECURITY X X X | X X X
VERIFY_SECURITY X X X | X X X
PROGRAM_FP X X | X |X X X X
VERIFY_FP X X | X |X X X X
PROGRAM_NVM X X | X |X X X X
VERIFY_NVM X X | X |X X X X
PROGRAM_NVM_ACTIVE_ARRAY X X | X X
VERIFY_NVM_ACTIVE_ARRAY X X | X X
PROGRAM_NVM_ACTIVE_RSTM3 X X | X X
RESET_CORTEXMS3 (SmartFusion X X | X |X X X X
only)

Note: The ENC_DATA_AUTHENTICATION Action is only available when you choose encrypted programming.

Note: PROGRAM_NVM_ACTIVE_ARRAY and VERIFY _NVM_ACTIVE_ARRAY actions are not available when
the EFMB read/write/verify is locked with FlashLock.

STAPL Actions
See the table below for a list of all the actions for the STAPL file.
Table 13 - STAPL File Actions

Action Description

PROGRAM Programs all selected family features: FPGA Array, targeted FlashROM pages, security
setting and silicon signature (if provided).

SmartFusion only: Resets the CORTEX M3.

VERIFY Verifies all selected family features: FPGA Array, targeted FlashROM pages, security
setting and silicon signature (if provided).

ERASE Erases the selected family features.

ERASE_ALL Erases all features in the targeted family device except Embedded Flash Memory
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Action Description
Blocks, regardless of the features selected to generate the STAPL file.
DEVICE_INFO Displays the IDCODE, Silicon Signature, the design name, the checksum, and device
security settings and programming environment information programmed into the
device.
READ_IDCODE Reads the device ID code from the device.
ERASE_FROM Erases only the targeted FlashROM pages, not the entire FlashROM.
PROGRAM_FROM Programs only the targeted FlashROM pages.
PROGRAM_ARRAY Programs the FPGA Array and Silicon Signature (if applicable) into the device.
SmartFusion only: Resets the CORTEX M3.
VERIFY_ARRAY Verifies the FPGA Array and Silicon Signature (if applicable) into the device.
ERASE_ARRAY Erases the FPGA Array and Silicon Signature (if provided).
PROGRAM_SECURITY Programs only the Security Settings.
ERASE_SECURITY Erases only the Security Settings.
PROGRAM_NVM Programs the targeted EFMBs.
SmartFusion only: Resets the CORTEX M3.
VERIFY_NVM Verifies the targeted EFMBs.
PROGRAM_NVM_ACTIVE_ARRAY [ Programs the targeted EFMBs while the FPGA Array remains active.
VERIFY_NVM_ACTIVE_ARRAY Verifies the targeted EFMBs while the FPGA Array remains active.
PROGRAM_NVM_ACTIVE_RSTM3 | SmartFusion only; programs the eNVM while the core is active and then resets the
CORTEX M3.
RESET_CORTEXMS3 SmartFusion only; resets the CORTEX M3.

Options available in STAPL Actions
The table below shows the available actions in the STAPL file.
Table 14 - STAPL File Actions

Action Description

PROGRAM When you target the Security Setting, you have the option of not erasing and programming the
Security Setting by deselecting the following two procedures before executing the action.

- SET_ERASE_SEC,

- DO_PROGRAM_SECURITY. When you perform encrypted programming, you have the option of
skipping the data authentication before programming by deselecting the DO_ENC_AUTHENTICATION
procedure before executing the action.
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Action Description

ERASE When you target the Security Setting, you have the option of not erasing the Security Setting by
deselecting the SET_ERASE_SEC procedures before executing the action.

PROGRAM_ARRAY | When you perform encrypted programming, you have the option of skipping the data authentication
before programming by deselecting the DO_ENC_AUTHENTICATION procedure before executing the
action.

Note: The DO_ENC_AUTHENTICATION procedure prevents you from proceeding with encrypted programming
with incorrect data due to corruption or an operator error. If incorrect data is detected during encrypted programming, the

device will not be functional after programming.
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Generate a Programming File in FlashPoint

FlashPoint enables you to program security settings, FPGA Array, and FlashROM features for SmartFusion,
IGLOO, ProASIC3, Fusion family devices. You can program these features separately using different
programming files or you can combine them into one programming file. Each feature is listed as a silicon
feature in the GUI.

You can generate a programming file with one, two, or all of the silicon features from the Programming File Generator first
page.
To generate a programming file:
1. Select the Silicon feature(s) you want to program.

e Security settings
o FPGA Array

e FlashROM
FlashPoint - Programiming File Generator - Step 1 of 2 E

Silicon Featureds) to be programmed:
[ Security settings
¥ FRGA Array
[V FlashromM
Criginal FlashROM configuration File:

r?:'|,A3PEQUAL'|,A3P125_BI'l,smartgen'l,UFROMFIXZ'l,UFROMFIXZ.ch —— |

™ Programming previously secured device(s)

o Specify [j0 States During Programming. ..

Silicon signature {max length is 8 HEX chars):

Back | Mext | Finish | Cancel |

Figure 136 - Programming File Generator — Step 1 of 2

Note: Note: When FlashPoint is invoked for the first time, after netlist files are imported and the design
is in post-layout state, the software retrieves the FlashROM and EFM blocks configuration files
from the imported netlists and imports the configuration files. Otherwise, you need to import
configuration files.

2. Click the Programming previously secured device(s) check box if you are reprogramming a device
that has been secured.

Because the SmartFusion, IGLOO, ProASIC3, Fusion families enable you to program the Security Settings
separately from the FPGA Array and/or FlashROM, you must indicate if the Security Settings were
previously programmed into the target device. This requirement also applies when you generate
programming files for reprogramming.

3. Enter the silicon signature (0-8 HEX characters). See Silicon Signature for more information.
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4. Depending upon the Silicon features you selected, click Next or Finish.

If you click Next, follow the instructions in the appropriate dialog box. If you click Finish, the Generate
Programming Files dialog box appears (as shown in the figure below). Use this dialog box box to specify
the programming file name, location, output format (STAPL file, SVF file, PDB file, DirectC DAT file, 1532
file), and, if necessary, limit the file size (as explained below).

Some testers may have memory size restrictions for a single SVF file. The SVF limit file option enables you
to limit the size of each SVF file by either file size or vectors.

The generated SVF files append an index to the file name indicating the sequence of files. The format is:
<SVF_filename>_XXXXX.svf

where XXXXX is the index of the SVF file. The first SVF file begins with <SVF_filename>_00000.svf and
increments by 1 until file generation is complete.

Maximum file size: Max file size limit for the SVF file; use this option to limit your SVF file size based on
number of kB.

Maximum number of vectors: Max vector limit for the SVF file; use this option to limit the size of your SVF
based on number of vectors.

Generate Programming Files El
Tame: Existing programming files in this location:
/8 | ToP HF.pdb
HF.stp
Lacation: ToP.pdb
| Pl adbla3p2s0 TOP.stp
CaToP_t532

EHEAE [OTor_svf

0 Output formats:
[JIEEE 1532 Files {*.bsd; *.isc)
[|Directd File {*.dat)
[wIPrograrming Data File (*.pdb)
[W]STAPL Filz (*,stp)
[w]Serial Yector Files ¥, svf)

v Limit file size

& Maximurn file: size 2000 KB
" Maximurn number of vectors ,7

Generate | Cancel |

Figure 137 - Generate Programming Files Dialog Box (Flashpoint)

Programming File Types

The table below summarizes the Microsemi SoC programming file types and programmers.

Unless otherwise noted, listing an individual device indicates the device family and all its derivatives. For
example, IGLOO indicates IGLOO, IGLOOe, IGLOO nano and IGLOO plus. See the Supported Families
topic for more information. See the list of programming file type descriptions below for more details.

Programming File Device Support Programmer
Type
PDB (*.pdb) See device FlashPro 4/3/3x
specifications
STAPL (*.stp) FlashPro 4/3/3x, FlashPro Lite, FlashPro,
Silicon Sculptor /11
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Programming File Device Support Programmer
Type
SVF (*.svf) Third party programmer
IEEE 1532 (*.isc or Third party programmer
*.bsd)

The following programming-related files are required if you use the related functional block elements in your
enabled devices. See the appropriate sections of the FlashPro help for more information on creating these
files.

File Type Device Support Function

FDB (*.fdb) | See device specifications | Contains your FPGA array data

UFC (*.ufc) Contains your FlashROM data

EFC (*.efc) Contains your Embedded Flash Memory file

PDB Files

A proprietary Microsemi programming data file.
STAPL Files

The Standard Test And Programming Language (STAPL) is designed to support the programming of
programmable devices and testing of electronic systems, using the IEEE Standard 1149.1: “Standard Test
Access Port and Boundary Scan Architecture” (commonly referred to as JTAG) interface. As a STAPL file is
executed, signals are produced on the IEEE 1149.1 interface, as described in the STAPL file. STAPL
operates on a single IEEE 1149.1 chain. STAPL supports the programming of any IEEE 1149.1-compliant
programmable device.

STAPL has support for programming and test systems with user interface features. A single STAPL file may
perform several different functions, such as programming, verifying, and erasing a programmable device.
Bitstream Files

Proprietary Microsemi programming data file.
SVF Files

Courtesy Serial Vector Format Specification from ASSET InterTech, 1999:

Serial Vector Format (SVF) is the media for exchanging descriptions of high-level IEEE 1149.1 bus
operations. In general, IEEE 1149.1 bus operations consist of scan operations and movements between
different stable states on the IEEE 1149.1 state diagram. SVF does not explicitly describe the state of the
IEEE 1149.1 bus at every Test Clock.

The SFV file is defined as an ASCII file that consists of a set of SVF statements. The maximum number of
characters on a line is 256, although one SVF statement can span more htan one line. Each statement
consists of a command and associated parameters. Each SVF statement is terminated by a semicolon. SVF
is not case sensitive.

IEEE 1532 Files

Courtesy ieee.org:

The IEEE 1532 files implement programming capabilities within programmable integrated circuit devices,
utilizing (and compatible with) the 1149.1 communication protocol. This standard allows the programming of
one or more compliant devices concurrently, while mounted on a board or embedded in a system, known as
In-System Configuration.
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Generate a Programming File for SmartFusion

Generate a Programming File for SmartFusion

You can configure and generate a new PDB file from FlashPoint.

If you are using Single Mode, click Create to add a new PDB, or click Modify to make changes to a loaded
PDB.

In Chain Mode, if you have not already done so, construct a chain and click Create PDB to create a new
PDB for programming, or click Modify PDB to make changes to a loaded PDB.

FlashPoint enables you to specify your security settings and silicon features when you generate your
programming file in SmartFusion. You can specify your EPGA Array, FlashROM, and Embedded Flash
Memory by importing FDB, UFC and EFC files, respectively (as shown in the figure below). If you have
imported a FlashROM and Embedded Flash Memory file you can click Modify to configure these feature
before saving your PDB file.

Click Specify I/O States During Programming to set custom I/O states.
NOTE: Y ou must import an FDB to populate Port Name and Macro Cell columns.

FlashPoint - A2F200M3F.pdb X

Silicon Featureds) to be programmed:

I¥ Security settings Specify,..

ER ¥ Frca array

Cihactelpritsmartfusion_sample_fpro_files\SD.fdb Impott. ..

B W Flashrom
Cihactelpritsmartfusion_sample_fpro_files\MSs_IUFROM_0,ufc Import. .. | Modify, .. |

m Iv Embedded Flash Memary

/¢y SilActel_Project_Testings|SmartFusionicomponentiwork),.. \M55_ENYM_D.efc Impart... | Madify. .. |

o Specify [j0 States During Programming. ..

Silicon signature {max length is 8 HEX chars):

Help Save PDB | Cancel

Figure 138 - FlashPoint Programming Settings for SmartFusion

Creating a Programming Database (PDB) File in Designer

The programming database (PDB) file supports SmartFusion, IGLOO, ProASIC3 and Fusion devices only.
This allows reconfiguration of the security settings, FlashROM, FPGA Array, and Embedded Flash Memory
Blocks. You create the file in Designer using FlashPoint and you modify the file in FlashPro.

You must create programming files for SmartFusion in FlashPro; see the Generate a Programming File for
SmartFusion topic for more information.

1. From the Designer main window, click the Programming File button. This brings up FlashPoint (see
figure below).
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FlashPoint - Programming File Generator - Step 1 of 3

Silicon Featurels) ko be programmed;
6 v Security settings
v FPGA Array
¥ FlashRomM
Criginal FlashROM configuration File:

Embedded Flash Memory Blocks (EFME):

Program Ella?lﬁ:: LE{I:':t:iI:Jn Original Configuration File
1 v firmwareh /My _ 1 F:\Flash_Memory_Block. efc b odify...

[ Programming previously secured devicels)

Modify IQ States During Programming. . .

Silicon signature (max length is 8 HEX chars):

Help ek Finish Cancel

Figure 139 - FlashPoint Programming File Generator - PDB File

2. Select the silicon feature(s) to be programmed: Security Settings, FPGA array, FlashROM, and
Embedded Flash Memory Block. If you are programming a previously secured device, check the
Programming previously secured device(s) and enter the silicon signature.

3. Click Finish to create the PDB file.

See Also
Configuring security and FlashROM settings in FlashPro
Configuring security settings in FlashPro

Configuring FPGA array settings
Configuring FlashROM settings in FlashPro
Configuring Embedded Flash Memory Block settings in FlashPro

Programming Embedded Flash Memory Block

For more information about the Embedded Flash Memory Block, see the Flash Memory System Builder
online help.

To program the Embedded Flash Memory Block:
1. Check the Program box to enable Embedded Flash Memory Block modification.
2. Click the Modify button to import Embedded Flash Memory Block configuration and memory content.
The Modify Embedded Flash Memory Block dialog box appears.
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Programming the FPGA Array
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Dlock location: 1
Bluck vonfigur ation fiks: DiwrodaDauditimm_all new Al eveelc It © nnfiguration FHe. .. |
Bluck conent:
Sclect All Chients Unsclect All Chents
Stan —_ JTAG Protection
Prngram |Client Type | Client Name | Address e Hrevent MPrevent | MNriginal Memnry Content File
fhex)  [dePtiRwidth) ooy wiite
1 [ Anaing Spste ash WA NiA r I
2 73 CFI Data cfiData N/ A I "2 Dr:\prodB0auditmm_simple\inpul_m Impart content...
E 7 Dala Stuiaus Us 0 148 r o D SprodB0ausdthrmmn sanplesingd Import contant
4 W Intiakzation it oo 1H0 I | I | Dr:\prod00audithmm_smple'input_m Impart content...
5 F RAM Initiakzat raminit 100 5129 I o
heo | o | cancel |

Figure 140 - Modify Embedded Flash Memory Block Content Dialog Box

3. Click the Import Configuration File button (if available) to import the Embedded Flash Memory Block
configuration and memory content from the EFC file. This will populate the client table below. All
clients that belong to this block will be selected by default.

4. Click the Import content button if you want to change the client memory content.
5. Click OK.

Note: Note: FlashPoint audits original configuration and memory content files and warns you if the files
cannot be located or if they have been updated.

Programming the FPGA Array

The FPGA Array contains your design; in FlashPro for SmartFusion you must have an FDB file to program
your FPGA Array.

You can program the FPGA Array by selecting the silicon feature FPGA Array in the Generate
Programming File page and clicking OK.

In FlashPro, if you are using a PDB with an FPGA Array you cannot de-select it for programming unless you
are using SmartFusion.

See Generate a programming file for more information.

Programming the FlashROM
You can program selected memory pages and specify the region values of the FlashROM.
To program FlashROM:

1. Select FlashROM from the Generate Programming File page.

2. Enter the location of the FlashROM configuration file. The FlashROM Settings page appears (see
figure below).

3. Select the FlashROM memory page that you want to program.
Enter the data value for the configured regions.
If you selected the region with a Read From File, specify the file location.

If you selected the Auto Increment region, specify the Start and Max values.

N

Click Finish.
FlashPoint generates your programming file.

Note: Note: You cannot change the FlashROM region configuration from FlashPoint. You can only
change the configuration from the FlashROM core generator.
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Silicon Signature

With Libero SoC tools, you can use the silicon signature to identify and track Microsemi designs and
devices. When you generate a programming file, you can specify a unique silicon signature to program into
the device. This signature is stored in the design database and in the programming file, and programmed
into the device during programming.

The silicon signature is accessible through the USERCODE JTAG instruction.
Note: If you set the security level to high, medium, or custom, you must program the silicon signature along with the
Security Setting. If you have already programmed the Security Setting into the target device, you cannot reprogram the

silicon signature without reprogramming the Security Setting.
The previously programmed silicon signature will be erased if:

¢ You have already programmed the silicon signature and
e You are programming the security settings, but you do not have an entry in the silicon signature field

Programming Security Settings

FlashPoint allows you to set a security level of high, medium, or none (SmartFusion uses radio buttons and
the option Clear Security instead of None).

To program Security Settings on the device:
1. If you choose to program Security Settings on the device from the Generate Programming File page,
the wizard takes you to the Security Settings page.
Your Security Settings page depends on your family.
2. Set the security level for FPGA and FlashROM (see the table below for a description of the security

levels).
Table 15 - FPGA and FROM Security Settings
Security Security Option Description
Level
High Protect with a 128-hit Access to the device is protected by an AES Key and the Pass Key.

Advanced Encryption The Write and Verify operations of the FPGA Array use a 128-bit AES
Standard (AES) key encrypted bitstream.

and a Pass Key From the JTAG interface, the Write and Verify operations of the
FlashROM use a 128-bit AES encrypted bitstream. Read back of the
FlashROM content via the JTAG interface is protected by the Pass Key.
Read back of the FlashROM content is allowed from the FPGA Array.

Medium Protect with Pass Key | The Write and Verify operations of the FPGA Array require a Pass Key.
From the JTAG interface, the Read and Write operations on the
FlashROM content require a Pass Key. You can Verify the FlashROM
content via the JTAG interface without a Pass Key.

Read back of the FlashROM content is allowed from the FPGA Array.

None No security The Write and Verify operations of the FPGA Array do not require keys.
The Read, Write, and Verify operations of the FlashROM content also do
not require keys.

This option is available for SmartFusion; to choose it, de-select the
Security Settings checkbox.
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Custom Security Levels

Note: Note: When a Device is programmed with a Pass key and AES key, only the Pass key is required
for reprogramming since re-entering the correct Pass key unlocks the bits that restrict programming
to require AES encryption and also unlocks the bits that prohibit reprogramming altogether (if
locked); thus both plaintext and encrypted programming are [re-] enabled.

Enable eNVM client JTAG protection - Enables eNVM client JTAG protection in the event you have not
set Medium or High security. Enables you to protect specific clients with a user pass key and then leave
others unprotected. This can be advantageous if you want to protect your IP, but give another user access
to the rest of the eNVM for storage. You can also set custom security levels for your eNVM.

Enter the Pass Key and/ or the AES Key as appropriate. You can generate a random key by clicking the
Generate random key button.

The Pass Key protects all the Security Settings for the FPGA Array and/or FlashROM.

The AES Key decrypts FPGA Array and/or FlashROM programming file content. Use the AES Key if you
intend to program the device at an unsecured site or if you plan to update the design at a remote site in the
future.

You can also customize the security levels by clicking the Custom Level button. For more information, see
the Custom Security Levels section.

To change or disable your security keys you must run the ERASE_SECURITY action code. This erases your
security settings and enables you to generate the programming file with new keys and reprogram, or to
generate a programming file that has no security key.

Custom Security Levels

For advanced use, you can customize your security levels.

To set custom security levels:

1. Click the Custom Level button in the Security Settings page. The Custom Security Level dialog
box appears.

2. Select the FPGA Array Security and the FlashROM Security levels. ForSmartFusion and Fusion
devices, you can also choose the Embedded Flash Memory Block level of security. The FPGA Array
and the FlashROM can have different Security Settings. See the tables below for a description of the
custom security option levels for FPGA Array and FlashROM.

Table 16 - FPGA Array

Security Option Description
Lock for both writing and verifying Allows writing/erasing and
Device Feature o E t ikt ek i V?riﬁhca,f]i?l'r,l\gf 'the I:PGA Alrray h
: ne Vi inter nly wi
security] “"“P' [Tpeaa [ verty | wnte | | V2 N¢ terface only wit

FPGA Array

a valid Pass Key.

i r i (5

Lock for writing

Allows the writing/erasing of the

Device Feature EEt. Encrypt bl (i EZSC‘SSAKérra\); oqcl_y W-ith g valid
Security Rcad | Verify | Write y._ erl |cat|o_n IS
FPGA Arrey v r [ﬁl ﬁ ille(;\fved without a valid Pass
Use the AES Key for both writing and verifying Allows the writing/erasing and
e Set_ oot Security Settings \ére;:ificgt;]on of It_he FPGA Arr_ay
Security Read | Verify | Write y with a valid AES Key via
— — the JTAG interface. This
Leliolh | 4 | o | configures the device to accept

an encrypted bitstream for
reprogramming and verification
of the FPGA Array. Use this
option if you intend to complete
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Security Option Description

final programming at an
unsecured site or if you plan to
update the design at a remote
site in the future. Accessing the
device security settings requires
a valid Pass Key.

Allow write and verify Allows writing/erasing and

get security Settings verification of the FPGA Array

Device Fzature L e WitE plain text bitstream and
without requiring a Pass Key or

FPGA Array | r [ an AES Key. Use this option

when you develop your product

in-house.

Read | Werify | Write

Note: The ProASIC3 family FPGA Array is always read protected regardless of the Pass Key or the AES Key protection.

Table 17 - FlashROM

Security Option Description
Lock for both reading and writing Allows the writing/erasing and
_ <ot Security Settings readlng of the FIashRQM via t'he
Device Feature s - | Encrypt : . JTAG interface only with a valid
ecurity Read | Verify | Write T
Pass Key. Verification is allowed
FlashROM & r i 7| (] @ | without a valid Pass Key.
Lock for writing Allows the writing/erasing of the
2 g FlashROM via the JTAG
: Set 5 Sett . . -
Device Feature Secﬁritg.r Encrypt Ecunly - sebial - interface only with a valid Pass
Read | Verify | write Key. Reading and verification is
FlashROM W r 1] (] 3 | allowed without a valid Pass
Key.
Use the AES Key for both writing and verifying Allows the writing/erasing and
Device Feature = E t oIy cling: ;/:rif;i;?Atign (:f tPe Flaslhr\)o't'\éI v
: ne
Security ryp Read | Verify | Write e interface only with a

valid AES Key. This configures
FlashROM ¥ | I = = the device to accept an
encrypted bitstream for
reprogramming and verification
of the FlashROM. Use this
option if you complete final
programming at an unsecured
site or if you plan to update the
design at a remote site in the
future.

Note: The bitstream that is read
back from the FlashROM is
always unencrypted (plain text).

Allow reading, writing, and verifying Allows writing/erasing, reading
and verification of the FlashROM
content with a plain text
bitstream and without requiring a
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Security Option

Description

Security Setti
Device Feature SEt- Encrypt bl Sl
Security Read | Verify | Write
FlashROM | H

valid Pass Key or an AES Key.

The FPGA Array can always read the FlashROM content regardless of these Security Settings.

Table 18 - Embedded Flash Memory Block

Security Option

Description

Lock for reading, verifying, and writing

Device Feature

Security Settings |

Set
Security

firmwareUNWVRL_INST (£ 1) | W r

Encrypt I

Read | Verify | Write |

i I - i 7

Allows the writing and reading of
the Embedded Flash Memory
Block via the JTAG interface only
with a valid Pass Key.
Verification accomplished by
reading back and compare.

Lock for writing

Set

Device Feature S

Encrypt

Security Settings

Read | Verify | Write

firmwareWNVM_INST (# 1) W r

@ | & S

Allows the writing of the
Embedded Flash Memory Block
via the JTAG interface only with
a valid Pass Key. Reading and
verification is allowed without a
valid Pass Key.

Use AES Key for writing

Set

Device Feature Encrypt

Security Settings

Security

Read | Verify | Write

firmwareWHVM_INST (# 1) I

[~ |

O B

Allows the writing of the
Embedded Flash Memory Block
via the JTAG interface only with
a valid AES Key. This configures
the device to accept an
encrypted bitstream for
reprogramming of the Embedded
Flash Block. Use this option if
you complete final programming
at an unsecured site or if you
plan to update the design at a
remote site in the future. The
bitstream that is read back from
the Embedded Flash Memory
Block is always unencrypted
(plain text), when a valid pass
key is provided.

Allow reading, writing, and verifying

Set

Device Feature Encrypt

Security Settings

Security

Read | Verify | Write

firmwareVNVM_INST (# 1)

| i

Allows writing, reading and
verification of the Embedded
Flash Memory Block content with
a plain text bitstream and without
requiring a valid Pass Key or an
AES Key.

3. To make the Security Settings permanent, select Permanently lock the security settings check box.
This option prevents any future modifications of the Security Setting of the device. A Pass Key is not

required if you use this option.
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Note: Note: When you make the Security Settings permanent, you can never reprogram the Silicon
Signature. If you Lock the write operation for the FPGA Array or the FlashROM, you can never
reprogram the FPGA Array or the FlashROM, respectively. If you use an AES key, this key cannot be
changed once you permanently lock the device.

4. (SmartFusion Only) Enable M3 Debugger option enables access to the M3 debugger even if security is
enforced. Select the Enable M3 debugger checkbox if you want to access the M3 debugger after
programming.

5. To use the Permanent FlashLock™ feature, select Lock for both writing and verifying for FPGA
Array and Lock for both reading and writing for FlashROM and select the Permanently lock the
security settings checkbox as shown in the figure below. This will make your device one-time-
programmable.

Silicon Feature Se?:zllilyn Encrypt Heasdecu'\l:tlis[e“mffrile
FPGA Array I I & R
FlashROM ¥ r i [E] i
eNVM (i 0) ~ r & & R
eNVM (i 1) I r & & R

o Ta see ellyM client ITAG protection information place your mouse cursor over each el
block.

V¥ Enable M3 debugaer
¥ Permanently lock the security settings.
o The following silicon Features will not be reprogrammable:

- Security settings, AES key, and silicon signature
- FPGA Array
- FlashRomM
- MM (# 00
- MM (# 1)

Help | OF I Cancel

Custom Security Level

6. Click the OK button. The Security Settings page appears with the Custom security settings
information as shown in the figure below.
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Reprogramming a Secured Device

Security Settings - Step 2 of 2 E|

Security level For this device:

Qg SEELTRy SHngS Security settings for FPGA Array:

- Use AES key to write or verify the FPGA Atray,

Security settings For FlashROmM:
- se AES key to write the FlashROM wia the JTAG interface.

Customn Level, .. | Default Level |

Pass Key (max length is 32 HEX chars):

| DE67EOFI0AEDTESAE L 766D 4A04EE 1659 Generate random key |

BES Key (max length is 32 HEX chars):

| BA7EESEGSCCBOATF47 7a007EZ77DO7 TS Generate random key

Help Back Finish Cancel

Figure 141 - Security Settings

Reprogramming a Secured Device

You must know the previous Security Settings of the device before you can reprogram a device with
Security Settings.

Programming a Secured SmartFusion Device
After you create a PDB you may wish to export a programming file for a secured device. To do so:
1. Create a PDB file (as explained above) with security set to High or Medium. Save the PDB file.

2. From the File menu, choose Export Single Programming File. The Export Programming Files dialog
box appears.

3. Click the Export programming file(s) for currently secured device checkbox. This exports
programming files for devices that already have security settings programmed.

4. Choose your outputs and enter your output file Name and Location.

5. Click Export to create the file(s). Your updated secured programming files are in the directory you
specified.

Custom Serialization Data for FlashROM Region

FlashPoint enables you to specify a custom serialization file as a source to provide content for programming
into a Read from file FlashROM region. You can use this feature for serializing the target device with a
custom serialization scheme.

To specify a FlashROM region:

1. From the Properties section in the FlashROM Settings page, select the file name of the custom
serialization file (see figure below). For more information on custom serialization files, see Custom
Serialization Data File Format.
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FlashROM settings - Step 2 of 2

FlashFOM regions: [Regior_7_1 |
Program Frepeities
page Fegicn_7_1
I 7
1
r s
- Read from fie
o Beoniipeiale
= HEX
-
-
r
& i
FlashROM programming fle ype:
% Single programming Fle for all devices " One pogramming fle per device
Humbes of devices o progran: 1 Torget programmes,
cBack | peio | [ Fnsh | Caeel | Hed

Figure 142 - FlashROM Settings

Custom Serialization Data File Format

FlashPoint supports custom serialization data files that specify the data in binary, HEX, decimal, or ASCII

text. The custom serialization data files may contain multiple data with the Line Feed (LF) character as the
delimiter. You can create a file by entering serialization data into any type of text editor. Depending on the
serialization data format (hex, ASCII, binary, decimal), input the serialization data according to the size of

the region you specified in the FlashROM settings page.

Semantics

Each custom serialization file has only one type of data format (binary, decimal, Hex or ASCII text). For
example, if a file contains two different data formats (i.e. binary and decimal) it is considered an invalid file.

The length of each data file must be shorter or equal to the selected region length. If the data is shorter then
the selected region length, the most significant bits shall be padded with 0’s. If the specified region length is
longer then the selected region length, it is considered an invalid file.
The digit / character length is as follows:
-Binary digit: 1 bit
-Decimal digit: 4 bits
-Hex digit: 4 bits
-ASCI1 Character: 8 bits
Note the standard example below:

If you wanted to use, for example, device serialization for three devices with serialization data 123, 321, and
456, you would create file name from_read.txt. Each line in from_read.txt corresponds to the serialization
data that will be programmed on each device. For example, the first line corresponds to the first device to be
programmed, the second line corresponds to the second device to be programmed, and so on.

Hex serialization data file example
The following example is a Hex serialization data file for a 40-bit region. Enter the serialization data below
into file created by any text editor:
123AEd210
AeB1
0001242E
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Custom Serialization Data File Format

Note: If you enter an invalid Hex digit such as 235SedF1, an error occurs. An error will also occur if you enter data that is
out of range, i.e. 4300124EFE.

The following is an example of programming "AeB1" into Region_7_1 located on page 7, from Word 5 to
Word 1 in the FlashROM settings page. See Custom serialization data for FlashROM region for more
information.

Table 15

Word 5

Word 4

Word 3

Word 2

Word 1

Word 0

Page 7

00

00

00

AE

Bl

Binary serialization data file example
The following example is a binary serialization data file for a 16-bit region:

1100110011010001

100110011010011
11001100110101111 (This is an error: data out of range)

1001100110110111
1001100110110112 (This is an error:

Decimal serialization data file example
The following example is a decimal serialization data file for a 16-bit region:

65534
65535

65536 (This is an error: data out of range)

6553A (This is an error:

invalid decimal digit)

Text serialization data file example
The following example is a text serialization data file for a 32-bit region:

AESB
A e

ASE3 23 (This is an error: data out of range)

65A~
1234
AEbF

Syntax

invalid binary digit)

Indentations in the syntax below indicate a wrapped line. If a line wraps and is not indented, then it should
appear on one line; you may need to expand your help window to view the syntax correctly.

Custom serialization data file =

<hex region data list> | <decimal region data list> |
<binary region data list> | <ascii text data list>

Hex region data list = <hex data> <new line> { < hex data> <new line> }

Decimal region data list = <decimal data> <new line> {<decimal data><new line> }
Binary region data list = <binary data> <new line> { <binary data> <new line> }

ASCII text region data list = < ascii text data> <new line> { < ascii text data> <new

line> }

hex data = <hex digit> {<hex digit>}

decimal data = < decimal digit> {< decimal digit>}

binary data = < binary digit> {< binary digit>}

ASCII1 text data
new line = LF

<ascii character> {< ascii character >}
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binary digit = “07]“1~

decimal digit = “07|“1”]“2”|“37|“4”|“5”|“67|“7°|“8"| “9”

hex digit = <0717 <2737 “4” |57 “6” |77 |“87 | 97| “A*|“B”|“C*|“D” | “E”| “F~" |
“a’] “b” | “c’] “d” | “e’] “F

ascii character = characters from SP(0x20) to“~”(OX7E).

Specifying 1/O States During Programming

You can modify the 1/O states during programming in FlashPro. In FlashPro, this feature is supported for
PDB files generated from Designer v8.5 or greater.

Note: PDB files generated from Designer v8.1 to Designer v8.4 (including all service packs) have limited display of Pin
Numbers only.

1. Load a PDB from the FlashPro GUI. You must have a PDB loaded to modify the 1/O states during
programming.

2. From the FlashPro GUI, click PDB Configuration. A FlashPoint — Programming File Generator
window appears.

3. Click the Specify 1/0 States During Programming button to display the Specify I/O States During
Programming dialog box.

4.  Sort the pins as desired by clicking any of the column headers to sort the entries by that header.
Select the 1/Os you wish to modify (as shown in the figure below).

5. Set the I/O Output State. You can set Basic 1/O settings if you want to use the default I/O settings for
your pins, or use Custom I/O settings to customize the settings for each pin. See the Specifying I1/0
States During Programming - I/O States and BSR Details help topic for more information on setting
your 1/O state and the corresponding pin values. Basic /O state settings are:

1 -1/O is set to drive out logic High
0 —1/O is set to drive out logic Low

Last Known State: I/O is set to the last value that was driven out prior to entering the programming mode,
and then held at that value during programming

Z - Tri-State: /O is tristated

Specify I/0 States During Programming
Load from file. .. | Save ko file... | [™ show BSR Details
Port Hame Macro Cell Pin Humber 1/0 State [Output Only) j
BIST ADLIB:INBUF T2 1
BvPASS_I0 ADLIB:INBUF K1 1
CLK ADLIB:INBUF B1 1
ENOUT ADLIB:INBUF J16 1
LED ADLIB:OUTBUF M3 a
MONITOR[O] ADLIB:OUTEUF BS 1]
MOMITOR[] ADLIB:OUTBUF c7 d
MOMITOR[Z] ADLIB:OUTBUF k] d
MONITOR[3] ADLIB:OUTBUF D7 d
MONITOR[4] ADLIB:OUTBUF A1 d
OEa ADLIB:INBUF E4 d
OEb ADLIB:INBUF F1 d
O5C_EN ADLIB:INBUF K3 d
PAD[10] ADLIB:BIBUF_LYCMOS33U ME d
PAD[11] ADLIB:BIBUF_LYCMOS33D R? d
PAD[12] ADLIB:BIBUF_LYCMOS33U D11 d
PAD[13] ADLIB:BIBUF_LYCMOS33D c12 d
PAD[14] ADLIB:BIBUF_LYCMOS33U RE d LI
Help | OF I Cancel |

Figure 143 - 1/0O States During Programming Window
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Custom /O Settings and Boundary Scan Registers

6. Click OK to return to the FlashPoint — Programming File Generator window.

Note: NOTE: I/O States During programming are saved to the ADB and resulting programming files
after completing programming file generation.

Custom I/O Settings and Boundary Scan Registers

Each I/O in your device is comprised of an Input, Output and Output Enable Boundary Scan Register (BSR)
cell..

The BSR cells enable you to define I/O states during programming and control the individual states for each
Input, Output, and Output Enable register.

The Specify /O States During Programming dialog box enables access to each of these BSR cells for
control over the individual states. You can use the 1/O State (Output Only) settings to set a specific output
state and ignore the other values for the individual BSR elements, or you can click the Show BSR Details
checkbox for control over the settings for each Input, Output Enable, and Output as you exit programming.

Specifying I/0O States During Programming - I/O States and BSR
Details

The I/O States During Programming dialog box enables you to set custom I/O states prior to programming.

I/O State (Output Only)
Sets your I/O states during programming to one of the values shown in the list below.
e 1-—1/Os are set to drive out logic High
e 0-1/Os are set to drive out logic Low

e Last Known State: I/Os are set to the last value that was driven out prior to entering the programming
mode, and then held at that value during programming

e Z - Tri-State: I/Os are tristated

When you set your /O state, the Boundary Scan Register cells are set according to the table below. Use the
Show BSR Details option to set custom states for each cell.

Table 19 - Default I/O Output Settings

Output State Settings
Input Control (Output Output
Enable)
Z (Tri-State) 1 0 0
0 (Low) 1 1 0
1 (High) 0 1 1
Last_Known_State | Last_ Known_State | Last Known_State Last_Known_State
Table Key:

e 1 —High: I/Os are set to drive out logic High
e 0-—Low: I/Os are set to drive out logic Low

e Last Known_State - I/Os are set to the last value that was driven out prior to entering the
programming mode, and then held at that value during programming
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Boundary Scan Registers - Enabled with Show BSR Details

Sets your I/O state to a specific output value during programming AND enables you to customize the values
for the Boundary Scan Register (Input, Output Enable, and Output). You can change any Don't Care value in
Boundary Scan Register States without changing the Output State of the pin (as shown in the table below).
For example, if you want to Tri-State a pin during programming, set Output Enable to O; the Don't Care
indicates that the other two values are immaterial.

If you want a pin to drive a logic High and have a logic 1 stored in the Input Boundary scan cell during
programming, you may set all the values to 1.

Table 20 - BSR Details I/0O Output Settings

Output State Settings
Input Output Enable Output
Z (Tri-State) Don't Care 0 Don't Care
0 (Low) Don't Care 1 0
1 (High) Don't Care 1 1
Last Known State Last State Last State Last State
Table Key:

e 1 —High: I/Os are set to drive out logic High
e 0 -—Low: I/Os are set to drive out logic Low
e Don't Care — Don’t Care values have no impact on the other settings.

e Last Known_State — Sampled value: 1/Os are set to the last value that was driven out prior to entering
the programming mode, and then held at that value during programming

The figure below shows an example of Boundary Scan Register settings.

Specify I/0 States During Programming
Load from file. .. | Save ko file... | ¥ show BSR. Details

_ Boundary Scan Registers -

Port HName Macro Cell Pin Number Input %l:.lapl;‘::g Dutput j
BIST ADLIB:INBUF T2 a 1 1
BvPASS_I0 ADLIB:INBUF K1 a 1 1
CLK ADLIB:INBUF B1 a 1 1
ENOUT ADLIB:INBUF J16 a 1 1
LED ADLIB:OUTBUF M3 1 1 a
MONITOR[O] ADLIB:OUTBUF ES 1 1 a
MOMITOR[] ADLIB:OUTBUF c7 1 a a
MOMITOR[Z] ADLIB:OUTBUF k] 1 a a
MONITOR[3] ADLIB:OUTBUF D7 1 a a
MONITOR[4] ADLIB:OUTBUF A1 1 a a
OEa ADLIB:INBUF E4 1 a a
OEb ADLIB:INBUF F1 1 a a
O5C_EN ADLIB:INBUF K3 1 a a
PAD[10] ADLIB:BIBUF_LYCMOS33U ME 1 a a
PAD[11] ADLIB:BIBUF_LYCMOS33D R? 1 a a
PAD[12] ADLIB:BIBUF_LYCMOS33U D11 1 a a
PAD[13] ADLIB:BIBUF_LYCMOS33D c12 1 a a

PAD[14] ADLIB:BIBUF_LYCMOS33U RE 1 a a LI

Help | OF I Cancel |

Figure 144 - Boundary Scan Registers
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Specify I/O States During Programming Dialog Box

The I/O States During Programming dialog box enables you to specify custom settings for 1/0s in your
programming file. This is useful if you want to set an 1/O to drive out specific logic, or if you want to use a
custom |/O state to manage settings for each Input, Output Enable, and Output associated with an I/O.

Load from file

Load from file enables you to load an 1/0O Settings (*.ios) file. You can use the 10S file to import saved
custom settings for all your I/Os. The exported 10S file have the following format:

e Used I/Os have an entry in the 10S file with the following format:

set_prog_io_state -portName {<design_port_name>} -input <value> -outputEnable <value> -
output <value>

e Unused I/Os have an entry in the IOS file with the following format:

set_prog_io_state -pinNumber {<device_pinNumber>} -input <value> -outputEnable <value> -
output <value>

Where <value> is:
e 1-1/Ois set to drive out logic High
e 0-1/Ois set to drive out logic Low

e Last Known_State: I/O is set to the last value that was driven out prior to entering the programming
mode, and then held at that value during programming

e Z - Tri-State: I/O is tristated

Save to file

Saves your I/O Settings File (*.ios) for future use. This is useful if you set custom states for your 1/0Os and
want to use them again later in conjunction with a PDC file.

Port Name
Lists the names of all the ports in your design.

Macro Cell
Lists the I/O type, such as INBUF, OUTBUF, PLLs, etc.

Pin Number
The package pin associate with the 1/0.

I/O State (Output Only)

Your custom I/O State set during programming. This heading changes to Boundary Scan Register if you
select the BSR Details checkbox; see the Specifying I/0 States During Programming - I/O States and BSR
Details help topic for more information on the BSR Details option.
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Specify I/0 States During Programming
Load from file. .. Save ko file... [™ show BSR Details
Port Hame Macro Cell Pin Humber 1/0 State [Output Only) j
BIST ADLIB:INBUF T2 1
BvPASS_I0 ADLIB:INBUF K1 1
CLK ADLIB:INBUF B1 1
ENOUT ADLIB:INBUF J16 1
LED ADLIB:OUTBUF M3 a
MONITOR[O] ADLIB:OUTBUF ES a
MOMITOR[] ADLIB:OUTBUF c7 d
MOMITOR[Z] ADLIB:OUTBUF k] d
MONITOR[3] ADLIB:OUTBUF D7 d
MONITOR[4] ADLIB:OUTBUF A1 d
OEa ADLIB:INBUF E4 d
OEb ADLIB:INBUF F1 d
O5C_EN ADLIB:INBUF K3 d
PAD[10] ADLIB:BIBUF_LYCMOS33U ME d
PAD[11] ADLIB:BIBUF_LYCMOS33D R? d
PAD[12] ADLIB:BIBUF_LYCMOS33U D11 d
PAD[13] ADLIB:BIBUF_LYCMOS33D c12 d
PAD[14] ADLIB:BIBUF_LYCMOS33U RE d LI
Help | OF I Cancel |

Figure 145 - 1/0O States During Programming Dialog Box

Generate a DAT file

DAT files are generated via the Generate Programming Files dialog box.
To access the Generate Programming Files dialog box from Libero SoC and generate a DAT file:
1. In the Design Flow window, expand Implement Design, right-click Generate Programming Data and
choose Open Interactively. This opens Designer.
Click Programming File to start FlashPoint.

3. Set your feature and 1/O options if necessary. Click Finish. This opens the Generate Programming File
dialog box, as shown in the figure below.
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Parallel Port Cable Information

Generate Programming Files E]

Mame: Existing programming files in this location:
| DAT_progl| | sD1.pdb
SD01.skp
Location:

| CiiDocuments and SettingsiFarleyciDeskioplactel_projl |

Browse. ..

Oukput formats:

[C]IEEE 1532 Files (*.bsd; *.isc)
[#]DirectC File {*.dat)
[¥]Pragramming Data File (*.pdb)
[]STARL File (* stp)

[C]5erial ector Files (*.5vf)

[ Generate ] [ Cancel ]

Figure 146 - Generate Programing Files Dialog Box - DirectC File (*.dat)
4. Set your output file Name and Location.
5. Set your Output Formats to DirectC file (*.dat) and Programming Data File (*.pdb).
6. Click Generate to create your file.

Parallel Port Cable Information

The FlashPro software supports the generic Parallel Port Cable.

To connect to the Parallel Port Cable:

1. From the Parallel Port Cable text box, select the Parallel Port Buffer Cable (as shown in the figure
below).

2. Select the parallel port that is connected to the cable from the Parallel Port text box.

Connect Parallel Port Cable [$_<|

Parallel port cable: | e Nl a0 =) = ) =

Parallel port: LPT1 j

[v Drive TRST pin

Help | Ik | Zancel

Figure 147 - Connect Parallel Port Cable

3. Click OK.
The Para2Buff programmer is added to the programmer list.
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Importing and Exporting Files

Importing Configuration Files

To import a configuration file:

1. From the File menu, choose Import Configuration File . The Import Configuration File dialog box
appears.

2. Navigate to your file and click Open.

Exporting Configuration Files

To export a configuration file:
1. From the File menu, choose Export and then choose Export Configuration File. The Export
Configuration File dialog box appears.

2. Navigate to your file and click Save.

Export Programming Files (SmartFusion Only)

Export Programming Files enables you to export DirectC DAT, PDB and STP programming files. Exporting
programming files is supported in both Chain and Single mode; to export programming files in Chain mode
you must select one SmartFusion device in your chain.

To export a programming file:

1. From the FlashPro File menu choose Export > Single Programming File. The Export Programming

Files dialog box appears.

2. Specify the Output format, Name and Location and click Export to create the files.
Export programming files for currently secured device enables you to generate PDB files for devices
that have already been programmed with security settings. It generates encrypted data for encrypted
features.
Target Programming Solution and STAPL file type options are available only if you have serialization.

Target Programming Solution

e Select Microsemi IHP (In House Programming) when generating STAPL or SVF files for Microsemi
IHP.

e Select Silicon Sculptor I, BP Auto Programmer, or FlashPro5/4/3 when generating programming files
for those programmers.

e Select Generic STAPL Player when generating STAPL files for generic STAPL players.
STAPL File Type Options

e Single STAPL file for all devices: Generates one programming file with all the generated increment
values or with values in the custom serialization file.

e One STAPL file per device: Generates one programming file for each generated increment value or
for each value in the custom serialization file.

Limit file size
Some testers may have memory size restrictions for a single SVF file. The SVF limit file option enables you
to limit the size of each SVF file by either file size or vectors.
The generated SVF files append an index to the file name indicating the sequence of files. The format is:
<SVF_filename>_XXXXX.svf
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Exporting a Chain STAPL File

where XXXXX is the index of the SVF file. The first SVF file begins with <SVF_filename>_00000.svf and
increments by 1 until file generation is complete.

Maximum file size: Max file size limit for the SVF file; use this option to limit your SVF file size based on
number of kB.

Maximum number of vectors: Max vector limit for the SVF file; use this option to limit the size of your SVF
based on number of vectors.

When serialization is available, choose the appropriate Target Programming Solution and STAPL File Type
(if necessary) for your programming chain.

Export Programming Files F§|

Loaded PDE file: D:ikemph TOP. pdb
i 1
e Cutpuk farmats: Mame:
[WIIEEE 1532 Files (*.bsd; *.isc) o | TOR
[w|DirectC File {*.dat)
[JProgramming Data File (*.pdb) Location:

[W]STAPL File (* stp) | Ditemp
[w]Serial Wector Files (*.swf)

Browse. ..

e Existing prograrnming files in this location:
e [
o~
i
-~
-~
v Limit file size
% Maimum File size | 9000] kB
" Maximum number of vectars ,7

Help Export | Close

Figure 148 - Export Programming Files Dialog Box

Exporting a Chain STAPL File

To export a chain STAPL file:

1. From the File menu, select Export and then choose Export Chain STAPL File. The Export Chain
STAPL File dialog box appears.

2. Name your file and click Save.

Note: Note: Chain STAPL file export is supported if all selected SmartFusion, IGLOO, ProASIC3 and
Fusion devices have STAPL or PDB files loaded.

Exporting a Chain SVF File

To export a chain SVF file:

1. From the File menu, choose Export and then choose Export Chain SVF File. The Export Chain SVF
File dialog box appears.

2. Name your file and click Save.

Note: Note: Chain SVF file export is supported if all selected devices have STAPL or PDB files loaded.
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Exporting Single Device STAPL Files

To export a single STAPL file in single mode:

This option is available only for single programming mode projects with a PDB file loaded (refer to Single
STAPL file basic tutorial for more information).

1. From the File menu, choose Export > Export Single Device STAPL File. The Export Single Device
STAPL File dialog box appears.

2. Name your file and click Save.

To export a single device STAPL file in chain mode:

This option is available only for chain programming mode projects with a PDB file loaded (refer to Chain
programming tutorial for more information). Exporting a single device STAPL file is only supported for one
device in the chain.

1. Select only one device from the chain, and from the File menu, select Export and then choose Export
Single Device STAPL File. The Export Single Device STAPL File dialog box appears.

2. Name your file and click Save.
Or

1. Right-click a device in the Chain Configuration Window, and then choose Export Single Device
STAPL File. The Export Single Device STAPL File dialog box appears.

2. Name your file and click Save.

Exporting Single Device SVF Files
The following steps describe how to export SVF files.
To export single device SVF files in single mode:

This option is available only for single programming mode projects with a PDB file loaded (refer to Single
STAPL file basic tutorial for more information).

1. From the File menu, select Export and then choose Export Single Device SVF File. The Export
Single Device SVF File dialog box appears.

2. Name your file and click Save.
Note: Multiple SVF files will be generated from a single PDB. Each file corresponds to a PDB action, and will be saved in
the <SVF_filename> folder as <SVF_filename>_<action name>.SVF.

To export single device SVF files in chain mode:

This option is available only for chain programming mode projects with a PDB file loaded (refer to _Chain
programming tutorial for more information).

1. Select only one device from the chain, and from the File menu, choose Export and then choose
Export Single Device SVF File. The Export Single Device SVF File dialog box appears.

2. Name your file and click Save.
Or

1. Right-click a device in the Chain Configuration Window, and then choose Export Single Device SVF
File. The Export Single Device SVF File dialog box appears.

2. Name your file and click Save.
Note: Multiple SVF files will be generated from a single PDB. Each file corresponds to a PDB action, and will be saved in
the <SVF_filename> folder as <SVF_filename>_<action name>.SVF.

Exporting Single Device 1532 Files

IEEE 1532 programming files will only be exported in FlashPro for SmartFusion devices when an FDB has
been properly imported.
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Opening an Existing FlashPro Project on a Different Machine

To export single device 1532 files in single mode:

This option is available only for single programming mode projects with a PDB file loaded (refer to Single
STAPL file basic tutorial for more information).

1. From the File menu, choose Export Single Device 1532 File. The Export Single Device 1532 File
dialog box appears.

2. Name your file and click Save.

Note: Note: Two files will be generated from a single PDB and will be saved in the
<1532_filename>_1532 folder as

Note: IEEE 1532 BSDL file - <1532_filename>.bsd
Note: IEEE 1532 Data file - <1532_filename>.isc

To export single device 1532 files in chain mode:

This option is available only for chain programming mode projects with a PDB file loaded (refer to Chain
programming tutorial for more information). Exporting a single device STAPL file is only supported for one
device in the chain.

1. Select only one device from the chain, and from the File menu, choose Export and then choose
Export Single Device 1532 File. The Export Single Device 1532 File dialog box appears.

2. Name your file and click Save.

1. Right-click a device in the Chain Configuration Window, and then choose Export Single Device 1532
File. The Export Single Device 1532 File dialog box appears.

2. Name your file and click Save.

Note: Note: Two files will be generated from a single PDB and will be saved in the
<1532_filename>_1532 folder as

Note: IEEE 1532 BSDL file - <1532_filename>.bsd
Note: IEEE 1532 Data file - <1532_filename>.isc

Opening an Existing FlashPro Project on a Different Machine

Opening a FlashPro project created on a different PC than it was created on causes tool problems. The
project cannot be opened and the PDB file cannot be imported. You must export the configuration file from
the original machine and import it on the new machine in order to preserve your project.

To move a FlashPro project and open it on a different machine:

1.  Export configuration files on the machine where you created the original project. The configuration
files contain all FlashPro settings, including loaded programming files.

2. Send the configuration files to the new desktop
3. Open FlashPro on the new desktop and create a new FlashPro project.
4. Import the configuration file.
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General Hot Keys

You can use hot keys for a lot of the features of the FlashPro software. See the table below for a list of
general hot keys.

Table 21 - FlashPro Software General Hot Keys

Feature Hot Key

New Project Ctrl+N
Open Project Ctrl+O
Save Project Ctrl+S
Import Configuration File Ctrl+l
Refresh Views F5
Refresh/Rescan for Programmers Ctrl+F5

See Also

Single STAPL programming hot keys

Chain programming hot keys

Single Device Programming Hot Keys

See the table below for the hot keys for single device programming.
Table 22 - Single Device Programming Hot Keys

Feature Hot Key

Load a STAPL file Ctrl + Shift + L
Select Action and Procedures Ctrl + Shift + A
Enable Serialization Ctrl + Shift + S
Select Serialization Data Ctrl + Shift + R
View Serialization Status Ctrl + Shift + U
View Chain Parameter (Pre/Post IR/DR) Ctrl + Shift + H
Configure Target Device Ctrl + Shift + D
Run Ctrl + Return

130 FlashPro User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

Chain Programming Hot Keys

See the table below for the hot keys for chain programming.

Table 23 - Chain Programming Hot Keys

Feature

Hot Key

Add Microsemi Device

Ctrl + Shift + T

Add non Microsemi Device

Ctrl + Shift + N

Remove Device

Ctrl + R

Configure Device

Ctrl + F

Load STAPL File

Ctrl + Shift + L

Load BSDL File

Ctrl + Shift + B

Enable Device

Ctrl+ E

Select Action and Procedures

Ctrl + Shift + A

Enable Serialization

Ctrl + Shift + S

Select Serialization Data

Ctrl + Shift + R

View Serialization Data

Ctrl + Shift + u

Copy Device

Ctrl + Shift + C

Cut Device

Ctrl + Shift + X

Paste Device

Ctrl + Shift + V

Move Device Down

Ctrl + D

Move Device Up

Ctrl + U

Run

Ctrl + Return

Batch Mode

& Microsemi

Chain Programming Hot Keys

Batch mode programming can be achieved by executing FlashPro TCL scripts from the command line.

The example below executes The FlashPro TCL script batch.tcl from the command line:
<location of Microsemi software>/bin/flashpro.exe script:batch.tcl

Batch.tcl contains the following script:

new_project -name {newproject} -location {./newproject} -mode {single}
set_programming_file -file {./design.stp}

set_programming_action -action {PROGRAM}

run_selected_actions
close_project
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About TCL Commands - FlashPro Tcl Command Reference

A Tcl (Tool Command Language) file contains scripts for simple or complex tasks. You can run scripts from
the Windows command line or store and run a series of Tcl commands in a *.tcl batch file. The Tcl
commands supported by FlashPro are listed in the table below.

Note: Tcl commands are case sensitive. However, their arguments are not.

Command Action

add_actel device Adds an Actel device to the chain

add_non_actel device Adds a non-Actel device in the chain

add non_actel device to database Imports settings via a BSDL file that adds non-Actel or non-Microsemi devices to
the device database

check flash_memory Performs diagnostics of the page status and data information

close project Closes the FlashPro project

compare_analog_config Compares the content of the analog block configurations in your design against the
actual values in the device

compare_flashrom_client Compares the content of the FlashROM configurations in your design against the
actual values in the selected device

compare_memory client Compares the memory client in a specific device and block

configure flashpro prg Changes FlashPro programmer settings

configure_flashpro3 prg Changes FlashPro3 programmer settings

configure flashpro4 prg Changes FlashPro 4 programmer settings

configure flashproLite prg Changes FlashPro Lite programmer settings

connect_cable Connects a parallel cable to a port

construct_chain_automatically Automatically starts chain construction for the specified programmer

copy device Copies a device in the chain to the clipboard

cut_device Removes one or more devices from the chain

dump_tcl _support Unloads the list of supported FlashPro Tcl commands

enable_device Enables or disables a device in the chain

enable prg Enables or disables one or more programmers

enable_prg_type Enables or disables all programmers of a specified programmer type

enable_procedure Enables/disables an optional procedure for an action

enable_serialization Enables/disables serialization for a device

export_config Exports a configuration file
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Command

Action

export _script

Exports the history in a Tcl script

export_secured pdb

Exports a single device secured PDB from the loaded PDB

export_single 1532

Exports a single device 1532 file

export_single dat

Exports a single device DirectC data file

export_single stapl

Exports a single device STAPL file

export_single_svf

Exports a single device SVF file

export_stapl Exports the ChainBuilder STAPL file in chain programming mode

import_config Imports a configuration file

new_project Creates a new FlashPro project or convert an old ChainBuilder project into a new
FlashPro project

open_project Opens a FlashPro project

paste device

Pastes the devices that are on the clipboard in the chain

ing_pr

Pings one or more programmers

read analog block config

Reads analog block configuration information

read device status

Compares the memory client in a specific device and block

read flash _memory

Reads information from the eNVM modules

read_flashrom

Reads the content of the FlashROM

read_id_code

Reads IDCode from the device without masking any IDCode fields

recover flash _memory

Removes ECC2 errors due to memory corruption by reprogramming specified flash
memory (NVM) pages

refresh_prg_list

Refreshes the programmer list

remove device

Removes the device from the chain

remove non_actel device to database

Removes settings for non-Microsemi or non-Actel device from the device database

remove_pr

Removes the programmer from the programmer list

run_selected_actions

Runs the selected action on the specified programmer and returns the exit code
from the action

sample_analog channel

Samples the configured analog channel with the ADC parameters you provided

save_log

Saves the log file

save_project

Saves the FlashPro project
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Command

Action

save project as

Saves the FlashPro project under a new project name

scan_chain_prg

Runs scan chain on a programmer

select from region _name

Enables you to select the serialization region you want to add to the log file

select serial range

Selects the serialization data

select target device

Sets the target device for programming in Single Device Programming mode

self_test prg Runs Self-Test on a programmer
set_bsdl file Sets a BSDL file to a non-Actel device in the chain

set _chain_param

Sets the chain parameters in single programming mode

set_debug_device

Identifies the device you intend to debug

set_debug_programmer

Identifies the programmer you want to use for debugging (if you have more than
one)

set _device to highz

Sets a disabled Microsemi or Actel device in Chain programming mode to HIGH-Z

set_device ir

Sets the IR length of a non-Actel device in the chain

set_device_name

Changes the user name of a device in the chain

set_device order

Sets the order of the devices in the chain to the order specified

set _device tck

Sets the maximum TCK frequency of a non-Actel device in the chain

set_device_type

Changes the family of an Actel device in the chain

set_main_log_file

Sets the FlashPro log file

set prg name

Changes the user name of a programmer

set_programming_action

Selects the action for a device

set_programming_file

Sets the programming file for a device

set_programming _mode

Sets the programming mode

set_serialization log file

Sets the FlashPro log file to be used for serialization

set_serialization_mode

Sets the serialization mode

update programming file

Updates the programming file with the selected parameters

Running Tcl Scripts from within FlashPro

Instead of running scripts from the command line, you can use FlashPro's Run Script dialog box to run a

script.
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Running Tcl Scripts from the Command Line

To execute a Tcl script file within FlashPro:
1. From the File menu, choose Run Script to display the Execute Script dialog box.

Execute Script §|

Script File: ||

Browse

Argurments: |

Fun Cancel | Help |

Figure 149 - Execute Script Dialog Box

2. Click Browse to display the Open dialog box, in which you can navigate to the folder containing the
script file to open. When you click Open, FlashPro enters the full path and script filename into the
Execute Script dialog box for you.

3. Inthe Arguments box, enter the arguments to pass to your Tcl script. Separate each argument by a
space character. For information about accessing arguments passed to a Tcl script, see

4. Click Run.

Running Tcl Scripts from the Command Line
You can run Tcl scripts from your Windows command line.

To execute a Tcl script file in the FlashPro software from a shell command line:
1. Atthe prompt, type the path to the Microsemi software followed by the word "SCRIPT" and a colon,
and then the name of the script file as follows:
<location of Microsemi software>/bin/flashpro.exe SCRIPT:<filename>
The example below executes in batch mode the script foo.tcl:
<location of Microsemi software>/bin/flashpro.exe script:foo.tcl
The example below executes in batch mode the script foo.tcl and exports the log in the file foo.txt:
<location of Microsemi software>/bin/flashpro.exe script:foo.tcl logfile:foo.txt
The example below executes in batch mode the script foo.tcl, creates a console where the log is
displayed briefly, and exports the log in the file foo.txt:

<location of Microsemi software>/bin/flashpro.exe script:foo.tcl console_mode:brief
logfile:foo.txt

If you leave console_mode unspecified or set it to 'hide' FlashPro executes without a console window. If
you want to leave the console window open you can run the script with the console_mode parameter set
to 'show’, as in the following example:
<location of Microsemi software>/bin/flashpro.exe script:foo.tcl console_mode:show
logfile:foo.txt
2. If you want to pass arguments to the Tcl script from the command line, then use the "SCRIPT_ARGS"
variable as follows:

<location of Microsemi software>/bin/flashpro.exe SCRIPT:<filename> SCRIPT_ARGS:"'paraml
param2 param3"

Arguments passed to a Tcl script can be accessed through the Tcl variables argc and argv. The example
below demonstrates how a Tcl script accesses these arguments:

puts "Script name: $argv0"

puts “Number of arguments: $argc"

set i 0

foreach arg $argv {
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puts "Arg $i : $arg"”
incr i
3

Note: Note: Script names can contain spaces if the script name is protected with double quotes:
flashpro.exe script:"flashpro tcl/foo 1.tcl"

Exporting Tcl Scripts from within FlashPro

To export a set of Tcl commands from the FlashPro history:
1. From the File menu, choose Export > Export Script.
2. Enter the filename and click Save. The Script Export Options dialog is appears (see image below).

Script Export Options

[ Include commands fram current project anl

Filenarne farmatting

+ Belative filenames [default]

" Qualified filenarnes [full path; including directary narne)

Help 2k, | Cancel

Figure 150 - Script Export Options Dialog Box

Check the Include commands from current project only to export commands of the current project
only. You can specify the filename formatting by selecting Relative filenames (relative to the current
directory) or Qualified filenames(absolute path, including the directory name).

4. Click OK.

add_actel device

Adds an Actel device to the chain. Either the Tille or device parameter must be specified. Chain
programming mode must have been set.

add_actel_device [-Tile {filename}] [-device {device}] -name {name} [-ukey {ukey value}]

Arguments
Where:
-file{Filename}
Specifies a programming filename.
-device{device}
Specifies the Actel device family(such as AFS600).
-name{name}
Specifies the device user name.
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add_non_actel_device

-ukey{ukey value}
Optional (SmartFusion only) - Specifies the ukey value.

Supported Families
Al

Exceptions
None

Example
add_actel_device —file {e:/design/stp/TOP.stp} —name {MyDevicel}
add_actel_device —device {A3P250} —name {MyDevice2}

add_non_actel device

Adds a non-Actel device in the chain. Either the file, or (-tck And -ir) parameters must be specified. The Chain

programming mode must have been set.

add_non_actel_device [-file {file}] [-ir {ir}] [-tck {tck}] [-name {name}]

Arguments
-file {filename}
Specifies a BSDL file.
-ir {ir}
Specifies the IR length.
-tck {tck}
Specifies the maximum TCK frequency (in MHz).
-name {name}

Specifies the device user name.

Supported Families
Al

Exceptions

None

Examples
add_non_actel_device —file {e:/design/bsdl/DeviceX_bsdl } —name {MyDevice3}
add_non_actel_device —ir 8 — tck 5 —name {MyDeviced}

add_non_actel device to database

Imports settings via a BSDL file that adds non-Actel or non-Microsemi devices to the device database so that they are

recognized during scan chain and auto-construction operations.
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add_non_actel_device_to_database [-file {bsdl_filename}]

Arguments
-file {bsdl_filename}
Specifies the path to the BSDL file and the BSDL filename add to the database.

Supported Families

All non-Microsemi and non-Actel families

Exceptions
N/A

Examples
The following example uses a BSDL file to add a non-Microsemi (1502AS J44) device to the device
database:
add_non_actel_device_to_database —file {c:/bsdl/atmel/1502AS_J44 _bsd}
The following example uses a BSDL file to add a non-Microsemi (80200) device to the device database:
add_non_actel_device_to_database —file {c:/bsdl/intel/80200 v1.0.bsd}

check_flash_memory

The command performs diagnostics of the page status and data information as follows:

e Page Status — includes ECC2 check of the page status information, write count
e Page Data - ECC2 check

check_flash_memory

[-name {device name}]

[-block {integer_value}]
[-client {client_name}]
[-startpage {integer_value}]
[-endpage {integer_value}]
[-access {all | status | data}]
[-show {summary | pages}]
[-File {filename}]

At a minimum you must specify -client <name> OR
-startpage <page_number> -endpage <page_number> -block <number>

Arguments
-name {device_name}
Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.
-block {integer_value}

(Optional argument; you must set -client or —startpage, —endpage and —block before use.) Specifies
location of block for memory check.

-client {client_name}

Name of client for memory check.
-startpage {integer_value}

Startpage for page range; value must be an integer. You must specify a —endpage and —block along with
this argument.
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close_project

-endpage {integer_value}

Endpage for page range; value must be an integer. You must specify a —startpage and -block along with
this argument.

-access {all | status | data}

(Optional argument; you must set -client or —startpage, —endpage and —block before use.) Specifies what
NVM information to check: page status, data or both.

Value Description

all Shows the number of pages with corruption status, data corruption and
out-of-range write count (default)

status | Shows the number of pages with corruption status and the number of
pages with out-of-range write count

data | Shows only the number of pages with data corruption

-show {summary | pages}

(Optional argument; you must set -client or —startpage, —endpage and —block before use.) Specifies
output level, as explained in the table below.

Value Description
summary Displays the summary for all checked pages (default)
pages Displays the check results for each checked page

-file {filename}

(Optional argument; you must set -client or —startpage, —endpage and —block before use.) Name of output
file for memory check.

Supported Families
SmartFusion, Fusion

Exceptions
None

Example

The following command checks the page status for block 0 from starpage 0 to endpage 2:
check_flash_memory -startpage 0 -endpage 2 -block 0O

The following command checks the memory status for the client 'DS8bit' and saves it to the file
‘checkFlashMemory.log'":

check_flash_memory -client {DS8bit} -file {checkFlashMemory.log}

close_project

Closes the FlashPro or FlashPro Express project.

close_project

Arguments
None

FlashPro User's Guide 139



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

& Microsemi

Supported Families
All

Exceptions
None

Example
close_project

compare_analog_config

Compares the content of the analog block configurations in your design against the actual values in the
device. In a typical SoC project, this directory is located at
<project_root>/smartgen/<analog_block_core_name>.

compare_analog_config
[-name "device_name'"™] -mem_Ffile_dir "mem_file_directory"
[-file "filename™]

Arguments
-name {device_name}

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

-mem_file_dir {mem_file_directory}
Location of memory file.

-file {filename}

Output filename.

Supported Families
Fusion

Exceptions
None

Example
The following command reads the analog block configuration in the directory F:/tmp/Analog_Block and
saves the data in the logfile compare_analogReport.log:

compare_analog_config -mem_file_dir {F:/tmp/Analog_Block} -file
{compare_analogReport.log}

The following command reads the analog block configuration information in the device 'AFS600' in the
directory F:/tmp/Analog_Block and saves the data in the log file compare_analogReport.log:

compare_analog_config —name {AFS600} -mem_file_dir {F:/tmp/Analog_Block} -Ffile
{compare_analogReport. log}

compare_flashrom_client

Compares the content of the FlashROM configurations in your design against the actual values in the
selected device.

compare_flashrom_client [-name {device_name}] [-File {filename}]
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compare_memory_client

Arguments
-name {device_name}

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.
-file {filename}

Optional file name for FlashROM compare log.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example
The following command saves the FlashROM data to the file 'FlashRomCompReport.log':
compare_flashrom_client -file {FlashRomCompReport.log}

The following command compares the data in the device 'A3P250' and saves the data in the logfile
'FlashRomCompReport.log':

compare_flashrom_client —name {A3P250} -file {FlashRomCompReport.log}

compare_memory_client

Compares the memory client in a specific device and block.

compare_memory_client [-name {device_name}] [-block integer_value] -client {client_name}
[-file {filename}]

Arguments
-name { device_name}

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

-block {integer_value}

(Optional argument; you must set -client.) Specifies location of block for memory compare.
-client {client_name}

Name of client for memory compare.

-file {filename}

Optional file name.

Supported Families
SmartFusion and Fusion

Exceptions
None

Example
The following command compares the memory in the client 'DS32' on the device 'AFS600'.
compare_memory_client -client DS32 -name AFS600
The following command compares the data at block '0' to the client 'DS8bit":
compare_memory_client -block 0 -client {DS8bit}
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The following command compares the memory in the device 'AFS600' at block '0' to the memory client
‘DS8bhit'":
compare_memory_client —name {AFS600} -block 0 -client {DS8bit}

The following command compares the memory at block '1' to the memory client 'DS8bit' and saves the
information in a log file to F:/tmp/NVMCompReport.log:

compare_memory_client -block 1 -client {DS8bit} -file {F:/tmp/NVMCompReport.log}

configure_flashpro prg

Changes FlashPro programmer settings.

configure_flashpro_prg [-vpp {ONJOFF}] [-vpn {ON]|OFF}] [-vddl {ON]OFF}] [-force_vddp
{ON|OFF}] [-vddp {2.-5]3-3}] [-drive_trst {ON]JOFF}] [-force_freq {ON|OFF}] [-freq {freq}]

Arguments
-vpp {ON|OFF}
Enables FlashPro programmer to drive VPP. Set to ON to drive VPP.
-vpn {ON]OFF}
Enables FlashPro programmer to drive VPN; set to ON to drive VPN.
-vddl {ON]OFF}
Enables FlashPro programmer to drive VDDL; set to ON to drive VDDL.
-force_vddp {ON|OFF}
Enables FlashPro programmer to drive VDDP; set to ON to drive VDDP.
-vddp {2.5]3.3}
Sets VDDP to 2.5 or 3.3 volts.
-drive_trst {ON|OFF}
Enables FlashPro programmer to drive TRST; set to ON to drive TRST.
-force_freq {ON|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families
ProASIC™S proASIC

Exceptions
None

Example

The following example enables the FlashPro programmer to drive the VPP, VPN, VDDL, VDDP, sets the
drive voltage to 3.3v, disables the driver for TRST, and does not force the programmer to use the TCK
frequency specified in the software.

configure_flashpro_prg —vpp {ON} —vpn {ON} —vddl {ON} —force_vddp {ON} —vddp {3.3} -
drive_trst {OFF} —force_freq {OFF}

configure_flashpro3_prg

Changes FlashPro3 programmer settings.
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configure_flashpro4_prg

configure_flashpro3 prg [-vpump {ON]OFF}] [-clk _mode {discrete_clk|free_running_clk}] [-
force_freq {ON|OFF}] [-freq {freq}]

Arguments

-vpump {ON]OFF}

Enables FlashPro programmer to drive VPUMP. Set to ON to drive VPUMP.
-clk_mode {discrete_clk]|free_running_clk}

Specifies free running or discrete TCK.

-force_freq {ON|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families

Exceptions

Example

SmartFusion, IGLOO, ProASIC3 and Fusion

None

The following example sets the VPUMP option to ON, TCK to free running, and uses the TCK frequency
specified in the programmer file (force_freq is set to OFF):

configure_flashpro3 prg -vpump {ON} -clk _mode {free_running_clk} -force_freq {OFF} -freq
{43

The following example sets VPUMP to ON, TCK to discrete, forces the FlashPro software to use the TCK
frequency specified in the software (-force_freq is set to ON) at a frequency of 2 MHz.

configure_flashpro3 _prg -vpump {ON} -clk_mode {discrete_clk} -force_freq {ON} -freq {2}

configure_flashpro4 prg

Changes FlashPro4 programmer settings.

configure_flashpro4 prg [-vpump {ON]OFF}] [-clk _mode {discrete_clk|free_running_clk}] [-
force_freq {ON|OFF}] [-freq {freq}]

Arguments

-vpump {ON]|OFF}
Enables FlashPro4 programmer to drive VPUMP. Set to ON to drive VPUMP.
-clk_mode {discrete_clk]|free_running_clk}

Specifies free running or discrete TCK.

-force_freq {ON|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families

SmartFusion, IGLOO, ProASIC3 and Fusion
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Exceptions
None
Example

The following example sets the VPUMP option to ON and uses a free running TCK at a frequency of 4 MHz
(force_freq is set to OFF).

configure_flashpro4 _prg -vpump {ON} -clk _mode {free_running_clk} -force_freq {OFF} -freq
{43
The following example sets the VPUMP option to ON, uses a discrete TCK and sets force_freq to ON at 2
MHz.

configure_flashpro4_prg -vpump {ON} -clk_mode {discrete_clk} -force_freq {ON} -freq {2}

configure_flashproLite_prg

Changes FlashPro Lite programmer settings.

configure_flashproLite prg [-vpp {ONJOFF}] [-vpn {ON]JOFF}] [-drive_trst {ON|JOFF}] [-
force_freq {ON|OFF}] [-freq {freq}]

Arguments
-vpp {ON]OFF}
Enables FlashPro programmer to drive VPP. Set to ON to drive VPP.
-vpn {ON]OFF}
Enables FlashPro programmer to drive VPN; set to ON to drive VPN.
-drive_trst {ON|OFF}
Enables FlashPro programmer to drive TRST; set to ON to drive TRST.
-force_freq {ON|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families
ProASICP-S

Exceptions
None

Example

The following example sets the programmer to drive the VPP, drive VPN, drive the TRST and uses the
frequency set by the programmer file (sets force_freq to OFF):

configure_flashprolite_prg —vpp {ON} —vpn {ON} —drive_trst {ON} —force_freq {OFF}

connect_cable

Connects a parallel cable to a port.

connect_cable -cable_name {cable_name} -port_name {port_name} [-drive_trst {ON]|OFF}]
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construct_chain_automatically

Arguments
-cable_name {cable_name}
Identifies the name of the parallel port cable you wish to connect.
-port_name {port_name}
Specifies the parallel port where the parallel programmer is connected.
-drive_trst {ON|OFF}
Enables the parallel port cable to drive TRST.

Supported Families
Al

Exceptions
None

Example

The following example connects the cable named Parallel_Port_Buffer_Cable to the port LPT1 and
enables drive TRST:

connect_cable -cable_name {Parallel_Port Buffer_Cable} -port_name {Lptl} -drive_trst

{ON}

construct_chain_automatically

Automatically starts chain construction for the specified programmer.

construct_chain_automatically[(-name {name})+]

Arguments
-name {name}
Specifies the programmer(s) name(s).

Supported Families
All

Exceptions
N/A

Example
Example for one programmer:
construct_chain_automatically -name {21428}
Example for two programmers:
construct_chain_automatically -name {21428} —name {00579}

copy_device
Copies a device in the chain to the clipboard. Chain programming mode must be set. See the paste device command for

more information.

copy_device (-name {name})*
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Arguments
-name {name}

Specifies the device name. Repeat this argument to copy multiple devices.

Supported Families
All

Exceptions

None

Example
The example copies the device 'mydevicel' to the same location with a new name 'mydevice2'.
copy_device —name {MyDevicel} —name {MyDevice2}

cut_device

Removes one or more devices from the chain. It places the removed device in the clipboard. Chain
programming mode must be set to use this command. See the paste_device command for more
information.

cut_device (-name {name})*

Arguments
-name {name}
Specifies the device name. You can repeat this argument for multiple devices.

Supported Families
All

Exceptions
None

Example

The following example removes the devices 'mydevicel' and 'mydevice2' from the chain.
cut_device —name {MyDevicel} —name {MyDevice2}

dump_tcl support

Unloads the list of supported FlashPro or FlashPro Express Tcl commands.

dump_tcl_support -file {file}

Arguments
-file {file}

Supported Families
All
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enable_device

Exceptions
None

Example

The following example dumps your Tcl commands into the file ‘tcldump.tcl’
dump_tcl_support -file {tcldump.tcl}

enable device

Enables or disables a device in the chain (if the device is disabled, it is bypassed). Chain programming
mode must be set. The device must be a Microsemi device.

enable_device -name {name} -enable {TRUE|FALSE}

Arguments
-name {name}
Specifies your device name
-enable {TRUE]FALSE}

Specifies whether the device is to be enabled or disabled. If you specify multiple devices, this argument
applies to all specified devices. (TRUE = enable. FALSE = disable)

Supported Families

All
Exceptions
None
Example
The following example disables the device 'mydevicel' in the chain.
enable_device —name {MyDevicel} —enable {FALSE}
enable_prg

Enables or disables one or more programmers.

enable_prg (-name {name})* -enable {TRUE|FALSE}

Arguments
-name {name}*
Specifies the programmer name. You can repeat this argument for multiple programmers.
-enable {TRUE]FALSE}

Specifies whether the programmer is to be enabled or disabled. If you specify multiple programmers, this
argument applies to all of them (TRUE = enable. FALSE = disable).

Supported Families
Al

Exceptions
None
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Example

The following example enables the programmers 'FP300085' and 'FP300086'.
enable_prg —name {FP300085} —name {FP300086} —enable {TRUE}

enable prg_type

Enables or disables all programmers of a specified programmer type.

enable_prg_type -prg_type {prg_type} -enable { TRUE | FALSE }

Arguments
-prgType { FP | FPLite | FP3 | PP }
Specifies the programmer type to be enabled/disabled (FP—FlashPro type programmers, FPLite—FlashPro
Lite type programers, FP3-FlashPro3 type programmers, PP—Parallel port cable type programmers).

-enable {TRUE]FALSE}
Specifies whether the programmers are to be enabled or disabled (TRUE—enable, FALSE-disable).

Supported Families
All

Exceptions
None

Example

The following example enables the FlashPro3 programmer.
enable_prog_type —prg_type{FP3} —enable{TRUE}

enable procedure

To enable/disable an optional procedure of an action. The device name parameter must be specified only
in chain programming mode. A programming file must have been loaded.

enable_procedure [-name {name}] -action {action} -procedure {procedure} -enable
{TRUE | FALSE}

Arguments
-name {name}
-action {action}
-procedure {procedure}
-enable {TRUE]FALSE}

Supported Families
All

Exceptions
None

Example
In single programming mode:
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enable_serialization

enable_procedure —action {PROGRAM} —procedure {DO_ERASE} —enable {TRUE}

In chain programming mode:

enable_serialization —name {MyDevice2} —action {PROGRAM} —procedure {DO_ERASE} —enable
{FALSE}

enable_serialization

Enables/disables serialization for a device. The device name parameter must be specified only in chain
programming mode. A programming file allowing serialization must be loaded.

enable_serialization [-name {name}] -enable {TRUE]FALSE}

Arguments
-name {name}
Specifies device name
-enable {TRUE]FALSE}
Enables (TRUE) or disables (FALSE) serialization.

Supported Families
Al

Exceptions
None

Example
Enabling serialization in single programming mode:
enable_serialization —enable {TRUE}
Disabling serialization on the device 'mydevice2' in chain programming mode:
enable_serialization —name {MyDevice2} —enable {FALSE}

export_chain_stapl
Exports the ChainBuilder STAPL file in chain programming mode.

export_chain_stapl -file {file}

Arguments
-file {File}
Specifies the file to be exported.

Supported Families
All

Exceptions
None

Example

The following example exports the STAPL file 'tcl_testing_chain.stp":
-export_chain_stapl -file {./tcl_testing_chain.stp}
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export_config

Exports a configuration file.

export_config -file {file}

Arguments
-file {file}
Specifies the file to export.

Supported Families
Al

Exceptions
None

Example
The following example exports the configuration file 'myconfigl’
export_config -file {myconfigl}

export_secured_pdb

Exports a single device secured PDB from the loaded PDB.

export_secured_pdb -Ffile {file} [-name {name}]

Arguments
—-file {File}
Specifies the file to export.
-name {name}
Specifies the name of the device in chain mode to export a single device currently secured PDB.

Supported Families
SmartFusion, Fusion

Exceptions
‘-secured' is only supported for SmartFusion devices.

Example
In single mode, the following command exports the secured PDB 'my_design.pdb':
export_secured_pdb -file {D:/TOP/my_design.pdb}

In chain mode, the following example exports the secured PDB 'my_design.pdb' from the A2F200M3F
device in the chain:

export_secured_pdb -name {A2F200M3F} -file {./my_design.pdb}

export_script

Exports the history in a Tcl script.
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export_script -file {file} -relative_path {TRUE|FALSE}

Arguments
-file {File}
Specifies the file to export.
-relative_path {TRUE]FALSE}
Specifies whether the file path must be exported as a relative path or an absolute path.

Supported Families
All

Exceptions
None

Example

The following example exports your Tcl history to the file 'history.tcl' with absolute pathnames.
export_script —File {./history.tcl} —-relative_path {FALSE}

export_single 1532
Exports a single device IEEE 1532 file.
export_single_1532 -file {file} [-name {name}] [-pdb {pdb_file}] [-secured]

Arguments
-file {file}
Specifies the file to export.
-name {name}
Specifies the name of the device in chain mode to export single device IEEE 1532 programming file.
-pdb {pdb_*File}

Specifies the PDB to use for exporting a IEEE 1532 programming file. By default, the loaded PDB is used
for exporting a IEEE 1532 programming file.

-secured

Exports a IEEE 1532 programming file for a secured device.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions

‘-secured' is only supported for SmartFusion devices.

Example

Single Mode, exports the secured IEEE 1532 files 'my_design.isc' and 'my_design.bsd' into folder
'D:/TOP/my_design_1532"' using the PDB 'my_design.pdb':

export_single 1532 -file {D:/TOP/my_design_1532) -pdb {D:/TOP/my_design.pdb} -secured
Chain Mode example exports secured IEEE 1532 files 'my_design.isc' and 'my_design.bsd' into folder
'D:/TOP/my_design_1532' from a device in the chain named '‘A2F200M3F' using the PDB 'my_design.pdb':
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export_single_1532 -name {A2F200M3F} -file {./my_design_1532} -pdb {./my_design.pdb} -
secured

export_single dat
Exports a single device DirectC data file.

export_single_dat -file {file} [-name {name}] [-pdb {pdb_file}] [-secured]

Arguments
-file {File}
Specifies the name of the file you are exporting.
-name {name}
Specifies the name of the device in chain mode to export a single device DirectC data file.
-pdb {pdb_File}

Specifies the PDB to use for exporting a DirectC data file. By default, the loaded PDB will be used for
exporting a DirectC data file.

-secured
Use this argument to export a secured DirectC data file.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
‘-secured' is only supported for SmartFusion devices.

Example
Single Mode, exports a secured DirectC DAT file 'my_design.dat' using the PDB file 'my_design.pdb':
export_single _dat -file {D:/TOP/my_design.dat} -pdb {D:/TOP/my_design.pdb} -secured

Chain Mode, exports a secured DirectC DAT file 'my_design.dat' from a device in the chain named
'A2F200M3F', using the PDB 'my_design.pdb'":

export single_dat -name {A2F200M3F} -file {./my_design.dat} -pdb {./my_design.pdb} -
secured

export_single stapl
Exports a single device STAPL file.
export_single_stapl -file {file} [-name {name}] [-pdb {pdb_TFfile}] [-secured]

Arguments
—File {File}
Specifies the file to export.
-name {name}
Specifies the name of the device in chain mode to export a single device STAPL file.
-pdb {pdb_File}
Specifies the PDB to use for exporting a STAPL file. By default, the loaded PDB is used for exporting a
STAPL file.
-secured
Exports a secured STAPL file.
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export_single_svf

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example

Single Mode example exports the secured file ‘my_design.stp' using the PDB 'my_design.pdb':
export_single_stapl -file {D:/TOP/my_design.stp} -pdb {D:/TOP/my_design.pdb} -secured

Chain Mode example exports secured STAPL file 'my_design.stp' from device 'A2F200M3F' using the PDB
'my_design.pdb'":

export single_stapl -name {A2F200M3F} -file {./my_design.stp} -pdb {./my_design.pdb} -
secured

export_single svf
Exports a single device SVF programming file.

export_single_svf -file {file} [-name {name}] [-pdb {pdb_Ffile}] [-secured]

Arguments
—File {File}
Specifies the file to export.
-name {name}
Specifies the name of the device in chain mode to export a single device SVF programming file.
-pdb {pdb_Tfile}

Specifies the PDB to use for exporting a SVF programming file. By default, the loaded PDB is used for
exporting a SVF programming file.
-secured

Exports a SVF programming file for a secured device.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions

'-secured' is only supported for SmartFusion devices.

Example
Single Mode, exports the secured SVF files for each programming ACTION with the following format
‘'my_design_ACTION.svf" into folder 'D:/TOP/my_design_SVF' using the PDB 'my_design.pdb'":
export_single_SVF -file {D:/TOP/my_design_SVF) -pdb {D:/TOP/my_design.pdb} -secured
Chain Mode example exports secured SVF files for each programming ACTION with the following format
'my_design_ACTION.svf'" into folder 'D:/TOP/my_design_SVF' from a device in the chain named
'A2F200M3F" using the PDB 'my_design.pdb':

export_single_SVF -name {A2F200M3F} -file {./my_design_SVF} -pdb {./my_design.pdb} -
secured
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export_spi_directory

Tcl command; exports the SPI directory that contains address and design version information for the
Golden and Update SPI images.

export_spi_directory [-golden_ver {decimal}] [-golden_addr {hex}] [-update_ ver {decimal}]
[-update_addr {hex}] -file {file}

Arguments

-golden_ver {decimal}

Specifies Golden SPI Image design version where decimal is a decimal value and less than 65536
(exclusive).

-golden_addr {hex}
Specifies Golden SPI Image address where hex is 32-bit hexadecimal value with prefix Ox/0X.
-update_ver {decimal}

Specifies Update SPI Image design version where decimal is a decimal value and less than 65536
(exclusive).

-update_addr {hex}

Specifies Update SPI Image address where hex is a 32-bit hexadecimal value with prefix 0x/0X.
-file {file}

Mandatory argument; specifies the file export location.

Supported Families

Examples

SmartFusion2, IGLOO2

Both golden* options go together. The same is true for both update* options.; the file argument is required:

export_spi_directory -golden_ver {23} -golden_addr {0x40001234} -file
{D:\flashpro_files\m2s090t_spi_1\designer\m2s090t_spi_1_MSS\export\m2s090t_spi_1_MSS1.spi
Dir}

export_spi_directory -update_ver {8} -update_addr {0x2000abcd} -file
{D:\flashpro_files\m2s090t_spi_1\designer\m2s090t_spi_1_MSS\export\m2s090t_spi_1_MSS2.spi
Dir}

export_spi_directory -golden_ver {23} -golden_addr {0x40001234} -update_ver {8} -
update_addr {0x2000abcd} -file

{D:\flashpro_files\m2s090t_spi_1\designer\m2s090t_spi_1_MSS\export\m2s090t_spi_1_MSS3.spi
Dir}
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new_project

import_config

Imports a configuration file.

import_config -file {file}

Arguments
-file {file}
Specifies the file to import.

Supported Families
All

Exceptions

None

Example

The following example imports the configuration file 'my_configl.ufc":

import_config -file {my_configl.ufc"}

new_project

Creates a new FlashPro project or convert an old ChainBuilder project into a new FlashPro project (the
mode parameter must be ‘chain’ in this case).

new_project -name {name} -location {location} -mode {single]chain} [-convert_chb
{convert_chb}]

Arguments
-name {name}
Specifies the project name.
-location {location}
Specifies the project location.
-mode {single]chain}
Specifies programming mode; either single or chain.
-convert_chb {convert_chb}
An optional argument that specifies the ChainBuilder project to be converted.

Supported Families
Al

Exceptions
None

FlashPro User's Guide 155



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

& Microsemi

Example
Create a new FlashPro single device project named 'FPPrj1' in a directory with the name 'FPProject1":
new_project -name {FPPrjl} -location {./FPProjectl} -mode {single}

Create a new FlashPro project named 'FPPrjChb' in the directory 'ChbProjectl’; converts the ChainBuilder
project 'prjl.chb' project to FlashPro.

new_project -name {FPPrjChb} -location {./ChbProjectl} -mode {chain} -convert_chb
{./chb_prj/prjl.chb}

open_project
Opens a FlashPro or FlashPro Express project.

open_project -project {project}

Arguments
-project {project}
Specifies the location and name of the project you wish to open.

Supported Families
Al

Exceptions
None

Example
Opens the 'FPPrjl.pro’ project from the FPProjectl directory
open_project -project {./FPProjectl/FPPrjl.pro}

paste device

Pastes the devices that are on the clipboard in the chain, immediately above the position_name device,
if this parameter is specified. Otherwise it places the devices at the end of the chain. The chain
programming mode must be enabled.

paste_device [-position_name {position_name}]

Arguments
-position_name {position_name}
Optional argument that specifies the name of a device in the chain.

Supported Families
Al

Exceptions
None

Examples

The following example pastes the devices on the clipboard immediately above the device 'mydevice3' in
the chain.
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ping_prg

paste_device —position_name {MyDevice3}

ping_prg

Pings one or more programmers.

ping_prg (-name {name})*

Arguments
-name {name}
Specifies the programmer to be pinged. Repeat this argument for multiple programmers.

Supported Families
All

Exceptions
None

Example

The following example pings the programmers 'FP300085' and 'FP30086'.
ping_prg —name {FP300085} —name {FP300086}

read_analog_block config

Reads each channel configuration on your analog system, enabling you to identify if/fhow each channel is
configured.

read_analog_block_config [-name {device_name}] [-file {Ffilename}]

Arguments
-name {device_name}

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

-file {filename}
(Optional) Identifies the name of the file to which read results will be saved.

Supported Families
Fusion

Exceptions
None

Example
The following command reads the analog block configuration information in the device 'AFS600':
read_analog_block_config —name {AFS600}
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read_device_status

Displays the Device Information report; the Device Information report is a complete summary of your device
state, analog block test values, user information, factory serial number and security information..

read_device_status [-name {device_name}] [-File {filename}]

Arguments
-name device_nhame

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.
-file {filename}

(Optional) Identifies the name of the file to which read results will be saved.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example

The following reads device info from the 'AFS600' device.
read_device_status -name AFS600

read_flash_memory

The command reads information from the NVM modules. There are two types of information that can be
read:

e Page Status — includes ECC2 status, write count, access protection

e Page Data

read_flash_memory

[-name {device name}]

[-block {integer_value}]
[-client {client_name}]
[-startpage {integer_value}]
[-endpage {integer_value}]
[-access {all | status | data}]
[-file {filename}]

At a minimum you must specify -client <name> OR
-startpage <page_number> -endpage <page_number> -block <number>

Arguments
-name {device_name}
Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.
-block {integer_value}

(Optional argument; you must set -client or —startpage and —endpage before use.) Specifies location of
block for memory read.

-client {client_name}

Name of client for memory read.
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read_flashrom

-startpage {integer_value}

Startpage for page range; value must be an integer. You must specify a —endpage and -block along with
this argument.

-endpage {integer_value}

Endpage for page range; value must be an integer. You must specify a —startpage and -block along with
this argument.

-access {all | status | data}

(Optional argument; you must set -client or —startpage, —endpage and —block before use.) Specifies what
eNVM information to check: page status, data or both.

Value Description

all Shows the number of pages with corruption status, data corruption and out-of-range write count
(default)

status | Shows the number of pages with corruption status and the number of pages with out-of-range write
count

data | Shows only the number of pages with data corruption

-file {filename}

(Optional argument; you must set -client or —startpage, —endpage and —block before use.) Name of output
file for memory read.

Supported Families
SmartFusion, Fusion

Exceptions
None

Example

The following command reads the flash memory for the client 'DS8bit' and reports the data in a logfile
‘readFlashMemoryReport.log':
read_flash_memory -client {DS8bit} -file {readFlashMemoryReport.log}
read_flash_memory —startpage 0 —endpage 2 —block 0 —access {data}

read_flashrom

Reads the content of the FlashROM from the selected device.

read_flashrom [-name {device_name}] [-mapping {logical | physical}] [-file {filename}]

Arguments
-name device_nhame

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.
-mapping {logical | physical}

(Optional) Specifies how the data read from the UFROM is mapped. Values are explained in the table
below.

Value Description
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Value Description
logical Logical mapping (default)
physical Physical mapping

-file {filename}
(Optional) Identifies the name of the file to which read results will be saved.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example

The following reads the FROM content on the device 'AFS600' and sets to physical mapping:
read_flashrom -name {AFS600} -mapping {physical}

read_id_code

The command reads IDCode from the device without masking any IDCode fields. This is the raw IDcode
from the silicon.

Note: Being able to read the IDCode is an indication that the JTAG interface is working correctly.

read_id_code [-name {device_name}]

Arguments
-name device_name

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example

The following command reads the IDCODE from the device 'AFS600'":
read_id_code —name {AFS600}

recover_flash_memory
The command removes ECC2 errors due to memory corruption by reprogramming specified flash memory
(NVM) pages and initializing all pages to zeros. The recovery affects data blocks and auxiliary blocks.

The write counters of the corrupted pages might not be accurate due to corruption. The recovery operation
will not change state of the page write counters.

Use the check_flash_memory command to detect flash memory errors.
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refresh_prg_list

recover_flash_memory

[-name {device_name}]
[-block {integer_value}]
[-client {client_name}]
[-startpage {integer_value}]
[-endpage {integer_value}]

At a minimum you must specify -client <name> OR
-startpage <page_number> -endpage <page_number> -block <number>

Arguments
-name {device_name}
Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.
-block {integer_value}

(Optional argument; you must set -client or —startpage and —endpage before use.) Specifies location of
block for memory recovery.

-client {client_name}

Name of client for memory recovery.

-startpage {integer_value}

Startpage for page range; value must be an integer.You must specify a —endpage and -block along with
this argument.

-endpage {integer_value}

Endpage for page range; value must be an integer. You must specify a —startpage and -block along with
this argument.

Supported Families
SmartFusion, Fusion

Exceptions
None

Example

The following command recovers flash memory data in the client 'DS8bit":
recover_flash_memory -client {DS8bit}

The following command recovers flash memory from block 0, startpage 0, and endpage 3:
recover_flash_memory -block 0 -startpage 0 -endpage 3

refresh_prg_list

Refreshes the programmer list. This is most often used to have FlashPro or FlashPro Express detect a
programmer that you have just connected.

refresh_prg_list

Arguments
None

Supported Families
All
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Exceptions
None
Example

refresh_prg_list
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refresh_prg_list

remove_device

Removes the device from the chain. Chain programming mode must be set.

remove_device (-name {name})*

Arguments
-name {name}

Specifies the device name. You can repeat this argument for multiple devices.

Supported Families
All

Exceptions

None

Example
Remove a device '"A3P250' from the chain:

remove_device (-name {A3P250})*
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remove _non_actel device from_database

Removes settings for non-Microsemi or non-Actel device from the device database.

remove_non_actel_device_from database [-name {device_name}]

Arguments
-name {device_name}
Specifies the non-Actel or non-Microsemi device name to be removed from the database. You can repeat

this argument for multiple devices.

Supported Families

Non-Microsemi and non-Actel devices

Exceptions

None

Example
The following example removes the F1502AS_J44 device from the database:

remove_non_actel _device_from _database —name {F1502AS J44}
The following example removes the SA2_ PROCESSOR device from the database:

remove_non_actel_device_from_database —name {SA2_PROCESSOR}

remove_prg

Removes the programmer from the programmer list.

remove_prg (-name {name})*

Arguments
-name {name}*
Specifies the programmer to be removed. You can repeat this argument for multiple programmers.

Supported Families
Al

Exceptions
None

Example

The following example removes the programmer '03178' from the programmer list:
remove_prg (nhame {03178})*
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run_selected_actions

run_selected_actions

Runs the selected action on the specified programmer and returns the exit code from the action. If no
programmer name is specified, the action is run on all connected programmers. Only one exit code is
returned, so return code cannot be used when action is run on more than one programmer. A
programming file must be loaded.

run_selected_actions [(-name {name})*]

Arguments
-name {name}

Optional argument that specifies the programmer name. You can repeat this argument for multiple
programmers.

Supported Families
Al

Exceptions
None

Example

The following example runs the selected actionS on the programmers 'FP30085' and 'FP30086'.
run_selected_actions —name {FP300085} —name {FP300086}

Example using return code:

if {[catch {run_selected_actions} return_val]} {puts "Error running Action"} else {puts
"exit code $return_val'}

Example returning exit code to the command line (returns exit 99 on script failure, otherwise returns exit
code from selected action):

if {[catch {run_selected_actions} return_val]}{exit 99} else {exit $return_val}

sample analog_channel

Performs analog-to-digital conversion of a selected analog channel. This command is used when debugging
the Analog Subsystem and is performed on the pre-configured analog channel with user-supplied ADC
conversion parameters. The command also performs digital filtering using a single-pole low-pass filter if you
opt to use it.

sample_analog_channel [(-name {name})*]
[-resolution {8 | 10 | 12}]
[-clock_periods {int_value}]
[-clock_divider {int_value}]
[-num_samples { int_value}]
[-Filtering_factor {real_value}]
[-initial_value {int_value}]
[-show_details {yes | no}l

[-File {Ffilename}]

Arguments
-name { name}

Specifies the analog channel to be sampled. Channel name is a combination of the channel type followed
by the channel index. Valid channel names are listed in the table below.

Family Valid Channel Name
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Family Valid Channel Name
Fusion AV<n>, AT<n>, AC<n>
SmartFusion AV<n>, AT<n>, AC<n>, ADC<n>

The maximum number of channels depends on particular device type; refer to the Analog Block
specification in the device handbook.

-resolution {8 | 10 | 12}

ADC conversion resolution. Specifies bit size of the conversion results. Selection of certain resolutions
may affect timing parameter valid ranges. See your device handbook for details.

-clock_periods {int_value }

Parameter specifying sampling time: Sampling_time = clock_periods * adc_clock_period.
-clock_divider {int_value }

Specifies clock prescaling factor.

-num_samples { int_value }

Optional argument that specifies the number of samples to be performed by the ADC. Default number of
samples is 1. Selecting multiple vs single sample will change appearance of the generated report. For the

single sample a single result is shown and if “show_details” is set to “yes” then detailed status of the ADC
register is also shown.

If multiple samples are requested then the results are printed in a table. If the digital filtering is enabled the
table also includes filtered results.

-filtering_factor {real_value}

Optional argument that specifies the filtering factor if multiple samples requested. The default value of 1.0
disables digital filtering.

-initial_value {int_value}
Optional argument that specifies the initial value for the digital averaging filter. The value is specified in

ADC register counts. Default value is set to 0. Specifying this parameter improves filtering process during
initial samples.

-show_details {yes | no}

Optional argument that specifies the level of the report output. Detailed output includes initial user-
supplied conversion parameters. For the single-sampling case final output also includes detailed content
of ADC register after sampling.

-file {filename}
Optional argument. Specifies name of output file for conversion results.

Supported Families
SmartFusion and Fusion

Exceptions
None

Example
The following example performs single sample analog-to-digital conversion for channel AVO:
sample_analog_channel —channel AVO —resolution 8 —clock_periods 4 —clock_divider 4
Example with multiple sampling and digital signal filtering for AVO:

sample_analog_channel —channel AVO —resolution 10 —clock_periods 4 —clock_divider 4 —
num_samples 10 —Ffiltering_factor 2.5
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save_log

save_log

Saves the log file.

save_log -file {file}

Arguments
-file {file}
Specifies the log filename.

Supported Families
Al

Exceptions
None

Example

The following example saves the log file with the name 'my_logfilel.log":
save_log -file {my_logfilel.log}

save_project

Saves the FlashPro or FlashPro Express project.

save_project

Arguments
None

Supported Families
Al

Exceptions
None

Example
save_project

save_project_as

Saves the FlashPro project under a new project name.

save_project_as -name {name} -location {location}

Arguments
-name {name}
Specifies the project name.
-location {location}
Specifies the project location.
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Supported Families
Al

Exceptions
None

Example

The following example saves the FlashPro project 'FPPrj2' to the directory 'FPProject2":
save_project_as -name {FPPrj2} -location {./FPProject2}

scan_chain_prg
In single mode, this command runs scan chain on a programmer.

In chain mode, this command runs scan and check chain on a programmer if devices have been added in
the grid.

scan_chain_prg [(-name {name})+]

Arguments
-name {name}
Specifies the programmer name.

Supported Families
All

Exceptions
None

Example

The following example runs scan chain on a single programmer (single mode) named '21428"
scan_chain_prg -name {21428}

select_from_region_name

Enables you to select the serialization region you want to add to the log file.

select_from_region_name —enable {1]0} —-region_name {name}

Arguments
-enable {1]0}
Enable serialization region logging. '1' enables serialization region logging; '0' disables it.
-region_name {name}
The name of the target serialization/client within FlashRom you wish to log.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion
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Exceptions
None

Example

The following example enables select_from_region_name and adds the serialization region 'afs090_b' to the
log file:
select_from_region_name -enable {1} -region_name {afs090 b}

select_serial _range

Selects the serialization data. Either the data or the from_data and to_data arguments must be
specified. A programming file allowing serialization must be loaded.

select_serial_range [-name {name}] [(-data {data})*] [-from data {from_data} -to_data
{to_data}]

Arguments
-name {name}
Specifies the device name. This argument must be specified in chain programming mode.
-data {data}
Specifies the data. You can repeat this argument for multiple serialization data.
-from_data {from_data}
Specifies the start of a range of data. Must be used along with the to_data argument.
-to_data {to data}
Specifies the end of a range of data. Must be used along with the from_data argument.

Supported Families
All

Exceptions
None

Examples
The following example selects serial range data on devices 1-4 in Single Programming mode:
select_serial_range —data {1} —data {2} —data {3} —data {4}
select_serial range —from data {1} —to_data {4}

The following example selects serial range data on devices 1-4 on the device 'MyDevicel' in Chain
Programming mode. :

select_serial_range —name {MyDevicel} —data {1} —data {2} —data {3} —data {4}
select_serial range —name {MyDevicel} —from data {1} —to_data {4}

select_target_device

Enables you to set a target device for programming in Single Device Programming mode. The command
is identical to the Select Target Device dialog box in FlashPro.

Select_target_device -name {device_name}

Arguments
-name {device_name}

FlashPro User's Guide 169



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

& Microsemi

Specifies the name of the target device.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Examples

The following example targets the A3P(L) / AGL1000 device for programming:
select_target_device —name {A3P(L)/AGL1000 (1)}

self _test prg

Runs Self-Test on a programmer.

self_test_prg (-name {name})*

Arguments
-name {name}
Specifies the programmer name. You can repeat this argument for multiple programmers.

Supported Families
Al

Exceptions
None

Example

The following examples runs the self test on the programmer '30175":
self_test_prg (-name {30175})*

set bsdl file

Sets a BSDL file to a non-Microsemi device in the chain. Chain programming mode must have been set.
The device must be a non-Microsemi device.

set_bsdl_file -name {name} -file {file}

Arguments
name {name}
Specifies the device name.
-file {file}
Specifies the BSDL file.

Supported Families

Any non-Microsemi device supported by FlashPro.
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Exceptions
None

Example
The following example sets the BSDL file /design/bsdl/NewBSDL2.bsdl to the device ‘MyDevice3':
set_bsdl_file —name {MyDevice3} —file {e:/design/bsdl/NewBSDL2.bsdl}

set _chain_param

Sets the chain parameters in single programming mode. Single programming mode must be set .

set_chain_param [-pre_ir {pre_ir}] [-pre_dr {pre_dr}] [-post_ir {post_ir}] [-post_dr
{post_dr}]

Arguments
-pre_ir {pre_ir}
Specifies the pre IR length.
-pre_dr {pre_dr}
Specifies the pre DR length.
-post_ir {post_ir}
Specifies the post IR length.
-post_dr {post_dr}
Specifies post DR length.

Supported Families
Al

Exceptions
None

Example

The following example sets the chain parameters for pre IR length to 2, pre DR length to 3, post IR length
to 4, and post DR length to 5:
set_chain_param —pre_ir {2} —pre_dr {3} —post_ir {4} —post_dr {5}

set_debug_device

Identifies the device you intend to debug.

set_debug_device -name {device_name}

Arguments
name {device_name}
Device name. The device name is not required if there is only one device in the current configuration.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion
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Exceptions
None

Example
The following example identifies the device 'A3P250' for debugging:
set_debug_device —name {A3P250}

set _debug_programmer

Identifies the programmer you want to use for debugging (if you have more than one). The name of the
programmer is the serial number on the bar code label on the FlashPro programmer.

set_debug_programmer -name {programmer_name}

Arguments
-name {programmer_name}
Programmer name is the serial number on the bar code label of the FlashPro programmer.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example

The following example selects the programmer 10841
set_debug_programmer -name {10841}

set_device_ir

Sets the IR length of a non-Microsemi device in the chain. Chain programming mode must be set. The
device must be a non-Microsemi device.

set_device_ir -name {name} -ir {ir}

Arguments
-name {name}
Specifies the device name.
-ir {ir}
Specifies the IR length.

Supported Families
Any non-Microsemi device supported by FlashPro.

Exceptions
None
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Example

The following example sets the IR length to '2' for the non-Microsemi device 'MyDevice4'":
set_device_ir —name {MyDevice4} —ir {2}

set_device_name

Changes the user name of a device in the chain. Chain programming mode must be set .

set_device _name -name {name} -new_name {new_name}

Arguments
-name {name}
Identifies the old device name.
-new_name {new_name}
Specifies the new device name.

Supported Families
Al

Exceptions
None

Example

The following example changes the user name of the device from ‘MyDevice4' to ‘MyDevice5':
set_device_name —name {MyDeviced4} —new_name {MyDevice5}

set_device order

Sets the order of the devices in the chain to the order specified. Chain programming mode must have
been set. Unspecified devices will be at the end of the chain.

set_device_order (-name {name})*

Arguments
-name {name}

Specifies the device name. To specify a new order you must repeat this argument and specify each
device name in the order desired.

Supported Families
Al

Exceptions
None

Example

The following example sets the device order for 'MyDevicel', ‘"MyDevice2', ‘MyDevice3', and ‘MyDevice4'.
‘MyDevice2' is unspecified so it moves to the end of the chain.
set_device_order —name {MyDevice3} —name {MyDevicel} —name {MyDevice4}

the new order is:
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set _device_tck

Sets the maximum TCK frequency of a non-Microsemi device in the chain. Chain programming mode
must be set. The device must be a non-Microsemi device.

set_device_tck -name {name} -tck {tck}

Arguments

-name {name}

Specifies the device name.

-tck {tck}

Specifies the maximum TCK frequency (in MHz).

Supported Families

Exceptions

Example

Any non-Microsemi device supported by FlashPro.

None

The following example sets the maximum TCK frequency of the non-Microsemi device 'MyDevice4':
set_device_tck —name {MyDeviced4} —tck {2.25}

set _device to_highz

Sets a disabled Microsemi or Microsemi device in Chain programming mode to HIGH-Z. This Tcl
command is related to the Set Device to HIGH-Z GUI command.

set_device_to_highz -name {device_name} —-highz {1]0}

Arguments

-name {device_name}

Target device hame in chain mode.

-highz {1]0}

Sets disabled device to HIGH-Z. '1' sets the device to HIGH-Z, '0' removes the setting.

Supported Families

SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None
Example
The following example sets the AFS090 device to HIGH-Z:
set_device_to_highz —name {AFS090} —highz 1
The following example removes the HIGH-Z setting from the AFS1500 device:
set_device_to_highz —name {AFS1500} —highz O
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set_device_type
Changes the family of a Microsemi device in the chain. The device must be a Microsemi device. The
device parameter below is now optional.

set_device_type -name {name} -type {type}

Arguments
-name {name}
Identifies the name of the device you want to change.
-type {type}
Specifies the device family.

Supported Families

Any Microsemi device supported by FlashPro.

Exceptions
None

Example

The following example sets the device 'MyDevice2' to the type A3PE600.
set_device_type —name {MyDevice2} —type {A3PE600}

set_main_log_file
Sets the FlashPro log file.
set_main_log_file -file {file}

Arguments
-file {file}
Specifies the log file.

Supported Families
Al

Exceptions
None

Example

The following example sets the FlashPro log file to 'log1000.txt'.
set_main_log_file —file {e:/10g/10g1000.txt}

set_prg_name

Changes the user name of a programmer.

set_prg_name -name {name} -new_name {new_name}
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Arguments
-name {name}
Identifies the old programmer name.
-new_name {new_name}
Specifies the new programmer name.

Supported Families
All devices supported by FlashPro.

Exceptions
None

Example

The following example changes the name of the programmer 'FP300086' to '‘FP3Prg2':
set_prg_name —name {FP300086} —new_name {FP3Prg2}

set_programming_action

Selects the action for a device. The device name parameter must be specified only in chain programming
mode. A programming file must be loaded. The device must be a Microsemidevice.

set_programming_action [-name {name}] -action {action}

Arguments
-name {name}
Specifies the device name.
-action {action}
Specifies the action.

Supported Families
SmartFusion, IGLOO, ProASIC3, Fusion

Exceptions
Must be a Microsemi device

Example

The following example sets the programming action in single programming mode:
set_programming_action —action {PROGRAM}

And in chain programming mode:

set_programming_action —name {MyDevicel} —action {ERASE}

set_programming_file

Sets the programming file for a device. Either the Tille orthe no_file flag must be specified. A
programming file must be loaded. The device must be a Microsemi device .

set_programming_file [-name {name}] [-File {file}] [-no_file { }]
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Arguments

set_programming_mode

-name {name}
Specifies the device name. This argument must be specified only in chain programming mode.
-file {file}
Specifies the programming file.
-no_File
Specifies to unload the current programming file.

Supported Families

Exceptions

Examples

SmartFusion, IGLOO, ProASIC3, Fusion

Must be a Microsemi device.

In single programming mode:

set_programming_file —File {e:/design/pdb/TopA3P250.pdb}

In chain programming mode:

set_programming_file —name {MyDevice2} —File {e:/design/pdb/TopA3P250.pdb}
set_programming_file —name {MyDevicel} —no_file

set_programming_mode

Sets the programming mode.

set_programming_mode -mode {single]chain}

Arguments

-mode {single]chain}
Specifies the mode, either single programming or chain programming.

Supported Families

Exceptions

Example

All devices supported by FlashPro.

None

The following example sets the programming mode to 'single’:
set_programming_mode -mode {single}

set_serialization_log_file

Sets the FlashPro log file to be used for serialization.

set_serialization_log_file -file {file}
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Arguments
-file {file}
Specifies the log file name.

Supported Families
All devices supported by FlashPro.

Exceptions
None

Example

The following device sets the log file used for serialization to 'log1000_serial.txt":

set_serialization_log_file —File {e:/109/1091000_serial . txt}

set_serialization_mode

Sets the serialization mode.

set_serialization_mode -mode {skip]reuse}

Arguments
-mode {skip]reuse}

Supported Families
All devices supported by FlashPro.

Exceptions
None

Example

The following example sets the serialization mode to 'skip'":
set_serialization_mode -mode {skip}

update programming_file
Updates the programming file with the selected parameters.

update_programming_file

[(-name {name})*]

-feature {value}

-signature {value}

-from_content {name}
-from_config_Ffile {name}
-number_of devices {value}
-from_program_pages {value}
-custom_security {value}
-security_permanent {value}
-fpa_security_level {value}
-from_security_level {value}
-efm_block_security{location:X;security level: value}
-pass_key {value} -aes key {value}
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update_programming_file

-efm_content {location:X;source: value}

-efm_block {location:X;config_file: value}

-efm_client {location:X;client:value; mem_file: value}
-tie_off_arch {value}

-set_io_state {value}

-pdb_file {name}

-enable_m3debugger {value}

Arguments
-name {name}
Specifies the device name. This argument must be specified only in chain programming mode.
-feature {value}
Select the silicon feature(s) you want to program. Possible values for this option are listed in the table
below, or the instance-specific program options available only for specific families (as shown in the table
below). Microsemi recommends that you specify your program parameters for each Embedded Flash
Memory Block (EFMB) instance, from 0-3. The instance specific program options replace [-feature
{value}].
value Family

{setup_security:on/off} SmartFusion

{prog_fpga:on/off} SmartFusion

{prog_from:on/off} SmartFusion

{prog_nvm:on/off} SmartFusion

{setup_security} Fusion

{prog_from} Fusion

{all} IGLOO; ProASIC3

To program the Embedded Flash Memory Block, use the following EFM arguments: -efm_block, -
efm_client, and -efm_block security.

-signature {value}

Optional argument that identifies and tracks Microsemi designs and devices.

-from_content {name}

Optional argument that identifies the source file for the FlashROM content. The file type is UFC or PDB
(default). This argument only applies when programming the FlashROM (prog_from option).
-from_config_file {name}

Optional argument that specifies the location of the FlashROM configuration file. This argument only
applies when programming the FlashROM (prog_from option) and the from_content is set to UFC.
-number_of_devices{value}

Optional argument that specifies the number of devices to be programmed. This argument only applies

when FlashROM has serialization regions. This argument only applies when programming the
FlashROM (prog_from option).

—-from_program_pages {value}

Optional argument that identifies the program pages in FlashPoint. This argument only applies when
programming the FlashROM (prog_from option).

-custom_security {value}
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Optional argument that specifies the security level. This argument only applies when programming the
security settings (setup_security) or programming previously secured devices. The following table shows
the acceptable values for this argument:

Value Description

Yes Custom security level

No Standard security level

-security _permanent {value}

Optional argument that specifies whether the security settings for this file are permanent or not. This
argument only applies when programming the security settings (setup_security) or programming
previously secured devices. The following table shows the acceptable values for this argument:

Value Description
Yes Permanently disables future modification of security settings
No Enables future modifications of security settings

-fpga_security_level {value}

Optional argument that specifies the security level for the FPGA Array. This argument only applies when
programming the security settings (setup_security) or programming previously secured devices. Possible
values:

Value Description

write_verify_protect | The security level is medium (standard) and the FPGA Array
cannot be written or verified without a Pass Key

write_protect The security level is write protected. The FPGA Array cannot be
written without a Pass Key, but it is open for verification (custom
FPGA)

encrypted The security level is high (standard) and uses a 128-bit AES
encryption

none The FPGA Array can be written and verified without a Pass Key

-from_security_level {value}

Optional argument that specifies the security level for the FlashROM. This argument only applies when
programming the security settings (setup_security) or programming previously secured devices. Possible
values:

Value Description

write_verify_protect | The security level is medium (standard) and the FlashROM cannot
be read, written or verified without a Pass Key

write_protect The security level is write protected. The FlashROM cannot be
written without a Pass Key, but it is open for reading and
verification (custom FlashROM)

encrypted The security level is high (standard) and uses a 128-bit AES
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Value

Description

encryption

none

The FlashROM can be written and verified without a Pass Key

-efm_block_security{location:X;security_level: value}

This option is available only for SmartFusion and Fusion; this argument only applies when
programming the security settings (setup_security) or programming previously secured devices.

‘X" identifies an Embedded Flash Memory Block instance from 0-3.
Possible values for security_level:

Value

Description

clients_jtag_protect

Enables eNVM client JTAG protection; a pass key is required for
this option.

write_verify_protect

The security level is medium (standard) and the Embedded Flash
Memory Block cannot be read, written or verified without a Pass
Key

write_protect

The security level is write protected. The Embedded Flash
Memory Block cannot be written without a Pass Key, but it is open
for reading (custom FB)

encrypted

The security level is high (standard) and uses a 128-bit AES
encryption

none

The Embedded Flash Memory Block can be written and read
without a Pass Key

-pass_key {value}

Protects all the security settings for FPGA Array, FlashROM, and Embedded Flash Memory Block. The
maximum length of this value is 32 characters. You must use hexadecimal characters for the pass key

value.

-aes_key {value}
Decrypts FPGA Array and/or FlashROM and Embedded Flash Memory Block programming file content.

Max length is 32 HEX characters.
-efm_content {location:X;source: value}
This option is available only for SmartFusion and Fusion; X identifies an Embedded Flash Memory Block
from 0-3. Option identifies the source file for the Embedded Flash Memory Block configuration content,
either an EFC or PDB file. If you specify EFC as your source, you need to specify the -efm_block
parameter. Possible values:

Value

Description

PDB

PDB | Embedded Flash Memory Block configuration and content is taken from your

EFC | FlashPoint uses the Embedded Flash Memory Block configuration and content
from the EFC file specified in -efm_block parameter

-efm_block {location:X;config_file: value}
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This option is available only for SmartFusion and Fusion; X identifies an Embedded Flash Memory Block
(EFMB) from 0-3.

Config_file specifies the location of the EFMB configuration file (must be an EFC file with full pathname).
-efm_client {location:X;client:value; mem_file: value}
This option is available only for SmartFusion and Fusion; X identifies an EFMB from 0-3.

You must specify the client name and its memory content file for each client of EFMB you wish to
program.
Mem_file specifies the file with the memory content for the client. If you want to program a client with a
PDB or EFC file memory content (as defined by the -efm_content argument), the mem_file path should be
empty (see example 3); but if a mem_file path is specified, the memory content from this file will overwrite
the client content in PDB or EFC (as defined by the -efm_content argument).

-tie_off_arch {value}
This optional argument is used only for IT6X6M2 and M7IT6X6M2 devices. Possible values:

Value Description

pull-down | Pull-down resistor: reduced quiescent power consumption

pull-up Pull-up resistor: compatible behavior for migrated ProASIC™"® designs

-set_io_state {value}

Sets the I/O state during programming by port name or pin number.

To set the I/O by port name, use -set_io_state {portName:<port name>; state:<state>}.
To set the I/O by pin number, use -set_io_state {pinNumber:<pin number>; state:<state>}.
To set all I/Os to the specified state, use -set_io_state {all; state:<state>}.

Possible state values:

Value Description
Tri-State Sets the I/O state to tristate
Last Known State Sets the I/O state to last known state
High Sets the I/O state to high
Low Sets the I/O state to low

-pdb_file {name}

Optional PDB filename; if not specified the default is ‘expresspdbX'.
-enable_m3debugger {yes | no}

SmartFusion only; .enables the M3 debugger.

Supported Families
All devices supported by FlashPro.

Exceptions
None

Example

Fusion example 1:
update_programming_file \
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-feature {setup_security} \

-feature {prog_from} \

-from_content {ufc} \

-from_config_file {D:/from_ah.ufc} \

-number_of_devices {1} \

-from_program_pages {1 2 3456 7 } \

-custom_security {no} \

-security_permanent {no} \

-fpga_security_level {write_verify protect} \

-from_security_level {write_verify protect} \

-efm_block_security {location:1;security_level:write_verify _protect} \

-efm_content {location:1;source:efc} \

-efm_block {location:1;config_file:{D:\ nvm_all_new.efc}} \

-efm_client {location:1;client:asb;mem_file:{}} \

-efm_client {location:1;client:cfiData;mem_file:{D:\cfid.mem}} \

-efm_client {location:1;client:ds;mem_Ffile:{D:\ds.hex}} \

-efm_client {location:1;client:initl;mem_file:{D:\initl.hex}} \

-efm_client {location:1;client:raminit;mem_file:{}}

Update loaded PDB file: use ufc file for FlashROM configuration and content; use efc file for block 1

configuration; efc memory content will be overwritten by memory content from specified mem files for

each client.
Fusion example 2:

update_programming_file \

-feature {prog_from} \

-from_content {pdb} \

-from_program_pages {1} \

-efm_content {location:1;source:pdb} \

-efm_client {location:1;client:cfiData;mem_file:{D:\cfid.mem}}

Update loaded PDB file: use pdb data for FlashROM; program only page 1; use pdb data for block 1;

program only client cfiData; overwrite memory content for this client with memory content from the

specified file.
Fusion example 3:

update_programming_file \

-efm_content {location:1;source:pdb} \

-efm_client {location:1;client:cfiData;mem_file:{D:\cfid.mem}} \

-efm_client {location:1;client:initl;mem_file:{}}

Update loaded PDB file: use pdb data for block 1; program client cfiData using memory content from the

specified file; program client initl using memory content from pdb (no mem_file path is specified) .
SmartFusion example:

update_programming_file \

update_programming_file \

-feature {setup_security:on} \

-feature {prog_fpga:off} \

-feature {prog_from:off} \

-feature {prog_nvm:on} \

-custom_security {no} \

-security_permanent {no} \

-fpga_security_level {none} \

-from_security_level {none} \

-efm_block_security {location:0;security_level:clients_jtag protect} \

-efm_block_security {location:1;security_level:clients_jtag protect} \
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-pass_key {73F09973E792ECI9F462AE5A446FB6C77} \
-efm_content {location:0;source:pdb} \
-efm_block

{location:0;config_file:{./eNVM_client_JTAG_protection_A2F500/allClients_Read_ON_Write_O
N.efc}}

\
-pdb_file {./fpro_jtag/fpro_jtag_30.pdb} \
-enable_m3debugger {no}
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Loopback Test

Troubleshooting

Loopback Test

The console software supports all JTAG functions and a diagnostic loopback test. Note that loopback is not
supported on all boards.
To perform the diagnostic test

1. Connect the loopback test board to the FlashPro.

2. Connect the FlashPro to the parallel/lUSB port of the PC.
3. Power-on the FlashPro.
4

From the Start menu, choose Programs > Microsemi FlashPro > Diagnotics. This opens the
diagnostics console program.

5. Connect to the FlashPro by entering openport Iptl or openport usb. The parallel port number depends
on the port used to connect the FlashPro.

6. Enter test. The unit runs into self-test mode. Do not interrupt the unit during self-test mode.

Note: Note: To see a complete list of all functions, enter help. To get a more detail description of each
function, enter help <command>.

SmartFusion2 and IGLOO2 Programming Authentication Error
Codes (AUTHERRCODE)

The table below lists authentication error codes for SmartFusion2 and IGLOO2 devices.

Errors related to programming failures (ERRORCODE errors) are summarized in SmartFusion2 and
IGLOO2 Programming Error Codes.

Table 24 - SmartFusion2 Programming Authentication Error Codes

AUTHERRCODE | Description Possible Cause Possible Solution
0 Passed (no - -
error)
1,2 Invalid, Programming file has | Regenerate programming file
corrupted been corrupted
bitstream
3 Invalid, corrupt | File contains an Provide a programming file with an encryption key that matches

encryption key | encrypted key that that on the device
does not match the
device First program security with master programming file, then
program with user encryption 1/2 field update programming files
File contains user
encryption key, but You must first ERASE security with the master security file, then
device has not been | you can reprogram new security settings

programmed with the
user encryption key

Device has user
encryption key 1/2
enforced and you are
attempting to
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AUTHERRCODE | Description Possible Cause Possible Solution
reprogram security
settings
4 Invalid, Programming file has | Regenerate the programming file
corrupted been corrupted
bitstream
5 Back level not | Design version is not | Generate a programming file with a design version higher than
satisfied higher than the back- | the back level version
level programmed
device
7 DSN binding DSN specified in Use the correct programming file with a DSN that matches the
mismatch programming file DSN of the target device being programmed
does not match the
device being
programmed
8 Invalid, Programming file has | Regenerate the programming file
corrupted been corrupted
bitstream
9 Insufficient Device does not Generate a programming file with the correct capabilities for the
device support the target device
capabilities capabilities specified
in programming file
10 Incorrect Incorrect Choose the correct programming file and select the correct
DEVICEID programming file device in chain
Incorrect device in Measure JTAG pins and noise or reflection. If TRST is left
chain floating, then add pull-up to pin
Signal integrity issues | Reduce the length of ground connection
on JTAG pins
11 Unsupported Old programming file | Generate programming file with latest version of Libero SoC
bitstream
protocol
version
12 Verify not
permitted on
this bitstream

SmartFusion2 and IGLOO2 Programming Error Codes
(ERRORCODE)

The table below lists authentication error codes for SmartFusion2 and IGLOO2 devices.

Errors related to authentication failures are summarized in SmartFusion2 and IGLOO2 Programming
Authentication Error Codes.

Table 25 - SmartFusion2 and IGLOO2 Programming Error Codes
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SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for Software v8.6 and Above

ERRORCODE Description
0 Passed (no error)
1 Fabric verification failed
2 Device security prevented operation
3 Programming mode not enabled
4 eNVM programing operation failed
5 eNVM verify operation failed

SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for
Software v8.6 and Above

The table below lists exit codes for SmartFusion, IGLOO, ProASIC3 and Fusion devices in software v8.6

and ABOVE only. See the Device Exit Codes for pre-v8.6 Software help topic for exit codes for older
versions.

Note: Exit codes with positive integers are reserved for current and future standard EXIT codes of the STAPL standard.

Exit codes with negative integers are reserved for vendor-specific EXIT codes.

Table 26 - Exit Codes for SmartFusion, IGLOO, ProASIC3 and Fusion Family Devices in Software v8.6 and Above

ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message
0 Passed (no
error)
1 A physical Physical chain configuration has
chain does been altered. Something has
not match the | become disconnected in the chain.
expected set | The specific IR length of non-
up from the Microsemi devices may be
STAPL file. incorrect.
Also known The order of the specified chain
as Checking | may be incorrect.
Chain Error.
0x8052 5 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
enter the issue during programming; check for

programming
mode.

Unstable VCC

Signal integrity issues on JTAG
pins.

Device is in FlashFreeze mode
(ProASICL or IGLOO devices)

Older software or programming file
used.

transients outside of Microsemi
specifications. See your device datasheet
for more information on transient
specifications.

Monitor VITAG during programming;
measure JTAG signals for noise or
reflection.

Disble the FlashFreeze pin (ProASICL or
IGLOO devices)
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ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message

Generate STAPL file with the latest version

of Designer/FlashPro.

Use latest version of FlashPro software.
0x801D 6 Failed to Incorrect programming file Choose the correct programming file and
0x8053 verify select the correct device in chain.

IDCODE Incorrect device in chain
Measure JTAG pins and noise or reflection.
Signal integrity issues on JTAG pins | If TRST is left floating then add pull-up to
pin.

Reduce the length of ground connection.
0x8005 6 Failed to Programming file generated with an | Generate STAPL file with the latest version
0x8009 verify AES older version of software of Designer/FlashPro. Use latest version of
0x800B Sec. FlashPro software.

Try again at a slower TCK.

Contact Microsemi Technical Support.
0x8008 6 Failed to File is not for M7, but target device | Check that the target device is M7 enabled.

verify is M7
IDCODE. Make sure that the programming file you
Signal integrity issues on JTAG generated is for an M7-enabled device.
Targetisan | pins.
M7 device Measure JTAG pins, noise and reflection.
0x800A 6 Failed to Files not for M1, but target device is | Check that the target device is M1 enabled.
verify M1.
IDCODE Make sure the programming file generated
Signal integrity issues on JTAG pins | is for an M1-enabled device.
Target is an
M1 device Monitor VITAG during programming;
measure JTAG signals for noise or
reflection.
0x800C 6 Failed to File is not for target device. Check the target device; make sure the
verify programming file generated is matches the
IDCODE. Signal integrity issues on JTAG pins | target device.
Core enabled Monitor VITAG during programming;
device measure JTAG signals for noise or
detected reflection.
0x800D 6 Failed to File is for M7 but target device is not | Check that the target device is not M7
verify M7. enabled.
IDCODE.
Signal integrity issues on JTAG Make sure that the programming file
The targetis | pins. generated is for non-M7 enabled device.
not M7
device Monitor VITAG during programming;
measure JTAG signals for noise or
reflection.
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SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for Software v8.6 and Above

ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message

0x800E 6 Failed to File is for M1, but target device is Check that the target device is not M1
verify not M1. enabled.
IDCODE.

Signal integrity issues on JTAG pins | Make sure that the generated programming
Target is not file is for non-M1 enabled device.

an M1 device
Monitor VITAG during programming;
measure JTAG signals for noise or

reflection.
0x8006 6 Failed to File is not for P1, but target device | Check that the target device is P1 enabled.
verify is a P1 device.
IDCODE. Make sure programming file generated is

Signal integrity issues on JTAG pins | for M1 enabled device.
Target is not

a P1 device Monitor VITAG during programming;
measure JTAG signals for noise or
reflection.

0x801E 6 A3PE600 Contact Microsemi Technical Support

Engineering

Sample

Device

Detected.

This device is

supported

with pre-v8.3

SP1 STAPL

files only

0x8057 8 Failed Erase | Unstable VPUMP voltage level. Monitor related power supplies that cause
Operation. the issue during programming; check for
Unstable VCC transients outside of Microsemi

specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) for more information on transient

specifications.
Unstable VCC_ROSC voltage level
(SmartFusion only) Monitor VITAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins.
0x8058 10 Failed to Monitor related power supplies that cause
program Unstable VPUMP voltage level. the issue during programming; check for
FPGA array transients outside of Microsemi
at row <row Unstable VCC specifications. See your device datasheet
number>. for more information on transient

Unstable VCC_OSC (Fusion only) specifications.

Unstable VCC_ROSC voltage level | Monitor VIJTAG during programming;
(SmartFusion only) measure JTAG signals for noise or
reflection.

Signal integrity issues on JTAG
pins.
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ERROR_CODE | Exit Exit Possible Cause Possible Solution

Code Message
0x805D 10 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
0x805E enable FPGA the issue during programming; check for
0x807B Array. Unstable VCC transients outside of Microsemi

specifications. See your device datasheet

Unstable VCC_OSC (Fusion only) for more information on transient
specifications.

Unstable VCC_ROSC voltage level

(SmartFusion only) Monitor VITAG during programming;
measure JTAG signals for noise or

Signal integrity issues on JTAG reflection.

pins.

0x8061 10 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
0x8062 program the issue during programming; check for
FlashROM. Unstable VCC transients outside of Microsemi
specifications. See your device datasheet

Unstable VCC_OSC (Fusion only) for more information on transient
specifications.

Unstable VCC_ROSC voltage level

(SmartFusion only) Monitor VITAG during programming;
measure JTAG signals for noise or

Signal integrity issues on JTAG reflection.

pins.

0x801B 10 Error Unstable VCC_NVM/VCC_0OSC Monitor related power supplies that cause
0x801C programming | voltage level (Fusion only) the issue during programming; check for
0x806C Embedded transients outside of Microsemi
0x806D Flash Unstable specifications. See your device datasheet
0x806E Memory VCC_ENVM/VCC_RCOSC voltage | for more information on transient

Block (EFMB) | level (SmartFusion only) specifications.

Signal integrity issues on JTAG pins | Monitor VJTAG during programming;
measure JTAG signals for noise or

NVM corruption is possible when reflection.

writing from your design; check the

NVM status for confirmation. Reset signal is not properly tied off in your
design.

Inspect device using Device Debug.
0x807D 10 Error Unstable VCC Monitor related power supplies that cause
0x807E programming the issue during programming; check for

system init Unstable VCC_OSC (Fusion only) transients outside of Microsemi
and boot specifications. See your device datasheet
clients Unstable VCC_ROSC voltage level | for more information on transient

(SmartFusion only) specifications.

Signal integrity issues on JTAG pins | Monitor VJTAG during programming;
measure JTAG signals for noise or
reflection.

Inspect device using Device Debug.
0x8069 10 Error Programming file generated with an | Generate STAPL file with the latest version
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SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for Software v8.6 and Above

ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message
0x806A programming | older version of software of Designer/FlashPro; use the latest version
0x806B Embedded of FlashPro software
Flash
Memory Try again at a slower TCK
Block (EMFB)
Inspect device using Device Debug.
Contact Microsemi Technical Support
0x808E 10 Error Try reprogramming
0x808F programming
0x8090 Embedded Contact Microsemi Technical Support
0x8091 Flash
Memory
Block (EFMB)
0x807F 10 Error Programming file generated with an | Generate STAPL file with the latest version
0x8080 programming | older version of software of Designer/FlashPro; use the latest version
system init of FlashPro software
and boot
clients Try again at a slower TCK
Inspect device using Device Debug.
Contact Microsemi Technical Support
0x8059 11 Verify O failed | Unstable VPUMP voltage level. Monitor related power supplies that cause
0x805B at row <row the issue during programming; check for
number> Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Verify 1 Unstable VCC_OSC (Fusion only) for more information on transient
failed at row specifications.
<row Unstable VCC_ROSC voltage level
number>. (SmartFusion only) Monitor VITAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins.
0x8060 11 Device is programmed with a Run VERIFY_DEVICE_INFO to verify the
Failed to different design. device is programmed with the correct
verify data/design.
FlashROM at | Unstable VPUMP voltage level.
row Monitor related power supplies that cause
<FlashROM | Unstable VCC the issue during programming; check for
row number>. transients outside of Microsemi
Unstable VCC_OSC (Fusion only) specifications. See your device datasheet
for more information on transient
Unstable VCC_ROSC voltage level | specifications.
(SmartFusion only)
Monitor VITAG during programming;
Signal integrity issues on JTAG measure JTAG signals for noise or
pins. reflection.
0x8075 11 Failed to Device is programmed with a Verify the device is programmed with the
0x8076 verify different design. correct data/design.
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ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message
0x8077 Embedded
Flash Unstable VCC Monitor related power supplies that cause
Memory the issue during programming; check for
Block (EFMB) | Unstable VCC_NVM/VCC_OSC transients outside of Microsemi
(Fusion only) specifications. See your device datasheet
for more information on transient
Unstable VCC_ENVM/VCC_ROSC | specifications.
voltage level (SmartFusion only)
Measure JTAG pins, and noise or reflection.
Signal integrity issues on JTAG
pins. Run DEVICE_INFO to confirm if the target
EFMB block is locked with FlashLock (pass
The EFMB data was modified in key). If the target EFMB block is locked,
your FPGA design after then you must unlock it by erasing the
programming. This could have security and then reprogramming with the
occurred during standalone verify. desired security settings. After unlocking the
target EFMB block attempt to rerun the
The target EFMB is locked with target ACTION.
FlashLock when running ACTION
PROGRAM_NVM_ACTIVE_ARRAY | Inspect device using Device Debug.
or VERIFY_NVM_ACTIVE_ARRAY.
0x8085 11 Failed to Device is programmed with a Verify the device is programmed with the
0x8086 verify system | different design. correct data/design.
init and boot
clients Unstable VCC Monitor related power supplies that cause
the issue during programming; check for
Unstable VCC_NVM/VCC_0OSC transients outside of Microsemi
(Fusion only) specifications. See your device datasheet
for more information on transient
Unstable VCC_ENVM/VCC_ROSC | specifications.
voltage level (SmartFusion only)
Measure JTAG pins, and noise or reflection.
Signal integrity issues on JTAG
pins. Run DEVICE_INFO to confirm if the target
EFMB block is locked with FlashLock (pass
The EFMB data was modified in key). If the target EFMB block is locked,
your FPGA design after then you must unlock it by erasing the
programming. This could have security and then reprogramming with the
occurred during standalone verify. desired security settings. After unlocking the
target EFMB block attempt to rerun the
The target EFMB is locked with target ACTION.
FlashLock when running ACTION
PROGRAM_NVM_ACTIVE_ARRAY | Inspect device using Device Debug.
or VERIFY_NVM_ACTIVE_ARRAY.
0x8072 11 Failed to Programming file generated with an | Generate STAPL file with the latest version
0x8073 verify older version of software of Designer/FlashPro; use the latest version
0x8074 Embedded of FlashPro software
Flash
Memory Try again at a slower TCK
Block (EFMB)
Inspect device using Device Debug.
Contact Microsemi Technical Support
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ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message
0x8083 11 Failed to Programming file generated with an | Generate STAPL file with the latest version
0x8084 verify system | older version of software of Designer/FlashPro; use the latest version
init and boot of FlashPro software
clients
Try again at a slower TCK
Inspect device using Device Debug.
Contact Microsemi Technical Support
0x8014 11 Failed to Unstable VCC Monitor related power supplies that cause
0x8015 verify the issue during programming; check for
calibration Unstable VCC_NVM/VCC_0OSC transients outside of Microsemi
data (Fusion only) specifications. See your device datasheet
for more information on transient
Unstable VCC_ENVM/VCC_ROSC | specifications.
voltage level (SmartFusion only)
Monitor VITAG during programming;
Signal integrity issues on JTAG pins | measure JTAG signals for noise or
reflection.
Try reprogramming.
Workaround: Disable optional procedure
CHECK_AND_BACKUP_CALIB
0x805A 11 Verify 0 failed | Device is programmed with a Run VERIFY_DEVICE_INFO to verify the
0x805C at row <row | different design device is programmed with the correct
number> . data/design.
Unstable VPUMP voltage level.
Verify 1 failed Monitor related power supplies that cause
at row <row Unstable VCC the issue during programming; check for
number> transients outside of Microsemi
Unstable VCC_OSC (Fusion only) specifications. See your device datasheet
for more information on transient
Unstable VCC_ROSC voltage level | specifications.
(SmartFusion only)
Monitor VITAG during programming;
Signal integrity issues on JTAG pins | measure JTAG signals for noise or
reflection.
0x8063 14 Failed to Signal integrity issues on JTAG Monitor related power supplies that cause
program pins. the issue during programming; check for
Silicon transients outside of Microsemi
Signature. specifications. See your device datasheet
Failed to for more information on transient
program specifications.
security lock
settings. Monitor VITAG during programming;
measure JTAG signals for noise or
reflection.
0x8068 -18 Failed to Incorrect AES key. Generate a programming file with the
authenticate correct AES key.
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ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message
the encrypted | Signal integrity issues on JTAG
data. pins. Monitor VITAG during programming;
measure JTAG signals for noise or
reflection.
0x805F -20 Failed to Programming file generated with an | Generate STAPL file with the latest version
verify older version of software of Designer/FlashPro; use the latest version
FlashROM at of FlashPro software.
row Device is programmed with a
<FlashROM | different design. Program with the correct data/design.
row number>.
Unstable VPUMP voltage level. Monitor related power supplies that cause
the issue during programming; check for
Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) for more information on transient
specifications.
Unstable VCC_ROSC voltage level
(SmartFusion only) Measure JTAG pins and noise or reflection.
Signal integrity issues on JTAG
pins.
0x8065 -22 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
program pass the issue during programming; check for
key. Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) for more information on transient
specifications.
Unstable VCC_ROSC voltage level
(SmartFusion only) Monitor VITAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins.
0x8066 -23 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
program AES the issue during programming; check for
key. Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) for more information on transient
specifications.
Unstable VCC_ROSC voltage level
(SmartFusion only) Measure JTAG pins and noise or reflection.
Signal integrity issues on JTAG
pins.
0x8055 -24 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
0x8056 program the issue during programming; check for
UROW. Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) for more information on transient
specifications.
Unstable VCC_ROSC voltage level
(SmartFusion only) Monitor VITAG during programming;
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SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for Software v8.6 and Above

ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins.
Make sure you mounted 0.01pF and
0.33uF caps on Vpump (close to the pin).
0x802A -27 FlashROM File contains no passkey and device | Provide a programming file with a passkey
Write/Erase is secured with a passkey. that matches the passkey programmed into
is protected the device.
by the Passkey in the file does not match
passkey. device.
A valid
passkey
needs to be
provided.
0x8025 -28 FPGA Array | File contains no passkey and device | Provide a programming file with a passkey
Write/Erase is secured with a passkey. that matches the passkey programmed into
is protected Passkey in the file does not match | the device.
by the device.
passkey.
A valid pass
key needs to
be provided.
0x802B -29 FlashROM File contains no passkey and device | Provide a programming file with a pass key
0x802D Read is is secured with a passkey. that matches the passkey programmed into
protected by | Passkey in the file does not match | the device
passkey. device.
A valid
passkey
needs to be
provided.
0x8024 -30 FPGA Array | File contains no passkey and device | Provide a programming file with a passkey
0x8026 verification is | is secured with a passkey. that matches the passkey programmed into
protected by | Passkey in the file does not match | the device.
a passkey. device.
A valid
passkey
needs to be
provided.

-31 Failed to AES key in the file does not match | Provide a programming file with an AES key
0x804B verify AES the device. that matches the AES key programmed into
0x8001 key. the device.
0x8007 Unstable VCC

Monitor related power supplies that cause
Unstable VCC_OSC (Fusion only) the issue during programming; check for
transients outside of Microsemi
Unstable VCC_ROSC voltage level | specifications. See your device datasheet
(SmartFusion only) for more information on transient
specifications.
Unstable JTAG/VPUMP voltage
level. Monitor VITAG during programming;
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Code Message
measure JTAG signals for noise or
reflection.
0x8000 -31 Failed to Programming file generated with an | Generate STAPL file with the latest version
verify AES older version of software of Designer/FlashPro; use the latest version
key. of FlashPro software.
Try again at a slower TCK
Contact Microsemi Technical Support
0x8020 -33 FPGA Array | File contains unencrypted array Provide a programming file with an
0x8022 encryption is | data, but device contains AES key. | encrypted FPGA Array data.
0x8028 enforced. A
programming
file with
encrypted
FPGA array
data needs to
be provided.
0x802C -34 FlashROM File contains unencrypted Provide a programming file with an
0x802F encryption is | FlashROM data, but the device encrypted FlashROM data.
enforced. A contains an AES key.
programming
file with
encrypted
FlashROM
data needs to
be provided.
0x801F -35 Failed to Pass key in file does not match Provide a programming file with a pass key
0x804A match pass pass key in device. that matches the pass key programmed into
key. the device.
0x802E -36 FlashROM File contains encrypted FlashROM, | Regenerate security programming file with
0x8030 Encryption is | but device encryption is not proper AES key.
not enforced. | enforced for FlashROM
Program device security.
Cannot
guarantee Retry programming FlashROM with
valid AES key encrypted programming file.
present in
target device.
Unable to
proceed with
Encrypted
FlashROM
programming.
0x8021 -37 FPGA Array | File contains encrypted FPGA Regenerate security programming file with
0x8023 Encryption is | Array, but the device encryption is proper AES key.
0x8027 not enforced. | not enforced for FPGA Array.
0x8029 Program device security.
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ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message
Cannot
guarantee Retry programming FPGA Array with
valid AES key encrypted programming file.
present in
target device.
Unable to
proceed with
Encrypted
FPGA Array
verification.
0x8067 -38 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
program pass the issue during programming; check for
key. Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) for more information on transient
specifications.
Unstable VCC_ROSC voltage level
(SmartFusion only) Measure JTAG pins and noise or reflection.
Signal integrity issues on JTAG
pins.
Bad device.
0x806F -39 ERROR: 2 or | Unstable VCC_NVM/VCC_OSC Monitor related power supplies that cause
0x8070 more errors voltage (Fusion only) the issue during programming; check for
0x8071 found on this transients outside of Microsemi
0x8081 page Unstable VCC_ENVM/VCC_ROSC | specifications. See your device datasheet
0x8082 (SmartFusion only) for more information on transient
0x8089 specifications.
NVM reset signal is floating in user
design Bias NVM reset to a logic state in user
design.
2 or more ECC errors found when
reading the eNVM Try reprogramming.
0x8010 -39 ERROR: 2 or | 2 or more ECC errors found when The master calibration data has been
more errors reading the master calibration data | corrupted. Try restoring master calibration
found on this from backup, if it exists, by running
page. RECOVER_CALIB.
Workaround: Disable optional procedure
CHECK AND_ BACKUP_CALIB
0x8013 -39 ERROR: 2 or | 2 or more ECC errors found when Rerun action to attempt to write backup
more errors verifying the backup calibration calibration again.
found on this
page. Workaround: Disable optional procedure
CHECK AND_ BACKUP_CALIB
0x8078 -40 Embedded Data in the file is encrypted with a Verify the programming file is generated
0x8079 Flash different AES key than the device. from the latest version of
0x807A Memory Designer/FlashPro.
0x8087 Block MAC
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ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message
0x8088 Failure.
0x8002 -42 Failed to File security settings do not match Provide a programming file with security
0x8003 verify security | device. setting that match the security settings
settings. programmed into the device.
0x8093 -42 Failed to Device eNVM/EFMB client JTAG Verify the device is programmed with the
verify protection settings are not correct eNVM/EFMB client JTAG protection
eNVM/EFMB | programmed or are programmed settings
client JTAG with different settings
protection
settings
0x8004 -43 Failed to File checksum and design name do | Verify the device is programmed with the
verify design | not match the device. correct data and design.
information.
0x8049 -44 Failed to The AES key in the file does not Provide a programming file with an AES key
verify AES match the AES key in the device. that matches the AES key programmed into
key. File does not contain an AES key the device.
and the device is secured with an
AES key.
0x8054 -45 Device Programming file was generated Generate STAPL file with the latest version
package with an older version of software of Designer/FlashPro; use the latest version
does not of FlashPro software.
match the

programming
file.

0x8033 -46 Embedded File contains no pass key or Provide a programming file with the correct
0x8038 Flash incorrect pass key but EFMB read is | pass key.
0x803D Memory secured with a pass key.
0x8042 Block X Read
0x8045 is protected
0x8046 by pass key.
0x8047 A valid pass
0x8048 key needs to
be provided.
0x8034 -46 Embedded File contains encrypted EFMB for Regenerate security programming file with
0x8039 Flash block X but the device encryption is | the proper AES key.
0x803E Memory not enforced for EFMB block X.
0x8043 Block (EFMB) Program device security. Retry
block X Read programming with EFMB block X with
is not encrypted programming file.
protected by
pass key.
EFMB

content is not
secure after
encrypted
programming.
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ERROR_CODE

Exit
Code

Exit
Message

Possible Cause

Possible Solution

Unable to
proceed with
encrypted
NVM
programming.

0x8032
0x8037
0x803C
0x8041

Embedded
Flash
Memory
Block (EFMB)
block X
encryption is
enforced. A
programming
file with
encrypted
EFMB data
needs to be
provided.

The programming EFMB data is not
encrypted, but the device contains
an AES key with encryption
enforced.

Provide a programming file with encrypted
EFMB data.

0x8031
0x8036
0x803B
0x8040

Embedded
Flash
Memory
Block (EFMB)
block X Write
is protected
by pass key.

A valid pass
key needs to
be provided.

File contains no pass key or
incorrect pass key, but device is
secured with a pass key.

Provide a programming file with a passkey
that matches the passkey programmed into
the device.

0x8035
0x803A
0x803F
0x8044

Embedded
Flash
Memory
Block (EFMB)
block X
Encryption is
not enforced.

Cannot
guarantee
valid AES key
present in
target device.

Unable to
proceed with
Encrypted
EFMB
programming.

File contains encrypted EFMB for
block X, but the device encryption is
not enforced for EFMB block X.

Regenerate security programming file with
proper AES key.

Program device security. Retry
programming EFMB block X with encrypted
programming file.

0x801A

No backup
calibration
data found or

No backup calibration copy has
been made or the backup copy has
been corrupted

If master copy is still intact, rerun Action to
create backup calibration copy.
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Code Message
backup Workaround: Disable optional procedure
calibration CHECK_AND_BACKUP_CALIB
data has
been
corrupted
8x804E -51 Failed to This version of the silicon does not | If programming the EFMB while the FPGA
access support programming of the is active is not required, then use actions
Embedded Embedded Flash Memory Block PROGRAM_NVM or VERIFY_NVM.
Flash while the FPGA Array is active. Otherwise, use latest revision of silicon.
Memory.
(AFS600
only)
0x804F -52 Failed to This version of the silicon does not | If programming the EFMB while the FPGA
access support programming of the is active is not required, then use actions
Embedded Embedded Flash Memory Block PROGRAM_NVM or VERIFY_NVM.
Flash while the FPGA Array is active. Otherwise, use latest revision of silicon.
Memory.
(AFS1500
only)
0x8050 -53 Failed to This version of the silicon does not | If programming the EFMB while the FPGA
access support programming block 3 of the | is active is not required, then use actions
Embedded EFMBs while the FPGA Array is PROGRAM_NVM or VERIFY_NVM.
Flash active. Otherwise, use EFMB blocks 0, 1, or 2, but
Memory. do not use block 3.
(AFS1500
only)
0x8051 -54 Failed to FPGA Array is accessing the target | If programming the EFMB while the FPGA
access EFMB block while attempting is active is not required, then use actions
Embedded programming. PROGRAM_NVM or VERIFY_NVM.
Flash Otherwise, check the FPGA design or use a
Memory. NVM reset signal is stuck in design. | different EFMB block that is not being
accessed. Check if target EFMB block logic
Unstable VCC is tied to reset.
MSS Clock is disabled during Monitor related power supplies that cause
programming. the issue during programming; check for
transients outside of Microsemi
MSS Clock is not properly routed to | specifications. See your device datasheet
the correct pin. for more information on transient
specifications.
Verify that the NVM reset signal in the
design is not stuck.
Verify the MSS clock is enabled during
programming.
If the MSS clock is defined as an external
I/O, then verify that it is properly routed to
the correct pin.
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ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message
0x808A -55 Failed to read | Programming file generated with an | Generate STAPL file with the latest version
0x8094 Embedded older version of software of Designer/FlashPro; use the latest version
Flash of FlashPro software
Memory
Block (EFMB) Try again at a slower TCK
Inspect device using Device Debug
Contact Microsemi Technical Support
0x808B -55 Failed to read | Unstable VPUMP voltage level. Monitor related power supplies that cause
Embedded the issue during programming; check for
Flash Unstable VCC transients outside of Microsemi
Memory specifications. See your device datasheet
Block (EFMB) | Unstable VCC_QOSC (Fusion only) for more information on transient
specifications.
Unstable VCC_ROSC voltage level
(SmartFusion only) Monitor VITAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG pins | reflection.
0x808C -55 Failed to read | Internal errror Contact Microsemi Technical Support
Embedded
Flash
Memory
Block (EFMB)
0x8011 -56 Failed to read Try reprogramming.
calibration
data Workaround: Disable optional procedure
CHECK_AND_BACKUP_CALIB
0x8012 -56 Failed to read | Unstable VCC Monitor related power
calibration supplies that cause the
data Unstable VCC_NVM/VCC_0OSC issue during
(Fusion only) programming; check for
transients outside of
Unstable VCC_ENVM/VCC_ROSC Microsemi specifications.
voltage level (SmartFusion only) See your device
datasheet for more
Signal integrity issues on JTAG pins information on transient
specifications.
Measure JTAG voltages,
noise, and reflection.
Try reprogramming.
Workaround: Disable
optional backup
procedure
CHECK_BACKUP_CALIB
0x808D -57 eNVM/EFMB | File contains no Pass Key and Provide a programming file with a Pass Key
0x8092 is protected device is secured with a Pass Key | that matches the Pass Key programmed
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ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message
by a Pass into the device
Key; you Pass Key in the file does not match
must provide | device
a valid Pass
Key

SmartFusion, IGLOO, ProASIC3 and FusionDevice Exit Codes for
pre-v8.6 Software

The table below lists exit codes for SmartFusion, IGLOO, ProASIC3 and Fusion devices in pre-v8.6 software
only. This includes v8.5 SP2, v8.5 SP1, v8.5, etc. See the Device Exit Codes for Software v8.6 and Above
help topic for exit codes for older versions.

Note: Exit codes with positive integers are reserved for current and future standard EXIT codes of the STAPL standard.

Exit codes with negative integers are reserved for vendor-specific EXIT codes.

Table 27 - Exit Codes for SmartFusion, IGLOO, ProASIC3 and Fusion Family Devices in pre-v8.6 Software

Exit Exit Message Possible Cause Possible Solution
Code
0 Passed (no error).
1 A physical chain Physical chain configuration has
does not match the | been altered. Something has
expected set up become disconnected in the chain.
from the STAPL The specific IR length of non-
file. Microsemi devices may be
Also known as incorrect.
Checking Chain The order of the specified chain
Error. may be incorrect.
5 Failed to enter Monitor VPUMP voltage during programming
programming Unstable VPUMP voltage level.
mode. Measure JTAG voltages, noise, and reflection.
Signal integrity issues on JTAG
pins. Generate STAPL file with the latest version of
Designer/FlashPro.
Older software or programming file | Use latest version of FlashPro software.
used.
6 Failed to verify Measure JTAG pins, noise and reflection.
IDCODE. Signal integrity issues on JTAG
pins.
8 Failed Erase Signal integrity issues on JTAG Monitor VPUMP voltage during programming.
Operation. pins. Measure JTAG voltages, noise, and reflection.
10 Failed to program | Signal integrity issues on JTAG Monitor VPUMP voltage during programming.
FPGA array at row | pins. Measure JTAG voltages, noise, or reflection.
" rowNumber,"."
10 Failed to enable Signal integrity issues on JTAG Monitor VPUMP voltage during programming.
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Exit Exit Message Possible Cause Possible Solution
Code
FPGA Array. pins. Measure JTAG voltages, noise, or reflection.
10 Failed to program | Signal integrity issues on JTAG Monitor VPUMP voltage during programming.
FlashROM. pins. Measure JTAG voltages, noise, and reflection.
11 Verify 0 failed at Device is programmed with a Run VERIFY_DEVICE_INFO to verify the device is
row",rowNumber,"." | different design. programmed with the correct data/design.
Verify 1 failed at Monitor VPUMP voltage during programming.
row",rowNumber,"." | Signal integrity issues on JTAG Measure JTAG voltages, noise and reflection .
Failed to verify pins.
FlashROM at
row",from
rowNumber-1.
14 Failed to program | Signal integrity issues on JTAG Monitor VPUMP voltage during programming.
Silicon Signature. pins. Measure JTAG voltages, noise, and reflection.
Failed to program
security lock
settings.
-18 Failed to Incorrect AES key. Generate a programming file with the correct AES key.
authenticate the
encrypted data. Signal integrity issues on JTAG Measure JTAG voltages, noise and reflection
pins.
-20 Failed to verify Device is programmed with a Program with the correct data/design.
FlashROM at row | different design.
Monitor VPUMP level during programming.
FRomRowNumber- | Signal integrity issues on JTAG Measure JTAG pins and noise or reflection.
1. pins.
-22 Failed to program | Unstable VPUMP voltage level. Monitor VPUMP voltage during programming.
pass key.
Signal integrity issues on JTAG Measure JTAG voltages, noise, and reflection.
pins.
-23 Failed to program Unstable VPUMP voltage level. Monitor VPUMP voltage during programming.
AES key.
Signal integrity issues on JTAG Measure JTAG pins and noise or reflection.
pins.
-24 Failed to program | Unstable VPUMP voltage level. Monitor VPUMP voltage during programming.
UROW.
Signal integrity issues on JTAG Measure JTAG voltages, noise, and reflection.
pins. Make sure you mounted 0.01iF and 0.33iF caps on
Vpump (close to the pin).
-25 Failed to enter Signal integrity issues on JTAG Measure JTAG voltages, noise, and reflection.
programming mode | pins.
-26 Failed to enter Signal integrity issues on JTAG Measure JTAG voltages, noise, and reflection.
programming mode | pins.
-27 FlashROM File contains no passkey and device | Provide a programming file with a passkey that matches
Write/Erase is is secured with a passkey. the passkey programmed into the device.
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Exit Exit Message Possible Cause Possible Solution
Code
protected by the Passkey in the file does not match
passkey. device.
A valid passkey
needs to be
provided.
-28 FPGA Array File contains no passkey and device | Provide a programming file with a passkey that matches
Write/Erase is is secured with a passkey. the passkey programmed into the device.
protected by the Passkey in the file does not match
passkey. device.
A valid pass key
needs to be
provided.
-29 FlashROM Read is | File contains no passkey and device | Provide a programming file with a pass key that matches
protected by is secured with a passkey. the passkey programmed into the device
passkey. Passkey in the file does not match
A valid passkey device.
needs to be
provided.
-30 FPGA Array File contains no passkey and device | Provide a programming file with a passkey that matches
verification is is secured with a passkey. the passkey programmed into the device.
protected by a Passkey in the file does not match
passkey. device.
A valid passkey
needs to be
provided.
-31 Failed to verify AES key in the file does not match | Provide a programming file with an AES key that matches
AES key. the device. the AES key programmed into the device.
Unstable JTAG/VPUMP voltage Monitor VPUMP/VJITAG voltage during programming.
level.
Measure JTAG voltages, noise, and reflection.
-32 Failed to verify File is not for M7, but target device | Check that the target device is M7 enabled.
IDCODE. is an M7. Make sure programming file generated is for M7 enabled
Target is an M7 device.
device Signal integrity issues on JTAG
pins. Measure JTAG pins , noise, and reflection.
-32 Failed to verify File is not for M1, but target device | Check that the target device is M1 enabled.
IDCODE. is an M1 device. Make sure programming file generated is for M1 enabled
Target is an M1 device.
device Signal integrity issues on JTAG
pins. Measure JTAG pins, noise, and reflection.
-32 Failed to verify File is not for target device. Check the target device. Make sure programming file
IDCODE. generated for target device.
Core enabled Signal integrity issues on JTAG pins
device detected Measure JTAG voltages, noise, and reflection.
-32 Failed to verify File is for M7, but target device is Check that the target device is not M7 enabled.
IDCODE. not M7. Make sure programming file generated is for non M7
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Exit Exit Message Possible Cause Possible Solution
Code
The target is not enabled device.
an M7 device Signal integrity issues on JTAG
pins. Measure JTAG voltages, noise, and reflection.
-32 Failed to verify File is for M1, but target device is Check that the target device is not M1 enabled.
IDCODE. not an M1 device. Make sure programming file generated is for non M1
The target is not an enabled device.
M1 device Signal integrity issues on JTAG
pins. Measure JTAG voltages, noise and reflection.
-33 FPGA Array File contains unencrypted array Provide a programming file with an encrypted FPGA Array
encryption is data, but device contains AES key. | data.
enforced. A
programming file
with encrypted
FPGA array data
needs to be
provided.
-34 FlashROM File contains unencrypted Provide a programming file with an encrypted FlashROM
encryption is FlashROM data, but the device data.
enforced. A contains an AES key.
programming file
with encrypted
FlashROM data
needs to be
provided.
-35 Failed to match Pass key in file does not match Provide a programming file with a pass key that matches
pass key. pass key in device. the pass key programmed into the device.
-36 FlashROM File contains encrypted FlashROM, | Regenerate security programming file with proper AES
Encryption is not but device encryption is not key.
enforced. enforced for FlashROM
Program device security.
Cannot guarantee
valid AES key Retry programming FlashROM with encrypted
present in target programming file.
device.
Unable to proceed
with Encrypted
FlashROM
programming.
-37 FPGA Array File contains encrypted FPGA Regenerate security programming file with proper AES
Encryption is not Array, but the device encryption is key.
enforced. not enforced for FPGA Array.
Program device security.
Cannot guarantee
valid AES key Retry programming FPGA Array with encrypted
present in target programming file.
device.
Unable to proceed
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Code
with Encrypted
FPGA Array
verification.
-38 Failed to program | Unstable VPUMP voltage level. Monitor VPUMP voltage during programming.
pass key.
Signal integrity issues on JTAG Measure JTAG pins and noise or reflection.
pins.
Bad device.
-39 Failed to verify Device is programmed with a Verify the device is programmed with the correct
Embedded Flash different design. data/design.
Memory Block Signal integrity issues on JTAG
(EFMB). pins. Monitor VPUMP voltage during programming.
Measure JTAG pins and noise or reflection.
The EFMB data was modified
through user FPGA design after Run DEVICE_INFO to confirm if the target EFMB block is
programming; this could occur locked with FlashLock (pass key). If the target EFMB block
during standalone verify. is locked, then you must unlock it by erasing the security
and then reprogramming with the desired security settings.
The target EFMB block is locked After unlocking the target EFMB block attempt to rerun the
with FlashLock when running target ACTION.
ACTION
PROGRAM_NVM_ACTIVE_ARRAY
or VERIFY_NVM_ACTIVE_ARRAY.
-40 Embedded Flash Data in the file is encrypted with a Verify the programming file is generated from the latest
Memory Block different AES key than the device. version of Designer/FlashPro.
MAC Failure.
-41 Error programming | Signal integrity issues on JTAG Measure JTAG pins and noise or reflection.
Embedded Flash pins.
Memory Block.
(EFMB)
-42 Failed to verify File security settings do not match Provide a programming file with security setting that match
security settings. device. the security settings programmed into the device.
-43 Failed to verify File checksum and design name do | Verify the device is programmed with the correct data and
design information. | not match the device. design.
-44 Failed to verify The AES key in the file does not Provide a programming file with an AES key that matches
AES key. match the AES key in the device. the AES key programmed into the device.
File does not contain an AES key
and the device is secured with an
AES key.
-45 Device package
does not match the
programming file.
-46 Embedded Flash File contains no pass key or Provide a programming file with the correct pass key.

Memory Block X
Read is protected
by pass key. A

incorrect pass key but EFMB read is
secured with a pass key.
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Exit
Code

Exit Message

Possible Cause

Possible Solution

valid pass key
needs to be
provided.

Embedded Flash
Memory Block,
block X encryption
is enforced. A
programming file
with encrypted
EFMB data needs
to be provided.

The programming EFMB data is not
encrypted, but the device contains
an AES key with encryption
enforced.

Provide a programming file with encrypted EFMB data.

Embedded Flash
Memory Block
(EFMB) block X
Write is protected
by pass key.

A valid pass key
needs to be
provided.

File contains no pass key or
incorrect pass key, but device is
secured with a pass key.

Provide a programming file with a passkey that matches
the passkey programmed into the device.

Embedded Flash
Memory Block
(EFMB) block X
Encryption is not
enforced.

Cannot guarantee
valid AES key
present in target
device.

Unable to proceed
with Encrypted
EFMB
programming.

File contains encrypted EFMB for
block X, but the device encryption is
not enforced for EFMB block X.

Regenerate security programming file with proper AES
key.

Program device security. Retry programming EFMB block
X with encrypted programming file.

Failed to access
Embedded Flash
Memory.
(AFS600 only)

This version of the silicon does not
support programming of the
Embedded Flash Memory Block
while the FPGA Array is active.

If programming the EFMB while the FPGA is active is not
required, then use actions PROGRAM_NVM or
VERIFY_NVM. Otherwise, use latest revision of silicon.

Failed to access
Embedded Flash
Memory.
(AFS1500 only)

This version of the silicon does not
support programming of the
Embedded Flash Memory Block
while the FPGA Array is active.

If programming the EFMB while the FPGA is active is not
required, then use actions PROGRAM_NVM or
VERIFY_NVM. Otherwise, use latest revision of silicon.

Failed to access
Embedded Flash
Memory.
(AFS1500 only)

This version of the silicon does not
support programming block 3 of the
EFMBs while the FPGA Array is
active.

If programming the EFMB while the FPGA is active is not
required, then use actions PROGRAM_NVM or
VERIFY_NVM. Otherwise, use EFMB blocks 0, 1, or 2, but
do not use block 3.

Failed to access

FPGA Array is accessing the target

If programming the EFMB while the FPGA is active is not
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Exit
Code

Exit Message

Possible Cause

Possible Solution

Embedded Flash
Memory.

EFMB block while attempting
programming.

NVM reset signal is stuck in design.

required, then use actions PROGRAM_NVM or
VERIFY_NVM. Otherwise, check the FPGA design or use
a different EFMB block that is not being accessed. Check if
target EFMB block logic is tied to reset.

Verify that the NVM reset signal in the design is not stuck.

ProASIC™Y® and ProASIC Exit Codes

The table below lists the exit codes for ProASIC

PLUS

and ProASIC family devices.

Table 28 - ProASIC ™S and ProASIC Family Devices Exit Codes
Exit Code Exit Message Possible Cause Possible Solution

0 This message
means passed.
This does not
indicate an error.

1 A physical chain Physical chain configuration
does not match the | has been altered. Something
expected set up has become disconnected in
from the STAPL the chain.
file. The specific IR length of
Also known as non-Microsemi devices may
Checking Chain be incorrect.

Error. The order of the specified
chain may be incorrect.

2 There is areading | The device either does not Check the device ID.
device ID failure. have a valid device ID or the

data cannot be read
correctly.

3 This occurs when | Connect was set up for a Set up for a ProASIC™"® device.
using ProASIC™*YS | ProASIC device and the
devices. device is actually

ProASICP™"S,

5 Programming set | The A500K device senses Power the VDDL down during programming. Check
up problem. Also the VDDL power supply as the device has the correct voltages on VDDP, VDDL,
known as Entering | being on. VPP, and VPN.

ISP Failure.
6 The IDCODE of The device targeted in the Choose the correct STAPL file and select the correct

the target device
does not match the
expected value in
the STAPL file.
This is a JEDEC
standard message.

STAPL file does not match
the device being
programmed.

User selected wrong device.
Device TRST pin is
grounded.

Noise or reflections on one

device.

Measure JTAG pins and noise or reflection. TRST
should be floating or tied high.

Cut down the extra length of ground connection.
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ProASICPLUS and ProASIC Exit Codes

Exit Code

Exit Message

Possible Cause

Possible Solution

or more of the JTAG pins
caused by the IR Bits
reading it back incorrectly.

Unknown
algorithm: alg=x,
prev=x Invalid data
read from device

This occurs with current
STAPL files when the
revision written into the
factory row is not rev 1 for
ProASICPLUS or rev 2 for
ProASIC devices. The
STAPL files from last year
may "exit 7" with newer
devices or the older revision
may cause this failure if the
STAPL file used is from
latest version.

It can occur if you are using
Engineering Sample parts
that are no longer supported,
such as ProASIC
Engineering Sample parts.
This error can also occur if
the programmer has trouble
reading the factory row due
to signal noise, crosstalk, or
reflections on the JTAG
signal and clock lines.

It can occur if you program
an -F ProASICPLUS device
with an old STAPL file.

This error occurs if you
connected VPP and VPN the
wrong way.

It occurs if there are no
bypass Caps on VPP VPN,
which damaged the device.

This error may occur if your
power supply cannot source
the correct current for
programming.

Re-generate STAPL file from Designer 6.1 SP1.
Replace A500K ES parts with commercial parts.
Double check VPP and VPN connections.

Make sure VPP and VPN have correct bypass caps.
Make sure that your power supply can deliver the
correct current during programming.

FPGA failed during
the erase
operation.

The device is secured, and
the corresponding STAPL
file is not loaded.

The device has been
permanently secured and
cannot be unlocked.

Load the correct STAPL file.

11

FPGA failed verify

The device is secured and
the corresponding STAPL
file is not loaded.

You used the Libero IDE
software v2.3 or earlier or
the Designer R1-2003
software or earlier to

Load the correct STAPL file.

Use later software versions —at least Libero v2.3
SP1 and Designer R1-2003 SP1.

Double-check the VPN bypass caps polarity.
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Exit Code

Exit Message

Possible Cause

Possible Solution

generate the STAPL file.
VPN caps were soldered in
the wrong polarity.

12 Security is The device is secured and
enabled. the wrong key/STAPL file

was entered.

The device is damaged.
The verification was
interrupted and therefore
fails, causing the software to
think the device is secure.

14 Program security
failure.

15 This is a factory During program, erase, or
Calibration Data verify, you must read back
CRC error. Calibration Data from the

FPGA. The data contains a
CRC. You use the CRC to
ensure the data is not
corrupted/wrong.

Device is damaged.

Noise on the FTAL signals
causes the programmer to
read back wrong data.

17 The device has The device is secured and Load the correct STAPL file.
been secured. the wrong key or STAPL file
Write-security is was entered.
enabled. The device is damaged.

-54 Failed to access Analog power supplies Connect the analog power supplies (Vccl5A,
Embedded Flash (Vccl5A, Vee33A, GNDAQ Vce33A, GNDAQ and GNDA)
Memory and GNDA) are not

connected.

-80 Error code results | An internal calibration (based | Check voltages on the device pins.
from STAPL files on DDP and VPP) failed. Check voltages on the VDDP and VPP pins.
for A500K devices.

-90 Unexpected RCK | Noise on the RCK signal. Disconnect the RCK and make sure TCK has a clean

detected.

You connected a CLK
source to the RCK signal.
The polarized bypass
capacitors on VPP or VPN
are reversed-biased and are
affecting the programmer’s
VPP or VPN output voltage.
This causes programming to
fail. Several FlashPros are
programming at the same
time and are too close to
each other.

Programmer not properly

signal.

Separate FlashPros away from each other while they
are programming Internal ISP.

Connect programmer as an Admin in FlashPro.
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ProASICPLUS and ProASIC Exit Codes

Exit Code

Exit Message

Possible Cause

Possible Solution

installed by Admin.

Calibration data
parity error.

Device is damaged.

Replace the device.

Null

Several FlashPros are
programming at the same
time and are too close to
each other.

FlashPro connects to PC
parallel port through a
dongle key.

Data length mismatch when
performing DRSCAN on
STAPL file.

Cable to target is
not connected

properly.

When the Analyze command
is executed, the FlashPro
looks for target devices. If
the cable connection is
wrong, FlashPro assumes
that nothing is connected at
all.

Confirm the connection between the header to the
device. If the board supplies the power to the device,
make sure the voltage level is correct.

Chain integrity test
failed: xx

The connection between the
FlashPro programmer and
the device is broken.

The programmer cable might
not be securely inserted into
the header.

The header is not connected
to the JTAG pins of the
FPGA correctly.

The configuration setting
(ProASIC/ProASICPLUS)
does not match the target
device.

Noise or reflections on the
JTAG pins has caused
communication between the
programmer and the device
to fail.

A dongle is plugged in
between the PC parallel port
and the FlashPro parallel
port cable.

Secure the connections.

Check the JTAG pins for signal activity.

Check for broken TDO, TMS, and TCK pins.

After checking all type of connections if the failure
exists, you may need to replace the first device (the
devices closest to the TDO of the programming
header) in the chain.

Remove the dongle.

Could not connect
to programmer on
port Ip1 or parallel
port device does
not support IEEE-
1284 negotiation

The remote device does not
respond to the negotiation
protocol, for a variety of
reasons.

Make sure the port is connected.

Make sure the connected device is a FlashPro/Lite
programmer.

Turn the programmer on.

Check parallel port setting in BIOS.

Make sure that there are no dongles in between the
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Exit Code

Exit Message

Possible Cause

Possible Solution

protocol

parallel port and the FlashPro connection.

Try another parallel cable, the parallel cable might be
defective.

Check to see if the programmer is damaged.

Make sure the FlashPro Lite has power. The
FlashPro Lite is powered from the target board
through the Vdd pin of the programming header.
Make sure the Vdd pin is connected and the target
board is powered up.

Secure the connection between the cable connector
and the programming header.

Before you program any devices, you should run the
self-diagnostic test. The diagnostic software can be
found on the Microsemi web site. If the test fails,
please contact Microsemi Customer Technical
Support at tech@Microsemi.com for credit and
replacement.

Note: The Self-test is only available for FlashPro, not
FlashPro Lite.

External voltage
detected on

The voltage supply for the
FPGA is driven by another

Set appropriate options in the Connect menu.

<Supply> source (board, external
power-supply), but the user
forgot to turn off the supply in
the Connect menu.
VDPP There is no Vddp voltage Check the Vddp supply on the board for appropriate

Disconnected.

supply to the FPGA.

You accidentally turned off
the Vddp supply in the
Connect menu.

The Vddp supply on the
board is not functioning.

voltages and correct the Connect menu.

More than one unidentified device.

If you want to
perform an
operation on the
ProASIC device,
the rest of the
devices in the
chain must be in
bypass mode.

To put devices in
bypass mode,
select
Configuration >
Chain Parameter
(or click the Chain
Parameter button
in the Single
STAPL
Configuration

STAPL settings of Pre IR,
Pre DR, Post IR, and Post
DR do not match the chain
configuration.

One or more of the devices
in the chain is damaged and
the ID CODE cannot be read
back.

Make sure you have set Pre IR, Pre DR, Post IR,
and Post DR to match the chain configuration. If you
are still experiencing the failure, it is likely that the
device's ID CODE cannot be read and you need to
replace the device.
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Exit Code

Exit Message

Possible Cause

Possible Solution

window), then set
the Pre IR, Pre DR,
Post IR or Post
DR.

Cannot find the
programmer with
ID xxx

The programmer is removed
from the PC.

Delete programmer (or reconnect programmer) and
select the Refresh Programmer button. See
Connecting Programmers for more information.

Fatal Error: Please
check programmer
set up.

Software cannot resolve the
error encountered in the
programmer.

Save the project file, restart the software, and power
cycle the programmer.

External voltage
xxx mV is detected
on XXX.

You have specified the
programmer to drive the xxx
but external xxx is detected.

Deselect the xxx in the programmer setting.

Executing action
xxx failed.

The STAPL runtime failed.

Executing action
xXx with serial
index/action xx
failed.

The STAPL runtime failed.

No Vpump voltage
source is detected.

Select the Vpump in the Programmer setting. Make
sure the external Vpump is properly turned on.

Vpump short
detected.

Use a different programmer. If the problem persists,
check the board layout.

xxxX Mhz TCK
frequency in this
STAPL file is not
supported by the
FlashPro Lite
detected. It
supports only 4
MHz TCK
frequency.

Check FlashPro Lite version being used. Use
FlashPro Lite Rev C or modify the STAPL file to 4
MHz.

xxX Mhz TCK
frequency in this
STAPL file is not
supported by the
FlashPro Lite
RevC detected. It
supports only 1, 2
or 4 Mhz TCK
frequency.

Modify STAPL file to 1, 2, or 4 MHz.

Cannot find the
serial Index/Action
xxx in STAPL file.

Mismatch between STAPL
file and the Index/Action
selection.

Make sure the STAPL file was not overwritten. Save
the project with updated serial/action selection.
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Exit Code

Exit Message

Possible Cause

Possible Solution

Duplicated serial
Index/Action xxx
was removed.

Mismatch between STAPL
file and the Index/Action
selection.

Make sure the STAPL file was not overwritten. Save
the project with updated serial/action selection.

Using local backup
copy XXX

Cannot find original copy.

Check for available space on the disk. Check that
write permissions are enabled.

FlashPro cannot
rename the
programmer/device
with an existing
name.

Name is already in use.

Create a new name.

FlashPro cannot
rename the
programmer/device
with an invalid
character.

Invalid character used in
programmer/device name.

Do not use invalid characters.

Automatic check
for updates.

FlashPro can check the Microsemi website to find if
an updated version of the software is available. If you
would like to have FlashPro automatically check for
software updates, choose Preferences from the File
menu. From the Updates tab, you can choose your
automatic software update settings. You can also
select Software Updates from the Help menu for
updates to the FlashPro software.

FlashPro parse
error.

FlashPro software failed to
parse the file.

FlashPro does not
support STAPL
files for xxx.

STAPL file not allowed.

Use a STAPL file for your device that is supported by
FlashPro.
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DC Characteristics for FlashPro5/4/3/3X

Electrical Parameters

DC Characteristics for FlashPro5/4/3/3X

Note: The target board must provide the VCC, VCCI, VPUMP, and VJTAG during programming. However, if there is
only one ProASIC3 device on the target board, the FlashPro5/4/3/3X can provide the VPUMP power supply via the USB

port.

The VJTAG signal is driven from a regulator internal to the FP4. The regulator can source up to 100mA on the VJTAG

pin.
Table 29 - DC Characteristic for FlashPro5/4/3/3X
Description Symbol Min Max Unit
Input low voltage, TDO VIL -0.5 0.35*VJTAG |V
Input high voltage, TDO VIH 0.65*VJTAG | 3.6 \%
Input current, TDO 1L, 1IH -20 +20 mA
Input capacitance, TDO 40 pF
Output voltage, VPUMP, VPP +3.0 +3.6 \Y
operating
Output current, VPUMP IPP 250 mA
VJITAG = 1.5V
Output low voltage, TCK, TMS, |VOL 0.0 0.2 \Y
TDI, 100pA load
Output low voltage, TCK, TMS, |VOL 0.0 0.30*VJITAG |V
TDI, 4mA load
Output high voltage, TCK, TMS, |V VJIJTAG-0.2 |[VJITAG \Y
TDI, 100pA load
Output high voltage, TCK, TMS, | VOH 0.70*"VJTAG | VITAG \
TDI, 4mA load
Output current, TCK, TMS, TDI 10L, -4 +4 mA
IOH

VITAG = 1.8V
Output low voltage, TCK, TMS, | VOL 0.0 0.2 Y,

TDI, 100pA load

Output low voltage, TCK, TMS, |VOL 0.0 0.3 \Y
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Description Symbol Min Max Unit

TDI, 6mA load

Output high voltage, TCK, TMS, | VOH VITAG-0.2 | VITAG \%

TDI, 100pA load

Output high voltage, TCK, TMS, | VOH 1.25 VITAG \Y

TDI, 6mA load

Output current, TCK, TMS, TDI | IOL, -6 +6 mA
IOH

VITAG = 2.5V

Output low voltage, TCK, TMS, | VOL 0.0 0.2 \%

TDI, 100pA load

Output low voltage, TCK, TMS, | VOL 0.0 0.6 \Y

TDI, 8mA load

Output high voltage, TCK, TMS, | VOH VITAG-0.2 | VITAG \%

TDI, 100uA load

Output high voltage, TCK, TMS, | VOH 1.8 VITAG \%

TDI, 8mA load

Output current, TCK, TMS, TDI 10L, -8 +8 mA
IOH

VITAG = 3.3V

Output low voltage, TCK, TMS, | VOL 0.0 0.2 \Y

TDI, 100pA load

Output low voltage, TCK, TMS, |VOL 0.6 \%

TDI, 8mA load

Output high voltage, TCK, TMS, | VOH VITAG-0.2 | VIJTAG \Y

TDI, 100pA load

Output high voltage, TCK, TMS, | VOH 2.4 VITAG \%

TDI, 8mA load

Output current, TCK, TMS, TDI 10L, -8 +8 mA
IOH

DC Characteristics for FlashPro Lite

Table 30 - DC Characteristic for FlashPro Lite

Description Symbol Min Max | Unit

Input low voltage, TDO VIL -0.5 0.7 \Y,
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DC Characteristics for FlashPro

Description Symbol Min Max | Unit
Input high voltage, TDO VIH 1.7 5.0 \%
Input current, TDO 1L, 1IH -10 +10 uA
Input capacitance, TDO 40 pF
Input voltage, VDD, operating (see note) +2.3 | +3.5 \%
Input voltage, VDD, power off -1.0 +1.0 \%
Input current, VDD IVDD 500 mA
Output voltage, VPP, operating VPP +15.9 | +16.5 |V
Output voltage, VPN, operating VPN -13.8 | -134 | V
Output current, IPP IPP 0 35 mA
Output current, IPN IPN 0 -15 mA
Output low voltage, TCK, TMS, TDI, 100uA load VOL 0.0 0.2 \Y
Output low voltage, TCK, TMS, TDI, 1mA load VOL 0.0 0.5 V
Output low voltage, TCK, TMS, TDI, 2mA load VOL 0.0 0.8 \%
Output high voltage, TCK, TMS, TDI, 100uA load VOH 2.1 25 \%
Output high voltage, TCK, TMS, TDI, 1mA load VOH 1.9 2.5 \Y
Output high voltage, TCK, TMS, TDI, 2mA load VOH 1.6 25 \%
Output current, TCK, TMS, TDI, nTRST IOL, IOH | -2 +2 mA

Note: Up to 3.5 V can be supplied to the FlashPro Lite on the VDD pin. However, if the VDD supply for the FlashPro is
also connected to the APA VDD supply, the voltage for the VDD pin cannot exceed 2.7 V.

DC Characteristics for FlashPro

Table 31 - DC Characteristic for FlashPro

Description Symbol Min Max Unit
Input low voltage, TDO VIL -0.5 0.30 * \%
VDDP
Input high voltage, TDO VIH 0.70* 5.5 \%
VDDP
Input current, TDO IL, IIH -10 +10 UuA
Input voltage, VDDP, VDDL 0 5.25 \Y
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Input voltage, VPP 0 21.0 \%
Input voltage, VPN -21.0 \%
Input current, VDDP, VDDL, VPN, VP IVCC 5.0 mA
Output voltage range, VDDP VDDP 1.5 3.3 \%
Output voltage range, VPP VPP 15.0 18.0 \%
Output voltage range, VPN VPN -16.0 -12.0 \%
Output voltage resolution / Acccuracy 100/ £50 mV
Output current, IDDP IDDP -135% +135 mA
Output current, IDDL IDDL -135* +135 mA
Output current, IPP IPP -2701* +270 mA
Output current, IPN IPN -270 +270! mA
Output low voltage, TCK, TMS, TDI, OUTO, | VOL 0.0 0.4 V
NTRST
Output high voltage, TCK, TMS, TDI, OUTO, | VOH 0.85* +0.3 \%
NTRST VDDP VDDP
Output current, TCK, TMS, TDI, OUTO, 10L, -12 +12 mA
NnTRST IOH

Note (1): When power supply mode is set to ABI_ GROUND.

* - If you want to power-up the device from the board power supply, clear the checkboxes for VDDL and VDDP. VPP and
VPN are required during programming only and are supplied by the FlashPro programmer.

(2) Microsemi does not have operating temperature information for the FlashPro programmer. FlashPro is intended to be
used as lab or production equipment and not tested at extreme temperatures. All devices in the unit are commercial temp.
FlashPro4 went through a burn-in cycle operating at 100C for 250 hours during quality testing. This involved repeatedly

powering the programmers and then programming after the burn in; they are not actively programming during the burn in.
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FlashPro4

Electrical Specifications

FlashPro4

The FlashPro4 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector
on the FlashPro4 unit is a 2x5, RA male Header connector, which is manufactured by AMP and has a
manufacturer’s part number of 103310-1. This is a standard 2x5, 0.1 pitch connector which is keyed. Use
the 10 pin right-angle header, AMP P/N 103310-1 (DigiKey P/N A26285-ND) for FlashPro4 and use the 10
pin straight header, AMP P/N 103308-1 (DigiKey P/N A26267-ND) for the straight version..

The signals on the pins of the FlashPro4 10-pin connector are shown in the figure below (extracted from
FlashPro4 product specification):

-~ TCK|1 2 |GND =~—
— TDO|3 4 |PROG_MODE —
— Tms[s 6 |VITAG -———
- Veump |7 g |nTRST ——=
-« TDI|9 10 [GND <+—»

Figure 151 - FlashPro4 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer itself. Arrows

show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.
Table 32 - FlashPro4 Signal Description

Signal Description
VPUMP 3.3V Programming voltage
GND Signal reference
TCK JTAG clock
TDI JTAG data input to device
TDO JTAG data output from device
T™MS JTAG mode select
NTRST Programmable output pin may be set to off, toggle, low, or high level
VITAG Reference voltage from the target board
PROG_MODE | IGLOO v2_family - Used for switching from VCC 1.2V to 1.5V during
programming
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Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the “Drive TRST” flag will be required to force the
JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to
select this flag.

FlashPro3

The FlashPro3 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector
on the FlashPro3 unit is a 2x5, RA male Header connector, which is manufactured by AMP and has a
manufacturer’s part number of 103310-1. This is a standard 2x5, 0.1 pitch connector which is keyed. Use
the 10 pin right-angle header, AMP P/N 103310-1 (DigiKey P/N A26285-ND) for FlashPro5/4/3/3X and use
the 10 pin straight header, AMP P/N 103308-1 (DigiKey P/N A26267-ND) for the straight version.

The signals on the pins of the FlashPro3 10-pin connector are shown in the figure below (extracted from
FlashPro3 product specification):

-— TCK|1 2 |GND =—
— D03 4 |N/C

*—TMS[S 6 |VITAG =—
- Voume |7 & |nTRST —4mw
- TDI|9 10 |[GND «—

Figure 152 - FlashPro3 10-Pin Connector
Note: All ground pins must be connected. The rectangular shape shows connections on the programmer itself. Arrows

show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.
Table 33 - FlashPro3 Signal Description

Signal Description
VPUMP [ 3.3V Programming voltage
GND Signal reference
TCK JTAG clock
TDI JTAG data input to device
TDO JTAG data output from device
T™MS JTAG mode select
NTRST | Programmable output pin may be set to off, toggle, low, or high level
VJIJTAG [ Reference voltage from the target board
N/C Programmer does not connect to this pin
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FlashPro Lite

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the “Drive TRST” flag will be required to force the

JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to
select this flag.

FlashPro Lite

For FlashPro Lite, the existing 26-pin connector is shown in the figure below.

N/C|1 2 IN/C

N/C|3 4 IN/C
N/C|5 6 |Vep ——
-~ GND}7 8 |Ven —
- GNDJ9 10 |SENSE -~
-— GND| 11 12 |TCK -
N/C| 13 14 {TDI .-
N/C L15 16 |TDO -—
-— GNDI17 18 |[TMS —
-— GND |19 20 |OUTO/RCK ——=
N/C |21 22 InTRST —
N/C|23 24 |Vop -—
N/C |25 26 |Vop -—

Figure 153 - 26-pin Connector for FlashPro Lite
Note: All ground pins must be connected. The rectangular shape shows connections on the programmer itself. Arrows

show current flow towards or from the rectangular programmer.
The appropriate SAMTEC micro connector target cable for this is:
Samtec FFSD-13-D-12.00-01-N.

The 12 inch cable is specified. This is likely to be more than enough to connect to the board and reducing
the inductance will help compared with 18 inches, which is supplied by the default with FlashPro Lite.

See the table below for a description of the signals.
Table 34 - FlashPro Lite Signal Description

Signal Description
VDDP VDD supply for logic I/0O pads
VDDL VDD supply for core
VPP Positive programming supply (+16.5V)
VPN Negative programming supply(-13.8V)
GND Signal reference
SENSE Input from target board to programmer to indicate connection to ground
TCK JTAG clock
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Signal Description

TDI JTAG data input to device

TDO JTAG data output from device

T™MS JTAG mode select

NTRST Programmable output pin may be set to off, toggle, low, or high level

RCK/OUTO | Programmable output pin may be set to off, toggle, low, or high level

N/C Programmer does not connect to this pin

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the "Drive TRST" flag will be required to force the
JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to
select this flag.

FlashPro

For FlashPro, you can use the same 26-pin target cable you used for FlashPro Lite, but the connections are
shown in the figure below.

-  2.5V/3.3V| 2 |Vooe —
-— 2.5V/3.3V|3 4 |\oor .
—  2.5V/3.3V|5 6 Ve E—
-~ GND|7 8 |Ven —
-~ GNDJg 10 [SENSE -—
- GND| 11 12 |TCK -

N/C| 13 14 |TDI -

N/C L 15 16 [TDO -
-~ GNDI7 18 |[TMS _—
- GND |19 20 |[RCK/OUTO —
- 2.5V |21 22 InTRST -
-— 2.5V |23 24 |Voou —
- 2.5V |25 26 | Voo, —

Figure 154 - 26-pin connections for FlashPro
Note: All ground pins must be connected. The rectangular shape shows connections on the programmer itself. Arrows

show current flow towards or from the rectangular programmer.

The table below shows the signal pin descriptions for FlashPro.
Table 35 - FlashPro Signal Description

Signal Description

VDDP VDD supply for logic 1/0 pads
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Signal Description
VDDL VDD supply for core
VPP Positive programming supply (+16.5 V)
VPN Negative programming supply (-13.8 V)
GND Signal reference
SENSE Input from target board to programmer to indicate connection to
ground
TCK JTAG clock
TDI JTAG data input to device
TDO JTAG data output from device
T™MS JTAG mode select
NTRST Programmable output pin may be set to off, toggle, low, or high
level
RCK/OUTO Programmable output pin may be set to off, toggle, low, or high
level
2.5V, 2.5V/3.3V, Programmer does not connect to these pins
N/C

& Microsemi
FlashPro 5/4/3/3X Characteristics

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the "Drive TRST" flag will be required to force the
JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to

select this flag.

FlashPro 5/4/3/3X Characteristics

Table 36 - JTAG Switching Characteristics for FlashPro5/4/3/3X

Description Symbol Min | Max | Unit
Output delay from TCK to TDI, TMS TTCKTDI -2 2 ns
TDO setup time before TCK rising, VIJTAG=3.3 TTDOTCK |12 ns
TDO setup time before TCK rising, VIJTAG=1.5 TTDOTCK | 145 ns
TDO hold time after TCK rising TTCKTDO |0 ns
TCK period TTCK 41.7 | 10667 |ns
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FlashPro and FlashPro Lite Characteristics

The table below shows the JTAG switching characteristics for FlashPro and FlashPro Lite measured at the
programmer end of the JTAG cable.

Table 37 - JTAG Switching Characteristics for FlashPro and FlashPro Lite

Description Symbol Min | Max | Unit
Output delay from TCK falling to TDI, | TTCKTDI 2 |2 ns
T™MS
TDO setup time before TCK rising TTDOTCK 5.0 ns
TDO hold time after TCK rising TTCKTDO | 0 ns
TCK period TTCK 40 (10240 |ns

lllustration of the JTAG Switching Characteristics

The figure below is an illustration of the JTAG switching characteristics.

X

WWW

TCK

TMS, TDI

A
-—[1cx B

Trouton —=

TTDCTCHAP‘

TrckToo—m
Figure 155 - JTAG Switching Characteristics

Device Debug

Device Debug / SmartDebug enables you to use JTAG to interrogate and view embedded silicon features

and device status (FlashROM, Security Settings, Embedded Flash Memory (NVM) and Analog System).

It provides tools to help troubleshoot some of the common issues related to the Embedded Flash Memory

and Analog System.

Device Debug supports IGLOO, ProASIC3, SmartFusion and Fusion devices. SmartDebug supports

SmartFusion2 and ProASIC3 devices.

The user support is separated into two sections:

e Using Device Debug to Find Solutions to Common Issues - Contains common issues and

troubleshooting instructions that will enable you to solve your problems as quickly as possible.

e Frequently Asked Questions - Answers to the most frequently asked questions about the tools and
silicon features related to your solution.
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Getting Started with Device Debug

If you are unfamiliar with Device Debug, you may find it helpful to review the Getting Started with Device
Debug topic. You can view descriptions of the Device Debug interface in the Reference section of the help.

Getting Started with Device Debug
This topic introduces the basic elements and features of Device Debug. If you are already familiar with the
user interface then proceed to Solutions to Common Problems or Frequently Asked Questions sections.

Device Debug (SmartDebug for some families) enables you to use JTAG to interrogate and view embedded
silicon features and device status (FlashROM, Security Settings, Embedded Flash Memory (NVM) and
Analog System). Device Debug is available as a part of the FlashPro programming tool.

See the Using Device Debug topic for an overview of the use flow.

You can use the debugger to:
e Get device status and view diagnostics

e Use the FlashROM debug GUI to read out and compare content

e Use the Embedded Flash Memory Debug GUI to read out and compare your content with your original
files

e Use the Analog System Debug to read out and compare your analog block configuration with your
original file

Using Device Debug

The most common flow for Device Debug is:
1. Start FlashPro. If necessary, create a new project.

2. Set up your FlashPro Project with or without a PDB file. If you are in single-device mode you will need
a PDB file. You can create a PDB file in both Single Device and Chain mode.

With a PDB, you will get additional information such as FlashROM and Embedded Flash Memory
partitions when debugging the silicon features. Best practice is to use a PDB with a valid-use design to
start a debug session.

3. Select the target device from your chain and click Inspect Device.
Click Device Status to get device status and check for issues

5.  Examine individual silicon features (FlashROM, Embedded Flash Memory Block and Analog System)
on the device.
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Solutions to Common Issues Using Device
Debug

Embedded Flash Memory (NVM) - Failure when
Programming/Verifying
If the Embedded Flash Memory failed verification when executing the PROGRAM_NVM, VERIFY_NVM or

PROGRAM_NVM_ACTIVE_ARRAY action, the failing page may be corrupted. To confirm and address this
issue:

1. Inthe Inspect Device window click View Flash Memory Content.

2. Select the Flash Memory block and client (or page range) to retrieve from the device.
3. Click Read from Device; the retrieved data appears in the lower part of the window.
4. Click View Detailed Status to check the NVM Status.

Note: Note: You can use the check_flash_memory and read_flash_memory Tcl commands to perform
diagnostics similar to the commands outlined above.

5. Ifthe NVM is corrupted you must reset the affected NVM pages.

To reset the affected NVM pages, either re-program the pages with your original data or ‘zero-out’ the
pages by using the Tcl command recover flash_memory.

If the Embedded Flash Memory failed verification when executing a VERIFY_NVM or
VERIFY_NVM_ACTIVE_ARRAY action, the failure may be due to the change of content in your design. To
confirm this, repeat steps 1-3 above.

NOTE: NVM corruption is still possible when writing from user design. Check NVM status for confirmation.

Analog System Not Working as Expected

If the Analog System is not working correctly, it may be due the following:
1. System supply issue. To troubleshoot:

e Physically verify that all the supplies are properly connected to the device and they are at the proper
level. Then confirm by running the Device Status.

¢ Physically verify that the relevant channels are correctly connected to the device.
2. Analog system is not properly configured. You can confirm this by examining the Analog System.

ADC Not Sampling the Correct Value

If the ADC is sampling all zero values then the wrong analog pin may be connected to the system, or the
analog pin is disconnected. If that is not the case and the ADC is not sampling the correct value, it may be
due to the following:

1. System supply issues - Run the device status to confirm.

2. Analog system is not configured at all - To confirm, read out the ACM configuration and verify if the
ACM content is all zero.

3. Analog system is not configured correctly - To confirm, read out the ACM configuration and verify that
the configuration is as expected .

Once analog block configuration has been confirmed, you can use the sample_analog_channel Tcl
command for debug sampling of the analog channel with user-supplied sampling parameters.
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ADC Not Sampling the Correct Value

If you have access to your Analog System Builder settings project (<Libero IDE
project>/Smartgen/AnalogBlock), you may use the compare function provided by the tool.
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Freqguently Asked Questions

How do |

How do |

How do |

unlock the device security so | can debug?

You must provide the PDB file with a User Pass Key in order to unlock the device and continue debugging.

If you do not have a PDB with User Pass Key, you can create a PDB file in FlashPro (if you know the Pass
Key value).

export a report?

You can export three reports from the Device Debug GUI: Device Status, Client Detailed Status from the
NVM, or the Compare Client Content report from the NVM. Each of those reports can be saved and printed.
If using a Tcl command, you can use the —file <filename> option for the following commands:
read_flash_memory

check flash_memory

compare_memory client

read_device_status
read_flashrom
read_analog_block_config

sample_analog_channel
compare_flashrom client

compare_analog_config

For example, you can use the following command to export the content of the client ‘datastorel’ in NVM
block 0 to the report file datastorel_content.txt:
read_flash_memory —client “datastorel” —file {C:\temp\datastorel content.txt}

generate diagnostic reports for my target device?

A set of diagnostic reports can be generated for your target device depending on which silicon feature you
are debugging. A set of Tcl commands are available to export those reports. The following is a summary of
those Tcl commands based on the silicon features.

When using the —file parameter, ensure that you use a different file name for each command so you do not
overwrite the report content. If you do not specify the —file option in the Tcl, the output results will be directed
to the FlashPro log window.

For the overall device:

read_device_status

read_id_code

For FlashROM:

compare_flashrom_client
read_flashrom

For Embedded Flash Memory (NVM):

compare_memory_client

check_flash_memory
read_flash_memory

For Analog Block:

read_analog block config
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Where can | find files to compare my contents/settings?

compare_analog_config
sample_analog_channel

To execute the Tcl command, from the File menu choose Run Script.

Where can | find files to compare my contents/settings?

FlashROM

You can compare the FlashROM content in the device with the data in the PDB file. You can find the PDB in
the <Libero IDE project>/Designer/Impl directory.

Embedded Flash Memory (NVM)

You can compare the Embedded Flash Memory content in the device with the data in the PDB file. You can
find the PDB in the <Libero IDE project>/Designer/Impl directory.

Analog System

You can compare the Analog System configuration in the device with the data in the loaded PDB file or in
the Analog System folder. Go to:

e Fusion devices - <Libero IDE project>/Smartgen/AnalogBlock
e SmartFusion devices - <Libero IDE Project>/component/<SmartDesign Project>/MSS_ACE_0

The tool automatically identifies the necessary files in the selected folder for comparison.

What is a UFC file? What is an EFC file?

UFC is the User FlashROM Configuration file, generated by the FlashROM configurator; it contains the
partition information set by the user. It also contains the user-selected data for region types with static data.

However, for AUTO_INC and READ_FROM_FILE, regions the UFC file contains only:
e Start value, end value, and step size for AUTO_INC regions, and
¢ File directory for READ_FROM_FILE regions

EFC is the Embedded Flash Configuration file, generated by the Flash Memory Builder in the Project
Manager Catalog; it contains the partition information and data set by the user.

Both UFC and EFC information is embedded in the PDB when you generate the PDB file.

Is my FPGA fabric enabled?

When your FPGA fabric is programmed, you will see the following statement under Device State in the
Device Status report:

FPGA Array Status: Programmed and Enabled
If the FPGA fabric is not programmed, the Device State shows:
FPGA Array Status: Not Enabled
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Embedded Flash Memory (NVM) Frequently
Asked Questions

Is my Embedded Flash Memory (NVM) programmed?

To figure out if your NVM is programmed, read out and view the NVM content or perform verification with the
PDB file.

To examine the NVM content, see the FlashROM Memory Content Dialog Box.

To verify the NVM with the PDB select the VERIFY or VERIEY NVM action in FlashPro.

How do | display Embedded Flash Memory (NVM) content in the
Client partition?
You must load your PDB into your FlashPro project in order to view the Embedded Flash Memory content in
the Client partition. To view NVM content in the client partition:
1. Load your PDB into your FlashPro project.
Click Inspect Device.
Click View Flash Memory Content.
Choose a block from the drop-down menu.

Select a client.

Click Read from Device. The Embedded Flash Memory content from the device appears in the Flash
Memory dialog box.

See the Flash Memory Dialog Box topic for more description on viewing the NVM content.

A

How do | know if | have Embedded Flash Memory (NVM)
corruption?

When Embedded Flash Memory is corrupted, checking Embedded Flash Memory may return with any or all
of the following page status:

e ECC1/ECC2 failure

e Page write count exceeds the 10-year retention threshold

e Page write count is invalid

e Page protection is set illegally (set when it should not be)
See the How do | interpret data in the Flash Memory (NVM) Status Report? topic for details.

If your Embedded Flash Memory is corrupted, you can recover by reprogramming with original design data.
Alternatively, you can ‘zero-out’ the pages by using the Tcl command recover_flash_memory.

Why does Embedded Flash Memory (NVM) corruption happen?

Embedded Flash Memory corruption occurs when Embedded Flash Memory programming is interrupted due
to:

e Supply brownout; monitor power supplies for brownout conditions. For SmartFusion monitor the
VCC_ENVM/VCC_ROSC voltage levels; for Fusion, monitor VCC_NVM/VCC_OSC.

e Reset signal is not properly tied off in your design. Check the Embedded Memory reset signal.
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How do | recover from Embedded Flash Memory corruption?

How do | recover from Embedded Flash Memory corruption?

Reprogram with original design data or ‘zero-out’ the pages by using the Tcl command
recover_flash_memory.

What is a JTAG IR-Capture value?

JTAG IR-Capture value contains private and public device status values. The public status value in the value
read is ISC_DONE, which indicates if the FPGA Array is programmed and enabled.

The ISC_DONE signal is implemented as part of IEEE 1532 specification.

What does the ECC1/ECC2 error mean?

How can

ECC is the Error Correction Code embedded in each Flash Memory page.
ECC1 — One bit error and correctable.
ECC2 — Two or more errors found, and not correctable.

| tell if my FlashROM is programmed?

To verify that your FlashROM is programmed, read out and view the FlashROM content or perform
verification with the PDB file by selecting the VERIFY or VERIFY FROM action in FlashPro.

Can | compare serialization data?

To compare the serialization data, you can read out the FlashROM content and visually check data in the
serialization region. Note that a serialization region can be an AUTO_INC or READ_FROM_FILE region.

For serialization data in the AUTO_INC region, check to make sure that the data is within the specified
range for that region.

For READ_FROM_FILE region, you can search for a match in the source data file.

Can | tell what security options are programmed in my device?

To determine the programmed security settings, run the Device Status option from the Inspect Device dialog
and examine the Security Section in the report.

This section lists the security status of the FlashROM, FPGA Array and Flash Memory blocks.

Is my analog system configured?

To determine if the analog block is configured, run the Device Status option from the Inspect Device dialog
and examine the Analog Block Section in the report. For example, the excerpt from the Device Status report
below shows that the analog block status is operational:

Analog Block:
OABTR Register (HEX): 0dbe37b
3.3V (vdd33): PASS
1.5V (vdd15): PASS
Bandgap: PASS
-3.3V (vddn33): PASS
ADC Reference: PASS
FPGA_Good: PASS
Status: Analog Block is operational

If you read out an all zero value when examining the Analog System Configuration, then it is possible that
the Analog System is not configured.
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You need to compare your analog system configuration with the design configuration from the Analog
System Builder

The -3.3V (vddn33) voltage is optional.

How do | interpret data in the Device Status report?

The Device Status Report generated from the FlashPro Device Debug Feature contains the following
sections:

e IDCode (see below)

e User Information

e Device State

e Analog Block (SmartFusion and Fusion only)
e Factory Data

e Security Settings

IDCode
The IDCode section shows the raw IDCode read from the device. For example, in the Device Status report
for an AFS600 device, you will find the following statement:
IDCode (HEX): 233261cf
The IDCode is compliant to IEEE 1149.1. The following table lists the IDCode bit assignments:
Table 38 - IDCode Bit Assignments
Bit Field (little Example Bit Value for Description
endian) AFS600 (HEX)
Bit [31-28] (4 bits) |2 Silicon Revision
Bit [27-12] (16 3326 Device ID
bits)
Bit [11-0] (12 bits) | 1cf IEEE 1149.1 Manufacturer ID for
Microsemi

Device Status Report: User Info

The User Information section reports the information read from the User ROW (UROW) of IGLOO,
ProASIC3, SmartFusion and Fusion devices. The User Row includes user design information as well as
troubleshooting information, including:

e Design name (10 characters max)

e Design check sum (16-bit CRC)

e Last programming setup used to program/erase any of the silicon features.

e FPGA Array / Fabric programming cycle count

For example:

User Information:

UROW data (HEX): 603a04e0alc2860e59384af926fe389F
Programming Method: STAPL

Programmer: FlashPro3

Programmer Software: FlashPro vX.X

Design Name: ABCBASICTO

Design Check Sum: 603A
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Device Status Report: Device State

Algorithm Version: 19
Array Prog. Cycle Count: 19

Table 39 - Device Status Report User Info Description

Category Field Description
User Row Data | (Example) Raw data from User Row
UROW data (HEX): (UROW)

603a04e0alc2860e59384af926fe389f

Programming
Troubleshooting

(Example)
Programming Method: STAPL

Known programming setup
used. This includes:

Info Programmer: FlashPro3 Programming method/file,
Programmer Software: FlashPro v8.6 | programmer and software. It
Algorithm Version: 19 also includes programming
Algorithm version used.
Design Info (Example) Design name (limited to 10

Design Name: ABCASICTO
Design Check Sum: 603A

characters) and check sum.

Design check sum is a 16-
bit CRC calculated from the
fabric (FPGA Array)
datastream generated for
programming. If encrypted
datastream is generated
selected, the encrypted
datastream is used for
calculating the check sum.

Device Status Report: Device State

The device state section contains:.

¢ |IR-Capture register value, and
e The FPGA status
The IR-Capture is the value captured by the IEEE1149.1 instruction register when going through the IR-

Capture state of the IEEE 1149.1 state machine. It contains information reflecting some of the states of the
devices that is useful for troubleshooting.

One of the bits in the value captured is the ISC_DONE value, specified by IEEE 1532 standard. When the
value is ‘1’ it means that the FPGA array/fabric is programmed and enabled. This is available for IGLOO,
ProASIC3, SmartFusion and Fusion devices.

For example:

Device State:

IRCapture Register (HEX): 55

FPGA Array Status: Programmed and enabled

For a blank device:

Device State:

IRCapture Register (HEX): 51

FPGA Array Status: Not enabled
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Device Status Report: Analog Block

The Analog block of the SmartFusion and Fusion devices monitors some of the key power supplies needed
by the device to function. These power supply status is captured in the OABTR test register in the Analog
block.

For example, if you run Device Status when the Fabric and Analog configuration is programmed and
powered up successfully the report indicates:

Analog Block:

OABTR Register (HEX): 0dbe3bb

3.3V (vdd33): PASS

1.5V (vdd15): PASS

Bandgap: PASS

-3.3V (vddn33): PASS

ADC Reference: PASS

FPGA_Good: PASS

Status: Analog Block is operational

Table 40 - Device Status Report - Analog Block Description

Analog Block Status Description
OABTR Register RAW data captured from the device
3.3V (vdd33) Vcc33a supply status
1.5V (vdd15) Vcenvm supply status
Bandgap Internal bandgap supply status
ADC Reference ADC reference voltage status
-3.3V (vddn33) Vddn33 supply status (optional voltage)
FPGA Good FPGA array or Fabric status

If the Fusion device is erased, the report indicates:
Analog Block:
OABTR Register (HEX): 188e3ba
3.3V (vdd33): PASS
1.5V (vdd15): PASS
Bandgap: PASS
-3.3V (vddn33): FAIL
ADC Reference: FAIL
FPGA_Good: FAIL
Status: Analog Block is non-operational
Analog Block is not programmed

Device Status Report: Factory Data

The Factory Data section lists the Factory Serial Number (FSN).
Each of the IGLOO, ProASIC3, SmartFusion and Fusion devices has a unique 48-bit FSN.
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Device Status Report: Security

Device Status Report: Security

The security section shows the security options for the FPGA Array, FlashROM and Flash Memory (NVM)
block that you programmed into the device.
For example, using a Fusion AFS600 device:

Security:

Security Register (HEX): 0000000088c01b

FlashROM

Write/Erase protection: Off

Read protection: Off

Encrypted programming: Off

FPGA Array

Write/Erase protection: Off

Verify protection: Off

Encrypted programming: Off

FlashMemory Block O

Write protection: On

Read protection: On

Encrypted programming: OFff

FlashMemory Block 1

Write protection: On

Read protection: On

Encrypted programming: OffF

Table 41 - Device Status Report - Security Description

Security Description
Status Info
Security Raw data captured from the device's security status register

Register (HEX)

Write/Erase Write protection is applicable to FlashROM, FPGA Array (Fabric)and
Protection Flash Memory (NVM) blocks. When On, the Silicon feature is
write/erase protected by user passkey.

Read Read protection is applicable to FlashROM and Flash Memory (NVM)

Protection blocks. When On, the Silicon feature is read protected by user
passkey.

Verify Verify Protection is only applicable to FPGA Array (Fabric) only. When

Protection On, the FPGA Array require user passkey for verification.

Reading back from the FPGA Array (Fabric) is not supported.

Verification is accomplished by sending in the expected data for
verification.

Encrypted Encrypted Programming is supported for FlashROM, FPGA Array
Programming (Fabric) and Flash Memory (NVM) blocks. When On, the silicon
feature is enable for encrypted programmed. This allows field design
update with encrypted datastream so the user design is protected.
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Encrypted Programming
To allow encrypted programming of the features, the target feature cannot be Write/Erase protected by user
passkey.

The security settings of each silicon feature when they are enabled for encrypted programming are listed
below.

FPGA Array (Fabric)

Write/Erase protection: Off

Verify protection: Off

Encrypted programming: On
Set automatically by Designer or FlashPro when you select to enable encrypted programming of the FPGA
Array (Fabric). This setting allows the FPGA Array (Fabric) to be programmed and verified with an encrypted
datastream.

FlashROM

Write/Erase protection: Off

Read protection: On

Encrypted programming: On
Set automatically by Designer or FlashPro when you select to enable encrypted programming of the
FlashROM. This setting allows the FlashROM to be programmed and verified with an encrypted datastream.
FlashROM always allows verification. If encrypted programming is set, verification has to be performed with
encrypted datastream.

Designer and FlashPro automatically set the FlashROM to be read protected by user passkey when
encrypted programming is enabled. This protects the content from being read out of the JTAG port after
encrypted programming.

Flash Memory (NVM) Block

Write/Erase protection: Off

Read protection: On

Encrypted programming: On
The above setting is set automatically set by Designer or FlashPro when you select to enable encrypted
programming of the Flash Memory (NVM) block. This setting allows the Flash Memory (NVM) block to be
programmed with an encrypted datastream.
The Flash Memory (NVM) block does not support verification with encrypted datastream.
Designer and FlashPro automatically set the Flash Memory (NVM) block to be read protected by user
passkey when encrypted programming is enabled. This protects the content from being read out of the
JTAG port after encrypted programming.

How do | interpret data in the Flash Memory (NVM) Status Report?

The Embedded Flash Memory (NVM) Status Report generated from the FlashPro Device Debug Feature
consists of the page status of each NVM page. For example:

Flash Memory Content [ Page 34 to 34 ]

FlashMemory Page #34:

Status Register(HEX): 00090000

Status ECC2 check: Pass

Data ECC2 Check: Pass

Write Count: Pass (2304 writes)

Total number of pages with status ECC2 errors: 0O

Total number of pages with data ECC2 errors: O

Total number of pages with write count out of range: O

FlashMemory Check PASSED for [ Page 34 to 34 ]

The "check_flash_memory® command succeeded.
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How do | interpret data in the Flash Memory (NVM) Status Report?

The Execute Script command succeeded.

Table 42 - Embedded Flash Memory Status Report Description

Flash
Memory
Status Info

Description

Status
Register
(HEX)

Raw page status register captured from device

Status
ECC2
Check

Check for ECC2 issue in the page status

Data ECC2
Check

Check for ECC2 issue in the page data

Write Count

Check if the page-write count is within the expected range.
The expected write count is greater than or equal to:

6,384 - SmartFusion devices
2,288 - Fusion devices

Note: Write count, if corrupted, cannot be reset to a valid value within the customer flow;invalid write count will not
prevent device from being programmed with the FlashPro tool.

The write count on all good eNVM pages is set to be 2288 instead of 0 in the manufacturing flow. The starting count of
the eNVM is 2288. Each time the page is programmed or erased the count increments by one. There is a Threshold that
is set to 12288, which equals to 3 * 4096.

Since the threshold can only be set in multiples of 4096 (2712), to set a 10,000 limit, the Threshold is set to 12288 and
the start count is set to 2288; and thus the eNVM has a 10k write cycle limit. After the write count exceeds the threshold,
the STATUS bit goes to 11 when attempting to erase/program the page.
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Device Debug User Interface

Inspect Device Dialog Box

Inspect Device is available as a part of the FlashPro programming tool. Refer to Using Device Debug for
information on how to configure the FlashPro to get access to this feature.

The Inspect Device dialog box enables you to access all the Device Debug features, such as the FlashROM,
Embedded Flash Memory (NVM) and Analog Block. If you have multiple devices and programmers
connected, choose your target device/programmer from the dropdown menu and use the ID code to verify
that you are inspecting the correct device.

View Device Status - Displays the Device Status Report. The Device Status Report is a complete summary
of your device state, analog block test values, user information, factory data and security information. Use
this dialog box to save or print your information for future reference.

View Analog Block Configuration - Opens the Analog Block Configuration dialog box. Enables you to view
the channel configuration for your analog block and compare the channel configuration with any other
analog block file.

View Flash Memory Content - Opens the Flash Memory dialog box. This dialog box enables you to view
the details for each flash memory block in your device.

View FlashROM Content - Opens the FlashROM data dialog box, enables you to view a list of the physical
blocks in your FlashROM and the client partitions in FlashROM configuration files.

Y Inspect Device @@

Programmer: 51538 (usbS15338) b

(=00 H A F 200MEF (AZF200MEF)

1D code read from device: SAL31CF

Iuisw Device Smusi Ii.risw Analog Block Cnniigur.uinnl l'-.n'iem Flash Memory Content ] Imw FlashROM Conkent I

Figure 156 - Inspect Device Dialog Box

Device Status Report

This dialog box displays the Device Information report. The Device Information report is a complete
summary of your device state, analog block test values, user information, factory serial number and security
information. Use this dialog box to save or print your information for future reference. See the Interpreting
the Device Status Report topic for information on the report contents.

238 FlashPro User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error

when clicked. View the online help included with software to enable all linked content.

1 Device Status Report

& Microsemi

Analog Block Configuration Dialog Box (SmartFusion and Fusion Only)

Device; AF3600 (AFS600) Programmer: 10868 (usb105863)

[ | 5ave ]

[ &4 Print ]

Device Status:

IDCode (HEX):

233261cf

Idser Information:

LR data (HEX):

23080041020408102045F 8766803481

Prograrmming Method: PDE
Programmer: FlashPro3
Programmer Software: FlashPro w&.6
Design Marme: top
Design Check Sum: 2308
Algorithm Yersion: 19
Array Prog, Cycle Counk: 1

Device State:
IRCapture Register (HEX): 55

FPGA Array Stakus:

Programmed and enabled

Analog Block:

OABTR Regisker (HEX): 1dbe3bb

3.3 (wdd33): PasS

1.5% (vdd15): PASS

Bandogap: Pass

-3.3% (vddn3ay: pass

ADC Reference: PASS

FPGA_Good: PSS

Skakus: #nalog Block is operational

Factory Daka:

Securiby:

Factory Serial Mumber (HE®):

Device has no security enforced.

gle00456ca0

Close

Figure 157 - Device Status Report

Analog Block Configuration Dialog Box (SmartFusion and Fusion

Only)

Enables you to:

¢ View the channel configuration on your analog system, identify if/fhow the channels are configured.

e Compare with the design configuration from the Analog System Builder for Fusion and SmartDesign
MSS Configurator for SmartFusion

The values displayed for each channel vary depending on the device family and channel you select; the
Channel configuration register read from the ACM is shown for each analog channel. Individual, decoded bit
fields of the register are listed immediately beneath (as described in Fusion and SmartFusion handbook).
The dialog box may display the following values:

Fusion Device
e Analog MUX select
e Internal chip T monitor
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e Scaling factor control

e Current monitor switch

e Current monitor drive control

¢ Direct analog input switch

e Pad polarity - G, T, V, C pad polarity, positive or negative

e Select low/high drive

e Prescaler op amp mode
SmartFusion Device

e Gain select

e Channel state

e Direct Input state

e Current Monitor state

e Current monitor strobe state

e Comparator state

e Hysteresis select

e Analog MUX select

e DAC input select

e Temperature monitor state

e Temperature monitor strobe state

o Vref switch state

To use the compare feature, select the Compare with checkbox. If the loaded PDB file contains Analog
Block configuration information the comparison appear automatically.

To use a specific Project File, click Browse and navigate to the Analog System Builder directory for for
Fusion or SmartDesign for SmartFusion. In a typical IDE project, this directory is located at:

e Fusion - <project_root>/smartgen/<analog_block_core_name>
e SmartFusion - <project root>/component/work/<SmartDesign project>/MSS_ACE_0

After specifying the compare directory the differences (if any) are indicated in red on a channel by channel
basis, as shown in the figure below.
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Embedded Flash Memory (NVM) Content

¥ Analog Block Configuration ? @
Channel configuration Compare with:  as15
Found 32 mismatched channels
A |
Channel Byte l¢ 1 AVD
B 081 |
AVD Device Content File Content
ACD 000 .r_ﬁ ; Byte OxE1 O35
o Analog MUX select Prescaler Direct input
AGD & scaling Factor control 0.3125 (&%) 0.15625 (16¥)
ATO OxB0 .ﬂ Current monitor switch ~ OFf on
0xS2 Direct analog input switch OFF on
AVl . ¥-pad polarity Positive Positive
AC1 Dx10 Prescaler op amp mode  Operational Powerdown
AG1 Oxi00 &
AT1 OO &
A2 02 -.ﬁ
AC? 010 |

Figure 158 - Analog Block Configuration Dialog Box for a Fusion Device (Differences in Red)

Embedded Flash Memory (NVM) Content

The NVM content dialog is divided into two sections. The top section shows the data that is retrieved from
the PDB that you specified. The bottom section shows the data that is retrieved from the actual device. The
View Flash Memory Content diagnostic enables you to:

¢ View content of Flash Memory pages (as shown in the figure below)
e Compare device content with original design content (requires a PDB that contains your EFC data)

e Check page status and identify if a page is corrupted or if the write count limit has exceeded the 10-
year retention threshold

Fusion Devices: Choose your block from the From block dropdown list This action populates the Select
dropdown list with the names of the clients in the selected block that is configured in the Flash Memory
System Builder.

SmartFusion Devices: Block selection is unused and unavailable.

Choose a client name from the Select dropdown list and click Read from Device to view the values. You
can also view a specific page range by selecting the <Page Range> option in the Select dropdown list and
then specifying the start page and the end page.

You must click Read from device each time you specify a new page range to update the view.

If you do not have your original design programming database (PDB) file, then you can also examine and
retrieve a range of pages. Specify a page range if you wish to examine a specific set of pages.
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, [yTe—— i3]

Retrieve Flash Memory Content from Device:
From block |0 - MS5_ENM_0.efc

Select |ACTEL_PPE_MERGE_CONFIG (p) 2] Read from Device *

Start address: |0xSFE0O (page 2044)
Chent size: 43 | bytes (1 page)
Latest Content Retrieved from Device: Mo Jun 0 16:16:01 2011

Retrieved Content: Client "ACTEL_PPE_MERGE_CONFIG", 45 bytes starting from address 0x:3FEQND

View Detailed Status| [Compare Client Content

Page Murmber | Address Sontert

o |1 Jz]3]4]s]s]z7z]s]s]ale]clole]cEF
opeq | SFEOOj DO 03 o0 00 10 00 10 W@ o0 03 10 02 03 @4 10 20
2044 3FE10| 01 [1x] 40 (1] 10 oo 10 10 o1 03 1 oz 43 04 10 20
opes | E20{11 o0 18 @ o1 03 220 18 10 00 10 00 00 03 2 10
opeq | 3FE30j 00 00 0O 00 0O OO OO 00 oOD OO0 OO0 OO0 00 @O0 00 00
on4q | OFE40j 00 00 o0 00 00 00 00 00 OO0 0D OO 00 00 ©0 00 00
op44 | SFESOjO0 OO D00 OO OO OO OO OO OO OO OO0 OO0 OO0 OO 00 OO
op44 | SFEEOj 00 00 0O 00 00O 0O OO0 00 00 OO 00 OO0 00 OO0 00 00
on44 | FE7Oj 00 00 00 00 00 00 00 00 o000 0D OO 00 00 ©0 00 00

Figure 160 - Flash Memory Dialog Box for a SmartFusion Device (Device Debug)

Figure 159 -

Embedded Flash Memory: Browse Retrieved Data

The retrieved data table displays the content of the selected client or the page range selection. Corrupted
pages content is displayed in red. Read-only page content, corresponding to clients defined with the Prevent
read option in Flash Memory System Builder, is displayed on gray background. If content cannot be read
(e.g. pages are read-protected, but security has been erased), it is displayed as XX. The mouse tooltip
summarizes abnormal content status (as shown in the figure below).

The corresponding page number and address (relative to the current block) are displayed in the left column.
The client size specified in the Flash Memory System Builder is shown at the top of the content table.

In the Retrieved Data View you can enter an Address value (such as 0010) in the Go to Address field and
click the corresponding button to go directly to that address.

Click View Detailed Status for a detailed report on the page range you have selected.

For example, if you want to view a report on pages 1-3, set the Start Page to 1, End Page to 3 and click
Read from Device, then click View Detailed Status; the figure below is an example of the data for a
specific page range.
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Embedded Flash Memory: Browse Retrieved Data

T Flash Memory Details

In Block 1, from Page 1 to Page 3, 334 bytes starting from address 0«80 as of Wed Jan 20 15:40:57 2010 [ E Save l l & Print ]

Flash Memory Content [ Page 1 ko 3 ]
FlashMermnary Page #1:
Status Reqgister{HEX): 000SF000
Status ECCZ check:  Pass
Data ECCZ Check:  Pass
Whrite Count: Pass (2258 writes)
Flashtemory Page #2:
Status Register{HEX): 000SF000
Status ECC2 check:  Pass
Data ECCZ Check:  Pass
Write Count: Pass (2258 writes)
Flashtemory Page #3:
Status Register{HEX): 000SF000
Skatus ECC2 check:  Pass
Data ECC2 Check:  Pass
whrite Count: Pass (2288 writes)
Total number of pages with status ECCZ errors: 0
Total number of pages with data ECZZ errors: 0
Total number of pages with write count out of range: 0
FlashMemary Check PASSED for [ Page L ko 3 ]

o~

Figure 161 - Flash Memory Details Dialog Box (Device Debug)

1 Flash Memory

Retrieve Flash Memory Content from Device:

From block |3 - newCore.efc | W
|2) Riead from Device *

{address 0x00000)

Seleck | <Page Range> W
Srart Page: |0

EndPage: |3 (4 pages, 512 bytes)

Latest Content Retrieved from Device:

Retrieved Content: In Blodk 3, from Page O to Page 3, 512 bytes starting from address (ol

Go b Addrass (hee):

Wed Jun 20 1043317 2010

Wiew Dietaled Stabus

|

Page Mumber | Address

o |1 Jz]3]s+|sle]z]es]s|ale]c]lo]e]cEF

ummmmmmmmmmmmmmmmmh
o | 00010 OO0 DD O 0O 00 O 00 0O OO o) 00 Do o0 00 00
e & @ © o ® m w  [rmmesmml
g | O00030| OO OO0 O 0O OO OO 0O OO OO0 OO0 OO OO OO OO0 OO OO
o | 00040| OO D) OO0 OO 0O OO 0O OO OO OO OO QOO OO0 OO 00 OO
ummﬂﬂmmﬂmmmmmmmmmm
g | 00080 OO D0 o0 OO OO OO DO OO OO OO OO QO OO OO Q0O OO
ummmmmmmmmmmmmmmmm
1 ] OODSOj 0D 0D O 0O 0O 0D 0O OO OO0 00 O OO0 OO Q00 00 OO
|mmmmmmmmmmmmmmmmm

W

H

Figure 162 - Flash Memory Browse Retrieved Data
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Embedded Flash Memory: Compare Memory Client

After you retrieve the data from the device, the Compare Client Content button enables you to compare the
content of the selected client from the device with the original programming database (PDB) file. The
differences are shown in the Compare Memory Client dialog (as shown in the figure below).

NOTE: This option is not available when you select to retrieve the data based on a page range.

1 Compare Memory Client

In Block 0, Clhient "DSBbIL", 256 bytes starting from address 0x0 as of Sun Jan 17 12:12:06 2010 | | save || & it |

Flash Memory Client Compare [DSE8bit - Block 0] Al

Difference at byte 0.
Byte |Design | Device
0 DedFly Oe0i0)

Difference at bytes 2 to 4.
Byte |Design | Device
2 Oc3d, | D0

3 oS | 00D

4 0:B8 | OwiDD

Difference at bytes & to 255,
Byte Design | Device
6 edFF O
7 oD | 000
& OxAR | 00D
9 OAd | DD
10 |kfd 000
11 |kAB  [0x00
e Ml | M0 .

Figure 163 - Compare Memory Client Dialog Box

FlashROM Content Dialog Box

Enables you to view the physical blocks in your FlashROM and the client partitions specified in the original
design content (requires a PDB that contains your UFC data). If the project's PDB does not contain UFC
data, only the physical blocks are displayed.

Scroll through the table to view the Words and Pages for your physical blocks.

The Client Partitions section lists the names and configuration details of the clients set up in the FlashROM
Builder. It automatically finds all mismatched client regions. To view the differences between a client and the
device content, select a region row in the Client Partitions table. This action will highlight the corresponding
device content in the Physical Blocks table. The mismatch details are displayed below the Client Partitions
table.

To copy to clipboard the content of the Physical Blocks table, select one or more cells in the table and type
Ctrl+C.
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Device Debug Tcl Commands

Y FlashROM

Phrysical Elocks

15 |14 | 1312|111 | w9 | s | 76| s5]| | z]z]|1]|an
7FF PE 7D FC 7B FA |F9 |78 77 F& |F5 |74 |F3 |72 |7l |FO
6lze |22 |2z |22 |22 ez |2z |z |22 (o2 |22 |22 |22 |22 |22 |22
5/sF DE ©OD 5C DB 54 59 D8 DF 56 |55 |D4 |53 D2 Dl |50
Pages |4 FERSIGINTMITOSIl OF F0 48 (D EF 0A BC DE (FO AR (D

%/3F BE BD 3C BE 34 |39 B8 B7 |36 |35 (B4 |33 B2 (Bl |30
/00 00 00 OO |00 OO0 |o0 |OF BE | FA FA P& P& P& |FA BB
{00 o0 o0 o0 o0 00 (00 |00 00 00 |00 00 |00 o0 (o0 (oo
ool 23 45 &7 89 0L |23 45 67 |89 |44 AE BB |CC |CD |DD

Client Partitions

FlashRoM configuration files D:\tempifromzfrom_File_core\from_file_core,ufc

Found 2 client regions that do not match with device content,

Reqgion Mame Reqgion Type Page Start \Word Size (words)
Region_3_11 Reead From file 3 11 5
Region_4_11 Skakic 4 11 5 &
Region_5_11 Ak Tne 5 11 1 R

Content details For selected region

From dewvice: ABCDEFOAEC
Shown as: HEXADECIMAL
From config file; 0000000000

f'i\, Misrnatch between configuration file content and device content,

Figure 164 - FlashROM Content Dialog Box

Device Debug Tcl Commands

The following table lists the Tcl commands related to Device Debug. Click the command to view more

information.
Table 43 - Device Debug Tcl Commands
Command Action Type
check flash_memory Performs diagnostics of the page status Embedded
and data information Flash Memory

(NVM)

compare_analog_config Compares the content of the analog block | Analog Block
configurations in your design against the
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Command Action Type

actual values in the device.

compare_flashrom_client | Compares the content of the FlashROM FlashROM
configurations in your design against the
actual values in the selected device.

compare_memory client | Compares the memory client in a specific | Embedded
device and block Flash Memory
(NVM)

read analog_block config | Reads each channel configuration on your | Analog Block
analog system, enabling you to identify
iffnow each channel is configured.

read device_status Displays a summary of the selected
device
read flashrom Reads the content of the FlashROM from | FlashROM

the selected device

read flash _memory Reads information from the NVM modules | Embedded
(page status and page data) Flash Memory
(NVM)
read_id_code Reads IDCode from the device without

masking any IDCode fields

recover_flash _memory Removes ECC2 errors due to memory Embedded
corruption by reprogramming specified Flash Memory
flash memory (NVM) pages and initializing | (NVM)

all pages to zeros.

sample_analog_channel [ Samples analog channel; enables you to
debug ADC conversion of the
preconfigured analog channel (you must
provide ADC conversion parameters )

set_debug_device Identifies the device you intend to debug.

set _debug programmer Identifies the programmer you want to use
for debugging (if you have more than
one).

SmartDebug for SmartFusion2 and IGLOO2

SmartDebug for SmartFusion2 and IGLOO2 supports probe capabilities in the device architecture and
device debug features for memory.

To open SmartDebug, in the Design Flow window expand Debug Design and double-click SmartDebug
Design (as shown in the figure below). The SmartDebug dialog box appears and lists your Device, the ID
Code read from your device, and your Programmer.

SmartDebug enables you to:
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SmartDebug for SmartFusion2 and IGLOO2

View Device Status — Displays the Device Summary Report. It is a summary of your device state, user
information, factory serial number and security information. Use this dialog box to save or print your
information for future reference.

View Flash Memory Content - Use this information to view, save or print the flash memory content in your
design.

Debug FPGA Array — SmartFusion2 and IGLOO2 devices have built in probe points that greatly enhance
the ability to debug logic elements within the device. The enhanced debug features implemented into the
devices give access to any logic element and enable designers to check the state of inputs and outputs in
real time. Live Probe and Active Probe are only available for the SmartFusion2 and IGLOO2 families.

e With Live Probe, two dedicated probes can be configured to observe a Probe Point (any input or
output of a logic element). The probe data can then be sent to an oscilloscope or even redirected back
to the FPGA Fabric to drive a software logic analyzer.

¢ Active Probe allows dynamic asynchronous read and write to a flip-flop or probe point. This enables
you to quickly observe the output of the logic internally or to quickly experiment on how the logic will be
affected by writing to a probe point.

e Memory debug gives you the ability to perform dynamic asynchronous reads and writes to a micro
SRAM or large SRAM block so you can quickly verify if the content of the memory is changing as
expected.

Debug SERDES - Enables you to examine and debug the SERDES blocks in your design. You can
configure your SERDES debug, and run PRBS and Loopback tests.
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testcased E o #
Tool
¥ Create Design
¥ Create Constraints

=~ » Implement Design
> Synthesize
= # ¥erify Post-Synthesis Implementation
. Simulate
% Compile
*J Configure Flash*Freeze
ﬁ:; Place and Route
=~ »# Edit Constraints
1) Constrainks
Timing Canstrainks
%" Floorplan Constraints
» Yerify Post Layout Implementation
. Simulate
ﬂh Yerify Timing
IEJ. Werify Power
v +[ | Generate Fabric Programming Data
=~ » Edit Design Hardware Configuration
[ Programming Connectivity and Interface
.’u Programmer Settings
% Device IfD States During Programming
=~ » Configure Security and Programming Opt...
Security Palicy Manager
: Programming Features
5. Update eV Memory Content
=~ » Program Design
@‘ Program Device
= Ef_-hug Design
20 Instrument Design
_ I SmartDebug Design
=~ » Handoff Design for Production
-@ Expart Programming File
+[ | Export Pin Repart
+[ | Expoart BSOL
= » Develop Firmware
B vrite Application Code

LSRR S

- 4
]

Figure 165 - SmartDebug in the Design Flow Window

Using SmartDebug with SmartFusion2 and IGLOO2

The most common flow for Device Debug is:

1. Create your design. You must have a FlashPro programmer connected in order to use SmartDebug.

2. Expand Debug Design and double-click Smart Debug Design in the Design Flow window.
SmartDebug opens for your target device.

3. Click View Device Status to view the device status report and check for issues.
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Device Status Report - SmartFusion2 and IGLOO2

4. Examine individual silicon features, such as FPGA debug.

Device Status Report - SmartFusion2 and IGLOO2

This dialog box displays the Device Information report. The Device Information report is a summary of your
device state, user information, factory serial number and security information. Use this dialog box to save or
print your information for future reference.
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Debug SERDES

The Debug SERDES dialog box (as shown in the figure below) enables you to examine and debug the
SERDES blocks in your design.

To Debug SERDES, expand SmartDebug in the Design Flow window and double-click Debug SERDES.

Debug SERDES Configuration is explained below. See the PRBS Test and Loopback Test topics for
information specific to those procedures.

SERDES Block identifies which SERDES block you are configuring. Use the dropdown menu to select from
the list of SERDES blocks in you design.

Debug SERDES - Configuration

Configuration Report

The Configuration Report output depends on the options you selected in your PRBS Test and Loopback
Tests. The default report lists the following for each Lane in your SERDES block:

Lane mode - Indicates the programmed mode on a SERDES lane as defined by the SERDES system
register.

PMA Ready - Indicates whether PMA has completed its internal calibration sequence for the specific lane
and the PMA is operational. See the SmartFusion2 or IGLOO2 High Speed Serial Interfaces User's Guide
on the Microsemi website for details.

TxPIl status - Indicates the loss-of-lock status for the TXPLL is asserted and remains asserted until the PLL
reacquires lock.

RxCDR status - Indicates the RXCDR loss-of-lock for the channel when asserted and locking to the
incoming data stream.

Click Refresh Report to update the contents of your SERDES Configuration Report. Any changes to the
specified SERDES register programming can be read back to the report.

SERDES Register Read or Write

Script - Runs your MSS Read/Write using a script. Enter the full pathname for the script location or click the
Browse button to navigate to your script file. Click Execute to run the script.
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Debug SERDES- PRBS Test

[ | Debug SERDES (2] =]

SERDES Block | SERDESIF_1 =

Debug SERDES

Configuration Report:

Configuration * | | Refresh Report
4 Tests SeLdes Bulock SERDESIF_1:
ane 0:
PRES Test Lane mode : EPCS (1.25 GHz) |
Loopback Test PMA Ready : True =
TxPLL status : Locked
RxCDR status : Unlocked
Lane 1:
Lane mode : EPCS (1.25 GHz)
PMA Ready : True
THPLL status : Locked
RxCDR status : Unlocked
Lane 2 :
Lane mode : EPCS (1.25 GHz) -

SERDES Register Read or Write:

() (Do)

Script:

Close

Figure 166 - Debug SERDES - Configuration

Debug SERDES- PRBS Test

PRBS data stream patterns are generated and checked by the internal SERDES block. These are used to
self-test signal integrity of the device. You can switch the device through several predefined patterns.

View Loopback Test settings in the Debug SERDES - Loopback Test topic.

SERDES Block identifies which SERDES block you are configuring. Use the dropdown menu to select from
the list of SERDES blocks in you design.

SERDES Lanes

Select the Lane and Lane Status on which you wish to run the PRBS test. Lane mode indicates the
programmed mode on a SERDES lane as defined by the SERDES system register.

Test Type
Near End enables a self test of the device. The serial data stream is sent from the SERDES TX output and
folded back onto the SERDES RX input.
External Cable is the normal system operation where the data stream is sent off chip from the TX output
and must be connected to the RX input via a cable or other type of electrical interconnection

Pattern
The SERDESIF includes an embedded test pattern generator and checker used to perform serial
diagnostics on the serial channel, as shown in the table below.

Pattern Type
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Pattern Type

PRBS7 Pseudo-Random data stream of 27 polynomial sequences

PRBS11 Pseudo-Random data stream of 2711 polynomial sequences

PRBS23 Pseudo-Random data stream of 2223 polynomial sequences

PRBS31 Pseudo-Random data stream of 2231 polynomial sequences

All Zeros Fixed pattern data

All Ones Fixed pattern data

Alternated Fixed pattern data

Dual Alternated Fixed pattern data

User Defined Sets your custom pattern

Error Count
Lists the number of errors after running your PRBS test. Click Reset to reset to zero.

li| Debug SERDES (2] = |
SERDES Elock | SERDESIF_1 =
Debug SERDES SERDES Lanes: (@ Lane 0 ) Lane 1 ) Lane 2 ) Lane 3
Coenfiguration Lane 0 status:  TwPLL RxCOR
4 Tests
PRBS Test Test Type:
Loopback Test :
P @ Near End Serial Loopback (On-Die) () Serial Data (Off-Die)
Pattern: i
I @ PRBST ) All Zeros (0000....00) I
_
") PRES11 (™) All Ones ( 1111....11)
1 Stor
*) PRBS 23 ) Alternated ( 101010..10) i
) PRBS 31 () Dual Alternated { 1100 ... 1100 )

" User Defined

Error Count:

:

Figure 167 - Debug SERDES - PRBS Test
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Debug SERDES - Loopback Test

Debug SERDES - Loopback Test

Loopback data stream patterns are generated and checked by the internal SERDES block. These are used
to self-test signal integrity of the device. You can switch the device through predefined tests.

See the PRBS Test topic for more information on the PRBS test options.

SERDES Block identifies which SERDES block you are configuring. Use the dropdown menu to select from
the list of SERDES blocks in you design.

SERDES Lanes

Test Type

Select the Lane and Lane Status on which you wish to run the Loopback test. Lane mode indicates the
programmed mode on a SERDES lane as defined by the SERDES system register.

PCle Far End PCS RX to TX Loopback - See the SmartFusion2 or IGLOO2 High Speed Serial Interfaces
User's Guide on the Microsemi website for details.
Parallel loopback - See the SmartFusion2 or IGLOO2 High Speed Serial Interfaces User's Guide on the
Microsemi website for details.
PCS Far End PMA RX to TX Loopback- See the SmartFusion2 or IGLOO2 High Speed Serial Interfaces
User's Guide on the Microsemi website for details.
| | Debug SERDES [
SERDES Elock | SERDESIF_1 =
Debug SERDES SERDES Lanes: (@ Lane 0 ) Lane 1 ) Lane 2 ) Lane 3
Configuration Lane 0 status:  TxPLL RxCDR

4 Tests

PRBS Test Test Type:

Loopback Test

PClIe Far End PCS Rx to Tx Loopback (PCIe only)
Parallel loopback { PCIe only )

(@ PCS Far End PMA Rx to Tx Loopback

Stop

Figure 168 - Debug SERDES - Loopback Test

Debug FPGA Array

Debug FPGA Array dialog box enables you to view your Live Probes, Active Probes and Memory Blocks.
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Debug File - Shows a path to your Debug File. The Debug file contains information used by SmartDebug
mainly for mapping user design names to their respective physical addresses. It also contains other
information used during debug process.

The Debug file is generated by Libero SoC during Place and Route and is stored in the design folder.

The Debug FPGA Array dialog box includes the Live Probes, Active Probes and Memory Blocks tabs.
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Debug FPGA Array

Live Probes

The Live Probes tab shows a table with the probe name and pin type. Once a net name is selected, it can be

assigned to either ChannelA or ChannelB.
Note: At least one channel must be set; if you intend to use both probes, they must be set at the same time.

The Active Probes READ/WRITE will overwrite the settings of Live Probe channels (if any).

[R5

W] Debug FPGA Array

Debug Fle:  C:MicrosemiSmartDetug fdebugFle_combined_names, et [ Prowse.

FPGA Array Debug Data
LivePiobes | Active Probes | Memory Biods

Fifter Search

Hame Type

NorthVellowhetlNorthYellowlnstl Legic

NosthVellowhet2:NorthVellolnst2 Seuth i

NorthGreenNet3:NorthGreenlnst3 Logic
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Figure 169 - Live Probes Tab in SmartDebug FPGA Array Dialog Box

After the channels have been set, SmartDebug configures the ChannelA and ChannelB IO’s to monitor the
desired probe points. The maximum number of simultaneous probes is two internal signals. There is also a

Filter box to filter through the Net Names. As you begin typing in the Filter box, the Net Name table only
shows results for the queried names.
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Active Probes

On the Active Probes tab a table of Probe Names is shown with the Name, Type (which is the physical
location of the flip-flop) and Value.

Click the Select Active Probes button to open a window that lists all the Available Probe Points and
Selected Probe Points. Both lists can be filtered using the inline Filter box . In between the two lists of Probe
points are buttons for adding and removing probe points from either list.

r -
7] Debug FPGA Array l = i

-
Debug File:  Z:/work/flashpro_projects/envm_nov7/designer/envm_test_design/envm_test_design_debug.txt
FPGA Array Debug Data
Active Probes Memory Blocks
Active Probe Data
Name Type & Value |:|
senvm_test_design_MSS_0/MDDR_ADDR. _.. Nerth IO low G 7 T

b el P :envm_test_design_MSS5_0/MDDR._ADDR. _... Morth 10 Low LE
Read Active Probes :envm_test_design_MSS_0/MODR_ADDR__. North 10 Hgh O T
Wirite Active Probes

:envm_test_design_MSS_0/MDDR._ADDR. _... Morth 10 Low LE |
:envm_test_design_MSS_0/MDDR._ADDR. _... Morth 10 High <7
:envm_test_design_MSS_0/MDDR_ADCR._... North IO Low a7 2

Figure 170 - Active Probes Tab in SmartDebug FPGA Array Dialog Box

Once you have selected the desired probe points appear in the Active Probe Data chart and you can read
and write multiple probes at the same time (as shown in the figure below).

The Value column fields are editable for each of the probe points. Clicking the circle shaped icon changes

the value, and clicking the back-arrow resets the value. Fields that have been changed are indicated by red
text. After the probes have been written, the values return to black text.

1] Select Active Probe Points | 2 ﬁ“
Avalable Probe Points Selectad Probe Points
Fiter [[search Fiter m
e Type e Name Type
;”‘-’“I' Netl:Narthellowlnst] kgl SouthYellowhet!:SouthYellowl Legic
NorthVellowNet2:NorthVellowlnst2 sah SouthGreenNet3SouthGreenlnst3 Logic
| MorthGreenhet3:MorthGreenlnst3 Logic West h West instd Logic
[ NorthGreenhietd: NorthGreenlnstd South10 o (281> | |ieGreenbiames WestGreentnst3 Logic
| SouthVellowNetl:SouthVellowlnstl Hogke [ pea> |
[SoutheliowNietz Southvellowtnet2 South 10 |_<-Remove |
| SouthGreenNet3:SouthGreeninst3 Logic |2 Remove A1j
SouthGreentNetd:SouthGreenlnstd BT
i Eact¥ellowhMNamel:EastVellowlnstl Logic
East'ellowName2:EastVellowlnst? Logic
. EastGreenName3:EastGreenlnstd Logic
EastGreenNamed:EastGreeninstd Logic -
oK [ conel

Figure 171 - Active Probes Tab - Select Active Probe Points
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Memory Blocks Tab

Memory Blocks Tab

The Memory Blocks tab shows a dropdown menu of defined memory blocks that are specified in your design
and generate a debug file. Once you select a memory block you can click Read Block to show the current
contents of the memory or write to individual memory locations. Each field is editable and multiple memory
locations can be written at the same time.

Each field is a 9 bit memory word so valid inputs are hexadecimal values between 0x0 and Ox1FF (as shown
in the figure below).

' ™y
] Debug FPGA Array [ © ezl

Debug File:  C:Microsemi/SmartDebug/debugFile_combined_names. txt Browse...
FPGA Array Debug Data

Live Probes | Active Probes | Memory Blocks

[MysiBoda -] [ Read Block ] Write Block
Memory Block Data

g

0010 000

0020

ElEEREEEEENEERDS
5% 333 3T EEEGE DS
g 88 888gggggsgsegse g g s
I BEERELNEREAENEDD
§ 8§88 888g8g88g8ggegsegsgs
g 8888888888 ¢8gsgs8s8 s
g 8888888 eggsgzegegsgs
53 %% 33838802
ENIEE RN LER NN ESEEE
g 888 8888¢ggggesgzsg s
§ 8§88 888gg8g88geggegsegsgs
E B EEREEEBEESEHEEERAES
ELREER A EEEELEEENS
§ 8§88 888g¢g88g8ggegsegsgs
g 88 888gggggsgsegesg g s

g
g 88 88ggegggse g g 8

p
]
B
B
]
-]
-]
b
]
1
-]
-}
B
1
]
1
1
-]

-]
b
P

]

 Close

Figure 172 - Debug FPGA Array - Memory Blocks Tab

Fields that have changed but have not yet been written appear in red text until you click the Write Block
button to initiate a memory write (as shown in the figure below).
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Debug File:  C:/Microsemi/SmartDebug/debugFile_combined_names. txt Browse...
FPGA Array Debug Data
LiveProbes | ActiveProbes | MemoryBlocks | )
(MySiBlock v ] [[ReadBlock | [ wite Block |

Memory Block Data

0230 000 000 000 00O 000 000 00O 00O 00O 00O 000 000 000 000 000 000
0240 000 000 000 000 000 000 000 00D 000 000 000 000 000 000 000 000
0250 000 000 000 000 000 000 000 00D 000 000 000 000 000 000 000 000
0260 001 002 003 004 005 005 006 007 008 009 000 000 000 000 000 000
0270 000 000 000 000 000 000 000 00D 000 000 000 000 000 000 000 000
0280 000 O0AA 000 000 000 000 000 000 000 000 000 000 000 000 000 000 |-
0290 000 000 000 000 OAA 000 000 000 000 000 000 000 000 000 000 000
0240 000 000 000 000 000 000 000 0S5 000 000 00O 000 000 000 000 000
0280 000 055 000 000 00O 000 000 000 OAA 000 000 000 000 000 000 000
02C0 000 000 000 000 000 00O 000 000 000 000 000 000 000 000 000 000
0200 000 000 000 000 000 000 055 000 000 000 00O 000 000 000 000 000
02E0 000 000 000 000 000 000 000 00O 000 000 OAA 000 000 000 000 000
02F0 000 000 000 000 000 000 000 00D 000 000 000 000 000 000 000 000
0300 000 000 000 000 OAA OO0 000 000 000 055 000 000 000 000 000 000
0310 000 000 000 000 000 000 000 00D 000 000 000 000 000 000 000 000
0320 000 000 000 000 000 000 000 000 000 000 000 000 000 000

([ e | [ Cose |

Figure 173 - Memory Blocks with Updated Values

SmartDebug Tcl Commands

The following table lists the Tcl commands related to Device Debug for SmartFusion2 and IGLOO?2. Click
the command to view more information.

Table 44 - Device Debug Tcl Commands

Command

Action

Debug File

set_debug data file

Sets the debug file

Probe

set_live_probe

Set Live probe channels A and/or B to the specified probe point (or points)

select_active_probe

Manages the current selection of active probe points to be used by active probe READ operations

read active probe

Reads active probe values from the device

write _active _probe

Sets the target probe point on the device to the specified value

LSRAM
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Customizing the Toolbar

Command Action
Debug File
read Isram Reads a specified block of large SRAM from the device
write_lsram Writes a seven bit word into the specified large SRAM location
uSRAM
read _usram Reads a uSRAM block from the device.
write_usram Writes a seven bit word into the specified uSRAM location.

Customizing the Toolbar

Display the tools and commands you frequently use in the toolbar by customizing it.
To customize the toolbar:
1. From the Customize menu, choose Toolbars. The Customize dialog appears.

2. Click the Toolbar tab and check the tools you want to display by checking their respective boxes, (see
figure below).

Note: Note: You can remove tools from your toolbar by deselecting tools from the Toolbar field.

Customize El

Toolbarz I EDITIITIEIFIdSI

Toolbars:

¥ ShowTootes  New.
[w] Tools

W
[w]| Prograrmers G Bt il Feset |

Toolbarn name;
Fil=

k. I Cancel Help

Figure 174 - Customize Dialog Box

3. Click inside the Show Tooltips checkbox for assistance in identifying icons on your toolbar when you
scroll across them with your mouse.

4. Click inside the Cool Look checkbox to change the look of your toolbar.
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5. Click OK.

You can create multiple toolbars and assign names to them. Click the New button and type in a name in the

New toolbar dialog box to create a new toolbar. The name of your toolbar will display in the Toolbar field.
Reset your toolbar to the default settings by clicking the Reset button.

To customize commands:

1. From the Customize menu, choose Toolbars. The Customize dialog appears.
2. Click the Commands tab.

Customize ' x|

Toolbars  Commands I

Categories: — Buttons
Nl ?
Toolz

Frogrammers

Select a categony, then click a button to zee its description. Drag the buttan
to any toolbar

D escription

k. I Cancel Help

Figure 175 - Customize Dialog Box

3. Select a category by clicking one of three options (File, Tools, or Programmers). As you click an
option, the buttons to the right of the category area change accordingly.

4. Click and drag a button to your toolbar.
5. Click OK after you have customized your toolbar.

You can also remove commands from your toolbar by reversing the click and drag method described in the
steps above. Click and drag tools from your toolbar to the Buttons field in the Customize dialog box.

Customizing the Programming Window

The FlashPro software also enables you to customize the programmer window by right-clicking on the
programmer window's header (see figure below).

Programmer Programmer Programmer
1] Hame Type

Port Programmer Programmer
Status Enabled

Figure 176 - Programming Window Header
The following right-click menu displays (see figure below).
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FlashPro Preferences

Set ‘Programmer Mame' Default Column Size
Set All Defaulk Sizes

Sort 'Programmer Mame' Ascending
Sort 'Programmer Mame' Descending

Programmer ID
v Programmer Mame
v Programmer Type
v Port
v Programmer Status
v Programmer Enabled

Custamize Columns. .,

Figure 177 - Right-click Menu

The Customize right-click menu (as shown above) is divided into three sections. Click an item in the first
section to set default sizes. Click an item in the second/middle section to add that item to the programmer
window, and click the Advanced or last section to customize the columns in the Programmer window from
the Customize Columns dialog box (see figure below).

Customize Columns 5[

Check the colurmns that vou would like visible in this
wigw, Use the Up and Down buttons to reorder the
columns however vou like.,

R ¢
[wProgrammer Mame
[wlProgrammer Tvpe Down &
[w]Port
[w]Programmer Skatus Hide
[w|Programmer Enabled
[w]Current Serial Data Shows

ErLE

Default

Ik I Zancel |

Figure 178 - Customize Columns Dialog Box

Note: Follow the instructions in the Customize Columns dialog box to customize the programming window. Use the Up
and Down buttons to move through the list. Use the Show and Hide buttons to hide or show columns in the programmer

window.

FlashPro Preferences

The Preferences dialog box includes three tabs: Log Window, Display Mode, and Updates (see figure
below). You can access the Preferences dialog box by choosing File > Preferences.
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Log 'window | Dizplay Mn:u:lel Llpdatesl

— Color Settings

Choose the color used to dizplay a meszage wpe by
clicking the caolar rectanale.

Ermrors Infos -
Wiamings [ |~ | Lirkz B -

Restore Defaultz |

[™ Clear log window automatically

| )4 I Cancel | Help

Figure 179 - Preferences Dialog Box

Log Window

The Log Window tab includes options for you to choose color settings for the various messages (Errors,
Warnings, Information, Links) displayed in the Log window (see figure above).

Display Mode

The Display Mode tab describes the two display modes available in the FlashPro software (as shown in the
figure below). Read each option carefully and choose the mode that will meet your programming needs. As
the Preferences dialog box indicates, the Classic Mode is designed for multiple programming runs when it is
not necessary for you to change your device settings. The Advanced Mode differs from the Classic Mode
because displays both windows (Programmer List and Device Configuration) in the same GUI. Use this
mode when you need to change device settings frequently.
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FlashPro Preferences

Log ‘window  Display Maode | Llpdatesl

FlazhFro dizplayz bwo windows:

- Programmer Lizt Window.

- Device Confiquration Window,

Select one of the modes below to display the Programmer List
and/ar the Device Configuration windowz):

f+ == =] Claszic Mode: Only one window view appears in the
j GUI &t a time. “r'ou must switch between the bwo
windawsz. |ze thiz made for multiple pragranmnming
runz when frequent device zetting changes are not
NECESEary.

[ E Advanced Mode: The bwo window views appear in
the zame GUI. ze thiz mode if you need to change
— device zettingz between programming runz.

| )4 I Cancel Help

Figure 180 - Preferences Dialog Box- Display Mode

Software Updates

The Updates tab lists the FlashPro software setting options. You can choose to have the FlashPro software
automatically check for updates at startup (from the Microsemi website) or remind you to check for updates

at startup (requires you to go to the Microsemi SoC website). If you want to decline both options, choose the
last option: Do not check for updates or remind me at startup.

Log Windnwl Display Mode  Updates

Automatic Software Lpdate;

Settingz
" Automatically check for updates at startup
" Femind me to check for updates at startup

* Do not check for updates or remind me at startup

To keep your software up-to-date, pou can automatically
check for available updates at startup. To manually check
for updates, from the Help menu, chooze Check for
Software Lpdates.

Thiz feature requirez an Internet connection.

| k. I Cancel Help

Figure 181 - Preferences Dialog Box- Updates

Software version is up to date

This informational message notifies you that there are no software updates available from Microsemi at this
time. You can set your update preferences to automatically check for software updates.
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FlashPro File Menu

In the Chain Programming mode, the Edit menu and the Configuration menu changes. The table notes

these changes.

Command Icon | Shortcut | Sub-menu Function

New Project Ctrl + N Create a new project

Open Project Ctrl+ O Opens the FlashPro Open Project dialog box

Restore Restores a ChainBuilder project in FlashPro

Chainbuilder

Project

Close Project Closes the current project

Save Project Ctrl+S Saves the current project

Save Project Opens the Save As dialog box; enables you to save your project in a

As different directory or with a different name

Import Ctrl + | Opens the Import Configuration File dialog box; enables you to import

Configuration configuration files for your device(s)

File

Set Project Main Log File | Opens the Set Log File dialog box; sets the location of your main log file

Log File >
Serialization Opens the Set Serialization Log File dialog box; sets the location of your
Log File serialization log file

Run Script Opens the Execute Script dialog box; enables you to run Tcl Scripts with

arguments

Export > Configuration | Opens the Export Configuration File dialog box; enables you to export
File configuration file(s)
Script Opens the Save As dialog box; enables you to export your actions as a

Tcl script

Chain STAPL | Opens the Export Chain STAPL File dialog box; enables you to export and
File save your Chain STAPL file
Chain SVF Opens the Export Chain SVF File dialog box; enables you to export and
File save your Chain SVF file
Single Device | Opens the Export Single Device STAPL File dialog box; enables you to
STAPL File export and save your single device STAPL file
Single Device [ Opens the Export Single Device SVF File dialog box; enables you to
SVF File export and save your single device SVF file
Single 1532 Opens the Export Single 1532 File dialog box; enables you to export and
File save your single 1532 file

Preferences Opens the Preferences dialog box; enables you to set your Log window,
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FlashPro Edit Menu

Command Icon | Shortcut Sub-menu Function

Display Mode and Update preferences for FlashPro

Exit Exits FlashPro

FlashPro Edit Menu

Command Shortcut Function

Cut Devices Ctrl + Shift + | Removes (cuts) devices from the project
X

Copy Devices Ctrl + Shift + | Copies the selected device(s) to your Clipboard

Cc
Paste Devices Ctrl + Shift + | Pastes the devices from your Clipboard into the
\% project
Clear Log Clears the Log window (deletes all Log window
Window content)

FlashPro View Menu

The View menu shows or hides the FlashPro GUI elements.

Command Sub-menu Function
Status Bar Shows/hides the FlashPro Status Bar
Programmer List Window Shows/hides the Programmer List Window
Programmer Details Shows/hides the Programmer Details Window
Window
Single Device Shows/hides the Single Device Configuration Window

Configuration Window

Log Window Shows/hides the Log window

Single Device Basic View | Enables the Basic view for the Single Device Configuration window
Configuration >

Advanced Enables the Advanced view for the Single Device Configuration window
View

FlashPro Tools Menu
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Command Icon | Shortcut Sub-menu Function
Mode > |m Single-Device | Sets FlashPro to Single-Device Programming mode
Programming
= Chain Sets FlashPro to Chain Programming mode
Programming
Serialization > % | Skip Serial Sets FlashPro to skip serial data during programming
Data
ru Reuse Serial Sets FlashPro to reuse serial data during programming
= Data
Programmer @ Opens the Programmer Settings dialog box; enables you to set options
Settings : for all FlashPro programmer types
Import Settings Opens the Import Settings for Non-Microsemi Devices dialog box;
for Non- enables you to import your settings for non-Microsemi devices you
Microsemi wish to program with FlashPro
Devices
Connect ‘fhﬂ | Opens the Connect Parallel Port Cable dialog box; enables you to
Parallel Port connect your parallel port buffer cable
Cable
Run m | Ctrl + Programs your device
! Enter

FlashPro Programmers Menu

Command Icon | Shortcut Function
Ping | #? Pings a selected programmer(s)
Self Test ‘ % Runs a self-test on the selected programmer(s)
Scan Chain @ Runs scan chain on the selected programmer(s)
Remove m Removes the selected programmer(s) from
FlashPro
Refresh/Rescan Ctrl + F5 | Refreshes FlashPro and rescans for programmers

FlashPro Configuration Menu

Command Icon | Shortcut Sub-menu Function
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FlashPro Customize Menu

Command Icon | Shortcut | Sub-menu Function
Select Action s | Ctrl + Shift
= |+ A
Serialization > Ctrl + Shift | Use Enables you to use Serialization in
+S Serialization | FlashPro
Ctrl + Shift | Select Enables you to set your
+R Range Serialization range

Ctrl + Shift | View Status | Enables you to view your

+U Serialization status

Load Ctrl + Shift Opens the Load Programming File

Programming +L dialog box

File

Unload Removes (unloads) your

Programming programming file from FlashPro

File

PDB Ctrl + Shift Opens the PDB Configuration

Configuration +P dialog box; enables you to set
your PDF configuration options

Select Target Ctrl Shift + Opens the Select Target Device

Device D dialog box; enables you to set
your target device for
programming

Chain Ctrl + Shift Opens the Chain Parameter

Parameter +H dialog box; enables you to set
parameters for your programming
chain

FlashPro Customize Menu

Command Function

Toolbars Opens the Customize dialog box to the Toolbars tab; enables you to
show/hide toolbars and tooltips

Commands | Opens the Customize dialog box to the Commands tab; enables you to
add/remove individual commands to your toolbars

FlashPro Help Menu

Command Icon Sub-menu Function
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Command Icon Sub-menu Function
Help > Help Topics Opens the help

Programmer View | Opens the help to the FlashPro
Programmer List Window topic

Details on Opens the help to the Programmer
Programmer View | Details Window topic
Single Device Opens the Single Device Programming
Programming help topic
Chain Opens the Chain Configuration Window
Programming help topic
Microsemi Web Opens the Microsemi website in your
Site default browser
Check for Checks for software updates (works
Software Updates only if you are connected to the
internet)
About FlashPro Lists the FlashPro release information

FlashPro Flow Window

The Flow window (located between the toolbar and Log window in the FlashPro GUI)consists of the
following buttons: New Project, Open Project, Configure Device, View Programmers, and Run. See the
table below for a description of these features.

ﬁ Configure Device

=

Open Project |iq' Yiew Programmers

RUN

Figure 182 - Flow Window
Table 45 - Flow Window Button Description

Button Description
New Project Creates a new project. Opens the New Project dialog box.
Open Project Opens a new project. Opens the Open Project dialog box.
Configure Device Opens the Single Device Configuration

window to configure your file.

View Programmers Opens the Programmer List Window for you to view your
programmers.

Refresh/Rescan for Rescans for programmers.

Programmers
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FlashPro Log Window

Button Description

Run Executes programming.

FlashPro Log Window

The Log window displays errors, warnings, and basic information about your device. Click the tabs at bottom
of the Log window to toggle between messages or click the All tab to display all of the messages.

You can access the Log window from the View menu.

Setting Log window preferences

From the Preferences dialog box, you can change the text color of the messages that appear in the Log
window.

To set Log window preferences:
1. From the File menu, choose Preferences.
2. Follow the directions in the Color Settings area or click the Restore Defaults button.

X

Log*#indow | Display Ml:u:lel Updatesl

— Color Settings

Chooze the color uzed o dizplay a meszage tpe by
clicking the color rectangle.

Errors Infos -
Warnings [ |~ | Links -

Restare Defaultz |

[ Clear log windaw autarnatically

k. Cancel | Help |

Figure 183 - Preferences
3. Click OK to apply settings.
Note: Y ou can clear the Log window by choosing Clear Log window from the Edit menu or you can automatically erase the

information by checking the Clear Log Window Automatically checkbox.

FlashPro Status Bar

The Status bar displays the program status, the programmer information (the file name for single device
programming and number of devices for chain programming), and the programming mode (single or chain).
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FlashPro Programmer List Window

To activate the Programmer List Window, select View > Programmer List Window. The FlashPro
Programmer List Window consists of a spreadsheet with the programmer name, programmer type, port
number, programmer status, programmer enable check box, and a Refresh/Rescan for New
Programmers button as shown in the figure below.

Note: Double-clicking any of the spreadsheet columns opens the Programmer Details window.

x

Programmer Programmer Port Prog Prog
Hame Type o Status Enabled

Device / Action

Programmer List Window

‘ Refresh/Resran for Prngrammers

Figure 184 - Programmer List Window

Changing the Name of your Programmer

You can change the name of your programmer by double-clicking in the spreadsheet cell or you can choose
Edit Cell from the right-click menu.

Connecting New Programmers
You can connect new programmers by clicking the Refresh/Rescan for Programmers button.

Accessing Right-Click Menus

If you have checked the Programmer Enabled checkbox, you can right-click on any of the spreadsheet
fields to access the menu in the figure below.

5 Ping

58 Self Test
@ 5Scan Chain
ﬁ Rernove

Disable

Run Selecked Programmers

Right-Click Menu

If you have not checked the Programmer Enabled checkbox, you can right-click in the on any of the
spreadsheet fields, to access a menu to remove or enable the programmer (see figure below).

% Remove

Enable

Figure 185 - Right-Click Menu

Programmer Details Window

The Programmer Details Window displays your programmer ID, port, type, name, and programming status
(see figure below). Use this window to check the status and access common commands (ping, self-test,
scan chain) and to enable/disable or remove the programmer from the chain.
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FlashPro Single Device Configuration Window

Programmet Details Window x

[v Enable programmer

Programmet I 01236

Port: usb01236

Type: FlashPro3
Prograrmer name: 01236

Skakus: SCAM CHAIM PASSED
Action: PROGRARM

Current Senalization D ata:;

Mext Senalization 0 ata;

Fing Self-test Scan chain | Femove |

Figure 186 - Programmer Details Window

You can access this window from the View menu or you can double click any of the fields in the
Programmer List Window (Programmer Name, Programmer Type, Port, Programmer Status, and
Programmer Enabled).

Click the Enable Programmer checkbox to enable your programmer and activate the Programmer Details
Window.

From the Programmer Details Window, you can ping a programmer, perform a self-test, scan a programmer,
Or remove a programmer.

FlashPro Single Device Configuration Window

Single Device Configur ation Window

To access the Single Device Configuration Window click the Configure Device button in the Flow window.
The Single Device Configuration window displays PDB/STAPL file and serialization information (see figure
below). You can also deactivate serialization by clicking the Serialization checkbox.

Programming file
To continue,

load existing programming File Browse. ..
or create new PDE File

EEEE =T

Figure 187 - Single Device Configuration Window
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Loading the PDB/STAPL File

You can load your PDB/STAPL file from the Configuration menu by choosing Load Programming File or
by clicking the Browse button in the Single Device Configuration Window.

You can set chain parameter settings by clicking the Chain Parameter button.

Selecting Serialization Indexes

To select the serialization indexes:
1. Check the Serialization checkbox to activate serialization.
2. Click the Select Serialization Indexes button. The Serial Settings dialog box appears (as shown in the figure

below).

Serial Settings E|

W00 -~ I N e L

Hagd»

[v Wiew unused data
[+ Yiew used data
[v View skipped data

Filker: | *

v Log serial data: |Regin:|n_6_3 j

Help | Ik | Cancel |

Figure 188 - Serial Settings Dialog Box

3. Click to select an index in the Indexes column.

4. Click the red arrow button that is pointing toward the Selected Indexes column to move an index to
the Selected Indexes column.

5. If you want to move all the Indexes to the Selected Indexes column, click the All button.
6. Click OK. Information about your serial indexes displays.

You can move indexes from the Selected Indexes column to the Indexes column by clicking the red arrow
buttons pointing toward the Indexes column.

You can set your indexes by choosing the following check boxes: View unused data, View used data, and
View skipped data.

Selecting Action and Procedures

You can select actions from the Basic mode and the Advanced mode. The Basic mode is provided for users
that only require the Program, Verify and Erase actions. In Basic mode, other actions are not visible, and the
Procedures run by an Action cannot be modified.

272 FlashPro User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

& Microsemi

FlashPro Single Device Configuration Window

Mode: © Basic { Advanced

Actian

f+ PROGRAM
£ VERIFY
" ERASE

Figure 189 - Basic Mode

The Advanced mode enables you to select an action and modify the procedures for the selected action. In
Advanced mode, actions are determined by the stapl standard used.

Mode: © Basic  Advanced

Actian

PROGRAM j

Procedures. ..

Figure 190 - Advanced Mode

To select an action (Advanced Mode):
1. Click the down arrow in the Action menu and select and action (see figure below).

Actian

PROGRAM [~

Hunll
FROGRAM_ARRAY
PROGRAM_FROM
PROGRAM_SECURITY
READ_IDCODE

WERIFY bt

Figure 191 - Action Menu
2. Click the Procedures button. The Select Action and Procedures dialog box appears.
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Figure 192 - Select Action And Procedures Dialog Box

3. Select a procedure or click the Restore Default Procedures button. Gray checkboxes indicate that
the procedure is mandatory.

Note: The procedures in the Select Action And Procedures dialog box are determined by the
STAPL standard. The Recommended procedures are selected by default and the Optional

procedures are unselected by default.

4. Click OK.
Note: Y ou can also click the Select Action and Procedures dialog box from the toolbar.

Chain Configuration Window

The Chain Configuration Window displays the chain order, the chain editing options, and the chain
configuration grid (see figure below).

The Show Chain Editing checkbox, when checked, displays your chain editing options (Configure device,
Add Microsemi Device, Add Non-Microsemi Device, and organization buttons to move your device within the

grid).
For information on how to add Microsemi and Non-Microsemi devices, see the Chain Editing help topic.

For information on how to use the Organize buttons, see Using the Organize Buttons in the Chain
Programming Grid.

You can enable programming and serialization by checking the Enable Device checkbox and the Enable
Serial checkbox in the Chain Configuration grid.

—-|rn| N wol—-ooo—-lml 2 rnol—-lwl 1 Tool—- | | _I _J _I %I
[¥ Show Chain Editing 4l

IR Max TCK = Enable  Enable

- . Senial
Device Name File Length = [MHz) | Device | Serial

At HIGH-Z

Action

Construct the chain from a Scan Chain operation...

Figure 193 - Chain Configuration Window
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Chain Configuration Window

Auto-Construction of Chain from Scan Chain

When in chain programming mode, the FlashPro software enables you to automatically construct the chain
by clicking the Construct the chain from a Scan Chain operation link, or by selecting Construct Chain
Automatically from the Configuration menu.

This enables you to scan a chain of devices and automatically construct the chain within FlashPro. If you are
using non-Microsemi devices, you will need to import the device settings into the database by using the
Import Settings for Non-Microsemi Devices dialog box. The software also scans the chain before
constructing it, which reduces the possibilities of having errors in the chain. For more information on how to
automatically construct a chain from scan chain, refer to the Automatic Chain Construction Tutorial.

Chain Editing Options
The FlashPro software enables you to edit your chain by adding Microsemi and Non-Microsemi devices.
You can add devices by clicking the Add Microsemi Device button and the Add Non-Microsemi Device
button or you can select these options from the Configuration menu.

Note: For more information about how to edit the chain, see Chain Editing.

Editing the Chain Configuration Grid
The Chain Configuration Grid enables you to select an Action for your device, Enable Serialization, and
edit the grid using the right-click menu.
To select an Action from the Configuration Grid:
1. Choose the device you would like to program and check the Enable Device checkbox.
2. Inthe Action column, click the down arrow to expose the drop-down menu (see figure below).
3. Select your desired action.

Action

PROGRAM =

DEVICE_IMNFO
ER&SE
ERASE_ALL
ER&SE_ARRAY
ERASE_FROM
P A b :
PROGRAM_ARRA,
PROGRARM_FROM
READ IDCODE
YERIFY

WERIFY _ARRAY
WERIFY _FROM

Figure 194 - Drop-Down Menu for Select Action

To enable Serialization:
1. Check the Enable Serial checkbox. By enabling serialization, the action options change.
Note: Note: Before you can enable serialization, you must check the Enable Device checkbox.
2. Inthe Action column, click the down arrow to expose the drop-down menu (see figure below).

Action

PROGRAM =
P i
PROGRAM_FROM
VERIFY
VERIFY_FROM

Figure 195 - Drop-Down Menu for Select Action
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3. Select your desired action.

4. Choose Select button from the Serial Data column, which is next to the Action column (see figure
below).

Serial
Data

Figure 196 - Serial Data Column
The Serial Settings dialog box appears.

5. Choose your serial settings from the Serial Settings dialog box.

See Serial Settings for more information about this topic.
Note: Uncheck the Enable Serial checkbox to disable serialization.

To edit the Chain Configuration Grid:

1. Select the device you would like to edit and right click anywhere in the row of the selected device. The
right-click menu below displays.

2. Select and click an option from the right-click menu.

Note: The Device Configuration menu includes options for configuring your device.
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Microsemi SoC Products Group Headquarters

Contacting Microsemi

Microsemi SoC Products Group Headquarters

Microsemi Corporation is a supplier of innovative programmable logic solutions, including field-
programmable gate arrays (FPGAS) based on antifuse and flash technologies, high-performance intellectual
property (IP) cores, software development tools, and design services targeted for the high-speed
communications, application-specific integrated circuit (ASIC) replacement, and radiation-tolerant markets.

Address: Microsemi SoC Products Group
3870 North First Street
San Jose, CA 95134

Phone: 408-643-6000

See Also
Customer Service
Technical Support
Sales

Technical Support

Highly skilled engineers staff the Technical Support Center from 7:00 AM to 6:00 PM Pacific Time, Monday
through Friday.

Visit Tech Support Online

For 24-hour support resources, visit Microsemi Technical Support at
http://www.microsemi.com/fpga-soc/design-support/fpga-soc-support

Contacting Technical Support

Contact us with your technical questions via e-mail or by phone. When sending your request to us, please be sure to include

your full name, company name, email address, and telephone number.

E-mail (Worldwide): soc_tech@Microsemi.com
Telephone (In U.S.): (650) 318-4460
(800) 262-1060
Telephone (Outside the US): Contact a local sales office
See Also

Microsemi SoC Headquarters
Customer Service

Sales

Documentation feedback
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Customer Service

Contact Customer Service for order status, order expedites, return material authorizations (RMA), and first
article processing. For technical issues, contact Technical Support.

The Customer Service phone number is +1 650 318 2470.
Customer Service email: customer.service@microsemi.com
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Regulatory and Compliance Information

EU Declaration of Conformity:

This product complies to Directive 2011/65/EU of the European Parliament and of the Council of 8 June
2011 on the restriction of the use of certain hazardous substances in electrical and electronic equipment.

To view the Declaration of Conformity in English:
http://www.microsemi.com/index.php?option=com docman&task=doc_download&gid=131772

Non-English:
http://www.microsemi.com/index.php?option=com docman&task=doc_download&gid=131748

Markings:

c € This product complies with 2004/108/EC, Electromagnetic Compatibility (EMC) Directive
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Product Support

The Microsemi SoC Products Group backs its products with various support services including a Customer
Technical Support Center and Non-Technical Customer Service. This appendix contains information about
contacting the SoC Products Group and using these support services.

Contacting the Customer Technical Support Center

Microsemi staffs its Customer Technical Support Center with highly skilled engineers who can help answer
your hardware, software, and design questions. The Customer Technical Support Center spends a great
deal of time creating application notes and answers to FAQs. So, before you contact us, please visit our
online resources. It is very likely we have already answered your questions.

Technical Support

Microsemi customers can receive technical support on Microsemi SoC products by calling Technical
Support Hotline anytime Monday through Friday. Customers also have the option to interactively submit and
track cases online at My Cases or submit questions through email anytime during the week.

Web: www.actel.com/mycases

Phone (North America): 1.800.262.1060
Phone (International): +1 650.318.4460
Email: soc_tech@microsemi.com

ITAR Technical Support

Microsemi customers can receive ITAR technical support on Microsemi SoC products by calling ITAR
Technical Support Hotline: Monday through Friday, from 9 AM to 6 PM Pacific Time. Customers also have
the option to interactively submit and track cases online at My Cases or submit questions through email
anytime during the week.

Web: www.actel.com/mycases

Phone (North America): 1.888.988.ITAR
Phone (International): +1 650.318.4900
Email: soc_tech_itar@microsemi.com

Non-Technical Customer Service

Contact Customer Service for non-technical product support, such as product pricing, product upgrades,
update information, order status, and authorization.

Microsemi’s customer service representatives are available Monday through Friday, from 8 AM to 5 PM
Pacific Time, to answer non-technical questions.

Phone: +1 650.318.2470
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Microsemi Corporation (NASDAQ: MSCC) offers a comprehensive portfolio of semiconductor
solutions for: aerospace, defense and security; enterprise and communications; and industrial
and alternative energy markets. Products include high-performance, high-reliability analog and
RF devices, mixed signal and RF integrated circuits, customizable SoCs, FPGAs, and

M"cmserr”' complete subsystems. Microsemi is headquartered in Aliso Viejo, Calif. Learn more at
¢ www.microsemi.com.

Microsemi Corporate Headquarters

One Enterprise, Aliso Viejo CA 92656 USA
Within the USA: +1 (949) 380-6100

Sales: +1 (949) 380-6136

Fax: +1 (949) 215-4996

© 2014 Microsemi Corporation. All rights reserved. Microsemi and the Microsemi logo are trademarks of
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